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Introduction

Our Mission Statement

L€ Our mission is to put a smile on the face of Excel users all over the world, k)
by providing a friendly and easy to use add-in, that saves time and speeds
up their work in Excel.

What is ASAP Utilities?

ASAP Utilities is a powerful Excel add-in that adds new functionality to Microsoft Excel to
save time and speed up your work.

We're proud and happy that, ever its first release in 1999, we can help Excel users all over
the world.

ASAP Utilities is called this way because it significantly reduces time-consuming work. ASAP
is an acronym that stands for "As Soon As Possible". Some choose to spell it out, others
tend to pronounce it "aysap". The word “utilities” means something that is useful.
Combined together ASAP Utilities stands for useful time-saving macro tools for Excel.

During the past 24 years our add-in has grown to become probably one of the world's most
popular add-ins for Microsoft Excel.

Over 2,500 users have reviewed ASAP Utilities and given it an average rating of 4.9 out of 5:
https://www.trustpilot.com/review/asap-utilities.com

We are proud to mention that ASAP Utilities is currently used worldwide in over 170
different countries by 750,000+ users and purchased by 26,000+ organizations.
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About this User Guide

This User Guide will show you what you can do with ASAP Utilities. It will tell you how to
install this Excel add-in and it gives a description of all the utilities available.

In our opinion a good program should be easy to use without the need of any
documentation. However, during the last 15 years, the need for documentation has
increased. ASAP Utilities has more tools than ever, and this user guide will help you to get
the best out of it.

Besides documenting the utilities in ASAP Utilities, we have also included a “How to”
chapter. In that chapter (chapter 6, “Practical Tricks to Save Hours in Excel with
ASAP Utilities” on page 283) we have listed common Excel questions and how to use
ASAP Utilities to answer them.

The most recent version of this User Guide is available on our website:

https://www.asap-utilities.com

This document currently covers everything available in version 8.1 which is the latest
version of ASAP Utilities when this User Guide is published.

Save paper

To save paper, this document is optimized for duplex printing.
To save even more paper, you can read this User Guide in PDF or XPS format on your
computer, tablet or e-reader.

Intended audience

The principal audience for this user guide is people that use Excel on a regular basis. The
focus is on introducing you to the tools available in ASAP Utilities.

We assume that you are already familiar with Excel and its structure (workbooks,
worksheets, ranges etc.). If you do not use the international/English version of Excel then
we recommend you view paragraph 2.6, “The Excel screen in English” on page 9.

8 Chapter 2
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2.6 The Excel screen in English

This documentation is in English since most people that use Excel speak this language.
Even though most people speak English, translating certain things in Excel might become
difficult or look strange. That is why we show you the layout of Excel and how certain things

are called in English.
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3 Getting started

3.1 How to get a copy of ASAP Utilities

3.1.1 Download from our website

You can download a copy of ASAP Utilities from our website:

https://www.asap-utilities.com

Home Screenshots 10 Languages Why use it?

-& asap utilities

What is it?~  Why u

wrload v Buy

s User Guide v Newsw

Download Pricing ContactUs Blog v

> Home

Save time in Excel with ASAP Utilities

“The most popular add-in for Excel users”
ASAP Utilities is a friendly Excel add-in that saves our users a lot of valueable time.
The many well-thought-out and useful tools make your work in Excel much easier and faster.

‘With great enthusiasm, and for over 20 years already, our team ensures that ASAP Utilities is
continuously evalving 1o help our users. Itis truly one of the world's most popular add-ins for Excel.

“A must-have for anyone who spends time in Excel”

Our mission is to put a smile on the face of Excel users all over the world, by providing a friendly and
easy to use add-in, that saves time and speeds up their work in Excel

Trusted daily by over 24,000 organizations
We love our work, are friendly and helpful and that shows in the quality of
our product and customer service. We strongly believe in long-term
solutions and relationships.

ASAP Utilities is used nowadays by over 750,000+ users and 24,500+
organizations worldwide.

‘You can read real and honest reviews on Trustpilot i

Download today and start saving time in Excel

Download our fully functional 90-day Business trial or the free Home&Student edition.
The latest version of ASAP Utilities, 8.0, was released on September 20, 2022

ASAP Utilities installs easily and creates its own tab in Excel from which you can start the tools

Ready to Save Hours in Excel? >

Excellent EJEIEIEIEN 2579 revievs on H Trustpilot

Choose your language of ASAP Utilities

With clients in over 140 countries, ASAP Utilities is used with many different languages.
YYou can choose from the following 10 languages for the ASAP Utilities user interface:

. English 6. Nederlands (Dutch)

. Deutsch (German) 7. Portugués do Brasil (Portuguese (Brazil))
. Espariol (Spanish) 8. Pycckmia (Russian)

. Frangais (French) 9. h¥({Edk) (Chinese (Simplified))

. Ialiano (Italian) 10. H#ZE (Japanese)

e oa oW =

Do more and save time with these added Excel tools
A few examples of tools that our users use most, or that saves them the most time, are:

Ton 10 mact nead tnnle Tan 10 mact Hima-cawine tanle

—_—— -]

Relax and enjoy how
these handy tools speed
up your Excel tasks

Excellent BN

2.579 reviews on K Trustpilot

Save time in Excel, increase
productivity. Start today

Download »

Choose from 10 languages
With clients in over 140
countries, ASAP Utilitie:
available in:

> English
Deutsch (German)
Espafiol (Spanish)
Erancais (French)
Italiano (Italian)
Mederlands (Dutch)
Portugués do Brasil
(Portuguese (Brazil))
Pycckuit (Russian)
R (EiE) (Chinese
(Simplified))

> B#3E (Japanese)
You can change the language
to your preferred language at
any time from within the
application.

Supported Excel versions
ASAP Utilities 8 works with the
Windows editions of

> [Excel 2010

> Excel 2013

> Excel 2016

> Excel 2019

> Excel 2021

> Excel 365 Desktop

Quickly Save Hours
Simple and practical examples
of how ASAP Utilities saves
you hours of time in Excel.

Awards & Reviews

Read the awards & reviews
from magazines, newsletters
and radio shows.

Trusted daily by over
24,000 organizations
Our list of clients exceeds
24,500 organizations in more
than 140 countries,

Pricing & Ordering
Buy your license(s) today. It's

onlv 118N 40 (0 for a sinala
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3.2 System requirements

3.2.1 Excel versions supported

ASAP Utilities 8 works with the Windows editions of:

= Excel 365 Desktop (both 32 bit and 64-bit)
= Excel 2021 (both 32 bit and 64-bit)
= Excel 2019 (both 32 bit and 64-bit)
= Excel 2016 (both 32 bit and 64-bit)
= Excel 2013 (both 32 bit and 64-bit)
= Excel 2010 (both 32 bit and 64-bit)

Starting from version 8, ASAP Utilities requires at least Excel 2010. However, we
recommend to use at least Excel 2013 because that is still updated by Microsoft.

For many years already Microsoft no longer supports old Excel versions. For users with
Excel 2000-2007 we still offer the older ASAP Utilities version 7. However, you could expose
yourself to serious and potentially harmful security risks by using such an old Excel version.

In 2023, the oldest version of Excel that Microsoft still updates is Excel 2013.

3.2.2 Windows versions supported

ASAP Utilities works on both 64-bit and 32-bit Windows versions, including the latest
Windows 11 and the server editions of Windows.

The minimum supported Windows version for the setup is Windows Vista.

Basically, if you can run any of the supported Excel versions from paragraph 3.2.1, “Excel
versions” on page 11, you can use ASAP Utilities.

3.2.3 Other requirements

Basically, if you can run any of the supported Excel versions from paragraph 3.2.1, “Excel
versions” on page 11, then your system is ready to use ASAP Utilities.

ASAP Utilities needs approximately 40 MB of disk space. This is for the program files and
the PDF User Guide together.

The minimum workable screen resolution is 1024 x 768 pixels.
The recommended screen resolution is full HD (1920 x 1080) or larger.

3.2.4 International versions of Excel, all supported

ASAP Utilities will run in all versions of Excel that meet the system requirements of Excel.
It doesn’t matter if your Excel is the international (English) version or you have local Dutch,
French, Spanish, Russian, Chinese, Arabic, Hebrew or any other language version. It works
in all.

Getting started 11
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Install and uninstall

To install ASAP Utilities, just follow the steps in the setup. Detailed and more technical
information is provided in paragraph 11.1, “Automatic installation on page 335.

Removing ASAP Utilities can be done easily via the Windows Control Panel, just like other
software.

Change the language of ASAP Utilities

In ASAP Utilities you can choose from the following 10 languages:

1. English 6. Portuguese (Brazil) (Portugués do Brasil)
2. Dutch (Nederlands) 7. ltalian (Italiano)

3. German (Deutsch) 8. Russian (Pycckuit)

4. Spanish (Espariol) 9. Chinese (Simplified) (F3(f&14))

5. French (Francais) 10. Japanese (H4A:E)

On popular demand more languages can be added, please contact us.

On its first use, ASAP Utilities will display all text in the same language as Excel.
If your Excel version is not one of the languages that ASAP Utilities has built-in, then
ASAP Utilities will default to the English language.

Language used in menus and dislogs:

Match Office Display Language (if available) ﬂ
—| English
Mederlands (Dutch)

Deutsch {(German)

—| Espafiol (Spanish)

Frangais (French)

Portugués do Brasil (Portuguese (Brazil))
Italiano (Italian)

Pycoami (Russian)

rhzr(iEiE) / Chinese (Simplified))
B (Japanese)

1
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3.4.1 ASAP Utilities in English
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Descriptions of all tools in ASAP Utilities

https://www.asap-utilities.com/features.php?lang=en us

3.4.2 ASAP Utilities in Dutch (Nederlands)
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Favorizten Tijd besparend tools Opties en instellingen Info en help Tips entrues Y
AL v fx v
A | 8 | ¢ [ b | E | F | 6 [ W | v | v | x | v | M | N | o | P | @ | R | s | T [ u | va
I .
2|
el
4
5]
6
7]
8]
9]
10|
1]
12|
13
14
15|
16 |
17|
18|
19|
0 v
Blad1 @® Ll »
| Gereed T% Toegankelikheid: alles in orde i o -—————+ 1w00% |

Beschrijving van alle tools in ASAP Utilities

https://www.asap-utilities.com/features.php?lang=nl nl
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3.4.3 ASAP Utilities in German (Deutsch)

P Suchen (Alt+h)

BB Automatisches Speichern Mappe? - Bxcel
Datei  Start Einfigen  Zeichnen  Seitenlayout  Formeln Daten Uberprifen  Ansicht Hife  ASAP Utiities O Kommentare
_& E‘E[ E:(l):l\ EH Blatter ~ [ spalten & Zeilen ~ ahlen & Zeiten v | @@ Web ~ [ import~ {5} ASAP Utilities Optionen v () Online-FAQ.
Favoriten & Anzeige | Ausnshlen £ Bereich ~ %7 Objekte & Kommentare Text~ [ Informationen ~ (5 Export ~ /O Tool finden und ausfahren (i) Info Tiop des
Tastenkombinationen ~ | Zentrum - [ Ausfallen~ [ Formatieren ¥ Jx Formein~ [ Datei a system~ | [> start v (%, Letates Tool emeut starten ), Registrierte Version Tages
Favoriten Zeitsparende Tools Optionen und Einstellungen Info und Hilfe Tipps und Tricks |~
AL v fx ~
A E | c | o | | L _© | & | | J | | ¢ L L 0N |l ©® | B | @ | &

I .

2|

3 |

4]

5|

al

7

2]

9|

10 |

1|

12

13

14

15 |

16 |

17

13 |

19 |

n v

Tabellel ® Ll »

| Bereit % Barrierefreineit: Keine Probleme i) o -————+ 100% |

Beschreibung aller Tools von ASAP Utilities

https://www.asap-utilities.com/features.php?lang=de de

3.4.4 ASAP Utilities in Spanish (Espanol)

ibrol - Excel P Buscar (Alt+Q)
Archivo Inicio  Insertar  Dibujar  Disposicién de pégina  Férmulas Datos Revisar \Vista Ayuda  ASAP Utiities = Comentarios
‘& E‘E[ a:& Ef Hojas ~ [ Columnas yFilas + = Namerosy Fechas~ | %@ Web ~ [ importar~ 45} Opciones de ASAP Utilities (@) FAQen linea F\
Fevoitos yTeclasde | Contral | Seleccionar £ Rango~ Z1 Objetos y Comentarios | [A] Texto + [ Informacién (55h Exportar ~ D Buscary ejecutar una utilidad (1) Informacién Suw&?m
métado abreviado ¥ de vision - [@ARellenar~ [ Formato ~ Jx Férmulas ~ [ Archivo y Sistema~  [> Inicio (' Ejecutela dltima herramienta @ Versién registrada del dia
Favoritos Herramientas que anorran tiempo Opciones y configuracion Informaciony ayuda  Sugerendias ytrucos
a1 - I -
A S - - ' S —w— — || Lt L ® J &8 I © | 0 | @ | & g
1 ]
2
3]
4|
5]
6
7]
8 |
9]
10|
11
12|
13
14
15 |
16 |
17
18|
10|
n -
Hojal @ « »
| sto fo Accesibinidadt todo correcto i o -———+ to0% |

Descripciones de todas las herramientas en ASAP Utilities

https://www.asap-utilities.com/features.php?lang=es es
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3.45 ASAP Utilities in French (Francais)

KH  Enregistrement automatiqu Bl Classeur! - Excel P Rechercher (aft+Q) & = @
Fichier Accuel Inserfion Dessin Mise enpage Formules Données Révsion Afiichage Aide  ASAP Utities © Commentaires
_& E}[ E¥ Fevillesv | [ Colonnes et Lignes + = Nombres et Dates v | @ Web v [ importer ~ 453 Options ASAP Utilities v (@) FAQen ligne F\
Favoris et Touches | Vision | Sélectionner | & Plage™ £ Objets et Commentaires > [A] Texte ~ [ Informations ~ [i2h Bxcporter D Rechercher et démarrer un utilitaire (1) Info Asmcz
de raccourei v Contréle v {7 Remplir~ [ Format ~ fx Formules ~ [ Fichier et Systéme~  [> Démarrer~ (*, Démarrez demier outil @, Version enregistrée du jour
Favoris Outils d enregistrement Options et paramétres Info et aide Trues etast. | ¥
AL v fx v
A B | c | D | E | F | G | H | | J | K | L | M | N | o | P | Q | R -
il L -
2|
3|
4|
5]
6]
7]
8]
9
10|
1|
12
13
14|
15|
16 |
17|
18|
19|
v
Feuill ® < »
| Prét T& Accessibilité : vérification terminée i B -————+ oo |

Descriptions de tous les outils dans ASAP Utilities

https://www.asap-utilities.com/features.php?lang=fr fr

3.4.6 ASAP Utilities in Portuguese (Brazil) (Portugueés do
Brasil)

Arquivo Paginalnicial Inserir Desenhar LayoutdaPAgina Formulas Dados Revisio Exbir  Ajuda  ASAP Utiliies © Comentarios
_& E‘l}f a:(l):l\ B Planithas + [ Colunas e Linhas ¥ i= NimeroseDatas~ | @ Web [® Importar~ {5} ASAP Utilities Opgdes » () Perguntas Frequentes Online F
TeclasdeAtalho | Controle | Selecionar £ Intervalo 3 Objetos e Comentdrios ¥ [A] Texto v [ Informagées » (i Exportar ~ P Localizar e executar um utilitario (D) Informagdes D‘g

e Favoritos - Visual M [ preencher~ | [ Formatar v [ Formulas [B Arquivo e Sistena v [> Iniciar~ ) Iniciar a dltima ferramenta novamente €, Versio registrada do Dia
Favoritos Ferramentas de economia de tempo Opgdes e configuragdies Informagdes e ajuda Dicas e trugques

AL v fe ~
L0 e | o L E I F |8 IO L0 | J I K Lo | 0t | 0 |l 0o | b @&/ /S| U L0 Y | O I

i —

21

2

4]

5]

6|

7]

£

9|

10]

1]

12|

13

14|

15 |

16|

17|

18|

19|

v
Planilhal ® . >
| Pronto % Acessibilidade: tudo certo ::3] 0 ———— o |

Descri¢Oes de todas as ferramentas em ASAP Utilities

https://www.asap-utilities.com/features.php?lang=pt br

Getting started 15


https://www.asap-utilities.com/features.php?lang=fr_fr
https://www.asap-utilities.com/features.php?lang=pt_br

ASAP Utilities User Guide

“Save hours in Excel”

3.4.7 ASAP Utilities in Italian (Italiano)

B cerea (a0

Home. Formule  Dabi  Revisione  Visualizza Guida  ASAP Utilities

<&

Preferitie Tastii  Controlle | Selezions
scelta rapida - i -

7 Fogii~ [ Colonne e Righe ~ = NumerieDate~ | @ Web~ [2 importa~ {5 Opaioni ASAP Utifties ~

£ itervalo - #1 Oggetti ¢ Commenti~ [ Testo - [ informasoni~ | [ Gsporta~ D Trova ed eseguiun'utita

(7) Domande frequenti online
G Informazioni

visualzzazio e 8 Riempimento~ | i Formata~ T Formule - BiFicesstema~ | [ Awis~ | (5 dwisdi

Al 8 | ¢ o | E | F | & L Y P Y S Y ! M N o | p [ a |

0|
n
2
13
14|
15
0]
7
18]
19

Preferiti Strumenti per risparmio di tempo Opzioni ¢ impastazion:

an

Fogliol @

pronte BB 17 Accessibilitic conforme

B B M -—a—-+ o

Descrizione di tutti gli strumenti di ASAP Utilities

https://www.asap-utilities.com/features.php?lang=it it

3.4.8 ASAP Utilities in Russian (Pycckmun)

D Nowex ahebh

© By Crpavsa  ASAP Utilities

- @ [3 Wunopr= | 5 Maganerpes ASAP Utites ~

(2 popmmuna~ [ Swcnopr= (5 Hiira wssmyerims yrasery

B owtancercnas | B> Hoam

B ¢ | ¢ | o | e | F | & | H | v | 2| & | & | M N | o | » | @ | R | s

iapaueTpat u sacrp b

B m Fl -—— 0m

OnuncaHusa Bcex MHcTpymeHToB B ASAP Utilities

https://www.asap-utilities.com/features.php?lang=ru ru
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3.4.9 ASAP Utilities in Chinese (Simplified) (4 =2 (f&{£))

£ BEA+Q & = O
X FE B 2B FTEAR AT BB =E 18 SE)  ASAP Utilities
‘& G;[ aa EIres- [EasT- ISMFSAS | @ Web~ [ SAv {5 ASAP Utilities i1 ~ @ EEEnaE F
g mE | me  GOEMY PuesmEe  [Awe mEs- Bese OswmEssala o =
G- =R M= F=c [ et v Sfeasty BxpsEs- D Fay O ESFRRLAEEnTE | QEEs =2
=23 HEFELE BIRIAE EEHRE  ErSED v
AL v Jx v
A | 8 | ¢c | p | E | F | G | H [ 0 | 3 | ¥ | L | M| N O [P Qa | R s |a
1 !
2,
3,
4_
5_
6_
7_
5_
9_
o)
11
12|
13|
14
15|
)
17|
el
19
~ v
Sheet1 @ ] >
| s TomENEE: e B M -——&——+ 100% |

ASAP Utilities tRFTA T BHY1%EH

https://www.asap-utilities.com/features.php?lang=zh hans

3.4.10 ASAP Utilities in Japanese (H 4A<zE)

£ EEAQ)

) Bookl - Excel

Jril W-h WA BE YL BR 79 @8 Fm ALT ASAP Utilities = 2sb
‘& E;[ ﬁa Byt~ | BT ST @ Web v [ fui-t~ 455 ASAP Utilities 7753y v @ #v3furAQ F

SRy Br | mp  GORE- DAvmhenob- ARk G w4~ [ okt | O 1-Frasled OF 4 $E|(g
[l e =2 v @Ea-  FEe=zE- fegte B opiesazhy | > 25k~ ¢ BRICBALL-ILEERS | O, 28/(-vay o
HRIAY BEmH Y- AT RE BREALT  EYREFIIE | v

Al v|: 5 v
A B c | D E F G H | 1 1|k L M N a | P a | R s a

o

2,

3,

4,

5|

6 |

7 |

8 |

9|

10|

11 |

12|

13|

14 |

]5_

16 |

17 |

18 |

19 | .

Sheet1 O] < »
| =mmT T TIEYEYT - RS St i M -————+ 100% |

ASAP Utilities D3R T DY — )L DB

https://www.asap-utilities.com/features.php?lang=ja ip
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3.4.11 Office Update

We recommend you to always install the latest updates and service packs from
Microsoft Office to improve Office its stability and security.

Although it is not necessary to run ASAP Utilities it is a good practice to keep your system

up-to-date.

3.4.12 Windows update

Although it is not necessary to run ASAP Utilities, it is recommended that you install the
latest service packs and updates to obtain the best out of your computer and keeping it
more secure. Run Windows update on your system.

3.5

How to operate ASAP Utilities

Once you have installed ASAP Utilities it adds an extra button/tab in Excel’s main menu.
All tools can be accessed via the ASAP Utilities menu and/or its shortcuts.

i) 5] ‘ < Bookl - Excel

File  Home Formulas Data  Review

<&

Favarites &
[Shortcut keys ~

Insert  Draw  Page Layout

E‘l;l B.:CI):‘\ B3 Sheets~
9 Range ~

A Fill

1. Select adjacent cells in column with the same value (Cirl~Alt+A)

P Columns & Rows -
vison | select #7 Objects & Comments ~
Control

[iZ Format +

2. Reload all installed add-ins (rebuilds the menu) (Ctrl+Alt+B)

3. Color each n'th row or column in selection... (Cirl+ Alt+ C)

P search (Alt+Q)

View Help ASAP Utiities
= Numbers & Dates~ | @ Web~

[A] Text ~

fx Formulas

[i@ Information ~
B File & System ~

[> start v

Time saving tools

[2 import~ 45} ASAP Utilities Options -

(568 Export ~

(@) Online FAQ F
O

() Info et
@) Registered version  the Day
Info and help

S5 Find and run a utility
(", start last tool again

Options and settings Tips tricks

4. Deselect cells... (Ctrl+Alt+D)

5. Set default path to current file (Ctrl+Alt+E)

6. Create a list of filenames and propesties in a folder.. (Ctrl+ Alt-F)
7. Export selection or active sheet as new file.., (Ctri+Alt+G)

8. Find and/or replace in all sheets... (Ctrl+Alt+ H)

@o@m UEHC

9. Apply formula/calculation to selected cells... (Ctrl+Alt+ 1)
10 (10 Start the last used utilty again.. (Ctrl+Alt+))
T 1. Extend selection to the last used column (Ctrl+ Alt+Shift= Right Arrow)
13 12, Extend selection to the last used row (Cirl+Alt+Shift+ Down Arrow)
14 £ 13 Move or resize selected range.. (Ctrls Alt-M)
16 B 14 Add newworksheet (fillin @ name)... (Ctrb+Aft-N)
17 B8 15. Select cells based on content, formatting and more... (Ctrb+Alt+ 0)
[ 16. Chenge formulas to their calculated values (Crb+Alt+ P}
20 {= 17.Quick numbering of selected cells.. (Ctrl+ Alt+Q)
[B 12 Reset Excel's last cell (Ctrl+Alt+R)
23 19. Saye file and create backup... (Ctrl+Alt+S)
24 Q 20.Vision Control.. (Ctrl+Shift+1)
26 [ 21. Move selected data (only values)... (Cri+Alt=X)
27 [3 22 Paste special (with combinations)... (Ctrl+Alt+Y)
[S 23 Insert current date and time with seconds (Ctrl+ Shift+D)
30 (D 24 Insert current time with seconds (Ctrl+ ShiftT)
£ 25, Find and run a utility... (Ctrl+Alt+Z)
33 Customize favorites menu

[ 26. Edit your favorite tools and shortcut keys..

Sheetl ®

Ready S T0Accessibility: Goodto go

i .
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Undo
Most (but not all) tools in ASAP Utilities have an undo

Not all tools in ASAP Utilities have an undo. Therefore, it is a good practice to thoroughly
test ASAP Utilities with non-critical data before relying on it or save your work before you
try something new with ASAP Utilities.

We did not just turn-off the undo or something like that; Excel has no built-in automatic
undo for macros. We are aware of the importance of global undo capabilities and continue
working on it.

No undo in macros are by design of Excel

By design, Excel nearly always resets the undo when you run a macro. If you run a macro,
you will see that the undo-history is reset, and the undo-button is disabled.

To enable undo for macros we wrote our own undo routine for ASAP Utilities. Basically, this
is another macro that stores the settings before running the tool and sets the undo to run
another macro that restores the original settings. Excel does not allow multi-step undo for
programmers so only the last action in ASAP Utilities can be undone (if available).

If you need to undo changes that were made prior to running an ASAP Utilities tool the only
option is to close the workbook without saving. This will revert to the original version, but
all changes made during the session will be lost.

Depending on the tools in ASAP Utilities some of the custom undo-routines are relatively
simple and have been implemented. However, some of the operations require complex
undo-procedures that have not yet been implemented because they are simply too difficult
or complex to create in the amount of time that we have available.

Since ASAP Utilities is under constant development perhaps the undo you are missing right
now is implemented in the next version.

Getting started 19



ASAP Utilities User Guide “Save hours in Excel”

Purchase ASAP Utilities

Time saved, “return on investment”

The tools from ASAP Utilities add new functionality to Excel and are guaranteed to save you
time and speed up your work.

The time saved with ASAP Utilities will recover the license costs nearly always within a few
weeks. And the purchase is a one-time free, not a yearly subscription.

On average ASAP Utilities saves people 32 hours each year (measured among 145,873 users
in January 2023).

With the following tool you can see how much time (and money) ASAP Utilities has saved
you so far:

ASAP Utilities Options » Report the estimated time that is saved by ASAP Utilities

Time Saveq

- Y Using Agap Ut
3
3 Measured usage: 1, november 2011
ast measured usage: 1 oktober 2012
Actual days used: 162
Total time saved in hours: 33,0

ilitie

e 1.1

Editions

ASAP Utilities exists in two editions:

= Business edition, 90 Day Trial (with full functionality)
Free 90-day trial. Price is USD 49 or less with volume discounts
= Home and Student edition
Free for home projects, school homework and use by charitable organizations

The ASAP Utilities 'Home and Student' edition is free and is (only) for non-commercial use,
such as home projects, schoolwork and use by charitable/non-profit organizations such as
the International Committee of the Red Cross, UNICEF, Amnesty International,
MSF/Doctors Without Borders etc..
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4.3 When to buy a license

4.3.1 Business Edition

This edition of ASAP Utilities is for companies, governments, etc...

We offer a free 90-day trial version with functionality.
To continue to use it after the 90-day trial period, simply purchase a license key.

4.3.2 Home & Student Edition, Charitable Organizations

The free "Home & Student" edition of ASAP Utilities is free to use for home projects, school
homework and charitable/non-profit organizations such as for example the International
Committee of the Red Cross, UNICEF, Amnesty International, MSF/Doctors Without Borders
etc.. Especially with providing it for free to students and charitable organizations, we hope
to contribute to a brighter future.

Purchasing a license is voluntary for this group and a reason to purchase a license can be:

= if you like ASAP Utilities and think it is worth the money

= if you do not want to install an update once or twice a year
= to get priority support

= to support future development

Note: This Home & Student edition cannot be used for commercial or business use.

4.4 Key benefits of a license

= Use itin a commercial organization (which is what most companies are)

= Priority support via email

= No forced updates twice a year

= Alicensed version will never expire

= Free upgrades (minor and major) for at least 3 years or to all versions 8.x whichever is
longer. If version 9 is released within 3 years of your purchase you get all upgrades
including version 9 free.

4.5 Who uses ASAP Utilities?

ASAP Utilities exists since 1999 and is used in a variety of organizations.

We are proud to mention that our list of clients exceeds 26,000 organizations in more than
140 countries worldwide (measured in January 2023).

See also paragraph 8.4, “Our clients, who uses ASAP Utilities?” on page 327.
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How to order

The purchase process is quick, secure, and easy.
You can choose from several online and offline payment methods, such as credit card,
bank/wire transfer and several other payment methods.

https://www.asap-utilities.com/buy.php

We have also made a walkthrough of the purchase process that shows all the options and
steps:

https://www.asap-utilities.com/registration-help.php

Instant delivery

Your registration code is sent to you by email immediately after the order is completed and
the payment is received.

This is usually within 5-30 minutes when you pay with a credit card. With other payment
methods such as a bank/wire transfer, invoice, or check/money order it might take a little
longer. As soon as the money is received the order is processed and you receive your
license key.

Secure ordering, online and offline payment methods

All orders/payments are handled by our reseller/partner MyCommerce (part of

Digital River) so that we can offer our clients several payment methods worldwide and,
with clients in over 140 countries, it reduces the worldwide TAX/VAT administration and
thus we can spend more time on the development and support of ASAP Utilities.

Orders are processed through a secure SSL connection in a PCl compliant data environment
from MyCommerce. Your personal information is kept secure and will not be transferred by
them to other parties. Our e-commerce partner provides a highly secure online payment
process for most credit cards and they also support offline payments by check and wire
transfer.
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4.7 How to enter your license detalls

To turn your copy of ASAP Utilities into a registered version do the following:

1.

In the Excel menu choose
ASAP Utilities » ASAP Utilities Options » 3. Enter License...

_ p e -

Help  ASAP Utilities

mbers & Dates > | @ Web~ [2 Import~ |55 ASAP Utilities Options~ |  (2) Online FAQ =1

t~ %@ Information ~ (i Export ~ 8% 1. Settings, language and contact information.
mulas ~ B File & System ~ | [> Start ~ M@ 2. Edit your favorite tools and shortcut keys...
G 3. Enter License...

(&)

4 Start the last used utility again...

OB E E w

5. Find and run a utility... =
6. Open the ASAP Utilities User Guide (English, PDF)...

7.7Tip of the Day - View Online

8. Read the latest news on ASAP Utilities

9. ¥isit the online FAQ: Frequently Asked Questions about ASAP Utilities

10. Check for new version on the ASAP Utilities website

[& 11. New teols in development (English only)

12, Close ASAP Utilities

(12 Show me the time that | saved by using ASAP Utilities

In case you have ASAP Utilities 7: In the Excel menu choose the right-bottom button in
the ASAP Utilities Tab in Excel. (Trial version..., Enter License... or Home&Student
Edition...). Then click on the button "Enter registration information".

Fill in all the fields exactly the same as in the email with your full license details.
You received two emails after the order was completed. The email from "ASAP Utilities
(A Must in Every Office BV)" contains the full license information.

After you entered the information click on the "Activate now >>" (or "Register" in
version 7) button.

We recommend you to use "copy and paste" to avoid typing errors.
The information is case sensitive.
You can use the shortcut Control+V to paste the information in the fields.

~&k asaputilites T

License information

Thank you for registering ASAP Utlities.
Please enter the registration information exactly as sent to you. The information is case sensitive. You can use
the shortcut Ctrl+V to paste the information in the fields.

Mame:

Organization:

Mumber of licenses:

I
I
Order number: |
I
I

License key:

Cancel Buy license. .. Activate now >>
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Available tools

In this chapter a short description is given of each tool (utility) as presented in the
ASAP Utilities menu .

Most tools provide extra functionality to Excel. Some tools just make Excel’s built-in tools
easier to access, either because they are hard to find or because now you can add your own
shortcut to it.

English, German, Spanish, French,
Portuguese (Brazil), Italian, Russian,
Chinese (Simplified), Japanese and Dutch
descriptions

The most recent descriptions and examples in English, German, Spanish, French,
Portuguese (Brazil), Italian, Russian, Chinese (Simplified), Japanese and Dutch are available
on our website:

https://www.asap-utilities.com/features.php

Home hots 10 L Why use it? Download Pricing Contact Us Blog 1" 4 f

-& asap utilities

Home Downloadwv Buyw Whatisit? v Whyuse\'t?VReviewsv User Guide Newsw Excel tipsv Supportv EN-USw

Ey—— - |

Descriptions of all tools in ASAP Utilities The ASAP Utilities menu

in Excel (English)
.. =

> Home > Features added to Excel

This list gives you a glance at the macro tools in ASAP Utilities
Please take the time to read it. I'm sure you'll find some great time-saving tools such as many others

did. B
E ENGLISH (US) / NEDERLANDS / DEUTSCH / ESPANOL / FRANGAIS / PORTUGUES DO BRASIL / i
mauaNe 4 pycorni / THIZ(ESHR) © HAEE S —
Excellent
The tools are organized into the following categories R =
1. Favorites & Shortcut keys... 12. Formulas...
2. Vision Control... 13. Web..
3. Select... 14. Information... )
. 35 Worksheet Functions
4. Sheets... 15. File & System... See the 35 new worksheet
5. Range.. 16. Import... functions that you get with
6. Fill.. 17. Export... ASAP Utilities in Excel.
7. Columns & Rows... 18. Start.. .
. . ) Quickly Save Hours
8. Objects & Comments... 19. ASAP Utilities Options... Simple and practical examples
9. Format... 20. FEind and run a utility... of how ASAP Utilities saves
10. Numbers & Dates... 21. Start the last used utility again... you hours of time in Excel.
11. Text... 22. Info.. Today's Tip
You can also view a fully expanded list with the entire ASAP Utilities submenus and their tools. (September 21st)

B N U P N
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The descriptions of the added features are available in all languages on our website and in

ASAP Utilities itself, such as for example in Spanish:

Why use it?

-& asap utilities

Download Pricing Contact Us Blog

Home Downloadv Buyv Whatisit?~ Why useit? v - Reviews v User Guide™ Newsw Exceltipsv Supportv ES-ESw

> Home > Features added to Excel

Descripciones de todas las herramientas en
ASAP Utilities

Esta lista proporciona una vista rapida de las herramientas de macros en ASAP Utilities.
Tome su tiempo en leerlo. Estoy seguro de que encontrard unas gran herramientas que le ahorraran
tiempo como muchos antes de usted han hecho.

AE]

Se puede cambiar el idioma a Espaiiol en ASAP Utilities. *

ENGLISH (US) / NEDERLANDS / DEUTSCH / ESPANOL / FRANGAIS / PORTUGUES DO BRASIL /

ITALIANG 7 PyCCKM#A / EPK(%W) / EZK%‘E

Con la excepcion del nombre y la descripcion de todas las herramientas, el resto del sitio web sigue

estando en Inglés.

Las herramientas estan organizadas en las siguientes categorias

1. Favoritos y Teclas de método 12. Férmulas...
abreviado... 13. Web...
2. Control de vision... 14. Informacién...
3. Seleccionar... 15. Archivo y Sistema..
4. Hojas... 16. Importar...
5. Rango... 17. Exportar...
6. Rellenar.. 18. Inicio...
7. Columnas y Filas... 19. Opciones de ASAP Utilities...
8. Objetos y Comentarios... 20. Buscary ejecutar una utilidad...
9. Formato... 21. [niciar nuevamente la utilidad usada
10. Nimeros y Fechas... por dltima vez...
11. Texto.. 22. Informacién...

También puede ver una lista totalmente expandida con todos los submenues de ASAP Utilities y
sus herramientas

Excel con ASAP Utilities en su menu

Funciones de hoja de calculo adicionales

Tendra varias funciones de hoja de célculo adicionales en Excel cuando ha instalado

ASAP Utilities.

Ejemplos de como emplear ASAP Utilities
Algunas de las preguntas preguntadas con mas frecuencia que pueden ser resueltas si se emplea
ASAP Utilities (solo inglés).

Encontrar rapidamente una herramienta dentro de
ASAP Utilities

En la opcidn "Informacidn..." en ASAP Utilities puede encontrar la misma descripcidn corta para

ENHANCED BY Google

El menu de ASAP Utilities
en Excel (Espariiol
(Spanish))
_:.—

Excelente

2579 opiniones en W Trustpilot

35 Worksheet Functions
See the 35 new worksheet

functions that you get with
ASAP Utilities in Excel.

Quickly Save Hours
Simple and practical examples
of how ASAP Utilities saves
you hours of time in Excel.

Today's Tip

(September 21st)

Today's featured time saving
tool.

List of tools
A description of all tools in
ASAP Utilities

Pricing & Ordering

Buy your license(s) today. It's
only USD 49.00 for a single
user license, or save up to 86%
with volume discounts.

Available tools
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Or for example Chinese (Simplified):

Home Screenshots 10 Languages Why use it?

-& asap utilities

Download Pricing Contact Us Blog

BEa- B

B [ ]

[
P

Home Downloadv Buyv Whatisit?v Why useit? - Reviews v User Guidev Newsv Exceltipsv Supportv ZH-Hansw

> Home > Features added to Excel

ASAP Utilities FRpFE T HEAYIHEA

RIS R TS A ASAP Utilities RV B,
ERLEEEE— T, FIEE, SoRIFSEA R, BRI ETEAEMHENIE,

@ ENGLISH (US) / NEDERLANDS / DEUTSCH / ESPANOL / FRANGAIS / PORTUGUES DO BRASIL /
1mALaND / Pycckwin / FRS(EHE) / BAGE

The language used in menus and dialogs (FEERITHEHERFEHAIES) in ASAP Utilities can be set to "S53 ¢

| (&%) / Chinese (Simplified))".

XL TRATLIRIS AL T

1. WEEERREE 12, 2.

2. e 13. Web...

3. PEEE.. 14, (ZR..

4 THEE. 15. SUESHRE.

5. [Xid.. 16. SA..

6. 7. 17. B4

7. BlSf.. 18. FHA.

8. MmSHET.. 19. ASAP Utilities jIT...
9. f&zt.. 20, EBRHEATHATE.
10. HFS0EA. 21. EEE bR STHTE.
1. XA 22, =R,

AP IABED S 20 ASAP Utilities TRERHT SN=2EHFIE,
HzzegprhE & ASAP Utilities #9 Excel

<& B ﬁ OInm-  EMSG- SEFEEM - @ Web~ [BA- G ASAP Usiies 511 - @ mamuam

o | = | 2w o Omesmre @z Bae- Ben- OmwmsssMIn | Oee
v ealo =1 feist- Byresmn - Ame O EWEALAETA | QiMEE

o sfvaI =n0en weiowk  mFsms -

a - S ]
A e c o e f s . A ! ’ K L wm | N | o | P | a R | s

1

2

:

.

s

5

7

[

b

10

"

12

13

1

15

1

7

i

1

B st | @ . .

= @ T emme —ona B @ m -

MY TEREAEL

TEIEZE T ASAP Utilities BIER T, #EB]LIE Excel BN SN T{FF=2E1.
ASAP Utilities {ﬁﬁﬂﬁ'iﬁa_:ﬂu

SR NMEME, oJlAEETE)IET ASAP Utilities 23,

RiEBHE ASAP Utilities FHIEPMTH,

7E ASAP Utilities =i "(E2..." ¥eIlish, ZOLIREIENTENEENE.
RIS, Jéﬁ—/\ﬂk%ﬁﬁiﬁﬁ&?mﬁ“
T Excel S28ach | 5EEE ASAP Utilities » E51%

ERILNERENFUANETILIATE, halliEds + g ERne ek g, o
AT 0" AT SRR A2 T S AN R e Ab

ENHANCED BY Google
Excel 1 ASAP Utilities
%288 (A3 ({&{F) / Chinese
(Simplified)))

Excellent

2,582 reviews on W Trustpilot

35 Worksheet Functions
See the 35 new worksheet
functions that you get with
ASAP Utilities in Excel.

Quickly Save Hours
Simple and practical examples
of how ASAP Utilities saves
you hours of time in Excel.

Today's Tip

(September 26th)

Today's featured time saving
tool.

List of tools
A description of all tools in
ASAP Utilities

Pricing & Ordering

Buy your license(s) today. It's
only USD 49.00 for a single
user license, or save up to 86%
with volume discounts.
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5.2 ASAP Utilities 1n the Excel menu

The tools from ASAP Utilities can be accessed via the ASAP Utilities menu/tab in Excel:

5.2.1 The Ribbon/main menu

B AutoSave (@ OFF) Bookl - Excel £ Search (Alt+Q) 7 B u}
file  Home Insert Draw Pagelayout Formulas Data Review View Help ASAP Utiities O Comments.
_& E;l ﬁ:(%‘\ E Sheets~ | [ Columns & Rows ~ = Mumbers & Dates~ @ Web [®import~ <G} ASAP Utilities Options > (2) Online FAQ F
Favorites Vision | Select &ARange~ | ¥ Objects & Comments v [A] Text + [@ Information ~ (i Export ~ © Find and run a utility @) Info WE?
Shortcut keys~ | Contral ~ A Fin - [ Format ~ S Formulas - [Ri File 8 System~ | [> Start~ () Start last tool again @) Registered version  the Day
Favorites Time saving tools Options and settings Info and help Tips tricks
AL ~ fx v
A B 1 ¢ Il b Il E 1 F Il S Il H 1 1 J Il K Il 1 M Il N Il o 1 P Il Q Il R 1 s 1 0
0 —
2 |
3
4]
5
6l
7|
8,
9 |
10|
1|
12|
13|
14|
15|
16 |
17|
18|
19
= v
Sheetl @® 4 >
| Ready % Accessibility: Gaod to go H M -—F——+ 100% )

5.2.2 Right-click/context menu

The most popular tools added are added to the right-click/context menu when you click on:

= cells

= column headings

= rows headings/numbers
= sheet tabs

Available tools
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Cell(s) right-click/context menu

When you right-click on a cell:

__|de "| Axvem- % 9 E English
] M. A . - <—03 _)08 5 1 Specialist| Spanish
— F=1 . :
fr s cars vatawas=administrator Il English
au ! isaciate Professor French
sg search the menus iftware Engineer IV Dutch
ca 2(0 Cut :cruiting Manager Italian
i - AAratar Cnalich
= (@ Copy 4 1. Change to UPPERcase
_|u [0 Paste Options: A" 2. Change to lowercase
ca
gb |-_|-j Ea 3. Delete leading and trailing spaces
___|us 5‘?;0 4. Convert unrecognized numbers (text?) to numbers
sk
pt /G) Smart Lookup A 5. Change values to text values (adding ' in front)
us l.—t\” @ 6. Convert/recognize dates...
— = £
—ﬁ Insert 5 pp 7. Clean data and formatting...
au Insel
ip Delete 5 [E 8 Countand/or color duplicates in selection...
— &S = 9. Count duplicates and give each set of duplicates its own color
Select >| ® P g 3
il -
E’a 10. Clear duplicated values in selection (leave one original)
ca Clear Contents P £l
_ | @ Quick Analysis 2% 11, Advanced character remove or replace...
fi
pt Sort 5 [ﬁ 12. Delete number of leading characters...
gb Filter 5 E] 13, Delete number of ending characters...
fi N
— il Table 5 m 14. Delete all after a given number of characters...
1 0l
nl E Get Data from Table/Range j,E 15, Copy values to empty cells below filled cells in selection
U B 16. Select cells based on content, formatting and mare... (Ctrl+Alt+0)
£ NewC a g
"] ew Comment
us +IJ New Note 17. Advanced sorting...
_|gb F £ Cell F} 18. Insert before and/or after each cell in your selection...
in Format Cells...
au Pick From Drap-down List D 19, Fill empty cells in selection...
I @ Link N :'E 20, Quick numbering of selected cells... (Ctrl+Alt+C)
be @ Lin
= @ 21, Apply formula/calculation to selected cells... (Ctrl+Alt+[)
ASAP Utilities >

22. Move or resize selected range... (Ctrl+Alt+M)
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Column(s) right-click/context menu

When you right-click on a column heading:

P search (alt+Q)

nulas  Data  Review View Help  ASAP Utilities

5‘7 - EE/ Wrap Text General v ﬁ @ Output

Il
il [%

= = = = =~ O 0 .00 Conditional Format as Headi
- = - D @B % 9 @ Formatting v Table v | =———
ant [catbri |15 «|A" A EE- % 9 B ] Number ] Styles
BI=0-A-EH-ARS
C = E | F | G
] Search the menus
A Cut
Countw Col E@ Copy bb I ﬂ Lauage ﬂ
_|de eologist| English
~fru (B Paste Options: utomation Specialist | Spanish
B Lis L*’—‘El atabase Administrator 111 English
~ |au ssociate Professar French
 |se Paste Special... oftware Engineer IV Dutch
_:E Insert ecruiting Manager TE'Ifnl
i
7gr Delete %9 1. Insert empty rows or columns in between...
_ il Clear Contents %X 2. Delete all empty rows
ca
_r Format Cells... B 3 Viewand manage hidden rows and columns...
: us Column Width... ﬂ:ﬁ 4. Delete all hidden rows and/or columns...
sk
_pti Hide @ 3. Color each n'th row or celumn in selection... (Ctrl+Alt+C)
T us Unhide E& 6. Select cells based on content, formatting and more.., (Ctrl+Alt+ Q)
—ﬁi ASAP Utilities > @ 7. Conditional row and column select, hide or delete..
au
ip Miscellaneous 5 8, Advanced sorting...
s, K BE 9. Puttogether rows or columns from several sheets...
il E|
. Finance A 3;3?’ 10. Change to UPPERcase
ca Basic Industries & A" 11. Change to lowercase
fi Consumer Services <
pt Technology C B 12. Delete leading and trailing spaces
gb Health Care H %Ly 13, Convert unrecognized numbers (text?) to numbers
fi Finance R
= - A 14, Change values to text values (adding ' in front)
il Finance S
nl Miscellaneous A @ 15. Convert/recognize dates...
. R )ﬂ@ 16. Clean data and formatting...
ru Finance C .
= Capital Goods 5 “x 17. Advanced character remove or replace..,
gb Finance V' [E 12 Countand/or color duplicates in selection...
in S
o Consumar Services = 19, Count duplicates and give each set of duplicates its own color
mx Technology A [[ﬁ 20, Clear duplicated values in selection (leave one original)
be v
E 21, Drawing paper... =
EE 22, Move or resize selected range... (Ctrl+Alt+M)
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3 Row(s) right-click/context menu

When you right-click on a row heading:

A B C D E
1 |Company Test Data
2
3 Company Name ﬂjob Title
4 |12-8597550 Jerde Inc de Consumer Non-Durables  Geologist |
5 |26-0571332 Rowe LLC ru Finance Automation Specialist
6 [11-4110254 Parisian-Breitenberg fr Health Care Database Administratt
7 |51-7306191 Smith Group au Associate Professor
8 |95-8287735 Gleichner Inc s Technolosyv Software Engineer IV
9 |B2-4505503 Sipes, Baumbach a @ 1. Insert multiple empty rows at ence... cruiting Manager

Wcaibi v[11 v|A A EE- % 2

1 -0
B I ~ S8
T S — 1
. __ __ _
17 LI
1. Search the menus *
: &
:' A Cut
! 57
X%
1 [ Copy
1 ﬁ:‘l Paste Options: =
1! E::!
al
x [ -
1 al
ZI Paste Special... .
2
2! Insert
B=
2 Delete
21
2 Clear Contents aQ
> A
Eormat Cells...
24 [E3]
| Row Height...
2! 2
3 Hide
3 A
3l Unhide
: =
3 ASAP Utilities > A
34|04-2159819  Marks-Jacobson ¢
35 |76-2171704 Koch-Turner =
36 |98-3698759 Johnson, Hamill an o
K
37 |60-9231053 Witting, Ullrich an¢ &
38 |29-6971191 Spinka-Rosenbaun [
39 |72-2226832 Christiansen and § @
Dataset ®
3

Ready ff,)\(cessibil\ty: Goodto go

o

w

=~

i

=

-

o

w

22.

23,

. Insert empty rows or columns in between...

Autofit row height (also on merged cells)

Delete all empty columns

. View and manage hidden rows and columns...

. Delete all hidden rows and/or celumns...

. Color each n'th row or column in selection... (Ctrl+Alt+C)
Select cells based on content, formatting and more.., (Ctri+Alt+O)
. Conditional row and column zelect, hide or delete...

. Advanced serting...

. Put together rows or columns from several sheets...

. Change to UPPERcase

. Change to lowercase

. Delete leading and trailing spaces

. Convert unrecognized numbers (text?) to numbers

. Change values to text values (adding ' in front)

. Convert/recognize dates..,

. Clean data and formatting...

. Count and/or color duplicates in selection...

. Count duplicates and give each set of duplicates its own color

. Clear duplicated values in selection (leave one original)

Drawing paper...

Move or resize selected range... (Ctrl+Alt+ M)

erator

es Associate
ological Engineer
iociate Professor
:ount Executive
nputer Systems An
iistant Professor
uctural Engineer

rountant [l

rior Quality Enginet
clear Power Engine
tor
alyst Programmer
rketing Manager
:Technical Architec
sign Engineer
alth Coach |
ruiter

ior Editor
istrative Officer

search Assistant Il
ntal Hygienist

vior Sales Associate
Quality Control
uctural Analysis Eng
dia Manager llI
ministrative Assists
Sales
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Sheet(s) right-click/context menu

When you right-click on sheet tab:

LU |42/ IBIBI0 CEMNdIa-ndiundgnn du Accounanc im
21 |26-7393239 Reynolds Inc jp Miscellaneous Senior Quality Engir
22 |78-2066839 Konopelski-Weissnat us MNuclear Power Engil

23 |03-9525831 Schowalter-Schinner
24 |37-2486957 Keebler Inc

25 |19-5874300 Rer
26 |68-2518495 Joh

1. Sort all sheets... tor

alyst Programme:
2. Export worksheets as separate files... rketing Manager

Technical Archit

un

Insert...

3. Create an index page with links to all sheets (clickable)...

27 |6a-sg2z1es  min B Delete ign Engineer

22 |05-6900157 Ker @ Rename 4, Protect multiple sheets at once... ilth Coach 1
29147-1313476 | Har Move or Copy... 5. Unprotect multiple sheets at once... pruiter

30 |43-4668224 Bei - rior Editor

31 |90-3495489 Wo E‘\ View Code 6. Add new worksheet (fill in a name)... (Ctrl+Alt+N) Tinistrative Offi(

iearch Assistant |
atal Hygienist
1ior Sales Associe

]

32 [60-2862525  O'C [ protect Sheet..
33 |36-0330669 Rok

34|04-2159819  Ma|
35 |76-2171704  Koc Hide
3698-3698759  Joh

7. Change name of selected sheets to selected cell's value

[¥]

Tab Color b 8. Quickly rename multiple sheets at once...

9. Copy a sheet's page and print settings... Quality Control

actural Analysis E
10, Print multiple sheets at once... T —————

37 |60-9231053 Wit dia Manager Ill
38 29-6371191  Spil Select All Sheets =2 11. Unhide all sheets ministrative Assi:
39 |72-2226832  Chr sales

ASAP Utilities > 12, Remove all empty worksheets
Data: : .

Ready [ T Accessibility: Good to go

HEESPwEOEHEH RO E

13. Count number of sheets

Save time with keyboard shortcuts

Studies calculate that using keyboard shortcuts allows to work 10 times faster than working
with the mouse. The time you spend looking for the mouse and then getting the cursor to
the position you need is lost time! Reducing the working time by 10 brings you greater
efficiency.

You can view or edit the shortcuts to start the tools from ASAP Utilities via:

ASAP Utilities » Favorites & Shortcuts » Edit your favorite tools and shortcut keys...

By default, ASAP Utilities uses the following shortcuts (which you can customize):

Shortcut Action

= Ctrl+Alt+A Select adjacent cells in column with the same value
= Ctrl+Alt+B Reload all installed add-ins (rebuilds the menu)

= Ctrl+Alt+C Color each n’th row or column in selection...

= Ctrl+Alt+D Deselect cells...

= Ctrl+Alt+E Set default path to current file

= Ctrl+Alt+F Create a list of filenames and properties in a folder...
= Ctrl+Alt+G Export selection or active sheet as new file...

= Ctrl+Alt+H Find and/or replace in all sheets...

= Ctrl+Alt+ Apply formula/calculation to selected cells...

= Ctrl+Alt+) Start the last used utility again...

Available tools 31
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Shortcut

Action

= Ctrl+Alt+Shift+Right Arrow
= Ctrl+Alt+Shift+Down Arrow

Ctrl+Alt+M
= Ctrl+Alt+N

= Ctrl+Alt+O
= Ctrl+Alt+P
= Ctrl+Alt+Q
= Ctrl+Alt+R

= Ctrl+Alt+S
= Ctrl+Shift+
Ctrl+Alt+X
= Ctrl+Alt+Y
Ctrl+Shift+D
Ctrl+Shift+T
= Ctrl+Alt+Z

@ o) Bookl - Excel

File Home Insert Draw Page Layout Formulas

E‘ BT Sheets ~
I g&\ &8 Range -

{EHFil~

Favorites & Vision  Select
Shortcut keys ¥ Contral ~

Data Review View Help
F Columns & Rows
¥ Objects & Comments ~
F# Format ~

Extend selection to the last used column
Extend selection to the last used row
Move or resize selected range...

Add new worksheet (fill in a name)...
Select cells based on content, formatting and more...
Change formulas to their calculated values
Quick numbering of selected cells...

Reset Excel’s last cell

Save file and create backup...

Vision Control...

Move selected data (only values)...

Paste special (with combinations)...

Insert current date and time with seconds
Insert current time with seconds

Find and run a utility...

ASAP Utilities

= Numbers & Dates~ | 2 Web ~

[A] Text ~

S Formulas ~

[i@ Information ~
[ File & System

1, Select adjacent cells in column with the same value (Ciri+Alt+ 4) paving tools
£ ) 2 Reload all installed add-ins (rebuilds the menu) (Ctrl=Alt+E)
EH 3. Color each n'th row or column in selection... (Ctrl+ Alt+ C) H 1 J K
; BF 4. Deselect cells... (Ctrl+ Alt+D)
3 % 5. Setdefault path to current file (Ctri+ Alt+E)
‘; @ 6 Create a list of filenames and propertics in a folder.. (Ctrl+Alt+F)
5 [ 7.Export selection or active sheet as new file... (Ctrl+Alt+G)
7 O &Find andfor replace in all sheets... (Ctrl+ Alt+H)
E @ 5. Apply formula/calculation to selected cells.. (Ctrl+Alt+1)
10 (10 Start the last used utility again... (Ctrl+Alt=)
:; T 11, Extend selection to the last used column (Ctrl+Alt+ Shift+ Right Arrow)
13 {} 12 Extend selection to the last used row (Ctrl+ Alt+Shift-Down Arrow)
14 £33 Move or resize selected range... (Cirb+ Aft+ M)
:: E 14. Add new worksheet (fillin a name)... (Ctr+Alt=N)
17 F&] 15. Select cells based on content, formatting and more... (Ctrl+Alt=0)
:3 [ 16. Change formulas to their calculated values (Ctrl+Alt+P)
20 = 17.Quick numbering of selected cells... (Ctrl+ Alt=Q)
2 [B 12, Reset Excels last cell (Ctri+ Alt+R)
2 1. Saye file and create backup... (Ctrl+Alt+5)
24 Q_ 20. Vision Control... (Ctrl+Shift+)
z:, [} 21 Mave selected data (only values)... (Cirl+Alt+X)
27 [& 22, Paste special {with combinations)... (Ctrl+Al+Y)
:2 (3 23 Insert current date and time with seconds (Ctrl+Shift+D)

30 (9 24.Insert current time with seconds (Ctrl+ShiftsT)
2 25, Find and run a utility... (Ctrl+Alt+7)
33 Customize favorites menu

[ 26. Edit your favorite tools and shartcut keys...
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Description of the tools in all languages

The descriptions of all the tools in all available languages can be found on our website:

https://www.asap-utilities.com/features.php

Home hots 10 Languages Why use it? Download Pricing Contact Us Blog v

-& asap utilities

> Home > Features added to Excel

p—r——

Descriptions of all tools in ASAP Utilities The ASAP Utilities menu

This list gives you a glance at the macro tools in ASAP Utilities. in Excel (English)

Please take the time to read it. I'm sure you'll find some great time-saving tools such as many others

did. T
ENGUISH (US) / NEDERLANDS / DEUTSCH / ESPAROL / FRANCAIS / PORTUGUES DO BRASIL / :
maLIAND / pycekwin / Th({EifE) / BAEE S —
Excellent
The tools are organized into the following categories =
1. Favorites & Shortcut keys... 12. Formulas.. Download >
2. Vision Control... 13. Web...
3. Select... 14. Information... )
. 35 Worksheet Functions
4. Sheets... 15. File & System... See the 35 new worksheet
5. Range... 16. Import... functions that you get with
6. Fill.. 17. Export.. ASAP Utilities in Excel
7. Columns & Rows... 18. Start.. .
) . Quickly Save Hours
8. Objects & Comments.. 19. ASAP Utilities Options... Simple and practical examples
9. Format... 20. Find and run a utility... of how ASAP Utilities saves
10. Numbers & Dates... 21. Start the last used utility again... you hours of time in Excel.
11. Text.. 22. Info.. Today's Tip
You can also view a fully expanded list with the entire ASAP Utilities submenus and their tools. (September 21st)
Tadmidn Exmr e hnn e
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5.5 Description of the tools in English

5.5.1 Favorites & Shortcut keys

A selection of your favorite tools. You can customize the list of tools that is shown here.

B AutoSave (@ Off) Book1 - Bxcel

File Home  Insert Draw  Page Layout Formulas Data Review Wiew Help  ASAP Utilities

‘& IET‘.E[ E_:C%!\ B Sheets ~ B Columns & Rows ~ = Numbers & Dates ~ €2y Web ~

Favorites & Vision Select gﬂ Range ~ 5’3 Objects & Comments ~ Text ~ |_'—|@ Information ~
Shartcut keys ~ Control M E Fill ~ Ejﬂ Format ~ ﬁ\: Formulas ~ % File & System
O, Select adjacent cells in column with the same value (Ctrl+Alt+A) saving tools
£ O 2. Reload all installed add-ins (rebuilds the menu) (Ctrl+Alt+B)
Bl 3. Coloreach n'th row or column in selection... (Ctrl+Alt+C) H | | ] | K |
; B3 4. Deselect cells... (Ctrl+ Alt+D)
3- _'__] 5. Set default path to current file (Ctrl+Alt+E)
:- E:[E':] 6. Create a list of filenames and properties in a folder... (Ctrl+Alt+F)
6- EL 7. Export selection or active sheet as new file... (Ctrl+Alt+G)
T: ,o 8. Find and/or replace in all sheets... (Ctrl+Alt+H)
i' @ 9. Apply formula/calculation to selected cells... (Ctrl+Alt+1)
10: C, 10, 5tart the last used utility again... (Ctrl+Alt+J)
::; IZ> 11. Extend selection to the last used column (Ctrl+Alt+ Shift+Right Arrow)
1?; u 12, Extend selection to the last used row (Ctrl+ Alt+Shift+ Down Arrow)
14_ EE 13. Move or resize selected range... (Ctrl+Alt+M)
::Z Eiﬁ 14, Add new waorksheet (fill in a name)... (Ctrl+ Alt+N)
17E Eﬁo\ 15. Select cells based on content, formatting and more... (Ctrl+Alt+0)
::i ﬁj 16. Change formulas to their calculated values (Ctrl+Alt+P)
2CE %E 17. Quick numbering of selected cells... (Ctrl+Alt+Q)
;; [% 18. Reset Excel's last cell (Ctri+Alt+R)
2?; 19, Save file and create backup... (Ctrl+Alt+5)
24 Q. 20.Vision Control... (Ctrl+ Shift+1)
;Z @ 21, Move selected data (only values)... (Ctrl+Alt+X])
2?5 ['% 22, Paste special {with combinations)... (Ctrli+Alt+Y)
;i ﬁ 23, Insert current date and time with seconds (Ctrl+Shift+ D)
3CE @ 24, Insert current time with seconds (Ctrl+ Shift+T)
:;— ,@ 25, Find and run a utility... (Ctrl+Alt+Z)
33- Customize favorites menu
;E @ 26, Edit your favorite tools and shortcut keys...
36
37
38
2a
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Edit your favorite tools and shortcut keys...

ASAP Utilities contains a lot of different utilities.
With the "Favorites & Shortcut keys" you can add the tools from ASAP Utilities that you use
most frequently and assign your own shortcuts to them.

By default, ASAP Utilities uses the following shortcuts (which you can customize):

Shortcut Action

= Ctrl+Alt+A Select adjacent cells in column with the same value
= Ctrl+Alt+B Reload all installed add-ins (rebuilds the menu)

= Ctrl+Alt+C Color each n'th row or column in selection...

= Ctrl+Alt+D Deselect cells...

= Ctrl+Alt+E Set default path to current file

= Ctrl+Alt+F Create a list of filenames and properties in a folder...
= Ctrl+Alt+G Export selection or active sheet as new file...

= Ctrl+Alt+H Find and/or replace in all sheets...

= Ctrl+Alt+ Apply formula/calculation to selected cells...

= Ctrl+Alt+) Start the last used utility again...

= Ctrl+Alt+Shift+Right Arrow  Extend selection to the last used column

= Ctrl+Alt+Shift+Down Arrow  Extend selection to the last used row

= Ctrl+Alt+M Move or resize selected range...

= Ctrl+Alt+N Add new worksheet (fill in a name)...

= Ctrl+Alt+O Select cells based on content, formatting and more...
= Ctrl+Alt+P Change formulas to their calculated values
= Ctrl+Alt+Q Quick numbering of selected cells...

= Ctrl+Alt+R Reset Excel's last cell

= Ctrl+Alt+S Save file and create backup...

= Ctrl+Shift+ Vision Control...

= Ctrl+Alt+X Move selected data (only values)...

= Ctrl+Alt+Y Paste special (with combinations)...

= Ctrl+Shift+D Insert current date and time with seconds
= Ctrl+Shift+T Insert current time with seconds

= Ctrl+Alt+Z Find and run a utility...
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Example screenshot: Change your favorite utilities and assign your own shortcut

File Home Insert Draw Page Layout Formulas Data  Review
‘& E‘g E.:C%‘\ B Sheets~ | [ Columns & Rows ~
£ - -
Favorites & Vision Select & Range gj Objects & Comments
Shortcut keys ~  Control - i Fill ~ 7 Format ~

View Help
= Mumbers & Dates =

Text~

fx Formulas ~

2 Search (alt+Q)

ASAP Utilities

@5 Web ~ [® Import~ {5 ASAP Utilities Options «

FO Information + @ Export ~ ,® Find and run a utility

[ File & System ~

[> start~

*, Start last tool again

Favorites Time saving tools Options and settings
AL ~ Jfx
A ¢ | o | e | F | &6 | H | v | 3 | x | L | M | N | o | @
L ]
2 ASAP Utilities - Edit your favorite tools and shortcut keys x
3] Avaiable tools: Your favorite tools:
4 o Vision Control... » Vision Control... || Select adjacent cells in column with the same value
5 Favorites & Shortecut keys » Edit your favorite tools and shorta’ Reload all installed add-ins {rebuilds the men)
— Select » Select cells based on content, formatting and more... Color each n'th row or column in selection. ..
6 | Select » Conditional row and column select, hide or delete... || Deselectcells...
7 Select » Move or resize selected range... Set default path to current file
o Select » Deselect cell. .. Create a list of flenames and properties in a folder. ..
8 3 Select » Inverse selection... Export selection or active sheet as new file...
9 Select » Merge selection of selected areas Find and/or replace in all sheets...
il Select » Select adjacent cells below active cell with the same vz - Apply formula/calculation to selected cells. ..
10 Select » Select adjacent cells in column with the same value - Start the last used utlity again...
.”_ Select » Extend selection to the last used row Extend selection to the last used column
L Select » Extend selection to the last used column Extend selection to the last used row
12 Select » Select cell in selection where value changes s Move or resize selected range...
13| Select » Select cells with the smallest number Add new worksheet (fill i
| Select » Select cells with the largest number e o 1 ting
14 Select » Select all cells with an error Change formulas to their calculated values
| Select » Select all sheets in your workbook Quick numbering of selected cells...
15 | Select » Select all objects on current worksheet Reset Excel's last cel
16 Select » Print preview selection Save file and create badkup...
- Select » Print selection vision Control. ..
17 Select » Set current selection to all worksheets Move selected datz (only values)...
18 Sheets » Add new worksheet (filin a name)... Reset to default Paste special (with combinations). ..
— Sheets » Insert multiple sheets (uses the cell values as sheet ni P Insert current date and time with seconds
19| Sheets »Rename current sheet... Insert current time with seconds
o Sheets » Quicky rename multiple sheets at once... = Find and run a utiity..
4] [¥ Display submenu name in list shorteut: I Ctrl+alt+0 - assign
22 |
23 Select cells based on content, formatting and more...
24 |
25 |
26 | Close Create a list of al shortcuts
27 |
28 | T T T T T T T T T
29 |
30|
31|
32 |
33|
24
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This tool shows the immediate result or your changes, for example if you uncheck the grid,
you will see the effect immediately.

Worksheet settings:

= Gridlines

= Page breaks

= Row & column headers

= Zero values

= Formulas

= Qutline symbols

= Zoom, you can use a slider to set the zoom percentage. As you slide you will immediately
see the result.

You can quickly apply the settings of the selected worksheets to all worksheets in your

workbook.

Workbook settings:

= Sheet tabs

= Horizontal scroll bar

= Vertical scroll bar

= Reference style: Al or R1C1

= Show objects: show all, show placeholders or hide all

Display settings for Excel on the application level:

= Formula bar

= Status bar

= Toolbars

= Full screen

= Comments: none, comment indicator only or comment & indicator

With this tool you can also:

= Browse through all open workbooks.

= Browse through the worksheets in your workbook and quickly see the settings per
worksheet.

= Quickly change the way your worksheet, workbook or Excel is displayed.

= Remove the selection restrictions in all worksheets.

= Set the default folder to the path of the selected workbook. This causes the dialogs for
opening and saving files to start in this folder the next time you use them.

= Reset the statusbar. Useful when the status bar is locked, for example with a certain
message due to a macro that was not properly finished.
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= Reset everything to default application settings. This will reset the statusbar, set the
calculation to automatic, enable the display of alerts (Application.DisplayAlerts = True),
set the cursor to default and enable all toolbars.

By default this utility can be started with the shortcut Ctrl+Shift+l.

Example screenshot: 1 Settings for current workbook

15
16
17
18
19
20
21
22
23
24

Ready

ASAP Utilities - Vision Centrol X

Open files/workbooks

0001 Example en-us.xisb -

Custom views:

Worksheets in this file:
week 01
week 02
week 03
week 04

week 24

3 week 01

Settings for current workbook | Appiication settings |

Sheet settings Workbook settings
¥ Gridines [V sheet tabs
hd I~ Page breaks ¥ Horizontal scrall bar
¥ Row & column headers [V vertical scroll bar
- IV Zero values

Reference style:

I~ Eormulas
= & a1 CRic1

I~ Outline symbols

Zoom For objects, show:

il 0 2l & show all
" show placeholds
100% 100% b4 Hidg;\aiate olders

Zoom in on selection
Current file's path:
C: 1s I
Apply current settings to all R R
worksheets

Remave selection restrictions in all Set the default folder to this
worksheets path

j Most commen settings Close

week 02 | week03 | week04 | week 05 week 06 | week07 | week08 | week09

% T?/Access\bihly: Good to go

Example screenshot: 2 Application settings

14
15
16
7
18
19
20

Ready

ASAP Utilities - Vision Control X

Open filesworkbooks

0001 Example en-us. xlsb -

Custom views:

Worksheets in this file:

week 01
week 02
week 03
week 04
week 05
week 06
week 07
week 08
week 09
week 10
week 11
week 12
week 13
week 14
week 15
week 16
week 17
week 18
week 19
week 20
week 21
week 22
week 23
week 24

3 week 01

Settings for current workbook  Application settings

Application settings
F¥ Formula Bar

h ¥ Status Bar
¥ Toolbars
- [~ Full screen
Comments
" None

* Comment indicator only
" Comment &indicator

Reset statusbar

Reset everything to default application
settings

ﬂ Most common settings

week 02 week 03 week 04 week 05 week 06 | week 07 week 08 week 09

3 T% Accessibility: Good to go

week 10

week 10

w

w
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Select

A collection of tools which make the selection of various items easier or now even possible.

Select cells based on content, formatting and more...

With this tool you can select cells based on their value, formatting style and other

properties.

You can for example select all cells between 50 and 250 or all bold cells or all red cells.

You can use the following criteria to select cells based on their contents:

= between

= not between

= equalto

= not equal to

= greater than

= lessthan

= greater than or equal to
= less than or equal to

= begins with

= does not begin with

= ends with

= does not end with

= contains

= does not contain

= like (text, with use of wildcard characters)
= not like (text, with use of wildcard characters)
= duplicate values

= unique values

= empty cells

= not empty cells

= FALSE

= TRUE

= text length

values in lowercase

values in UPPERCASE

odd numbers

even numbers

number (constant)

number (formula)

number (link to sheet)

number (link to file)

formula with reference to file

formula with reference to sheet

contains any of the values specified in a range
does not contain any of the values specified in a
range

contains any of the full words specified in a range
does not contain any of the full words specified in
arange

equals a value specified in a range

does not equal a value specified in a range

does not equal a value specified in a range
contains all values specified in a range

contains all full words specified in a range
matches regular expression

You can use the following criteria to select cells based on formatting and more:

= cell color

= font color

= font name

= fontsize

= font = bold

= font <> bold

= font = underline
= font <> underline
= font =italic

= font <> italic

= strikethrough

= has hyperlink

has comment
protected cells
unprotected cells
odd rows

even rows

odd columns

even columns

visible cells

hidden value/formula
number format contains
merged cells
unmerged cells

Available tools
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You can use the following criteria to select cells based on their date:

Some people use this utility as an alternative for or addition to Excel's AutoFilter.

between

not between

equal to

not equal to
greater than

less than

greater than or equal to
less than or equal to
Weekday

Month

Year

Quarter

By default this utility can be used with the shortcut Ctrl+Alt+0.

Note:
The speed of the utility decreases if the matching cells are in many non-contiguous blocks
of cells. The speed can be increased by first sorting your data.

You cannot use this utility to select cells on a condition that is set via conditional

formatting.

Due to a limit in Excel, this utility can select a maximum of 8192 non-contiguous blocks of
cells. More information about this is on the Microsoft website:

https://support.microsoft.com/kb/832293/en-us

Example screenshot: 1 Select cells based on their value

1969 1970 1971
2 |Aardvark 41 66 17 30 50 17 94 15 8 99
3 |Albatross 22 22 83 60 60 15 95 a9 43 61
P g = —
4 |Alligator ASAP Utilities - Advanced cell selecting - =)
5 |Alpaca — —
6 |Ant Based on content | Based on formatting and mare | Date |
7_|Anteater Select all cells with a value:
& |Antelope
9 |Ape less than or equal to ;I I 10
. between
10 |Armadillo not betwean
11 |Baboon equal to |
not equal to
12 |Badger | greater than
13 |Barracuda 9 less than [
greater than or equal to
14 |Bat K s tanoreaa .
15 |Bear begins with
does not begin with
16 |Beaver ends with
17 |Bee does not end with
. contains
14 |Bison does not contain
19 |Boar lke (text, with use of wildcard characters)
| notlike (text, with use of wildcard characters)
20 |Buffalo —— duplicate values
unique values
21 |Butterfly empty cells
22 |Camel 1| notempty cells 14 51
- FALSE
23 |Caribou TRUE 78 51!
24 |Cat teTt Iengilh 24 93
. values in lowercase
25 | Caterpillar velues in UPPERCASE 2 12
26 | Chamois odd numbers 91 16
even numbers
27 |Cheetah number {constant) 2 84
28 |Chicken number (formula) 51 26
. number {ink to sheet)
29 |Chimpanzee number {ink to file) 73 =5
; = formula with reference to file
il Chinchilla formula with reference to sheet & 2
31 |Chough contains any of the values spedified in a range 89 12
contains all of the values specified in a range
32 |Clam does not contain any of the values specified in a range Sl b
33 |Cobra contains any of the full words specified in a range 41 42
contzins all of the full words specified in a range
34 | Cockroach does not contain any of the full words specified in a range 76 0
35 |Cormorant equals a value specified in a range 66 22
36 | Coyote does not Esual a value sgedﬁed in %ange - - - 73 50
37 |Crab 43 99 24 33 2 75 34 22 96 66
22 lrrann @ A 11 A= =a @9 Fo 13 2 21
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Example screenshot: 2 Select the cells with duplicated values
[ A [ B c ) E F G

1 |email address
2 |amsterdam@asap-utilities.com I
3 |amsterdal
= - 5
| 4 |ankara@asa Asap Utilities - Advanced cell selecting
5 |athens@as -
| 6 |belgrade@: Based on content | Based on formatting and more | Date |
7 |berlin@asa
8 |bern@asay Select all cells with 2 value:
i bratislava@: duplicate values A ™ Match Case
10 |brussels@:
Ml Look in
11 |brussels@:

Select in 45 cells:

@& cell
1+ Range:
Lez= " Entire row

1 Worksheet ™ Entire column

| ¥ Auto dose after selecting

4 Iminsk@asap-utilities_com
25 |moscow(@asap-utilities.com

Example screenshot: 3 Select by text length
A B C D E F G H | J

1 1 1969 1970
2 |Aardvark a1 66 17 30 30 17 94 15 8
i
3 |Albatross - i - 49
- ASAP Utilities - Advanced cell selecting
4 |alligator - - 0 62
5 |Alpaca Based on content | Based on formatting and more | Date | 5 54
6 |[Ant ) 2 31
Select all cells with a value:
7 |Anteater 7 52
3 |antelope || textlength =l o 3 38
9 |ape Lookin: 8 a9
10 |Armadilio ||| | values defauit = 6 5
11 b 1 30
12 |Badger Selectin 222 ¢cellst ————————————————————— g 6
* cell
13 |Barracuda | | & pange: ALAZZ2 =] P 0 100
14 |Bat FREE 0 58
15 |Bear " Worksheet (] " Entire column 6 99
16 |Beaver 4 31
17 |Bee 3 a5
18 [Bison Close [~ Auto dose after selecting 4 38
19 |Boar - - - - - 3 77
20 [Buffalo 74 13 22 51 55
21 [Butterfly I 96 a7 5 54 9 95 48 83 9
i

Example screenshot: 4 Select cells by their formatting and more such as bold cells

A B C 0
il Keyword B3 Competition B Global Monthly Searches Bd | ocal Monthly Searches ||
2 |shop 0.06 13600000
3 |machine - F 3
1 [maker ASAP Utilties - Advanced cell selecting i
5 |makers
& (bar Based on content. Based on formatting and more | pate |
7 _|machines Select all cells based on its format:
8 |pot
9 |table '*‘:I'tzl"""' K|
cell color
ey font color
11 [bean font name
12 |green font size
font = bold
1::' :’h'e’ S font <> bald
| = (pedns font = underine & cel
15 |mug A font <> underline et
16 [mugs font = talic Entire row
e ¢ font <> italic
17 |pots strikethrough " Entire column
| 18 fcups has hyperlink
19 |cake has comment
. protected cells
Az unprotected cells oK
21 Jcompany | odd rows 4|
22 recipe == evenrows
23 lreci odd columns W F—

l
2 || vabe cole 201000
ﬁcugs mugs hidden value fformula 201000
26 |grinder numbe; fownatmmams 201000
- merged cells
27 Jreview unmerged cells 201000
281 ooy U5 201000
29 Jroasters 0,08 201000
—|_3U Lo 0,16 165000
31 |grinders 022 165000
sl 0,08 135000
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Example screenshot: 5 Select the cells with the same color as cell A2 (yellow)

B C D
N Keyword B2 Competition B Global Monthly Searches B | ocal Monthly Searches ||
shop 0,06 13600000

2
3 |machine | 0,72 1830000
4 |maker . * -
5 |makers ASAP Utilities - Advanced cell selecting pa—
6 1o Based on content  Based on formatting and mare I Date | -
7 _|machines = =
8 |pot Select all cells based on its format:
9 |[table .
10 Jeup cell color +| ofcel: a2 =
11 |bean
12 |green
13 |tah\e: 1l
14 Jbeans Selectin 233 el ————————————————————
15 |mu @ cel
16 [mugs & Range: [(azazza .|
" Entire row F—
17 |pots
18 " worksheet =] " Entire column

™ Auto dose after selecting

U,ﬁ 201000
25 |cups mugs | 0,19 201000
Fr e 1 noan Anannn

Example screenshot: 6 Select all cells that are strikethrough (perhaps marked for

deletion)

A B C o]

.ompetition hd Global Monthly Searches hd Local Monthly Searches (|
X 13600000

machina | 072 1830000

3]
4 |maker =
5 |makers ASAP Utilities - Advanced cell selecting
[ B
7
8

I Keyword
2

bar
Based on content  Based on formatting and more | Date |

machines
t Select all cells based on its format:
9 |table
| strikethrough -

10 [cup
11 |bean
12 [green
13 [tablas
_14 |beans
15 |mug
16 fmugs & Range:
17 [pots
18 [cups " Worksheet
19 [eaks

20 |equipment
21 [company

22 |recipe Close | ¥ Agto dose after selecting

23 |recipes = = —
24 |broak — [KE 201000
25 |cups mugs | 0.19 201000

LY P 1 noan An4nnn

Select in 233 cells:
& cell

" Entire row

 Entire column

Example screenshot: 7 Select cells by date such as all dates that are on Tuesday

A | B [ C [ D | E [ F [ G [

1 appl app2 app3 app4 app5 appé
| 2 wor | 2010-01-09 20100107  2010-01-04  2010-01-09  2010-01-01  2010-01-09
%m: ;ziz; ASAP Utilities - Advanced cell selecting ~_-- ;_ .
| 5 woa | 201008 5o o0 content | Based an formatting and more Dase |

6 |\wos 2010-0:
7 lwos | 20100 Select al cells with a value:
| & wor | 20100 Dieckday ] | Tuesday =l i
9 wos 2010-01| between i
| not between
| 10 woo 2010-01|| equal to L
| 11/wio | 2010-08) —| Ef::@fﬂ‘; |
|12 /w11 | 202008 [ § fess than I
(3w [ aooof) | | prmreomet o | C |
| 14 |w13 2010-01 " Entire row [
|15 w1 2010-01| Q,":E"r‘*‘ * Entire column [
| 16 wis |  2010-01) GQuarter I
| 17 | w16 L
| 18 | w17 [
| 19 /wis
| 20 w19
|21 /w20 | 20100102 20100101  2010-01-05  2010-01-06  2010-01-05  2010-01-09
27w nnenions NINLN1_nT 2N1nLNons 1NNt nin.nina NINNI_NA
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Conditional row and column select, hide or delete...

This utility allows you to select, hide or remove rows or columns based on a certain
condition.

You can use the following criteria to select, hide of remove the entire rows or columns:

= between = unique values

= not between = oddrows

= equalto = even rows

= not equal to = every n'th row number

= greater than = odd columns

= lessthan = even columns

= greater than or equal to = every n'th column number

less than or equal to
like (text, with use of wildcard characters)

empty cells
completely empty rows

= not like (text, with use of wildcard characters) " completely empty columns
= duplicate values (you can choose to keep the first
value)

With the criteria for text and duplicate or unique values you can choose if you want the
utility to be case sensitive.

When looking for duplicates the program also searches in hidden cells in your selection,
with the other search options hidden cells are skipped.

Some people use this utility as an alternative for or addition to Excel's AutoFilter.

Example screenshot: 1 Conditional row and column select hide or delete

1 ASAP Utilities - Conditional row and column select, hide or delete

1. Searchin: 2, Perform ackion on rows or columns? . = I
This wtility searches for a specified

K * Rows " Columns value, and then selects, hides or 1

ALA1396 J - : deletes the entire colurmn or row where -

this value is found. |

3. What to do with the entire row from each found cell; |

swhien looking For duplicates the
™ Select " Hide v Delete program also searches in hidden cells in -

yaur selection, with the ather search .

options hidden cells are skipped,

4, Search options: g g2 -
i For more Flexibilty and options you can 1

use the utility: .

between

not betwesn Select » Select cells based on content, 1

farmatting and more. .. -

equal to
not equal ko
greater than
less than 1
greater than or equal to .
less than or equal bo oK
like with use ds)
A — not like {kext, with use of wildcards) =
N duplicate values T T T T T
unique values
odd rows
BVEN 10WS
every nth row number
empty cells
completely emply rows
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Example screenshot: 2 Create a list of unique brand names

HOo[ 1 [ 0]

A | 8 | ¢ | o | E | F | & |
Brand names
Rover
Toyota
Mitsubishi
Rover
Audif” - - ]
Toy ASAP Utilities - Conditional row and column select, hide or delete
ghi 1, Searchin: 2, Perform action on rows o columns?
Cﬁe WJ * Rows " Columns
Che
Ford 3, What ko do with the entire row from each found cell:
Hyu ™ select " Hide ¥ Delete
Hyur|
Ruve 4. Search options:
Toyal) -
Toyd | duplicate values j
Ford ™ Case Sensitive

(¥ Keep the first value of each duplicate
" Delete all duplicate values

Clase

¥ auto close

This utility searches for a specified
value, and then selects, hides or
deletes the entire column o row where
this value is found,

When laoking for duplicates the
program also searches in hidden cells in
wour selection, with the other search
options hidden cells are skipped.

For mare flexibilty and options vou can
use the utiliby:

Select » Select cells based on content,
Formatting and mare. ..

titsubishi
Rover
Rover
Rover
Ford
Chevrolet
Mitsubishi

||| ok r e rafrafralm o= =2 2 === === R
—
)
2
=

m

xample screenshot: 3 Each brand listed once

A [ B [ ¢ | o | E | F
1 |Brand names

| 2 |Raver

| 3 |Toyota

| 4 |Mitsubishi

| 5 |Audi

| B |Chevrolet

L7

8 ]

1 9 ]
0

Hyunday
Ford

Saab

| 10 |Bentley

| 11 |Mazda

| 12 Jaguar

| 13 |Wolkswagen
|14 |aka

15 ]
|16 |
17 ]
18

1

44
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Move or resize selected range...

With this utility you can easily move or resize your selected range of cells.
This utility will only change you selected range of cells, not the data underneath it.

This is very powerful tool in combination with for example the "Select cells based on
content, formatting and more..." utility. For example, if you have to make the cells in
column B bold where the value in column A is "The Netherlands". You can then use the
conditional select on column A and then use this "move" utility to move your selected
range one column to the right. You then have selected all cells in column B that have in the
same row the value "The Netherlands" in column A.

By default you can start this utility with the shortcut Ctrl+Alt+M.

Example screenshot: 1 Move or resize selected range

A B £
il Keyword Competition  Global Monthly Searches Local Mo
2 |shop 0,06 13600000
3 [machine | 0,72 1830000
4 |\maker 0,52 1830000
5 'makery ASAP Utilities - Move or resize selection
6 |bar
7 |machil Move and resize ]Change selecﬁon]
2 |pot || «| v Reset
9 |table i‘
ofcup | 7| Gepelnamsnmmenine | | s
11 bean 1 | Alt+U =up
o] || A
13 tables hd _ | | Alt4R =right
14 |beans [ 4 ]| L 3 1|
L5l till last row ‘ till last column
16 |mugs Close
17 |pots
18 |cups o
19 cake 0.01 301000
20 |equipment 0,77 301000
21 |company 0,07 246000

39 lemminn nna SACAAN
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Deselect cells...

With this utility you can deselect cells, something that is normally not possible in Excel.

In most MS Windows programs you can deselect by holding the Control-key. That does not
work in Excel, which is why this utility is very useful.

By default you can start this utility with the shortcut Ctrl+Alt+D.

Example screenshot: 1 Before

Al B[ ¢ I bl ETFIJTe T HT I T TJTETTLTNw

1 app1 app2? app3 appd app appb app? app8 appd app10 app11 ap
2 [wo1 41 66 17 30 50 17 94 15 8 99 65
3 |woz 82 22 83 60 60 15 95 69 49 61 7
4 |wos 57 10 9% 99 64 33 44 a0 62 3 39
5 |wo4 25 7 a7 66 97 14 75 35 54 61 11

ewos | 20 20 % 62 13 10 9 2 31 8 5
7 |wos 25 45 94 44 32 32 78 27 52 [ 4
8 |\wo7 94 66 86 9 100 97 70 8 8 91 30
9 |wos 99 13 63 36 a1 67 50 98 89 11 6
% m?g gg 45 : ASAP Utilities - Deselect cells... @i_ﬁJ 32 g; gg
% m:; 52 1 Select the cells you want to deselect: 105 33 ;;g
14 w13 36 62 $957:50511 58 5 82
15 w14 M 82 a9 78 78
16 |W15 69 8 )| a7 3
17 |W16 23 95 45 34 20
18 |\Wi17 74 44 38 55 10
19 |w18 32 62 7 92 10
20 |w19 91 6 55 37 56
21 |w20 96 47 9 33 33
22 w21 100 3 14 51 70
23 |w22 16 70 78 51 45
24 w23 82 24 24 99 85
25 |\ w24 59 76 2 12 40

Example screenshot: 2 After

A B[ ¢ [ DJETJTFITeTTHT T TTJIJTEKETTLTN
1 app1 app2 app3 app4 app5 appb app7 app8 app9 app10 app11 ap
2 \Wo1 4 66 17 30 50 17 94 15 8 99 65
3 |woz 82 22 83 60 60 15 95 69 49 61 7
4 W03 57 10 96 99 64 33 44 40 62 3 39
5 |Wo4 25 7 97 66 97 14 75 35 54 61 "
6 |W05 20 20 90 62 13 10 95 22 31 58 6
7 W06 25 45 94 44 32 32 78 27 52 68 4
8 \Wo7 94 66 86 9 100 97 70 8 38 91 30
9 Wog 99 13 63 36 81 67 50 98 89 1 ]
10 W09 38 42 72 66 76 49 79 66 6 37 34
11 w10 33 1 18 64 17 98 58 11 30 32 60
A2 w11 65 1 65 7 85 55 62 29 6 93 80
13 |w12 13 4 16 A 1 81 28 10 100 il 72
14 w13 36 62 13 7 66 10 98 90 58 5 82
15 w14 34 82 52 g 67 64 82 56 99 78 78
16 W15 69 8 59 N 53 10 74 44 3 87 3
AT (W16 23 95 6 28 55 23 94 63 45 34 20
18 |w17 74 44 12 59 81 95 1 64 38 55 10
19 |w1s 32 62 19 40 98 57 14 63 77 92 10
20 |\W19 91 6 78 13 74 13 22 51 55 37 56
21 |w20 96 47 § 54 9 95 48 83 9 33 33
22 w1 100 3 29 80 37 20 83 78 14 51 70
23 |\w22 16 70 7 79 72 57 7 62 78 51 45
24 w23 82 24 42 N 35 36 54 72 24 99 85
25 |W24 59 76 99 33 100 32 35 4 2 12 40
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Inverse selection...

This utility will inverse your selection.

It will ask you to select a range, and extract your current selection from it. What remains is
a selection which consists of the new cells, but without your initial selection.

This can be useful for example when you want to select a lot of cells, except for a few ones.
This is a bit of the opposite of the "Deselect cells..." utility.

A B C

i Keyword Competition  Global Monthly Searches Local Mo

2 ishop \ 0.06 13600000

3 Imachine ) 0,72 1830000

4 maker \ 052 1830000

5 makers ASAP Utilities - Inverse selection... (=0 Mo 1500000

: ibar — Select the range around your selection: 133332

3 lpot [sa2:4a234 | 1220000

9 'table [ ok ][ canca | 1220000

10 icup = = 1000000

11 bean ! ; 823000

12 green : 0.26 823000

13 tables H .52 A B C

14 ibeans : 0434 i3l Keyword Competition  Global Monthly Searches Local Mo

15 jmug E 0175 [shop 0.06 13600000

16 /mugs ' 0.19 3 'machine 072 1830000

17 jpots ' 0.37 4 maker 0.52 1830000

18 jcups | 017 5 mal 05 1500000

18 |cake ! 0.01 6 |bar 0,09 1220000

20 jequipment ' 0.77 7 'machines 0,76 1220000

21 pany ' 0.07 8 pot 0.44 1220000

22 jrecipe ! 0.02 g [table 0.47 1220000

23 recipes E 0.02 10 |cup 0,13 1000000

24 {break : 0.02 11 bean 0.1 823000

25 jcups mugs E 0.19 12 green 0,26 823000

26 ygrinder | 0.19 13 |tables 0,52 823000

27 jreview ' 0.2 14 beans 0.1 673000

28 lreviews ! 0.25 15 mug 0,17 550000
16 mugs 0,19 550000
17 |pots 0,37 450000
18 |cups 017 368000
19 |cake 0,01 301000
20 equipment 0,77 301000
21 company 0,07 246000
22 |recipe 0.02 246000
23 |recipes 0,02 246000
24 |break 0.02 201000
25 cups mugs 0,19 201000
26 grinder 0,19 201000
27 review 02 201000
28 reviews 0.25 201000
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Merge selection of selected areas

This utility merges multiple contiguous selections (areas) of cells into a new selection.

Sometimes Excel needs one selected range to perform certain actions and gives you the
error "The command you chose cannot be performed with multiple selections. Select a
single range and click the command again.".

If the resulting selection is a solid square range you can use this utility to combine the
multiple selections into a new single selection.

If the individual selections together make a contiguous rectangle, you can use this tool to
create a new single selection.

For example when your select the range [A10:A50] and [B10:B50], this tool will make it one
selection: [A10:B50].

Example screenshot: 1 Excel error, select a single range

A B C D

8 Company - City - ‘Country =

2 |ABCTelecom Minsk Belarus

3 |LexCorp Brussels Belgium

4 |Mammoth Pietures Sofia Bulgaria

5 |Vvidelecl] Microsoft Becgl - o

6 bi — —

7 |Chaser: The commi ou chose cannot be performed multiple selections.

5 lpraxiscy| A Select a single rang=*arg dlick the commaind again.

9 |Fake Bre

10 i

11 |Charles

12 |The Frying Dutchman Budapest Hun|

13 |Three Waters / Dublin Ireland \

14 |Universal Export " Rome italy

15 |Acme COIP/ Luxembourg Luxembourg \
16 'Wayne Enterprises Oslo Norway

PR T er—

Example screenshot: 2 Your selected areas transformed to one single range

A B & D E

S Company -Ciw -Cuunhv =

2 |ABCTelecom Minsk Belarus
| 3 |LexCorp Brussels Belgium

4 HfSAP Utilties - Merge selection of selected areas IR =)

5 |Videlectri: T T

6 |Sombra Col _

7 Chasers EQ‘\ Do you want to merge the selection of your selected areas?

8 Praxis Corj —

9 |Fake Brothi|

10 Mainway T

11

Three Waters Dublin

14 |Universal Export Rom~ -l |
15 | Acme Corp Luxe
16 | Wayne Enterprises Oslg— =
- 2 |ABC Telecom Minsk Belarus
17 |Tip Top Cafe War =
= 3 [Lexcorp Brussels Belgium
18 |123 Warehousing Bucl s - -
4 Pictures Sofia Bulgaria
19 Omni Consimer Products M -
5 |Videlectrix Zagreb Croatia
20 Data Systems Bel - "
— —— 6 [Sombra Corp Prague Czech Republic
21 Allied Biscuit Brati
- - 7 |Chasers Copenhagen Denmark
22 Transworld Ct Ljul " " e a
- - & |Praxis Corporation Helsinki Finland
23 Extensive Enterprise Ma -
- 9 |Fake Brothers Paris France
24 Nord: Defense todl - -
> - 10 y Toys London Great Britian
25 |United Fried Chicken Berr
1 11 [Charles T¢ d Agency Athens Greece
26 |Barrytron An -
——— —1 12 [The Frying Dutchman Budapest Hungary
13 [Three Waters Dublin Ireland
14 |Universal Export Rome Italy
15 |Acme Corp Luxembourg Luxembourg
16 |Wayne Enterprises Oslo Norway
17 |Tip Top Cafe Warsaw Poland
18 [123 Warehousing Bucharest Romania
19 [Omni Consimer Products Moscow Russia
20 |Data Systems Belgrade Serbia
21 |Allied Biscuit i Slovakia
22 [Transworld Consortium Ljubljana Slovenia
23 |Extensive Enterprise Madrid Spain
24 |Nordyne Defense Dynamics Stockholm Sweden
25 |United Fried Chicken Bern Switzerland
26 |Barrytron Ankara Turkey
EE R—— Wi Lkeaina
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Select adjacent cells below active cell with the same value

This utility will expand your selection to include all adjacent cells which have the same
value below your active cell.

2 |Burleigh and Stronginthearm Barcelona Spain
3 |QWERTY Logistics Barcelona Spain
4 Sombra Corporation Barcelona 5 A B C
5 Blammo Cordoba L B Compa -1 Bl Co ~
6 Carrys Candles Cordoba 5S¢ 2 |Burleigh and Stronginthearm Barcelona Spain
7 |Demo, inc. Cérdoba Sp 3 |QWERTY Logistics Barcelona Spain
& Roxxon Cordoba 5§ 4 |Sombra Corporation Barcelona Spain
9 |Wayne Enterprises Cordoba Sg 5 |Blammo Cérdoba Spain
10 Big T Burgers and Fries Las Palmas S§ 6 |Carrys Candles Cordoba Spain
11 Charles Townsend Agency Las Palmas Sg 7 |Demao, inc. Cordoba Spain
12 Cogswell Cogs Las Palmas Sf & Roxxon Cordoba Spain
13 |Foo Bars |Las Palmas ls; 9 \wayne Enterprises Cordoba Spain
14 Globo Gym American Corp Las Palmas Sj 10 |Big T Burgers and Fries Las Palmas Spain
15 |Gringotts Las Palmas Sg 11 |Charles Townsend Agency Las Palmas Spain
16 Initrode Las Palmas 2 Cogswell Cogs Las Palmas Spain
17 | Input, Inc. Las Palmas S o Bars Las Palmas Spain
13 Klimpys Las Palmas 5 1 obo Gym American Corp Las Palmas Spain
19 Mainway Toys Las Palmas S¢ 15 |Gringotts Las Palmas Spain
20 Megadodo Publications Las Palmas Sg 16 |Initrode Las Palmas Spain
21 |Mr. Sparkle Las Palmas Sg 17 [Input, Inc. Las Palmas Spain
22 Petrox Oil Company Las Palmas Sp 18 [Klimpys Las Palmas Spain
23 Sixty Second Avenue Las Palmas Sg 18 |Mainway Toys Las Palmas Spain
24 strickland Propane Las Palmas Sf 20 [Megadodo Publications Las Palmas Spain
25 |Taco Grande Las Palmas Sg 21 |Mr. Sparkle Las Palmas Spain
26 The Frying Dutchman Las Palmas Sj 22 |Petrox Oil Company Las Palmas Spain
27 | Three Waters Las Palmas Sp 23 |Sixty Second Avenue Las Palmas Spain
28 Universal Export Las Palmas 5§ 24 |Strickland Propane Las Palmas Spain
29 ABCTelecom Madrid Sg 25 |Taco Grande Las Palmas Spain
20 nicWak o sleicl 26 |The Frying Dutchman Las Palmas Spain
27 Three Waters Las Palmas Spain
28 |Universal Export Las Palmas |Spain
29 ABC Telecom Madrid Spain
P P i .
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Select adjacent cells in column with the same value

This utility will expand your selection to include all adjacent cells which have the same

value above and below your active cell.

By default you can start this utility with the shortcut Ctrl+Alt+A.

A B c
il Company uc'rtv uCuunhv ﬂ
2 Burleigh and Stronginthearm Barcelona Spain
3 QWERTY Logistics Barcelona Spri- ! a B c
o ombre Corporation e o 5"
5 Blammo Cordoba Sp - " " —
N 2 Burleigh and Stronginthearm Barcelona Spain
GijCarrys Candles Cordoba sa 3 QWERTY Logistics Barcelona Spain
7 Demo, inc. Cardoba Sp - -
- 4 Sombra Corporation Barcelona Spain
S84 Roxxon - Cn?rdoba sa 5 Blammo Cordoba Spain
J Wayne Er\tsrprlsesr Cordoba se 6 |Carrys Candles Cardoba Spain
10 Big T Burgers and Fries Las Palmas Sp 7 Demo, inc. cordoba Spain
11 |Charles Townsend Agency Las Palmas Sp 2 |Roxxon Cordoba Spain
12 Cogswell Cogs Las Palmas .‘SP 9 Wayne Enterprises Cardoba Spain
13 |Foo Bars - ILaS Palmas = 10 Big T Burgers and Fries Las Palmas |Spain
4 Gll?bu Gym American Corp Las Palmas 11 Charles Townsend Agency Las Palmas Spain
15 |Gringotts Las Palmas S "
 inirode Las Palmas 12 |Cogswell Cogs Las Palmas Spa!n
oo Bars Las Palmas |Spain
7 IHPUt' Inc. Las Palmas s bo Gym American Corp Las Palmas |Spain
15 HITDVS Las Palmas q 15 |Gringotts Las Palmas |Spain
15 Mainway Toys —— Las Paimas s 16 |Initrode Las Palmas [Spain
20 Megadodo Publications Las Palmas s 17 Input, Inc. Las Palmas spain
21 Mr.Sparlﬁle Las Palmas 18 |Klimpys Las Palmas spain
22 P?trox 0il Company Las Palmas 19 Mainway Toys [z elles spain
= Slx-tySecond Avenue Las Paimas s 20 |Megadodo Publications Las Palmas [Spain
24 Strickland Propane Las Palmas s 21 Mr. sparkle Las Palmas spain
25 Taco Grfnmds Las Palmas 22 Petrox Oil Company Las Palmas |Spain
26 The Frying Dutchman Las Palmas %23 Sixty Second Avenue Las Palmas Spain
7 Thr_eeWatErs Las Paimas s 24 |Strickland Propane Las Palmas [Spain
28 Universal Export Las Pa-lma; s 25 | Taco Grande Las Palmas spain
32 J:PC_’TEL_IECUT Esfrfj 26 | The Frying Dutchman Las Palmas |Spain
27 Three Waters Las Palmas Spain
28 |Universal Export Las Palmas |Spain
23 ABC Telecom Madrid Spain
20 Dicabiono . Modrid i

Extend selection to the last used row

This utility will extend your selected range to the last used row on your worksheet.

This way you can easily extend your selection without having to scroll down.

This is very useful when you cannot use Excel's built in shortcuts such as 'Ctrl+Shift+Arrow
key down' because of empty cells in between or 'Ctrl+Shift+End' because you only want to

extend your selection down and not include the columns to the right.

You can for example use this to quickly copy a formula down to the last used row without

having the difficulty of scrolling and finding the end of your data manually.

By default you can start this utility with the shortcut Ctrl+Alt+Shift+Down Arrow.

50
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A B C D E F G
1 ompa h TR-0 hd TR-0 4 TR-0 Bd TR-04 Bd TR-0 I 1r-06 B}
2 |Blammo 12|
3 Chasers
4 Niagular 73 E = G
5 |Krustyco 67 51
6 ZiffCorp n
7 |Chez Quis 58 16 S
& |Roxxon 2 2
9 |Wayne Enterprises 2 et -
\g T Brgers and Fries
10 Big T Burgers and Fries 11 Charies Townsend Agancy )l i s. =
12 Copswell Cogs [ I
11 | Charles Townsend Agency 61 16| |13 Foosars E &
12 |Cogswell Cogs 46 57 1 ;‘,,D:;:Zﬂmw"m" = - — "
13 |Foo Bars 76 20 | i —
14 Globo Gym American Corp 11 50 : u::‘:“m :: : :’; -
15 |Gringotts 84 leaticns
16 |Initrade 60 65 52} E fE]
17 Input, Inc. T I E——
18 |Klimpys 69 31| S reroying iman B ] I—
19 | Mainway Toys 14 79| [EiTheee Waten
28| Univarsal Export
20 Megadodo Publications 25 KB Telacom 7 n 7
50 g Kahuna Burger 1
21 Mr. Sparkle ¥ 20 ] &
22 | Petrox Oil Company 52 78 T ——
5 ; o 2w =
23 Sixty Second Avenue 60 27 Bl o »
24 Strickland Propane 18 45
25 |Taco Grande 24 33
26 The Frying Dutchman
27 Three Waters &) s &
28 |Universal Export " M -
2 19 12 1
29 | ABC Telecom 77 o = - o
20 nis abuoon. a 1 I )
=) 12
£ I )
E a
nf
s s w  w
W wl @ Fil
55 Glovo-cnam E I ]
55| Croreniies o - TR}
53 Mosty Corp ™ I -
58 Demo, inc.
58] Mocks Biner
@sunpien
6 widet cosp
62, Thert Bank
63 Dem company 5
84 Tip Top Cafe an &y L}
65| Contra perk = I T
86| SpringShield ) ™
57| Data Systems I [0

Extend selection to the last used column

This utility will extend your selected range to the last used column on your worksheet.
This way you can easily extend your selection without having to scroll to the right.

This is very useful when you cannot use Excel's built in shortcuts such as 'Ctrl+Shift+Arrow
key right' because of empty cells in between or 'Ctrl+Shift+End' because you only want to
extend your selection to the right and not include the rows at the bottom.

Very useful when for example you want to copy a formula to the right to the last used
column.

You can for example, use this to quickly copy a formula to the right to the last used column
without having the difficulty of scrolling and finding the end of your data manually.

By default you can start this utility with the shortcut Ctrl+Alt+Shift+Right Arrow.

Available tools 51
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A B = D E F G
BN company = TR-02 B TR-03 EdTR-01 EdTR-05 EdTR-06 3 TH
2 |123 Warehousing 71 27 51 78
3 |ABCTelecom 77 83 17
4 |Acme Corp
5 |Acme, inc. 50 41 61 37 52
6 |Allied Biscuit 55| 12 26
7 |Barrytron 23] 58 21 42 85
8 |Big Kahuna Burger 30| 16 30 21
9 |Big T Burgers and Fries
10 |Blammo 12
11 |Central Perk 49] 84 10 35 41 37
12 |Charles Townsend Agency 61 16 66 75 63
13 |Chasers
14 |Chez Quis - 58| 16 22 17 36 65
Chotchkies 85| 59 19 29 41 17
46| 57 80 38 28 56
42 27 19 21
55

0 L W L, 3 | w
= T ——— C—y F—— " O - =

a w w ® _a_ v _m " " T T ) S )

I —— - 5 “ R —— s “ fra——1

s _» s a4 v _n w_ & _m_w _u_w -

& 5w ow ow i3 5 5 N i 5

Select cell in selection where value changes

This utility selects the cell in a selected range where the value changes.

This is helpful when dealing with a large number of adjacent cells with the same value in a

column and you want to "jump" down to the cell where the value changes.

Coul

ntry

1
2 |Burleigh and Stronginthearm Vigo Spain
3 |QWERTY Logistics Vigo Spair |
4 |Sombra Corporation Vigo Spa B C
5 |Blammo vigo o 1 C""‘P""‘! B city H country |
6 |Carrys Candles vigo spa 2 Burleigh and Stronginthearm Vigo Spain
7 |Demo, inc. vigo spa 3 QWERTY Logistics Vigo Spain
2 |Roxxon vigo spa 4 Sombra Corporation Vigo Spain
9 |Wayne Enterprises vigo spai > Blammo Vigo Spain
10 |Big T Burgers and Fries vigo Spal 6 |Carrys Candles Vigo Spain
11 |Charles Townsend Agency vigo Spa 7 |Demo, inc, Vigo Spain
12 |Cogswell Cogs vigo spai & Roxxon Vigo Spain
13 |Foo Bars vigo spal 9 Wayne Enterprises Vigo Spain
14 |Globo Gym American Corp vigo spal 10 Big T Burgers and Fries Vigo Spain
15 |Gringotts vigo spa 11 Charles Townsend Agency Vigo Spain
16 |Initrode vigo spa 12 Cogswell Cogs Vigo Spain
17 [Input, Inc. vigo spai 1> Fo0 Bars : Vigo Spain
18 |Klimpys vigo spa 14 Globo Gym American Corp Vigo Spain
19 |Mainway Toys vigo spai 1 Sringotts Vige Spain
20 |Megadodo Publications Vigo Spa gl Initrode Vigo Spain
21 |Mr. Sparkle vigo spa 17 Input, Inc. Vigo Spain
22 |Petrox Oil Company vigo spa 18 | Klimpys Vigo Spain
23 |sixty Second Avenue vigo Spal 19 Mainway Toys Vigo Spain
24 |strickland Propane vigo spal 20 Megadodo Publications Vigo Spain
25 |Taco Grande vigo Spa 21 Mr. Sparkle Vigo Spain
26 |The Frying Dutchman vigo Spa 22 Petrox Oil Company Vigo Spain
27 |Three Waters vigo Spa = SixFySecond Avenue Vig" Spﬁin
28 |Universal Export vigo [spa 24 strickland Propane V!go Spa!n
29 | ABC Telecom vizo N 25 Taco Grande Vigo Spain
30 |Big Kahuna Burger Vigos [Spal he Frying Dutchman V?go Spa?n
21 |Gadgetron vigo spa ree Waters Vige Spain
32 |Galaxy Corp vigo spa 28 Universal Export Vigo Spain
" 29 ABC Telecom Vigo Spain
33 |General Forge and Foundry Vigo 4l
24 |Initech vigo o 30 ‘Big Kahuna Burger I\.'igos ISpain
31 Gadgetron Vigo Spain
32 Galaxy Corp Vigo Spain
33 General Forge and Foundry Vigo Spain
34 | Initech Vigo Spain

52
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Select cells with the smallest number

This utility selects the cells with the smallest number in your selected range.
Excel's =MIN() function is used to determine the smallest value and then this utility selects
the cells with that value.

A B & D 3 F G H
B8 company TROL TRO2 TRO3 TR04 TR05 TR06 TRO7
2 |ABC Telecom 57 178 167 167 158 190 14g]
3 |Big Kahuna Burger 17 147 140 122 7 173 102
4 |Big T Burgers and Fries 67 126 157 8 115 167 134
5 Blammo 8 18 108 114 55 172 85|
| 6 |Charles Townsend Agency 196 = - e b - "
7 |Chasers 130 1
8 |Chez Quis 198 2 ABCTelecom 57 178 167 167 158 190 149
5 |Cogswell Cogs I 3 |Big Kahuna Burger 17 147 120 122 71 173 102]
| 10 |Foo Bars L0 4 Big T Burgers and Fries 67 126 157 89 115 167 136
At =2 5 Blammo 81 118 108 14 %5 172 85
12 Globo Gym American Corp Z : 6 Charles Townsend Agency 196 n 17 195 128 56 148
13 |Gringotts g el 7 Chasers 130 29 122 127 187 164 147,
|14introde | £ 8 |Chez Quis 148 193 135 118 57 m 113
15 |Input, Inc. * 9 Cogswell Cogs 103 178 8 184 154 54 96|
16 | Klimpys 10 Foo Bars 106 67 81 52 143 93 102
17 |Krustyco i 11| 182 sd 82 150 55 172 142
18 |Mainway Toys 16 12 Globo Gym American Corp 72 187 76 131 156 58 183
19 Megadodo I 13 | Gringotts 81 100 183 134 119 185 161
20 |mr. sparkle = 14 Initrode 166 196 89 S5 146 143 155,
21 |Niagular £ 15 Input, Inc. 136 110 121 141 86 191 52
22 |Petrox Oil Company 171 b impys 2] e 126 175 70 152 174
|2[Roxxon | = $ 17 Krustyco 130 144 196 103 65 170 136
24|sixty Second Avenue 103 18 Mainway Toys 169 122 181 198 193 121 157,
2] st Propane i * 19 Megadodo Publications 7% 68 60 151 12 93 112
20l Taco Grande 10 * 20 M. sparkle 133 [ 152 121 164 108 92
27 The Frying Dutchman L5 £ 21 Niagular 36 99 137 185 132 194 121
28 | Three Waters 120, 22 Petrox 0l Company 17 123 109 57 170 62 138
29| Universal Export 155, 23 Roxxon 162 175 124 51 97 72 96/
30| Wayne i g 148 " 24 sixty Second Avenue 109 150 159 141 17a 120 149
| 31 |ziffCorp =2 25 strickland Propane 110 138 77 186 84 169 186
3z 26 Taco Grande 100 198 115 151 155 152 183
2 27 The Frying Dutchman 155 200 150 68 %5 151 145
‘ 28 ‘ThIEE Waters 126 50 91 90 160 123 74|
29 Universal Export 169 160 64 143 171 12 134
30 Wayne i 148 113 s5 177 154 181 87
31 ziffcorp 163 91 124 132 I3 86 13
32
33

Select cells with the largest number

This utility selects the cells with the largest number in your selected range.
Excel's =MAX() function is used to determine the largest value and then this utility the cells
with this value

B c 3 F G H
§ 9 Company TR-01 TR-02 TR-05 TR-06 TR-07
2 |ABC Telecom 57 167 158 190 149)
3 |BigKahuna Burger 17 122 n 173 102|
4 |Big T Burgers and Fries 67 89 15 167 136/
5 |Blammo 81 114 95 172 85
6 Charles Townsend Agency 196 - B T e T ¢ = D E E G H
7 [chasers 130 .
| 8 (ChezQuis 8 2 ABCTelecom 57 178 167 167 158 150 149
9_|Cogswell Cogs = 3 BigKahuna Burger 17 147 140 122 7 173 102
BiliFoo Bars 109, 4 Big T Burgers and Fries 67 126 157 8 115 167 136
& I 5 Blammo 81 118 108 114 95 172 85
12 |Globo Gym American Corp | & 72 6 Charles Townsend Agency 196 7 171 195 128 56 143
13 Gringotts La 7 Chasers 130 8 132 127 187 164 147
14 initrode 8 ChezQuis 148 192 135 118 57 111 113
15 |Input, Inc. 9 Cogswell Cogs 103 178 83 184 154 54 96,
16 |Klimpys 10 |Foo Bars. 106 67 00| 52 143 93 102
17 |Krustyco 130 1 182 50 82 150 55 172 142|
18 Mainway Toys 165, 12 Globo Gym American Corp ) 187 7% 131 156 58 183
i s 13 Gringotts 8 100 183 134 119 185 161
20 | Mr. Sparkle 133 14 Initrode 166 196 ) 55 145 149 155
| 21 Niagular 22 15 Input, Inc. 136 110 121 141 86 191 52
22 petrox Oil Company 171 16 Klimpys 24 178 126 175 70 152 174|
E|Roxxon 1 17 Krustyco 130 144 196 103 65 170 136
28 |sixty Second Avenue 105 18 Mainway Toys 163 122 181 198 193 121 157,
| 25 [strickland Propane 110 o s 7 8 0 151 12 53 12
2l Taco Grande Lon) 20 Mr. Sparkle 133 84 152 121 164 108 52
27 [The Frying Dutchman 155 S1lNiozular 6| | 137 185 132 192 121
EHlIThree Waters 126 22 petrox Oil Company 171 123 109 57 170 62 138
_'729 Universal Export |16 155 Roxxon 163 175 124 51 o7 72 96
30 wayne 20 24 Sixty Second Avenue 109 154 159 141 172 120 149
31 [ziffcorp 109 25 strickland Propane 110 138 b1l 186 84 169 186
52 26 Taco Grande 100 198 115 151 155 152 183
== 27 The Frying Dutchman 155 53 130 68 95 151 145|
28 Three Waters 126 50 51 50 160 123 7
29 Universal Export 169 160 64 143 171 12 134
30 Wayne 138 13 55 177 154 181 87
31 ziffcorp 169 91 124 132 75 86 113
32
33
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Select all cells with an error

This utility will select all cells on your worksheet with a formula that results in an error
value.

Tip:
If you want to hide these errors, for example if you use a =VLOOKUP() formula, the
following tool from ASAP Utilities can be useful: 'Custom formula error message'

B2 - Fe | =VLOOKUP({A2;K$1:L523;2;FALSE)
A B c D
3 Company Employees
2 |ABCTelecom #NA
3 Big Kahuna Burger #N/A
4 |Big T Burgers and Fries #N/A
5 |Blammo 81
6 |Charles Townsend Agency 196
7 Chasers 13 B2 BC £ = KUP(AZ;KS$1:1523;2;FALSE)
8 |Chez Quis 1 A B C D
9 |Cogswell Cogs 10 Company Employees
10 Foa Bars 1015 | agc Telecom #N/A
11 |Gadgetran 3 |Big Kahuna Burger H#N/A
12 | Globo Gym American Corp #N/A 13 [Big T Burgers and Fries #N/A
13 |Gringotts 5 Blammo 81
14 |Initrode 16 5 Charles Townsend Agency 196
15 |Input, Inc. 13 7 chasers 130
16 Klimpys & g [Chez Quis 148
17 |Krustyco 13 5 cogswell cogs 103
18 | Mainway Toys 18 10 Foo Bars 106
19 |Megadodo Publications L ET Gadgetron 182
20 Mr. Sparkle 135 ‘Globo Gym American Corp H#N/A
21 | Niagular #N/A 113 Gringotts 81
22 |Petrox Oil Company 17 14 Initrode 166
23 Roxxon #N/A 15 Input, Inc. 136
24 sixty Second Avenue #N/A |5 Klimpys 84
25 |Strickland Propane #N/A 17 Krustyco 130
26 |Taco Grande 1M 15 Mainway Tays 169
27 |The Frying Dutchman 150 19 M gadodo Publications 76
28 | Three Waters 12 30 Mr. sparkle 133
29 |Universal Export 1 Zl‘Niagule[ #N/A
30 |Wayne Enterprises 14 55 'potrox Oil Company 171
31 |ZiffCorp 16! 53 [Roxxon #N/A
24 Sixty Second Avenue #N/A
25 |Strickland Propane #NSA
26 Taco Grande 100
27 The Frying Dutchman 155
28 Three Waters 126
29 Universal Export 169
30 Wayne Enterprises 148
31 ZiffCorp 169,
an
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Select all sheets in your workbook

This utility will select all sheet tabs in your workbook.

This can also be done in Excel by right clicking on a sheet tab and then choosing to select all
sheets, but a lot of people don't know this.

The advantage of this tool in ASAP Utilities is that you can assign your own shortcut to this
action.

38
4 4 » M| Vienna  Dubln “New York . London Luxembourg Amsterdam Copenhagan Minsk “Prague . ¥J
Ready |

36
37
38
i | Vienna . Dublin . New York .~ London Luxembourg Amsterdam Copenhagen Minsk “Prague . ¥J
Ready |

Select all objects on current worksheet

This utility selects all objects on your current worksheet.
These objects are for example shapes, text boxes, pictures, wordart, clip art, charts, forms
toolbar controls, control toolbox controls, etcetera.

}
-
O
-~
om
-
(o)
g|o*
z =
e
- =
<=
_=
z=
=z 0

o

@~ e
H
2
i}
N
©
g

w01 41 66 17 30 50 17

W03 57 10 9 99 64 33 44 40 62 3 33 83 35
66 97 14 75 35 54 61 11 96 94
W05 20 20 90 62 13 10 95 22 31 58 6 11 52

W07 94 66 8 9 100 97 70 8 38 91 30 66 20
9 © wos 99 13 63 36 8 67 50 98 89 11 6 28 25

106
149
113
30
14
8
134
1
10 W09 38 42 72 66 76 49 79 66 6 37 34 43 38 85
1 W10 33 1 18 64 17 98 58 11 30 32 60 97 91 68
12 W11 65 1 65 7 8 55 62 29 6 93 80 19 60 40
13 Wiz 13 4 16 31 81 81 28 10 100 11 72 33 12 56

14 W13 36 62 13 7 66 10 98 90 58 5 82 64 60 89
15 W14 34 82 52 8§ 67 64 s2 56 99 73 78 30 86 38
16 W15 69 8 59 31 53 10 74 44 31 87 3 88 50 25
17

18

19

20

21 Button 10 | Button 11 Button 12|

2

A B C D E F G _H I J K L M N
Hwor a1 e 17 30 s0 17 94 15 8§ 99 65 8 53 106

1
2

3

4

5 Hwos 25 7 57 66 57 14 75 35 54 61 11 % 94
6 HBwos 20 20 %0 e2 13 10 %5 2 31 % 6 1 52 1
=
8
9

13 H5w12 13 4 16 31 81 81 28 10 100 11 72 33 12 56

2l lownrd Lo |
21 o O el S v

Available tools 55



17

18

19

ASAP Utilities User Guide “Save hours in Excel”

Print preview selection

This utility will show you a print preview of only your selection.

Print selection

This utility will print your selection immediately to the default printer.

Set current selection to all worksheets

This utility selects the currently selected range on all worksheets in your workbook.

This way you can for example quickly set the selected range to Al on all sheets at once. If
you use your workbook as a form for completion such as a weekly report this can be very
useful.

s
ASAP Utilities - Set current selection to all worksheets [=x=) 3

I."'_"“ Do you want you make your current selection (C7), the selected range
Y on all worksheets?

Cancel n

56 Chapter 5
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Sheets

A selection of sheet tools.

Add new worksheet (fill in a name)...

This utility asks you for a name and then adds a new worksheet with that name.

This way a new worksheet is added at then end of your sheets with the name you provide.
It is easier than inserting a sheet; double-click it and then typing the name. If you use the
shortcut to start this utility it is faster too.

By default this utility can be started with the shortcut Ctrl+Alt+N.
If you just want to insert a worksheet without specifying a name you can use Excel's
shortcut Shift+F11.

m

27

28

29

. ASAP Utilities - Add new worksheet (fill in a name)... | &[S
31 Type the name for the new worksheet:

32 The name can contain a maximum of 31 characters.

33 Mot allowed are the characters: :\/? *[and]

34 Sales March

5
a7

38

39 %

W 4 » ¥ [ Sales January | Sales February ~ %1

Ready | -

W 4 ¥ M| Sales January Sales February | Sales March ' ¥1
| Ready |

Insert multiple sheets (uses the cell values as sheet names)...

This utility quickly adds new worksheets based on the information in your selected data
range.

For each cell in your selection a new worksheet will be created and the cell content will be
used for the name of the new worksheet.

You can specify to use a certain worksheet as a source/template sheet. This way you can for
example easily create 52 copies of that worksheet.

Usage:

1. Select a range of cells that contain the names for the new sheets. (You can use the "Quick
numbering of selected cells" utility from ASAP Utilities, or Excel's built in fill tools to help
you quickly create a list of names).

2. Start this utility, set the options and a sheet will be created for each and based on each
cell in your selection.
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EEAH9-~-|= 0022 - Time registration per week.dsx - Microsoft Excel

“Hume Insert Page Layout Formulas Data Review View ASAP Utilities

Columns & Rows = (33 Numbers & Dates = €5 Web - [ Import ~

" [5) % [l sheets -
_ﬁ [ Range‘ [ Objects & Comments ~ |A| Text ~ | nformation ~ ] Export ~

My favorite | Vision Select
tools ™ Control =~ =i Fill™ Format ~ Jx Formulas ~ :'h File & System = b Start = |
Time saving tools

Favorites

a1 - £ | \week o1

A B c D E F G H | J
(Week 01

(Week 02
Week 03 | [ asap utiities - Quickly add mutiple sheets
(Week 04
Week 05 Worksheets to be created: 52
(Week 06
(Week 07
(Week 08
(Week 09
(Week 10 Er s
Week 11 [V Color sheet-tabs based on cell colors
(Week 12
(Week 13
(Week 14
(Week 15
(Week 16
(Week 17
(Week 18
(Week 19
[Week 20
(Week 21
(Week 22
(Week 23
(Week 24

Week 25
4 4+ M| Weeks < Time registration temphte (]

Ready | e

Do you want to add 52 worksheets with the names defined in selected cells for example like
‘Week 01" as in the first cell in your selection?

Template for the new worksheets:

Time registration template ~|
{none, create blank worksheet)
Weeks

Time registration template

B

YT B R B B
o oo ol e

22 \Week 22

23 Week 23

24 Week 24

25 Week 7R

W 4 M| Weeks Time registration tem Week 01 Week 02~ Week 03 " Week 04 Week 05 Week
Ready |

Rename current sheet...

This utility asks you for a new name and then renames the current sheet.

You can also double-click on the sheet-tab to rename it or do it via Excels Format menu.
The advantage of this tool in ASAP Utilities is that you can assign a shortcut to it via the

favorites menu.

29
30
a1
32 Rename Sheet (o |

33
34 ame

35
36
37
38

9
W 4 b » | Sales January Sales February | Salse March .~ ¥3
Ready |
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Quickly rename multiple sheets at once...

This tool allows you to quickly rename multiple or all sheets in your workbook at once.

You can:

= Use "Find & Replace" in sheet names
= |nsert text before sheet names
= Insert text after sheet names

= Automatically generate sheet names from the values in selected cells.

file ~ Home  Insert ~ Draw  Pagelayout  Formulas  Data  Review View Help  ASAP Utilities
", G;[ a:l:‘ FHsheets~ | [ Columns & Rows ~ = Numbers & Dates~ | @ Weh ~ [® import ~ | PR ASAP Utilities Optians~ | (7) Online FAQ
Q &ARange ~ %] Objects & Comments ~ [ Information~ G Export~ | [> Find and run a utility (D infa
Favorites & Vision | Select -
Shortcut keys~ | Control |~ LEAFll [ Format ~ Jx Formulas ~ [BrFile & System~ | [> Start~ Bl Start last tool again @) Registered version
Favorites Time saving tools Options and settings Info and help
% || Tokyo
M | N | O | P | Q
1
2 X
3
4 |s8o Paulo =
5 |Mexico City =
6 |Cairo Concel
7 4|
8 [Beijing
9 |Dhaka
oz Insert before
11 |New York
12 |karachi Insert after
13 |Buenos Airy ok Ci
" :_"‘ ey Find & Replace
14 | Chongging| Karachi
15 e E .,
16 |Kolkata Createfom N,
17 |Manila ¥ | selection 3
18 |Lagos iy ALA3D E ]
19 |Rio de Jane ,.’
- ~_ -
20 |Tianjin ‘-R-Es—at-'
21|k =
2
23 |Los Angele! ThEE
24 |Moscow The maximum length for a
R sheet name is 31
25 characters.
26 |Lahore
Fangakae Some characters are not
27 |Bangalore ang allowed by Excel and will be
i automatically replaced by
26 |Paris _ o underscore () by this
29 |Bogota Al Invert Nane tool.
30 |Jakarta 4| 4| 4|
n
2]
v Sheetl | Sheet? | Sheet3 | Sheetd | Sheets | Sheet6 | Sheet? | Sheets | Sheetd | SheetlD | Sheetll | Sheetiz | Sheeti3 | Sheettd | Shi ...

Delhi Shanghai Sdo Paulo Mexico City ‘ Caira | Mumbai Beijing

Ready

Dhaka ‘ Osaka | New York City ‘ Karachi

Buenos Aires ...

®

c
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Change name of selected sheets to selected cell’

s value

With this utility you can rename the selected worksheets based on the value in a certain

cell.
You can rename all selected worksheets by giving them as a name the

cell A1 on each worksheet.

value of for example

|name

eGate |

Internet Solutions

week 1

@ g~ 0024 - Change name of selected sheets to selected cell's valuexlsb [Group] - Microsoft Excel =8 %
“_Home Insert  Pagelayout  Formulas  Data  Review  View | ASAP Utilities > @ o @ =
" © [} [ sheets - [ Columns & Rows » (3} Numbers & Dates ~ €5 Web - (% mport - (A ASAP Utilities Options =
‘ ] Range * | Objects & Comments ~ [A] Text |@ Information ~ @] Export* | B Find and run a utility -
Favorites & | Vision Select y . Info and
Shortcut keys = | Control  ~ & Fill v (Gl Format ~ fe Formulas ~ [y File & System ~ p Start - Start last tool again help =
Favorites Time saving toals Options and setings
c2 - £ | week1 >
-

| 2013 ASAP Utilities - Change name of selected sheets to selected cell's value S I ! projectcode
- 0 00 00 00
project & Do you want to change the name of the selected 53 workshests to the
W' value thatis in cell C2 on each sheet?
N Cancel
=
Hd4rH Sheet 1 “Sheet 2 “Sheet 3 . Sheet4 . Sheet5 , Sheet 6 . Sheet7 . Sheet8 . Sheet9 . Sheet 10 . Sheet 11 [i[4 [ | »
Ready | |[EEm e G0 &)
|
) -
1| | week 1 “week2 ~week3 ~week4 ~“week5 week6 week7 ~week8 ~week9 ~week10 ~ week11 week|[d| [ | »
Ready | [EO@m % 00— |
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Insert sheet(s) name in selected cell(s)

This utility inserts the name of the worksheet into your selected range in each of your
selected worksheets.

You can for example use this to insert the sheet name into cell Al on every selected
worksheet.

HE=-r-ir B P - e s 5] s e el o ] < e e e el - n
- Frm [ 1. Fron v [ ] = L=y - ik pem o g
q | I ol Berri s ) Crcemid B hlrr - @ Kty c [ o 8 s Cof e
LK DRF ISR L R T R | ] Brremne - i S - 0 Frooss e il
TS TESs o
R e R — . ——— HwmLime - ¢ JEeaera aEe =
Tpoop [T e T IE
r [ I=]
eGate | I —
Tesarap Zelmines
el e o s, 3t v ]
I T - o
I e e ol e v el ool e e L2 D v el e
1 rdrrea e ===
=
T TR T T TR T — -nl_-u--_n-I:_‘.-l___r T
L i = = - i
—r
JE d =1 e T e i s ey e e e v vt e [T
- L L] - raEE ETEEl e T ] wighe &
r" M ol e (L s — s RS TS R T T e = R o o oy -
. % S e = ol dp fhrmermm - il rgesc B wa e sy firmpl
- -|.||I|_-- — e - . i re=a iy . BrEE s oA [ LTS TR e
s = i L T

= N T 7
eGate woek 1 - E

FaEval SEnREn

FeH B e e i e WL R R R A ]
3y =1 ogm mr m am @y

= o |

LI R HE T T ST T T T T T
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Sort all sheets...

With this utility you can sort the sheets in your workbook.
You can sort the sheets alphanumeric (text), numerically (numbers) or by their tab-color.
You can also specify to sort the sheets ascending or descending.

To be able to sort by the tab-colors you need at least Excel 2002/XP.

Example screenshot: Sort sheets by their value or color

13| Uec 2006 194 143 224 18/ 22 194 gy 139
14 Jan 2007 52 187 89 69 192 14 172 82
15 hEE] 227 132 175
16 ASAP Utilities - Sort all sheets 96 166 53 101
17 49 139 174 207

Options

g 79 203 87 28

% sort alphanumeric (text) 33 124 57 67

" Sort numeric (numbers) : 44 165 79 51
Cancel

(™ Sort by tab color — i 135 50 9

22 29 a0 197 203
23 —— 33 225 149 178
2 17 17 10 93
25 ' Ascending (A-2) 95 28 163 107
26 " Descending (Z-4) 32 121 105 96

59 3326 2802 2131

4 4 ¥ Vienna . Dubin . New York . London uxembourg .~ Amsterdam .~ Copenhagen .~ Minsk . Pragu
Ready |
28

H 4 v W[ Amsterdam . Copenhagen .~ Dubin . London -~ Luxembourg Minsk_“New York . Prague | Vient
Ready |

Create an index page with links to all sheets (clickable)...

This utility will create a clickable index page; a new worksheet with a hyperlink to all
worksheets and chart sheets in your workbook.

You can see this as a menu for your workbook with the names of- and a link to all sheets
and a quick navigation back to the main menu (index worksheet).

This can be useful when you are dealing with large files with a large quantity of worksheets
and/or chart sheets.

To quickly return to the index sheet ASAP Utilities has added a new name to your workbook
that refers to cell Al on the index sheet. This name is"___INDEX_SHEET___ASAP_Utilities".
To quickly return to the index sheet select this name in the name box in the formula bar.

Note:

In Excel it is not possible to create a hyperlink to a chart sheet. To be able to link to a chart
sheet ASAP Utilities uses a macro for this. This has a side effect if you workbook contains
chart sheets and you use this tool and then the file is used by someone that does not have
ASAP Utilities. When they then click on a link to a chart sheet they will receive an error that
the macro cannot be found.
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1"
12
13 ASAP Utilities - Sheet index
14
15 — Sheets to index:
16 ¥ Worksheets ™ Chart sheets
17
13 — Owerwrite existing index sheet?
19 = o * Yes (the entire sheet wil be replaced!)
20
21 — Position of the index sheet:
22 * Begin " End {” Before current sheet
23
24 — Index order:
25 " Alphabetically (Ascending)
26 " alphabetically (Descending)
27 ¥ Original sheet order
28 ¢~ Worksheets first, then chart sheets
29 (" Chart sheets first, then worksheets
30
chl Cancel |
32
33 “
34 4
H 4 b M Summary Definitions | week 1 “week 2 “week 3 “week4 “week5 “weekt “week7
Ready | i
A B c D ™t F G H
1 Sheet Index: )
2 |Summary
3 |Definitions
4 \weekl
5 week?2
6 \week3
T weeka
8 \week5
9 weekt
10 week 7
11 \week 8
12 \week 9
13 |\week 10
14 \week 11
15 \week 12
16 week 13
17 |\week 14
18 week 15
19 \week 16
20 \week 17
21 \week 18
M 4 » M| Index sheet . Summary Definitions “week 1 ~“week2 ~“week3 “week4 ~“week5 wee
Ready |
\

Split the selected range into multiple worksheets...

With this tool you can quickly split your selected data into multiple sheets.
You can do this either by value/group in a column or you can specify the number of rows to
create per sheet.

Examples:
Create a new sheet for each company in your table.

Note:
Your initial data remains unaltered.
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If you want to save the new created worksheets as separate files, then you can do this with
the utility "Export » Export worksheets as separate files...".

We have also received the request for this tool from people that used workbooks with over
500 000 rows (Excel 2007+) and then needed to create a file that could be opened in Excel
2003. In order to do that they had to split the information into pieces of a max of 65536
rows per worksheet because that is the maximum amount of rows that a sheet in Excel
2003 can contain. With this tool you can quickly have ASAP Utilities do that for you.

2 |Barcelona Burleigh and Stronginthearm
3 [Barcelona QW sqp tiites - Spit the data into multiple worksheets
4 |Barcelona Sol
5 |Cordoba Bla When to create a new worksheets for the data in range A1:1120
6 |Cordoba Cal
7 |Cérdoba De ' For every new value/group in column:
8 |Cordoba Ro! ' For every so many rows:
9 |Cordoba Wz
10 |Las Palmas Big — Copy rows as headers on each new worksheet?
11 |Las Palmas Ch: Mumber of rows to repeat at the top of each sheet:
12 |Las Palmas Cog
13 |Las Palmas Fod | [ Template for the new worksheets:
14 |Las Palmas Gle I (none, create blank worksheet)
15 |Las Palmas Gri
o oo el inif First cell of destination range: I Al J
17 |Las Palmas Ini I™ InsertRows
18 [Las Palmas Kli ¥ Keep Source Formatting
19 |Las Palmas Ma
50 | vd | [ Name for the new sheets that are created:
o3 |l el M " Leave default Excel sheet name
22 |Las Palmas Pel " Sequential numbering
23 |Las Palmas Six " Use se ering
24 |Las Palmas Str (O s eg e i i =
25| LR T4 & Use the value of the cellin the specified column
26 [Las Palmas The |
27 |Las Palmas Thl| Prefix: Suffix:
28 |Las Palmas unif I
29 |Madrid AB{ Example:
30 |Madrid Big | (Baroe\ona
31 [Mad Gad
32 [Mad Gall
33 [Mad Gel
34 |Ma In
35 |Ma Le:
L2A | d Luthnrtarm
A B C D E F G
1 ompa R-0 R-0 R-0 R-04 R-0
2 |Bafgelona Burleigh and Stronginthearm 12
3 Barcelona QWERTY Logistics
4 |Bakcelona Sombra Corporation 73 28
5
]
7
8
9
10
1
i Barcelona . Cdrdoba . Lss Palmes_~ Madrid .~ Pamplona_~ Sevile - Vigo %2 ~[J4[_____
Ready | @
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Export worksheets as separate files...

With this utility you can save all or the selected worksheets in your workbook as separate
files.
You can choose a folder in which you want the worksheets to be saved.

The worksheets can be saved in the following file formats:

= Excel Workbook (*.xIsx)

= Excel Binary Workbook (*.xlsb)

= Excel 97-2003 Workbook (*.xls)

= CSV (Comma delimited) (*.csv)

= Text (Delimited by semicolon ';') (*.txt)
= Text (Tab delimited) (*.tsv)

= Formatted Text (Space delimited) (*.prn)
= Text (Pipe (]) delimited) (*.txt)

= Text (Delimited by tilde '~') (*.txt)

= Web Page (*.htm, *.html)

= Single File Web Page (*.mht, *.mhtml)
= PDF (*.pdf)

When exporting text files in Unicode format, you can choose between the standard UTF-16
character coding from Excel, or the commonly used UTF-8 character coding.

Your last used settings will be remembered.

Example screenshot: 1

e% | cues-us-uu 1eu P aus 13 I Y 1 £

25| 2023-09-07 18 11 as P 1as 2e 162 Py

26| 2023-10-29  ASAP Utilities - Export workshests as separate files... X
eliTotal _ [ Export folder
28 The selected worksheets will be saved in the export location with the name of the worksheet as
20 flename.
30 C:\Projects\Marathon) [
31 =
32 [¥ Open this folder in Windows Explorer after export
EE]
34 Worksheets to export: File format:
35 || Excel Binary Workbook (=.xsb) |
36 g Excel Workbook (%.xisx
= Dublin Excel Binary Workbook (*xsb!
L Excel 97-2003 Workbook (*.xis)
38 €SV (Comma delimited) (. csv)
= Text (Delmited by semicolon '} (% txt)
Text (Tab delimited) (* tsv)
40 Formatted Text (Space delimited) (*.prm)
Text (Delimited by pipe 'I) (% txt)
“ Text (Delimited by tide '~) (*.txt)
42 Web Page (*.htm, = html
Single File Web Page (*.mht, *.mhtmi)
43 POF (*.pdf)
44
7 Use non standard settings:
46 o
a7 I
43 =
49
=7 If the fle already exists:
=0 R [ overnrite =N
52 .
5 Al Invert Done cancel oK
54 :
55 )

Amsterdam | Copenhagen | Dublin | London | Luxembourg | Minsk | MewYork | Prague | Vienna

Available tools 65



11

ASAP Utilities User Guide

“Save hours in Excel”

Example screenshot: 2

2% | eusa-uo-uu Leu ces s

143 L L i 73

25| 2023-09-07 11a 11 As

27 |Total — Expart folder

ASAP Utilities - Export worksheets as separate files...

A7 190 20 183 107

28 The selected worksheets will be saved in the export location with the name of the worksheet as

2 flerame.

| C: Projects Marathon|

32 [V Open this folder in Windows Explorer after expart

=7 Copenhagen
Dubin

- London

| Luxembourg

[ File format:

Browse
5

| Excel Binary workbook (*.xisb)
Ou

[¥ Do not export hidden cells

— How to export:
& Values only

£ Values and formuias

I the fle already exists:
’7| Overnrite -

—

52 | "
= A Tnvert None

Amsterdam Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York Prague Vienna

Example screenshot: 3

25| 2023-09-07 119 1 as 7 109 Ee 162 1071
26| 2023-10.29 ASAP Utilities - Export worksheets as separate files... x
27 | Total — Export folder
28 | The selected worksheets wil be saved in the export location with the name of the worksheet as
20 filename.
30 o

g :Projects\Marathon) .
31| =
32 |V Open this folder in Windows Explorer after expart
33
3 4’ — o expart: [~ File format:
35 | Amsterdam | csv (comma delmited) (=.csv) ~|
36 openhagen

- Dublin ¥ Unicode UTF-8 -
37

— London ¥ Do not export hidden cells
2 Luxembourg
=) — How to export:
40| @ yvalues (12)
4 (o I Ei
2 Eormuias (=3E5)
43 " Ag displayed (EUR 12,00)
il
=  Use non standard settings:

I Figlds enclosed by:

46 |
a7 I Decimal separator:
I I™ Aftemative fie extension:
49
50/ 1f the file already exists:
51: ””””” ’7 Overnrite |
52 |
= al Tnvert None Cancel |
54

= T T !
55 | A

Amsterdam | Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York | Prague Vienna

Remove all empty worksheets

This utility removes all empty worksheets in your workbook that do not contain any data
and formatting or objects.
You can use this to clean up your workbook, for example before a colleague or client has to
work with it. This way the focus is only on the worksheets that are in use.
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Unhide all sheets

This utility will unhide all sheets.
Normally in Excel you can only unhide one hidden sheet at a time. Now you can quickly
make them all visible in one step.

Hide selected sheets

This utility will hide the selected sheets.

You can already do this in Excel but the advantage of this tool ASAP Utilities is that you can
now assign your own shortcut to it.

Hide selected sheets extra (x1VeryHidden)

This utility will hide the selected sheets with the so called "xIVeryHidden" feature.

This way the sheet cannot be made visible the normal way in Excel (Format > Sheets >
Unhide). You can only unhide the sheet by using a macro (VBA-code), or by using a tool
such as "Unhide all sheets" in ASAP Utilities.

Protect multiple sheets at once...

This utility allows you to protect the selected or all sheets in your workbook with the same
password at once.

The built in method of Excel allows you to only protect one sheet at a time. If you want to
protect multiple sheets in Excel you have to protect them one by one. This can take a long
time if you have many sheets and might result in accidentally forgetting one.

With this tool protecting your sheets is much easier and furthermore a lot faster.

Depending on your Excel version you can set additional settings, just like in the normal
Excel protection dialog.
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Example screenshot: Protect multiple sheets at once

3
T
= p I I I I
9 ASAP Utilities - Protect multiple sheets at once
10
1 Type a password to prevent unauthorized users
2 from removing the sheet protection, The password Allow all users of the worksheet to
is case sensitive, can be up to 255 characters long, ¥ Select locked cells
13 and can contain any combination of letters, ¥ select unlocked cells
14 numbers and symbals i
[~ Format cells
15 ™ Format columns
16 [~ Format rows
i Enter password (optional) I Insert columns
= [smsmmenne I Insertrows
19 [ insert hyperlinks
20 Re-enter password I™ Delete columns
21 [Fremmmmmannans [~ Delete rows
22 [ sort
23 ' Mask password [~ Use AutoFilter
24 I” Use FivotTable reports
2 Protect [~ Edit objects
26 " gelected sheets (1) [™ Edit scenarios
27 {* gl sheets (52)
28
29 T
30 Cancel oK
il
32 ! ! ! ! i i i
33
M 4 » M| Week 01 “Week 02 -~ Week 03 ~Week 04 ~Week 05 ~Week 06 ~Week 07 ~Week 08 ~Week 09 W
Ready |

Unprotect multiple sheets at once...

This utility allows you to unprotect the selected or all sheets in your workbook with the

same

password at once.

The built in method of Excel allows you to only unprotect one sheet at a time. If you want
to remove the protection from multiple sheets you have to unprotect them one by one.

This can take a long time if you have many sheets.
With this tool unprotecting your sheets is much easier and furthermore a lot faster.

Example screenshot: Unprotect multiple sheets at once

"
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32

33
CICC

ASAP Utilities - Unprotect multiple sheets

If the sheets are protected by a password, enter it below.
Leave the field blank if no password is required.

Password

[¥ Mask password

Unprotect:
" selected sheets (1)
{* all sheets (52)

Cancel

Week 01 "Week 02 ~Week 03 ~Week 04 ~Week 05 ~Week 06~ Week 07

Ready |
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Print multiple sheets at once...

Quickly print multiple worksheets or chart sheets at once.
You can choose which sheets to print or quickly select all. If you specify to create a single

print job, the page numbering will be continuous; if not the page numbering will start with
1 on each of the selected sheets.

Example screenshot: Print multiple sheets at once

ASAP Utilities - Print multiple sheets

Workbool: [ Time registration. s

9 Worksheets | Charts |

Worksheets in selected file:

12 ] Weeko1
Week 02
Week 03
Week 04
Week 05

RHEEOOO00

Week 11
Week 12
Week 13
Week 14
Week 15
Week 16

OO00000 R

29 None Inverse

E]

Chooge printer

Calculate
pages to print

Create a single
print job

Worksheets 5
Charts:

32 T ! !

13
WA ¥ Week 01 - Week 02 Week 03 “Week 04 ~Week 05~ Week 06~ Week 07 ~Week 08 'V

Ready |

Copy a sheet's page and print settings...

With this tool you can easily copy the page and print settings from a worksheet to other

worksheets.

You can copy the following properties:

= Rows to repeat at top
= Columns to repeat at left
* Print area

= Header left

= Header right

= Footer left

= Footer center

= Footer right

= Margin left

= Right margin

= Center header

= Top margin

= Bottom margin

= Header margin

= Footer margin

Row and column headings
Gridlines

Printing quality

Center on page horizontally
Orientation

Draft quality

Paper size

Print comments

First page number

Print in black and white
Order

Zoom/scaling

Center on page vertically
Scale to fit page

Available tools
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Note:

The speed of this utility might vary, depending on the type of printer(driver) that is set as
default when the tool is executed.

Starting from Excel XP/2002 you can also insert a picture in the header or footer.
Unfortunately this is something that cannot be copied to other worksheets by using a
macro. So if you have a picture in the header or footer it will not be copied with this tool in
ASAP Utilities. From the Microsoft website: "The only way to work with pictures in headers
or footers for multiple worksheets is to select all the worksheets, and then insert a graphic
by using the Insert Picture dialog box (click the Insert Picture button), or format the graphic
by using the Format Picture dialog box (click the Format Picture button). The original
graphic file is needed for this procedure."

2

32

ASAP Utilities - Copy page and print settings

Active printer (might affect speed): Caneel | T I

Xerox Phaser 6121MFP #:2 on TPVM:

33

E

g— Source worksheet to read from: — Copy the following settings:

7 I Amsterdam ;I ¥ Center on page horizontally

Er Al Nene W Center on page vertically
1 | Copy to the following worksheets: W Zoom/scaling

i— Copenhagen ¥ Rows to repeat at top ~ Ea\e. to fit page
4 ¥ Columns to repeat atleft W Margin left

4 ¥ Erint area ¥ Right margin

42 ¥ Header left ¥ Top margin

4 ¥ Center header ¥ Bottom margin

44 . ¥ Heagder right ¥ Header margin

4 T ¥ Eooter left ¥ Eooter margin

46 Prague ¥ Footer center ¥ Orientation

4 Vienna ¥ Footer right ¥ Draft quality

4§ ¥ Row and column headings ¥ paper size

40 ¥ Gridineg ¥ Eirst page number

& ¥ Brint comments ¥ Order

51 al | [ | T ¥ Printing guality [¥ Print in black and white
52

53

54

5

56
W 4 » ¥| Amsterdam . Copenhagen . Dublin “London .~ Luxembourg . Minsk “Mew York . Prague . Vienna “#3

Ready |
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Set print area on selected worksheets

This utility sets the currently selected range as the print area on all selected worksheets.
In Excel you can only set the print area on one sheet at a time. With this utility you can now
easily set the same print area in multiple sheets at once.

A | B | ¢ | o | e [ F | @ [ W | 1
1 (Week 1
2
3
4 |Description Mon Tue Wed Thu Fri Sat Sun
3]
|5
|7 | ASAP Utilities - Set print area on selected worksheets =5
8
El -
10 I’ ‘-I Do you want to set the currently selected range (A1:H18) as print area
F Y on the selected 52 worksheet(s)?
12
|24
|15
16
17
18
19
20

21
HArH week 46 . week 47 . week 48  week 49 . week 50 . week 51 . week 52 ¢ [] 4

Ready \ l

A E c D E PG H 1
1 Week 1
2
3
4 Description Mon Tue Wed Thu Fri * Sun
5
6
7
8 4
9
10 y 4
1 y
12

I_.

week 46 week 47 . week 48 week 49 week 50 “week 51 . week 52 % {I] 4
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Clear the print area on selected sheets

This utility removes the print area on the selected sheets.
In Excel you can only clear the print area on one sheet at a time. With this utility you can
now easily clear the print area on multiple sheets at once.

A B C D E F G H 1

1 Week 1

2

3

4 Description Mon Tue Wed Thu Fri Sat Sun
£ L]

6

; ASAP Utilities - Clear the print area on selected sheets ﬂ

9

10 0’ Do you want to remove the print area settings on selected 52

11 €W worksheets?

12

13

- Concel

15

16

17

18

19

20
PRI week 1 “week? ~“week3 ~weekd week5 ‘week 6  week7 week 8 week[]4[
Ready |

Remove all page breaks on the selected worksheets

This utility removes all manually set pages breaks from your selected worksheets.

In Excel you can only remove all page breaks one sheet at a time by first selecting all cells
and then choosing "Reset All Page Breaks" in the "Insert" menu.

With this utility you can now easily remove the page breaks on multiple sheets at once and
you don't need to select all cells upfront.

[ A B c D E F G H 1

1 [Week 1

2

3

4 Description Mon Tue Wed Thu Fri Sat Sun

5

6 ASAP Utilities - Remove all page breaks on the selected worksheets [
7

8

3 Do you want to remove all manually set page breaks on the selected 52

AB orksheets?

10

1

i Cancel

13

14

15

16

17

13

19

20
o week 1 “week2 “week3 ~“weekd ~“week5 week 6 week7 week 8 week[]4[
Ready |
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Freeze panes on multiple sheets at once

This utility freezes the panes in all or all selected worksheets, based on your selected range.
If you have selected only one sheet the utility works on all worksheets in your workbook. If
you have selected multiple sheets, it will work on those selected sheets.

Freezing panes allows you to select data that remains visible when scrolling in a sheet. For
example, keeping row and column labels visible as you scroll.

To freeze the panes, first do one of the following and then start this tool:

= top horizontal pane: select the row below where you want the split to appear.

= |eft vertical pane: select the column to the right where you want the split to appear.

= both the upper and left panes: click the cell below and to the right of where you want the
split to appear.

In Excel you can only freeze the panes on one sheet at a time. With this utility you can now
quickly do this on multiple sheets at once.

[ A T 8 [ ¢ [ o [ e [ F [T & [ wu | 1
1 Week 1
2
8
4 Description Mon Tue Wed Thu Fri Sat Sun
5
6
; ASAP Utilities - Freeze panes on multiple sheets at once @
El —
10 [e] Do you want to freeze panes on the selected 52 sheets above row 57
1 =
12
13
14 Cancel
15
16
17
13
19
20
21 — |
44 r M| week1 “week2 week3 ‘week4 ‘weekS5 week6 week7 week8 Sweek[4[
Ready |
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23 Unfreeze panes on multiple sheets at once

This utility unfreezes the panes on all or all selected worksheets at once.
If you have selected only one sheet the utility works on all worksheets in your workbook. If
you have selected multiple sheets, it will work on those selected sheets.

In Excel you can only unfreeze the panes on one sheet at a time. With this utility you can
now quickly remove this on multiple sheets at once.

A B = D E F G H I

1 Week 1

2

8

4  Description Mon Tue Wed Thu

1

12

= ASAP Utilities - Unfreeze panes on multiple sheets at once

15 =~
l_e\ Do you want to unfreeze panes on all selected 52 sheets?
\

26

\:14 » M| week 1 ‘week? ~“week3 weekd week5 ~week 6 ~week7 week 8 week[]d |
Ready |

24 Put together rows or columns from several sheets...

This utility will copy the specified columns or rows from each selected sheet, and combines
them into a new sheet.

You can for example put the data from F of each selected worksheet side by side on a new
worksheet.

Usage:
1. Select the desired worksheets from which you want to combine the data.
2. Start this utility and then select the column(s) or row(s) you wish to put together.

If you choose the option "Create dynamic links (cell references)", the new worksheet will
contain formulas with a cell reference to the original data. If you choose this option the
display of zero values on the new worksheet will be turned off. The display of zero values is
an Excel worksheet setting which you can also control with the "Vision Control" utility in
ASAP Utilities.
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Example screenshot: Put together rows or columns from several sheets

ASAP Utilities - Put together rows or columns from several sheets x
Worksheets Put side by side or below each other on a new worksheet:
= Tl vertcally (ID) =
Ol liJ i Last Calumn
(o
(%' Tile horizontally (=)
" Rows: liJ
# Rows: [2 - |:tastrow

" Entire sheet

Values or cell references:

% Copy the values

(™ Create dynamic links (cell references)

All Invert ‘ lNone

Copy the data in the specfied columns or rows from each of the 3 selected sheets, and put the data together on a new worksheet,
| You can for example put the data from F of each selacted worksheet side by side on a new worksheet.

25 Remove all unused styles on every sheet

This utility removes all unused styles from every worksheet in your workbook.
In most of the times this fixes the problems when you get the message "Too Many Different
Cell Formats" in Excel.

What this message means is explained by Microsoft:

You receive a "Too many different cell formats" error message in Excel.

This problem occurs when the workbook contains more than approximately 4000 different
combinations of cell formats. A combination is defined as a unique set of formatting
elements that are applied to a cell. A combination includes all font formatting (for example:
typeface, font size, italic, bold, and underline), borders (for example: location, weight, and
color), cell patterns, number formatting, alignment, and cell protection.

Source: https://support.microsoft.com/kb/q213904/

\\’J s 61:% 78 65 % 29§ 1258 49 | § 14
L e Py -
" ASAP Utilities - Remove all unused styles on every sheet X

\_ Do you want to remove the unused styles in all worksheets?

™ Also remove unused built-in Excel styles

ord 102

|
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‘/\_7— 3 61:% 78 : % A5 8 29 | 8 1265 : & 49 : § 14 ¢

ASAP Utilities - Remove all unused styles on every sheet X
_\/\/ $ | 9
1 There were 55 styles available in your workbook 0130.xsb. [
/\\ g 91 Only 53 are in use. $ 30 ¢
<N
1 The following 2 styles were not in use and have been I
removed: H ¢
’\/\ $ 3 - Expenses fill : $ =
ol - Cost of Sales fill E
|8 3 s 26 !
~ — i
~ B F .
V/\L,——ﬁ 188 11§ 30 S 9 3 62:% 395 102 ¢
10:52:00 21-04-2022 2.000 HR 3.00
ASAP Lhilities - Remove all unused styles on every sheet X

There were 62871 styles available in your workbook 0130 -
Problematic file with ta many styles.xlsh
Only 48 are in use,

The following 62823 styles were nat in use and have been
removed:

- Warning Text 4
- Warning Text 3
- Warning Text 2
-Total4

- Total 3

~Total 2
-Titled

-Title 3

-Title 2
-Percent95
-Percent 94
-Percent933
-Percent932
-Percent 93
-Percent923
-Percent922
-Percent92

- Percent 9
-Percent 89
-Percent88
-Percent87
-Percent363
-Percent862
-Percent86
-Percent 853

LLevos sivesuze awounn aww

26 Delete unused empty ending rows/columns

This utility will remove all empty unused rows and columns at the right and bottom of your
data range.
It is useful when the "Reset Excel's last cell" tool from ASAP Utilities can't reset the last cell.

You can use this utility when the end of your worksheet is (far) below or to the right of the
actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes
you to a blank cell below or to the right of the actual data.

Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part
of each worksheet that is in use, meaning the section that contains data or formatting.
Sometimes the last cell of a worksheet may be beyond the range of your actual used data.
This issue may cause you to have a larger file size than necessary, you may print extra
pages, you may receive "Out of Memory" error messages, or you may experience other
unusual behavior. Clearing the excess rows and columns to reset the last cell can help to
resolve these issues.

You can locate the last cell of the active worksheet by pressing CTRL+END.".
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Example screenshot: 1 Before

EH9--=

Mme Insert
<

Favorites & Vision Select
Shortcut keys ~ | Control -
Favorites

o s 0040 - Delete unused empty ending rows and columns.xlsx [Group] - Microsoft Excel

Page Layout Formulas Data Review View ASAP Utilities

E Sheets ~ [ Columns & Rows ~ Mumbers & Dates ~ -éé Web - Elmport -

[ Range - [»] Objects & Comments ~ [A] Text [ mformation - @] Export -

|zt Format ~ f« Formulas ~ 1 File & System = Start *
Time saving tools

= Fill =

[ ASAP Utilities Options =

b Find and run a utility

Start last tool again
Options and settings

= @ = |
2@ o=@ =
@ Online FAQ

@0

@ Registered version

Info and help

XFD1048576 - (- 5|

KEQ XER XES XET XEU XEV XEW XEX XEY XEZ KFA
1

1048553
1048554
1048555
1048556
1048557
1048558
1048559
1048560
1048561
1048562
1048563
1048564
1048565
1048566
1048567
1048568 \
1048569
1048570
1048571
1048572
1048573
1048574
1048575

1048576

===

ASAP Utilities - Delete unused empty ending rows/columns

Do you want to remove all unused empty rows and columns at the end
of each selected worksheet?

—

W4 M| DL 02,03 0% 05, 06, 0]

Ready |

Example screenshot: 2 After

’@ H ) - 0 e HL |5 0040 - Delete unused empty ending rows and columns.xlsx [Group] - Microsoft Excel E@u‘
mM Insert  Page Layout Formulas Data Review  View | ASAP Utilities a@ =2 =
', Q [} [Ed sheets ] Columns & Rows ~ Numbers & Dates * &5 Web ~ (G mport +  [Ef ASAP Utilities Options ~ & Online FAQ
E Range = | Objects & Comments = @Text - @.Infamatmn - E] Export B Find and run a utility olnfo
Favarites & Vision Select .
Shorteut keys - | Control  ~ =i Fill = [53} Format ~ fe Formulas ~ [ File & System = b Start v Start last tool again 7 Registered version
Favorites Time saving tools Options and settings Info and help
K67 fe| 714 v
B z D E F G H 1 K M -
j ) Company TR-01 TR-02 L E TR-04 TR-05 TR-06 TR-07 TR-08 TR-09 -10
44 Osato Chemicals 442 381 120 878 330
45 Petrox Oil Company 457 738 256 441 652
46 Plow King 331 268 71 949 14
47 |Primatech 627 385 801 441 765
48 Roxxon 277 639 616 355 372
43 Sample, inc 573 160 354 712 866
50 Sixty Second Avenue 460 195 804 938 242
51 |Smith and Co. 213 928 317 633 335
52 SpringShield 891 542 375 919 678
53 Sto Plains Holdings 884 169 543 359 439
54 strickland Propane 387 958 384 59 602
55 Taco Grande 213 683 115 283 835
56 The Frying Dutchman a 581 106 827 620
57 The New Firm 609 719 489 963 75
58 Three Waters 908 15 127 372 709
59 Thrift Bank 592 995 705 343 887
60 Tip Top Cafe B8a1 n7 97 338 458
61 Universal Export 21 301 932 643 928
62 Videlectrix 835 398 118 44 950
63 Virtucon 86 856 142 547 133
64 'Wayne Enterprises 440 986 748 903 190
65 Widget Corp 26 123 943 656 788
66 ZewvoToys 418 162 235 1 697
EIZiHCDrp 37 83 721 187 683
W v [ 01| 0203 04,705 06 %2
Ready |
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Reset Excel's last cell

This utility causes Excel to recognize the last used cell in your worksheet correct again.
You can use this utility when the end of your worksheet is (far) below or to the right of the
actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes
you to a blank cell below or to the right of the actual data.

Two indications that Excel doesn't recognize the last cell correctly are:
1. The end of your worksheet is (far) below or to the right of the actual range that is in use.
2. The scrollbars are very small but you don't have that much data.

Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part
of each worksheet that is in use, meaning the section that contains data or formatting.
Sometimes the last cell of a worksheet may be beyond the range of your actual used data.
This issue may cause you to have a larger file size than necessary, you may print extra
pages, you may receive "Out of Memory" error messages, or you may experience other
unusual behavior. Clearing the excess rows and columns to reset the last cell can help to
resolve these issues.

You can locate the last cell of the active worksheet by pressing CTRL+END".

By default this utility can be used with the shortcut Ctrl+Alt+R.

A B c D E F G H [l

42287
42283
42289 .
42250 ASAP Utilities - Reset Excel's last cell @
42291

e Y

4225 @ Excel's last cell has been reset so that Excel recognizes the real last used
42233 WY cellsgain.

42294, The last used row has been reduced from row 42301 to row 67.
12295 The last used column has been reduced from calumn Hto column F.

42296

42297 .

42239
42300
42301 | _|

42302 =
42303 =
H 4+ M| Example %2 []4] [ | » 1]
Ready | |[Em & 100% =) v (+)

Company -1|TR-01 |+ |TR-02 |~ |TR-03 |»|TR-04 |»|TR-05 ~ G
52 |SpringShield 39 75
53 |Sto Plains Holdings 61 15 67 69
54 |Strickland Propane 18 45 42 66 27,
55 |Taco Grande 24 33 30 41 30|
56 |The Frying Dutchman
57 |The New Firm 36 42 A6 65 75
58 Three Waters
59 |Thrift Bank
60 Tip Top Cafe 37 81 68 83
61 Universal Export
62 |Videlectrix 67 13 12 67 40
63 Virtucon 25 19 12 11 80
64 Wayne Enterprises
65 \Widget Corp
66 Zevo Toys 53 53 13 59 14
67 |ziffcorp [
62 [~
W 4+ M| Example <% 4] m ] » [
Ready | |[FEE @ 100% (= L} (+)
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A collection of tools for working with ranges and cells.

With this utility you can find and/or replace in all worksheets at once.

This makes it easier to find information across you entire workbook.

The results will be displayed in a list and you can quickly activate a cell from this list. You
can replace the results one by one or replace them all at once.

One of the advantages in comparison to Excel's default search and replace capabilities is
that this utility makes is easier to deal with the special characters line feed (Alt+Enter),
carriage return and tab.

You can use the following codes to search for these special characters or use them as
replacement: {If} = line feed (Alt+Enter/ascii code 10), {cr} = carriage return (ASCIl code 13),
{tab} = tab character.

Another advantage is it doesn't have Excel's length limit. In Excel you can receive the error
"Formula is too long". Excel finds what you are looking for but you cannot replace it. This
error has nothing to do with formulas; you can also get it if your cells contain only text. In
such a case you can use ASAP Utilities to replace the text, because this utility does not have
that limitation.

You can configure the following settings:

= Find what: the information to search for. You can use the ? and * wildcard characters;
use ~? and ~* to find the ? and * characters.
= Replace with: the value to replace the search value with.
= Find/replace in:
- All worksheets
- Current worksheet
- Selected range
= Search: by rows or by columns
= Look in: formulas or values.
= Match Case
= Match entire cell contents

By default you can start this utility with the shortcut Ctrl+Alt+H.
Your last used settings will be remembered.
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Example screenshot: 1

ASAP Utilities - Find and/or replace in all sheets

You can use the ? and * wildcard characters; use ~7 and ~* to find the ? and * characters.
You can use the following codes for spedal characters:
{f} = line feed (alt+enter/asdi code 10), {cr} = carriage return (ASCII code 13), {tab} = tab character

Search for: Replace with:

2012 [2012 Lo mraa |
Find/replace in: Search By Rows - Cose |
Al worksheets Look in: ‘ Values j
" Current worksheet [ Match Case Bepiace
r ¢

Range (ALiKS7) ™ Match entire cellcontents Bl
Fold out »>

Select a row to jump to the found cell: Results found: 18
Shest Cel  vaue Formua Display  Action =
01 N2 2012 2012
01 Y22 2012 2012
01 N43 2012 2012
02 N2 2012 2012
02 Y22 2012 2012
02 N48 2012 2012
03 N2 012 012
03 Y22 2012 2012
03 N48 2012 2012
04 N2 2012 012 ~|

Example screenshot: 2

.
ASAP Utilities - Find and/or replace in all sheets

You can use the ? and * wildcard characters; use ~? and ~* to find the ? and * characters.
You can use the following codes for special characters:
{if} = line feed (alt+enterfasdi code 10), {or} = carriage return (ASCII code 13), {tab} = tab character

Search for: Replace with:
‘Press ALTHENTER {f}to insert the line break ‘Press ALTHENTER to insert the line break Find all
Findfreplace in: Search By Rows i Close |

@ All worksheets Lockin: [ values |

" Current worksheet [~ Match Case

r oy 22
Range (N2;Y22;N48) [~ Match entire cell contents

i

Fold out >>
Select a row to jump to the found cell: Results found:

Advanced sorting...

This tool extends the options to sort your data.
You can sort on up to 5 columns at once. Furthermore you can sort on many more
properties than just the cell values.

With this tool you can sort by:

= Value = Strikethrough

= Number format = Text Length

= Cell Color = Random order (shuffle)

= Cell Color Indexnumber = Reverse order

= Font Color = Formula

= Font Color Indexnumber = Email address host (@...)

= Font Size = Alphanumeric content based on the numeric
* Font Name portions

= Bold = Value, ignore minus sign (-) in numbers
= [talic = Year-Month-Day

= Underline = Year-Day-Month
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= Month-Day-Year = Day-Month-Year
= Month-Year-Day = Day of the week (start on Sunday)
= Day-Year-Month = Day of the week (start on Monday)

A B & D
Fl Keyword B Competition Bl Global Monthly Searches Bl Local Monthly Searches (Nethd]
2 [shop 0.06 13600000
3 |machine 12 b |
s ASAP Utilities - Advanced sorting —
5 |makers Sort orientation: My list has: g |
6 |bar @ Top to bottom @ Header row y
A=)  Lefttoright £ Noheader row =
2 |pot B |
9 |table Sortby - g |
10 [cup Kepword () ] [ B o] o S0 T cpsesensive |
11 |bean Vaive —
Number format
12 [green Thenby Humber N |
13 |tables | Keyword (4) ] | cell Color indexnumber § |
Font Color
shill=o Font Color Indexnumber R
15 |mug Thenby Font Size
16 |mugs I ;‘ Font Name B
17 |pots | Iic N
Thenby Underiine N
18 [oups — | shictvoush u
19 |cake TextLength
- | Random order (shuffie) I
20 Thenby Reverse order g
21 Formula
company [ ] | Email address host (@...) R
22 |recipe Alphanumeric content based on the numeric portions g
i Value, ignore minus sign () in numbers
23llecipes o ) Year-Month-Day oK F—
24 |break Cancel Year-Day-onth & |
25 Month-Day-Year
Month-Year-Day —
26 [grinder
. Day-Month-Year
2Tl Eview Day of the week (start on Sunday)
28 |reviews Day of the week (starton Monday)
29 [roasters 0.08 201000
30 [buy 0.16 165000
31 [grinders 0.22 165000
32 Jart 0.08 135000
33 [club 0.03 135000

1

2

El

4 |break 0.02 201000
5 |cake 0.01 301000
6 |cake recipe 0 90500
7 [club 0.03 135000
2 |coupons 0.19 110000
9 |french press 0.09 43500
10 |pictures 0.02 135000
11 |recipe 0.02 245000
12 [recipes 0.02 245000
13 |school 0.06 90500
14 [shop 0.06 13600000
15 |table 047 1220000
16 |tables 0.52 823000
17 i 0.36 9900
18 [am 0.04 40500
19 |bags 0.17 33100
20 |baskets 0.06 43500
21 |bay 011 74000
22 |bean 0.1 823000
23 |bean grinder 0.27 6600
24 |bean grinders 0.4 4400
25 |bean prices 0.14 2900
26 [bean roaster 0.18 6600
27 [beanery 0.03 8100
28 |beans 0.1 673000
29 |beans for sale 0.52 3600
30 [beans online 041 4400
31 |beans wholesale 041 5400
32 |berry 0.14 60500
33 [bot 0.08 3600

Sort the data in random order
This utility sorts your selected range in a random order from top to bottom.
You can for example use this to randomly sort your list to pick 5 lottery winners.

Another example is to make sure that the start of the competitors in a contest is in random
order.
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Example screenshot: Sort in random order

A B C D E F | 4| A B

1 LENE u Age A 1 3 Age hd
2 |Agustin 43 2 |Francesco 22
3 |Aiden 31 3 [Ethan 21
4 |Alejandro 21 4 |Ryan 42
5 |Alexander 42 5 |Jén 39
- & M\ saP Uit - Sort the data in random order =) ol =
| T ] 7 [Matthew 20
8 | 8 |Maksym 48
9 @l Do you want to sort your data in random order from top to bottem? 9 lacob i
10 = 10 [Narek 45
1| 11 [Ali 23
112 12 [Andrei 24
|13 &I 13 [Nathan 32
14 = 14 [Eetu 30
15 [Emil 34 15 |Enzo 27
16 |Enzo 27 16 [Jack 21
A7 |Erik 49 17 [Jens 32
18 |Ethan 21 18 [Josh 23
19 [Francesco 22 19 |Daan 37
20 |Georgi 37 20 [Santiago 34
21 |Georgios 31 21 [Raphael 28
22 |Giorgi 30 22 |Leon 28
23 |Hans 42 23 |Noah 38
24 (Iker a2 24 j 43
25 [ivan 34 25 [Iker 42
26 [ack 21 26 [Mohamed 33
27 |lacob a1 27 |lonas 21

Sort values inside each cell in selection...

This tool sorts the contents of each cell in your selection.
You can choose if the cell contents are:

= Separated by a space

= Separated by a comma
= Separated by a comma + space

= Separated by a line break (Alt+Enter)
= Or enter your own separator

You can sort either ascending (A-Z) or descending (Z-A)

Tip: You can also use this on a (temporary) extra column in preparation to identify duplicate

cel

| values.
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A B | ¢ | o | E | F | =& A

1 [Montgomery, Alabama 1 |Alabama, Montgomery
2 |Juneau, Alaska 2 |Alaska, Juneau

3 |Phoenix, Arizona 3 |Arizona, Phoenix

4 |Little Rock, Arkansas 4 |Arkansas, Little Rock

5 California 5 |california, Sacramento
6 |Denver, Colorado & |Colorado, Denver

7 |Hartford, Connecticut 7 |Connecticut, Hartford
& |Dover, Delaware 3 |Delaware, Dover

g |Tallahassee ASAP Utilities - Sort values inside each cell in selection... X 9 |Florida, Tallahassee

10 |Atlanta, Ge 10 |Georgia, Atlanta

1 Honolulu,_ [~ 1. The values within each cell are delimited by: 1 Honolulu

12 |Boise, Idah | © Space © Semicalon 12 |Idaho, Boise

13 |Springfield | © comma " Line brezk (Alt+Enter) 13 [lllinois, Springfield

14 [ Indi 0li | & comma +5Space © Other: l_ 14 [Indiana, Indianapolis
15 [Des Moinet 15 |lowa, Des Moines

16 |Topeka, Kal — 2. Order 16 |Kansas, Topeka

17 Frankfori  ascending (At 7) 17 KEthIfCI(‘(, Frankfort

14 |Baton Roug 12 |Louisiana, Baton Rouge
19 AuguslaE o ‘Eesue'?d_!”? (Z_m” 19 [Maine, Augusta

20 polis,| |  Reverse order; 20 |Maryland, Annapalis
21 |Boston, Ma 21 |Massachusetts, Boston
22 |Lansing, Mi 22 |Michigan, Lansing
23[st. Paulj ! oK 23 |Minnesota, St. Paul

24 |Jackson, M T 24 |Mississippi, Jackson

25 Jeffersoﬁm 25 |Missouri, Jefferson City
26 |Helena, Montana 26 |Montana, Helena

27 |Lincoln, Nebraska 27 |Nebraska, Lincoln

28 |Carson City, Nevada 28 |Nevada, Carson City

29 |Concord, New Hampshire 28 |New Hampshire, Concord
30 |Trenton, New Jersey 30 |New Jersey, Trenton
31 |Santa Fe, New Mexico 31 |New Mexico, Santa Fe
32 |Albany, New York 32 |[New York, Albany

33 |Raleigh, North Carolina 33 |North Carolina, Raleigh
34 |Bismarck, North Dakota 34 |North Dakota, Bismarck
35 | Columbus, Chio 35 |Ohio, Columbus

36 |Oklahoma City, Oklahoma 36 |Oklahoma, Oklahoma City

Flip selected cells

This utility will flip the cells in your selection.

The utility works on cells in one column or one row at a time.

If you have for example selected four cells in one row (A1:D1) with the values 1, 2, Cand D
then this utility will reverse the values so that the values in the range A1:D1 become D, C, 2
and 1.

1
2 Vienna
3 Minsk Belarus\
4 Brussels Bel, A B
5 sofia -
6 Zagreb Cro| 2 Vienna Austria
7 |Prague Czd 3 |Minsk Belarus
8 Copenhagen Derl 4 Brussels Belgium
9 |Helsinki Finl 5 Sofia Bulgaria
10 Paris Fral 6 Zagreb Croatia
11 London Grel 7 Prague Czech Republic
12 Athens Gre & Copenhagen Denmark
13 Budapest Hu 9 Helsinki Finland
14 | Dublin Irel| 10 Paris France
15 Rome Ital{ 11 London Great Britian
16 | Luxembourg Lux| 12 Athens Greece
17 Oslo Nodj 13 Budapest Hungary
14 | Dublin Ireland
15 Rome Italy
16 Luxembourg Luxembourg
17 |Oslo Norway

Available tools
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Move screen (place selection in top-left of screen)

This utility will scroll the displayed range in your worksheet so that your selected range is
displayed at the top-left.

Show selection in center of screen

This utility will scroll the displayed range in your worksheet so that your selected range is
displayed in the center.

This can be useful to set the focus to certain cells and because you don't have to use the
scrollbars to do it manually.

Custom formula error message...

This utility makes it easy to display a custom error message for formulas that produce an
error.

Instead of an error such as #N/A or #VALUE!, you can have your own (more logical) error
message displayed when a formula results in an error.

For example, if you have a VLOOKUP formula but no result is found then the formula will
then display the value #N/A. You use can this utility to tell Excel what it should display when
the formula results in an error, for example to display nothing (an empty result) when no
result is found or a user friendly message such as "country not found".

This utility wraps an =IF(ISERROR(old_formula),[value in case of error],old_formula) formula
around the existing formulas. You can do this manually, but it is easier and faster with help
of ASAP Utilities.

This utility has two advantages compared to writing the =IF(ISERROR()) formula manually:
1. It is easier and quicker because you don't have to type in the formula.
2. You can also use this utility on a range of cells with different formulas.
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Example screenshot: Hide or replace error values

N

A B c D E F G H | J A B c

B Name -1 Age - B Name Rl Age hd
2 | Agustin a8 2 |Agustin 48
3 |Aiden #NJA 3 |Aiden

4 |Alejandro 21 - 4 |Alejandro 21
5 |Alexander 42 | ASAP Utilities - Custom formula error message 5 |Alexander 42
Eal & — Errors to replace in your selection: § al =
T |Andrei 24 7 |Andrei 24
8 Arda #N/A e 8 |arda -
9 |Artem a7 #NAME? 9 |Artem 47
10 |Bence 40 ﬂﬂf‘ 10 |Bence 40
11 |Benjamin 43 #NUM! 11 |Benjamin 43
12 Daan #NJA FHL 12 |Daan =
13 |Daniel 33 [ Alternative text for the error message: 13 |Daniel 33
14 |Eetu 30 I N 14 |Eetu 30
15 |Emil 34 15 |Emil 34
16 Enzo = [V skip existing ISERROR{) formulas 16 [Enzo =
17 Erik #NJA You can make the field with the alternative error message 17 |Erik -
18 |Ethan aNJA blank to hide all errors. 18 |Ethan -
19 |Francesco 2 _ 19 |Francesco 22
20 |Georgi 37 20 |Georgi 37
21 |Georgios 31 21 |Georgios 31
22 |Giorgi 30 22 |Giorgi 30
23 |Hans 42 23 |Hans 42
24 |Iker 42 24 |iker 42
25 |lvan 34 25 |lvan 34
26 |Jack 21 26 |Jack 21
27 |Jacob H#N/A 27 lJacob =

Paste special (with combinations)...

This utility does a "Paste Special", where you can use a combination from the options.
With the built in Excel "Paste Special" dialog you can only paste one item at a time. With
this utility you can now for example past both values, comments and formatting in one
step.

Follow the following steps to use this:

1. Copy your data range (for example with Ctrl+C).

2. Select the cell or range where you want to paste

3. Start this utility to paste the information/properties.

By default you can start this utility with the shortcut Ctrl+Alt+Y.

~y

-
ASAP Utilities - Paste special

— Paste

¥ Formulas [ validation

[~ values [V All except borders
¥ Formats ™ Column widths
2 Comments

— Operation
' None  Multiply
" agd " Divide
” Subtract

— Extra
I skip blanks I Transpose
[~ Paste Link

Cancel |
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Paste values and formatting

This utility pastes both the values and formatting in one single step.

Follow the following steps to use this:

1. Copy your data range (for example with Ctrl+C).

2. Select the cell or range where you want to paste

3. Start this utility to paste both the values and formatting.

Paste values only

This will paste the copied data as values only.

You can assign your own shortcut to this via the "Favorites & Shortcut keys" menu. This tool
can speed things up when you use this often and save you a few strokes/mouse actions
compared to the "Paste > Paste Values" via the menu in Excel when you assign a shortcut to
it.

Copy selection and paste into only the visible cells...

This tool copies the visible cells in your current selection and then pastes these into only
the visible cells in a given destination range.

If there are hidden rows or columns in either the source or target range, then those will be
skipped. The data will then be pasted into the first next visible row or column.

This tool can be useful when pasting data into a filtered list.

]2 J

B Paste oy o bl rows i g« copy o = E

) [ c o e A c o £
1 1 tesiol 1
2 2 temm 2 ™ s o s am
3 3 e N e an  swr s mm
4 4 testod R TV T
5 s W e s 7
O 6 taf 454 Usives O] T T
7 7 = s a1 mes  mm
8 8 1l | ok be o s m5 s m
2 3 1ed B zu m em
) 10 tef = o ks mm e e
u 1 ted ss  sm wm em
1 2 T 51 asa 151 s
) 13 testnn E A T T
m 1 testid W sl o0 % 54 e
) 15 testas W s o mwo sm
1 16 testis B om e s am s
[ 17 test1 W0 67 15 a0 7es  ma
1 15 tesinn W 7w aw sm
) 19 testas W s 3 mu en em
= 2 etz m 1y m  m on am
n W e m e ey nn
z 1753

e 3 countan_sums 20 | G0
[ - £ v{
B ——————
| [ 3 o

4 : o 3 a S
1 EWl i1 B swiei 6] sapis K sweria B smeus B
2 2 il testor  sess 17
3 EET] 2 stz a1 mm
a ) 3 testox s 1w
5 (7] e 4 estos a6 w7
6 £l ™ 5 estos e a
7 (& a7z 5 testos 3504 3%
[ [ 38 7 testor s ams |
a [0 s B testos a2 66|
T £ 577 9 testoy 758 766l
n 107 3@ 1 estla  mn am
n EDET 1 otestil 117 me
n [ s 12 stz sk mm
u 145 so1 15wtz s e
15 247 ™ 1 wstia om0 sae
6 [E 57 15 _tast1s am a3
Y] w0 7 16 testi1s Mes 2 |
1 [5] a7 17 testl7 a0 s |
B 181 523 1B testls e s
] [ 17 15 test1s B am
n ) B testm sz nn
n 1759

n 1760

W s ¥ W[ Sheetl | Sheet2 ~‘Shestd BN DE (WL PR | | [ 4+ A| Sheets /T3 M4 (2
Reagy Fiieroe | Count 0 _sum 212 |GHICIEN 0% (= &
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Fill cells with their formatted value

This utility replaces the contents in the selected cells with their formatted value.

For example if you have a cell with the value "384216938" with the cell formatting "000 -
000 00 00" then it will be displayed as "038 - 421 69 38".

This utility will then fill the cell with the value "038 - 421 69 38".

This can for example be useful when you use mailmerge in MS Word because that reads the
value of the cell and ignores the cell formatting.

Example screenshot: Fill cells with their displayed value

B2 - fe 20421538 B2 - '020 - 42169 38
A B € D E F G H A B © D E

Bl Name -l Phone = Bl Name ~ Phone 7

2 | Agustin 020 - 42169 38 2 |Agustin 020 - 421 63 38

3 |Aiden 020 - 495 56 96 3 |Aiden 020 - 495 56 96

4 |Alejandro 020- 4157746 4 |Alejandro 020 - 41577 46

5 |Alexander 020-7224363 5 |Alexander 020-7224363

6 Al = 3 6 |Ali 020- 7618023
T; ASAP Utilities - Fill cells with theirf‘urmatled value &J 7 |Andrei 020 - 245 49 07
8 Al 8 |Arda 020- 18293 95
ii I-’ 7"‘.‘ Do want to replace the values in selected cells with their formatted 9 |Artem 020 - 286 60 72
| 10 B8 L values? s ss000) 10 |Bence 020- 513 3246
11 B4 ‘I;:Ir‘ :‘:ms;:wi:”[;ﬂt;;:;ralue [1,15] formatted as [EUR * £.220| 11| Benjamin 020- 403 26 63
12 D4 12 |Daan 020 - 255 44 02
i& 13 | Daniel 020-7142393
14 |E8 Cancel 14 |Eetu 020- 8651244
EE 15 |Emil 020- 2601154
16 |En [ URT=zrESTII 16 |Enzo 020- 2743592
17 [Erik 020-3736317 17 |Erik 020-3736317
18 |Ethan 020 - 466 27 58 18 |Ethan 020 - 466 27 58
19 |Francesco 020- 27046 93 19 |Francesco 020- 270 46 93
20 Georgi 020-06147 70 20 |Georei 020- 0614770

Replace conditional formatting with static formatting in
selection

This tool replaces the conditional formatting in the selected cells with regular (static)
formatting.

The formatting, that has been applied via conditional formatting rules (number, font,
border and fill) is verified and then applied as regular (static) formatting.

The conditional formatting rules are then removed, but not the effects.

A practical example:

'We work a lot with conditional formatting, but our client wants us to "freeze" the format
(which means no more use of conditional formatting...) in order to have a classical Excel
format (mainly cell and font colors). The idea is to do the same thing as we can do with
formulas or calculations "copy > paste as values" but for conditional formatting.'
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Note:

Data Bars and Icon Sets cannot be made static with this tool.

Price Price Price Price Price
i§ Product n vendor 1 nvendorz n vendor 3 ﬂ vendor 4 n vendor 5 n
PR163

2]
3 PR1SO
4 pR164
5

1 6

PR152

@% Do you want to replace the conditional formatting in selected cells with
@ standard/static formatting?
Conditional Format settings of Number, Font, Border and Fill will be
applied. Data Bars and Icon Sets cannot be made static with this tool.

Continue?

17 e — = —— =
18 |PR172 14.4 13.57 13.29 14.31-!!I

FIEIEIEIEIEIEIEIEIEI
AN RN B A R

19 PR161 14.81 17 17.77 17.8 16.82]
20 |PR165 21.76 2518 25.06 22.35)
21 PR1 11 4 1352 11 86 1241 12 2

@9 c -+
Home Insert Page Layout Formulas Data Review View ASAP Utilities

=5 % cut

. sl 11 A= [%] A S wrap Text
- 53 copy ~
Past: - | i - = = | £ 35 | 5 Merge & Cente
e jFomatPa\‘:kter (B s /ﬁ G- |BEA- === 58| e ncens
Clipboard it — Font Theme Colors™ ™ lignment
E EEEEEE)
B2 - N 7
tmew 0 =
F G
Price Price Pr IIIIIIIIE
Standard Colors
19.71
3 PRISO 25.67 2™ .N an EEEEE 24.7
4 PR1B4 14.61 15.15 s
5 PR152 19.72| 2146 | @ More Colors. 22.71]
6 PR173 13.88 13.63 15.36 13.78 14.12
7 PRI166 26.76 30.27 27.57 26.96 27.28
8 PR162 22.3 22.87 24.78 26.08 263

9 PR160 14.12 13.69 14.56
10 PR159 11.16 9.75
11 PR154
12 PR155

Copy formulas without changing their cell references...

This utility copies all formulas without changing the cell references.

Normally Excel adjusts the cell references if you copy your formulas to another location.
You would then have to "fix" all cell references with a dollar sign (for example change Al to
SAS1) to keep the cell references the same.

With this utility you can now easily copy your formulas to another location without Excel
having the cell references changed and without the need of adjusting the cell referenced
first.

Besides the formulas this utility will also copy the formats, comments and validation.

Move selected data (only values)...
This utility moves the content of your selected range to another location.
It is a bit similar to "cut" and "paste" but instead of the built in Excel method, it will only

paste the values.
Moreover it will not update any cell references. If you move your data Excel automatically
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adjusts the formula references to point to the new location. This utility prevents that. For
example if you have a formula with a reference to range A1:B10 and you use this utility to
move the contents of cell A1:B10 to another location, the formula will still use to A1:B10.
If you your range contains cells with formulas then these will be replaced with their
calculated value.

Copy multiple selected ranges...

With this utility you can copy multiple selected ranges at once.

If you have selected multiple (non-contiguous) ranges you cannot easily copy this in Excel. If
you try to do this you get an error similar to "The command you chose cannot be
performed with multiple selections. Select a single range and click the command again.".

If you can copy it, because the ranges are all on the same columns or rows then Excel
ignores the empty rows or columns in between.

With this utility you can now easily copy these cells.

Transpose data with formulas...

This utility will transpose your data and preserves the cell references.
Unlike the standard Excel methods which changes the cell references when the data shifts,
this utility will not change the cell references in your formulas.

Example screenshot: 1 Before

B1 - fx =Sheet11A10
A 8] c [ D [ E [ F [ 6 ]
value |Am513rdam !Ankara Athens Belgrade Berlin Bern

formula used: |=Sheet?/A10 |=Sheetf!B10 =Sheetf!C10 |=Sheet1!D10 |=Sheet1!E10 |=Sheetf!F10

n|b NMA

Example screenshot: 2 The result, all cell references have been preserved

AT - f =Sheet1lA10
A

value
[Amsterdam
Ankara
Athens
Belgrade
Berlin
Bemn
Bratislava

o=~

=1

=

[~}

o

=

Split the selected range into multiple worksheets...

With this tool you can quickly split your selected data into multiple sheets.
You can do this either by value/group in a column or you can specify the number of rows to
create per sheet.

Examples:
Create a new sheet for each company in your table.
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Note:
Your initial data remains unaltered.

If you want to save the new created worksheets as separate files, then you can do this with

the utility "Export » Export worksheets as separate files...".

We have also received the request for this tool from people that used workbooks with over
500 000 rows (Excel 2007+) and then needed to create a file that could be opened in Excel
2003. In order to do that they had to split the information into pieces of a max of 65536
rows per worksheet because that is the maximum amount of rows that a sheet in Excel
2003 can contain. With this tool you can quickly have ASAP Utilities do that for you.

Barcelona Burleigh and Stronginthearm

A B
City B company [~ ] i

c D 3 F G
TR-01 BTR02 BATR03 BATR04 EITR-05 B
12

Barcelona Qv
Barcelona

ASAP Utilities - Split the data into multiple worksheets

1
2
3
4
Bl St H) When to create a new worksheets for the data in range AL1120 2
6 |Cordoba Cal
7 |cérdoba Def | | Eor every new value/group in column: [a-cy | 36
2 |cérdoba ROY | | Forevery so many rons: [woo |
9 |Cérdoba Wi
10 [Las Palmas Big Copy rows as headers on each new worksheet?
11 |Las Palmas Chi ( Number of rows to repeat at the top of each sheet: 1
12 |Las Palmas Cof 28
13 |LasPalmas  Fod | [ Template for the new 66
14 |Las Palmas Gl | (none, create blank workshest) | 7
15 |Las Palmas Gri 53
15[z Pl e il First cell of destination range: | a1 J =
17 [Las Palmas In I Insert Rows
18 |LasPalmas Kl | [ Keep Source Formatting 43
19 |Las Palmas M
20 |Las Palmas md| Name for the new sheets that are created:
21 |Las Palmas M " Leave default Excel sheet name
22 |Las palmas pef " Sequential numbering | 53
23 |Las Palmas Si | 24
24 |Las Palmas St eadin er | 27
S asPalinas ” TS| | (5 e e vahe of the cllin the spedfied colam | =
26 [Las Palmas The |
27 |LasPalmas  Thy)| = Prefi: Suffix:
28 |Las Palmas unj|| I
25 |madrid AB B 12
30 |Madrid Big| | (Eamelnna 30
31 [Madrid Gal | 58
32 |Madrid Gal| 34
33 [Madrid Gel Caes 33
34 [Ma I — 57
35 |madrid Lex 37
26 | i LutharCarn
A B C E
1 ompa R-0 0 0
2 Baftelona Burleigh and Stronginthearm 12
3 |Baktelona QWERTY Logistics
4 Barcelona Sombra Corporation 73 23
5
6
7
8
9
10
1
" Barcelona * Cdrdoba Las Palmas Madrid Pamplona “Sevile “Vigo . ¥J |I| «
Ready | |E
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Clear duplicated values in selection (leave one original)

This utility will remove all duplicated values within the selected cells and keep one original.
The first cell containing a duplicated value will keep its value, all other cells with this same
value will have their contents cleared.

This way only one of each value will remain.

You can specify if you want this utility to be case sensitive.

If your selection contains formulas then this utility compares the calculated values. This

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as
a duplicate.

Example screenshot: 1

——

B A B
'+ rr—
2 |Copenhagen 2 |Copenhagen
3 |London 3 |London
4 [Minsk 4 |Minsk
5 [Dublin 5 |Dublin
6 |London 6
T |New York 7 |New York
§ [Prague 8 |Prague
9 [New York 9
10 [Dublin 10
11 |New York 11
12 |London 12
13 [Dublin 13
14 [Luxembourg 14 |Luxembourg
15 |Amsterdam 15 |Amsterdam
16 |Vienna 16 |Vienna
17 |New York 17
18 18
40 19

Example screenshot: 2

A
Il email address

A
L email address

2 |amsterdam@asap-utilities.com 2 |amsterdam@asap-utilities.com
3 |amsterdam@asap-utilities.com 3

4 |ankara@asap-utilities.com 4 |ankara@asap-utilities.com

5 |athens@asap-utilities.com 5 |athens@asap-utilities.com
6 |belgrade@asap-utilities.com 6 |belgrade@asap-utilities.com
7 |perlin@asap-utilities.com 7 |berlin@asap-utilities.com

§ |bern@asap-utilities.com 8 |bern@asap-utilities.com

9 |bratislava@asap-utilities.com 9 |bratislava@asap-utilities.com
10 |brussels@asap-utilities.com 10 |brussels@asap-utilities.com
11 |brussels@asap-util "

12 |bucharest@asap-uti 12 |bucharest@asap-utilities.com
13 [budap p 13 |bud, @asap-utilities.com
14 |copenh 14 |copenh sap-utilities.com
15 |dublin@asap-util 15 |dublin@asap-utilities.com
16 |dublin@asap-util 16

17 [helsinki@asap-u 17 |helsinki@asap-utilities.com
18 |kiev@asap-utiliti 18 |kiev@asap-util com

19 |lisbon@asap-uti 19 |lisbon @asap-utilities.com

20 (ljublj; sap-utilities.com 20 |ljubljana@asap-utilities.com
21 |london@asap-utilities.com 21 |london@asap-utilities.com
22 (luxembourg@asap-utilities.com 22 |luxembourg@asap-utilities.com
23 |madrid @asap-utilities.com 23 |madrid@asap-utilities.com
24 |minsk@asap-utilities.com 24 |minsk@asap-utilities.com

25 |moscow@asap-utilities.com 25 |moscow @asap-utilities.com
26 [moscow@asap-utilities.com 26

27 |nicosia@asap-utilities.com 27 |nicosia@asap-utilities.com
28 |oslo@asap-utilities.com 28 |oslo@asap-utilities.com

29 |paris@asap-utilities.com 29 |paris@asap-utilities.com

30 |prague @asap-utilities.com 30 |prague@asap-utilities.com
31 |prague @asap-uti 31
32 raxk'avfk@asatutllltles.com 32| rezk'avik@asatutilitias.com
33 33

u u

Available tools
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Count and/or color duplicates in selection...

This utility tells you how many duplicate values there are in your selected range.
You can choose to paint all duplicate cells with a certain color.

Note:

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the

same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as
a duplicate.

Example screenshot: 1 Count and color duplicated values

A 8 c D E F
1 [Belgrade paris
2 [Berlin Prague
3 [Bern Reykjavik
4 |Bratislava Riga
5 |Brussels Rome -
& San Maring | asap utiities - Count and/or color duplicates in selection...
7 |Budapest Sarajevo
& |Copenhagen  Skopje
o | Cxim o 98 you Nt £ i the el vith 3 Guplcte vl 3 certan
10 |Helsinki Stockholm
11 |Kiev London
12 |Lisbon Prague Yes No
13 |Brussels Tirana
14 |London Térshavn
15 |Luxembourg  Vaduz
16 | Madrid Vienna
17 |Minsk Vilnius
12 |Moscow Warsaw
12 |Nicosia Yerevan
20 |0slo Zagreb I
21
A 8 c D E F
1 [eelgrade paris
2 [Berlin Prague
2 Bem ReYKIBVIK 1" »51p Utiiies - Select a color %
4 |Bratislava Riga
5 |Brussels Rome o . . . . . . . . Example:
5 |Bucharest San Marino
7 |pudapest  saraevo | NI [N N 0 W
& |copenhagen  skople |
9 |Dublin sofia - u EEENE
10 |Helsinki stockholm | [l [ | [ N | cancel
11 |Kiev london |
12 |Lisbon prague |
12 |Brussels Tirana 1 | H [ |
14 |London Térshavn
15 |tembourg. vadz | I I EEER |
16 [Madrid Vienna | RGB value: 153204255 J |
17 |Minsk Vilnius | EBXvalue: s90ccer Egteolors | |
18 |Moscow Warsaw Color index: 37
19 [Nicosia Yerevan ‘|
20 |oslo zagreb )
21
22
A 8 c D E F
1 [Belgrade Paris
2 [Berlin
3 [Bern Reykjavik
4 |Bratislava Riga
5 Rome
5 [Bucharest san Marino
7 |Budapest Sarajevo AASAP Utilities - Count and/or color duplicates in selection... X
2 |Copenhagen  Skopje
9 |Dublin Sofia
—o B e o f;i(a\ of & duplicate values were found in the selected 40
11 |Kiev
12 |Lisbon
i |
14 Térshavn
15 |Luxembourg  Vaduz
16 | Madrid Vienna
17 |minsk vilnius
12 | Moscow Warsaw
12 |Nicosia Yerevan
20 |oslo Zagreb
21
22
23
24
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Example screenshot: 2 Just count the duplicates without coloring them

A 8 @ p) E F A B c D E F
1 [Belgrade Paris 1 [Belgrace Paris

2 |Berlin Prague 2 |seriin Prague

3 |Bern Reykjavik 3 |Bern Reykjavik

4 |Bratistava Riga 4 [Bratistava Riga

5 |Brussels Rome 5 |Brussels Rome

6 |Bucharest  san Marin~ 6 |Bucharest  sanMarin~

7 |Budapest sarajevg A3AP Utilities - Count and/or color duplicates in selection... 7 |Budapest Sarajevo | ASAP Utilities - Count and/or color duplicates i selection X
8 |copenhagen  skopje # 8 |copenhagen  skopje

9 |Dublin sofia o Do you want to give the cells with a duplicate value a certain 9 [Dublin Sofia o Atotal of & duplicate values were found in the selected 40
10 |Helsinki Stockhol cell color? 10 |Helsinki stockhol cells.

11 |Kiev London 11 |Kiev London

12 [Lisbon Prague F 3 12 |Lisbon Prague

13 |Brussels Tirana = 13 |Brussels Tiragna
14 |London Térshava ]| 14|London Térshavn T

15 |Luxembourg  Vaduz 15[luxembourg  Vaduz |

16 |Madrid Vienna 16 |Madrid Vienna

17 |Minsk Vilnius 17 | minsk Vilnius

18 |Moscow Warsaw 12 |Moscow Warsaw

12 |Nicosia Yerevan 19 | Nicosia Yerevan

20 |oslo 2agreb ! 20|oslo Zagreb |

21 21

Count duplicates and give each set of duplicates its own color

This tool counts and colors the duplicate values in your selection.
Each set of duplicated values is given its own unique color.

This helps to quickly find the duplicated values, by having a set of colors each of which can
readily be distinguished from one another.

Example:

If your selection contains 5 cells with the value "London" then those 5 cells will all get the
same color, for example blue. And if the value "Paris" exists in 3 cells then those 3 cells will
also get the same, but a different color, such as green.

Note:

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the
same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as

a duplicate.

A B A B
1 |London Belgrade 1 _Belgrade
2 [Berlin Prague 2 Berlin Prague
3 |Bern Reykjavik 3 Bern Reykjavik
4 |Bratislava Riga 4 PBratislava Riga
| 5 |Paris Rome 5 Paris Rome
6 |Brussels Paris 6 Brussels Paris
7 |Budapest Sarajevo 7 |Budapest Sarajevo
' 8 [Copenhagen Skopje 8 Copenhagen Skopje
. 9 |Dublin Sofia 9 Dublin Sofia
' 10 [Helsinki Stackholm 10 |Helsinki Stockholm
|11 [Kiev London 11 Kiev
12 |Lisbon Prague 12 Lisbon Prague
13 [Brussels Tirana 13 |Brussels Tirana
14 [London London 14
15 |Luxembourg Vaduz 15 |Luxembourg Vaduz
16 [Madrid Vienna 16 | Madrid Vienna
| 17 |Minsk London 17 Minsk
18 |Moscow Warsaw 18 Moscow Warsaw
| 15 |Paris Yerevan 19 Paris Yerevan
20 |Oslo Zagreb 20 Oslo Zagreb
ACnpenhagen Mascow 21 Copenhagen Moscow
22 (Skopje Vienna 22 Skopje Vienna
23 22
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Create a list of all range names in the workbook

This utility creates a report with all named ranges in your workbook.

A new workbook will be created which lists all the named ranges within your workbook and
their cell references and comments.

Replace the range names used in formulas with their cell
references (on selected sheets)

This utility replaces the range names, used in formulas in the selected sheets, with their cell
references.

For example if you have a value in cell C10 with the range name 'quantity' and you used a
formula such as '=A1*quantity', then this utility will replace that formula with '=A1*C10".

Example screenshot: 1 Select the sheets and start the utility and the range names will be
replaced with their cell references

‘ c2 - 5 | =AZ*unit_price*dollar_to_euro
A B c D E F G H
1 | quantity worth in USD  worth in EUR
2 236 $118,000] €84,286]
3 263 $131,500 €93,929
: 12 ASAP Utilities - Replace the range names used in formulas with their cell refere... g
| 9
Fi 28 .@ Do you want to replace the range names used in the formulas by their
3 af & cell references on all 1 selected worksheets?
=
10 26
11 114 Cancel
12 291
13 182 S1,000 257857
14 194 $97,000 €69,286
139 $69,500 €49,643
260 $130,000 €92,857
67 $33,500 €23,929

152 $76,000 €54,286
$197,500 €141,071
32000, £27143

cz - =A2*Definitions!$AS1*DefinitionsISAS2

A B c D E F G H

quantity worthinUSD  worth in EUR

F
2 236 $118,000[ £84,236]

3 263 $131,500 €93,929
4 105 $52,500 £237,500
5 28 $14,000 £10,000
6 93 $46,500 £33,214
7 25 $12,500 €8,929
8 40 $20,000 €14,286
9 253 $126,500 £50,357
10 260 5$130,000 £92,857
1 110 $55,000 €39,286
12 290 $145,000 €103,571
13 162 $81,000 £57,857
14 194 $97,000 £69,286
15 139 $69,500 €43,643
16 260 $120,000 €92,857
17 67 $33,500 £23,929
18 152 $76,000 £54,286
19 395 $197,500 €141,071
piil TR 2R 000 £27143
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Example screenshot: 2 A report with the changes that were made

A B E D E F
1 |Sheet ICell Value Original formula New formula

2 After B2 118000 =A2*unit_price =A2*DefinitionsISAS1

3 After C2 "$84,285.71 =AZ*unit_price*dollar_to_eu=A2*Definitions!$A$1*Definitions!SAS2
4 |After B3 131500 =A3*unit_price =A3*Definitions!SAS1
5 After C3 '593,92&.5? =A3*unit_price®dollar_to_eu=A3*Definitions!SAS1*Definitions!SAS2
6 After B4 52500 =Ad*unit_price =A4*DefinitionsISAS1
T After ca 'SS?,SO0.00 =A4*unit_price*dollar_to_eu=A4*Definitions!$A51*Definitions!SAS2
§ After BS 14000 =A5*unit_price =A5*Definitions!SAS1
9 After C5 '510,000.00 =A5*unit_price®dollar_to_eu=A5*Definitions!SAS1*Definitions!SAS2
10 After B6 46500 =AG*unit_price =A6*DefinitionsISAS1
11 After C6 "$33,214.29 =A6*unit_price*dollar_to_eu=A6*Definitions!$A$1*Definitions!SAS2
12 After B7 12500 =A7*unit_price =A7*Definitions!SAS1
13 After C7 '58,923.5? =A7*unit_price®dollar_to_eu=A7*Definitions!SAS1*Definitions!SAS2
14 After B8 20000 =A8*unit_price =AZ*DefinitionsISAS1
15 After C8 "$14,285.71 =A8*unit_price*dollar_to_eu=Ag*Definitions!$A$1*Definitions!SAS2
16 After B9 126500 =A9*unit_price =A9*Definitions!SAS1
17 After 9 '590,35?.14 =A9*unit_price®dollar_to_eu=A9*Definitions!SAS1*Definitions!SAS2
18 After B10 130000 =A10%unit_price =A10*Definitions!SAS1
19 After C10 "$92,857.14 =A10*unit_price*dollar_to_e=A10*Definitions!SAS1*Definitions!SAS2
20 After B11l 55000 =Al1*unit_price =A11*Definitions!SAS1

21 |After €11 '539,2&5.?1 =Al11%unit_price*dollar_to_e =A11*Definitions!SAS1*Definitions!SAS2

25 Delete all range names in selection
This utility removes all range names within your selected range.
Note:

If the range name is used in a formula then the formula will result in an error when the
range name is removed.

26 Delete all range names in the entire workbook
This utility removes all range names in your entire workbook.
Note:

If the range name is used in a formula then the formula will result in an error when the
range name is removed.

27 Delete all range names with an invalid cell reference (#REF!)

This tool removes all range names that have an invalid reference (#REF!).
A report with the results will be presented to you.
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Fill

Collection of tools for filling cells and adding data.

Fill empty cells in selection...

This utility fills all empty cells in your selection with a specified value.

If only one cell is selected then all empty cells within the used range of your worksheet will
be filled.

Overwrite filled cells in selection...

This utility fills all non-empty cells in your selection with a specified value.

If only one cell is selected then all filled cells within the used range of your worksheet will
be filled with the new value.

Copy values to empty cells below filled cells in selection

This utility fills all empty cells in your selection with the value from the first filled cell found
above.

This can be very useful if you want for example to prepare your data for a pivot table.

A B C D E
| 1 [ [ company B2 B2 B0z H
2 [Austria Luthorcorp 2 31 14
3 Virtucon 59 30 37
4 Forge And B c D E
5 |Belarus Lexcorp | 1 [LITTHT B2 212 2013 H
3 ‘& [hustria Luthorcorp 2 31 14
7 |Belgium initech?” | 3 [Austria virtucon 59 30 37,
8 4 |austria Forge And Foundry 37 10 42
9 5 |Belarus Lexcorp 3 51 8
10 Big Kahun 6 [Belarus [zevo Toys 20 1 13
11 [Bulgaria [smith Anc 7 [Belgium Initech 10 15 17/
12 [The New | 8 [Belgium 51 45 15|
13 [Croatia 9 [Belgium Mammoth Pictures 55 2 33
14 Moes Tave 10 [Belgium Big Kahuna Burger 35 0 50
15 Galaxy Col 11 |Bulgaria |smith And Co. 43 28 47
16 Burleigh | 12 |Bulgaria [The New Firm 43 57 17/
17 |sombra c¢ 13 [croatia videlectrix 8 24 12|
18 Querty La 14 |Croatia Moes Tavern 59 29 17/
19 [Czech Republic _|Globo-che 15 |croatia Galaxy Corp. 32 16 14
20 |spacely sg 16 [croatia Burieigh 31 7 36/
21 |Denmark Chasers | 17 [croatia |sombra Corporation 37 37 42
22 |spade Anc 18 [croatia Quwerty Logistics 30 29 1
23 Monarch £ 19 [czech Republic |Globo-chem 9 19 43
24 Roboto Ini 20 |czech Republic  |spacely Sprockets 8 ) 20
25 Praxis Cor 21 [Denmark Chasers 32 2 59
26 [Finland |Acme, Inc 22 |Denmark |Spade And Archer 22 2 49
27 General P| 23 [Denmark Monarch Playing Card Co. 59 2 34
28 water Ane 24 [Denmark Roboto 29 59 27,
29 Fake Brott 25 [Denmark Praxis C i 49 15 51
30 Demo Con 26 [Finland |Acme, Inc. 36 43 22
3 widget cc 27 [Finland General Products 4 21 49
32 23 [Finland water And Power 11 13 49
33 |France Mainway ] 29 [Finland Fake Brothers 49 1 2
34 Big T Burg 30 |Finland Demo Company 32 2 4
3 klimpys | 31 |Finland widget corp 22 51 11/
36 Petrox Oil 32 |Finland Propane 8 6 10|
7 |Great Rritian Charies ¢ 33 |France Mainway Toys 34 6 4
34 [France Big T Burgers And Fries 22 50 29|
35 [France Klimpys a1 0 20|
36 [France petrox Oil Company 23 55 32/
7 IGreat Rritian Charles Townsend Acen a1 27 3
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Fill up with leading zeros...

This utility fills the numbers in the selected cells up with leading zeros to a given length.
The utility will actually add the zeros and therefore change the data. If you only need the
number to be displayed as if they have leading zeros then it is better to use cell formatting
with a number format such as for example '000000'.

Numbers with decimals will be rounded to the nearest integer.

For example if you specify a length of 3 then a cell with the value 1 becomes 001, 34
becomes 034 and numbers greater than 100 will not be changed because they already have
a length of 3 characters or more

If a formula in your selection has a number as a result then the calculated value will be
filled it up with the zeros and the original formula is replaced.

A B C D E

Company Code

ABC Telecom 69

Big Kahuna Burger 140

Big T Burgers and Fries 50|

Blammo 35|

Chal —

Chal ASAP Utilities - Fill up with leading zeros... L5 [

Chel | what is the total length you would like the numbers to become, filed up with

leading zeros?
(Cogt | e example type 2 for 01, 4 for 0001 etc.,
Fool | (Numbers with decimals will be rounded to round numbers. Formulas will be
Gad converted to values.)

3

A A SR A ™ [Ty
a-mru»-nommwmﬁamu»—-c‘wm‘“’*"‘““"““

Glo
Grinly|
Initi
Input;
Klimpys
Krustyco
Mainway Toys
Megadodo Publications A B c
Mr. Sparkle IEX Company Code
Niagular 2 |ABCTelecom 0069
Petrox Oil Company 3 |Big Kahuna Burger 0140|
Roxxon 4 Big T Burgers and Fries 0050|
Sixty Second Avenue 5 |Blammo LI
25 | strickland Propane 6 |Charles Townsend Agency 0154]
26 Taco Grande 7 |Chasers Q)
27 1 8 |Chez Quis 0122
9 |Cogswell Cogs 0029
10 |Foo Bars 0049
11 Gadgetron 0130|
12 |Globo Gym American Corp 0145
13 |Gringotts 0174
14 |Initrode 0117
15 |Input, Inc. 0158
16 |Klimpys 0023
17 |Krustyco 0005
18 Mainway Toys 0067|
19 Megadodo Publications 0153
20 |Mr. Sparkle 0038|
21 |Niagular 0107
22 |Petrox Qil Company 0081
23 Roxxon 0052
24 Sixty Second Avenue 0020
25 |strickland Propane 0120
26 Taco Grande 0036,

Available tools 97



ASAP Utilities User Guide

“Save hours in Excel”

Insert before and/or after each cell in your selection...

This utility adds a value in front of and/or at the end of the content of each cell in your

selection.

The utility will show you an example of the resulting values.

You can specify the following:

= The value to insert before at the front of each cell

= The value to add at the end of each cell

= Use the value, formula or displayed (formatted) value from the cells.

= Include hidden cells
= Skip empty cells

The 'reset’ button clears the insert before and after values and resets the options to their
default values. This can be useful because this tool always remembers your previous

settings.

You can also use this utility to build a formula around the current values.

Example screenshot: 1

A B C D

I Keyword B Competition Bl Global Monthly Searches B Local Monthly Searche]
2 |+shop 0,06 13600000

3 [+machine 1 072 1330000
iﬂnaker ASAP Utilities - Insert at beginning and/or end

5 |+makers
6 |+bar add before: | x|
7 [+machines =

3 |+pot | +coffes j y
9_Hable add after: e I
10 |+cup =

11 |+bean I J

12 |+green {iff  =line feed character (alt+enter)
13 |+tables {tab} = tah character

14 [+beans
%:—mtgs— treat cells as: —————————
17 [+pots | values (default) = ——
18 [+cups ™ Indude hidden cells

1] pieeti I skip empty cells Reset . —
20 |+equipment R

21 |+company —E= )y
22 [+recipe +coffee +shop y
23 [+recipes +coffee +machine r
24 |+break +coffee +maker

25 |+cups +mugs 1:2: :‘g‘:rke"s

26 |+grinder +coffes +machines

27 [+review +coffee +pot

28 [+reviews +eoffee +able
29 [+roasters = = =

30 [+buy 016 165000
31 |+grinders 0.22 165000

32 |+art 0.08 135000

23 laciin nnz 43&0AN
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Example screenshot: 2

A B B D
|1 -
2 |+coffee +shop 0,06 13600000
3 |#coffee +machine 0,72 1830000
| 4 |#coffee +maker 0,52 1830000
5 |#coffee +makers 0.5 1500000
6 [+coffee +bar 0.09 1220000
7 |#coffee +machines 0,76 1220000
8 |+coffee +pot 0,44 1220000
9 |+coffee +table 047 1220000
10 |+coffee +cup 0,13 1000000
| 11 |#coffee +bean 0.1 823000
12 |+coffee +green 0,26 823000
| 13 |#coffee +tables 0,52 623000
14 |+coffee +beans 01 673000
15 |+coffee +mug 017 550000
16 |+coffee +mugs 0,19 550000
17 |#coffee +pots 0,37 450000
18 |+coffee +cups 017 368000
19 |#coffee +cake 0,01 301000
| 20 |#coffee +equipment 0.77 301000
21 |#coffee +company 0,07 246000
22 |+coffee +recipe 0,02 246000
23 |+coffee +recipes 0,02 246000
24 |+coffee +break 0,02 201000
25 |+coffee +cups +mugs 0,19 201000
26 |#coffee +grinder 0,19 201000
27 |+coffee +review 0,2 201000
28 |+coffee +reviews 0,25 201000
| 29 |#coffee +roasters 0,08 201000
30 |+coffee +buy 0,16 165000
31 |+coffee +grinders 0,22 165000
32 |+coffee +art 0,08 135000
ETR P A na 42cnnn

Fill '‘between values' linear in selection (vertical)

This utility fills your selection with a series based on the values of the cells in your selection.
The utility fills in a series in each column within your selected range.

It uses Excel's Fill method with the following settings:

Series in: Columns

Trend: Yes

Type: Linear

Fill '‘between values' linear in selection (horizontal)

This utility fills your selection with a series based on the values of the cells in your selection.
The utility fills in a series in each row within your selected range.

It uses Excel's Fill method with the following settings:

Series in: Rows

Trend: Yes

Type: Linear
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Quick numbering of selected cells...

This utility helps you to quickly fill the selected cells with a series or numbered list.

The utility is flexible and offers several options to choose from.

You can configure the following settings:

Series setting:

= Create a series with numbers:

- The number to start with.

- The number to increment with.

- Restart counting after a certain value.

- Fill up the numbers with leading zeros to a specified length.
= Create a series based on the letters from alphabet in lowercase (a, b, c, etc.).
= Create a series based on the letters from alphabet in uppercase (A, B, C, etc.).

Options:

= You can specify to restart the counting if the value in a certain column changes.

You can

use this for example if you have a list with city names and you want to restart the
counting when the name of the city changes. You can also specify to put the value of the

changing column in front of and/or after the value in the series.

= You can add a value in front of and/or after each value in the series. This way you can for
example create series with week numbers and add the text 'Week ' in front of each value

in the series.
= You can specify the cell alignment.

By default you can start this utility with the shortcut Ctrl+Alt+Q.

Example screenshot: 1 Example 1

A B z D E F A B
1 LET ﬂﬁmup 1 LET hd Group hd
2 |Luthorcorp 2 |Luthorcorp 1]
3 |Virtucon | 3 |virtucon 2
4 |Mal ASAP Utilities - Quick numbering of selected cells... 4 |Mammoth Pictures 3|
5 |Big i e 5 |Big Kahuna Burger 4
— Series settings gt -—-\ -
6 Sl | & ympers smr;mm: ,— 6 |Smith And Co. 5|
7 |The i 7 |The New Firm 1
r Incremeft wi ith: L) - -
2 |vid § 1 — 2 |Videlectrix 2|
i
3 Mol Restart count after r‘:mhﬁr 9 Moes Tavern 3
10 | Gall Fill up with leading ?GWS? b x| L IxampIE 10 Galaxy Corp 4|
11 |Son . s | 1 [ M 11 Sombra Corporation 5
5 ol Alphabet lowercase (a, b, c etc.) [ 12 Qwerty Logistics 1
13 Gld " Alphabet uppercase (A, B, C, etc.) i 13 |Globo-chem 5|
14 5pd oot 5 14 Spacely Sprockets 3|
15 |Chi L ! 15 |Ch 4
Restart numbering if the value in the ’—L| 2 asers
16 Spd| | following column changes: 3 16 Spade And Archer El
17 |Rol : 17 |Roboto Industries 1
18 Pral I Add value of changing column before prefix 1 18 | Praxis Corporation 2|
18 Al | e of chanaing comm fter s H 19 Acme, Inc. 3
20 Ge SR e SRS o 20 General Products 4
21 |wa H 21 | water And Power 5|
Prefix: ,7 1
22 |FaK 2 22 |Fake Brothers 1
23 |De) &utis i 23 |Demo Company 2|
24 Wil | e slignment: = i 24 |widget Corp El
25 |Stri 2 25 |strickland Propane 4
26 [Ma 26 |Mainway Toys 5|
27 |Big Burgers 27 |Big Burgers 1]
28 |Klimpys 28 Klimpvs 2
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Example screenshot: 2 Example 2

B C D E A B C
| 1 b ompany untry | 1 b mpany m Country
2 Luthorcorp Austria 2 1|Luthorcorp Austria
3 Virtucon Austria 3 2|Virtucon Austria
4 = n 4 3|Mammoth Pictures Belgium
5 ASAP Utilities - Qulck-num bering_ufieled.ed cells... 5 4lBig kahuna Burger Belgium
] [ Series settings - 6 5|smith And Co. Belgium
7 * Numbers Starpith: 7 6]The New Firm Belgium
8 Incremef:t with: 8 7|videlectrix Bulgaria
9 Restart-count afer ;‘mee“ 9 8]Moes Tavern Bulgaria
10 b 10 9|Galaxy Corp Bulgaria
Fill up with leading Zefos: - -
11 o : 11 10jSombra Corporation Croatia
12 " Mlphabet lowercase (a, b, cetc.) iy * 12 1i1jQwerty Logistics Croatia
13  Aphabet uppercase (&, B, C, etc) i 13 12|Globo-chem Croatia
14 3 14 13|Spacely Sprockets Croatia
15 — options g 15 14|chasers Czech Republic
16 Restart numbering if the value in the l_;l 7 16 15|Spade And Archer Czech Republic
17 following column changes: g 17 16|Roboto Industries Czech Republic
18 10 18 17|Praxis Corporation Denmark
19 [ Add value of changing column before prefix ]1; 19 18|acme, inc. Denmark
20 I~ Add value of changing column after suffix 13 20 19|General Products Denmark
21 E 21 20fWater And Power Denmark
22 Prefix: l— 15 22 21|Fake Brothers Finland
23 Suffxc l— g 23 22|Demo Company Finland
24 18 24 23|widget Corp Finland
5 Cell alignment: | b 5 24|strickland Propane Finland
26 2 26 25|Mainway Toys France
27 T 27 26|Big T Burgers And Fries  France
28 Txlimny: Erance | 28 270klimny: Erance
Example screenshot: 3 Example 3
5 D E F B
1 B Name Group hd
" 2 |Luthorcorp 2 Luthorcorp [o10
3 |Virtuc N 3 |Virtucon 020
4 \Mamm ASAP Utilities - Qu-ick numbeing of selected cells... 4 |Mammoth Pictures 020
5 BigKall | — series settings — 5 |Big Kahuna Burger 040
6 |[Smith @ Numbers Smrt‘ﬁm: 6 |Smith And Co. (050
7 |The Ng Increment with: 7 |The New Firm 010
8 Videle Restart count aftes Brbrre 2 Videlectrix 020
9 MoesT § i % 9 |MoesTavern 030
10 | Galaxy! Fill up with leading e 10 | Galaxy Corp 020
11 |Sombri ( Aphabet lowercase (a, b, c etc.) = 11 |Sombra Corporation (050
12 |Qwe 12 Qwerty Logistics 010
13 Globz ||| PR R ECE 13 Globzvchei'\ 020
14 |Spacelyl| Options 14 |Spacely Sprockets 030
15 |Chaser] | | Restart numbering if the value in the [ =] | o 15 |Chasers 040
16 |Spade f | | folowing column changes: gﬁ 16 |Spade And Archer 050
17 |Robot 050 17 Roboto Industries 010
18 [praxis{|| | | 94 value of changing column before prefix gzlg 18 |Praxis Corporation 020
19 Acme b | [~ add value of changing column after suffix 030 15 |Acme, Inc. 050
20 Egg 20 General Products 040
21 |Water [ | prefix: l— 010 21 \Water And Power (050
22 |Fake Bl | o o — pe 22 |Fake Brothers 010
23 \Demo( | 040 23 Demo Company 020
24 |widge{ | | celldignment: = o= 24 |widget Corp 020
25 |Strickld)| 020 25 |Strickland Propane 040
26 |Mair y 1oy 26 |Mainway Toys (050
27 |Big Burgers | | 27 |Big Burgers 010
28 |Klimoy: | | | 28 |Klimpvs. 020
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Example screenshot: 4 Example 4

D B z
| 1| | 1] Country
2 | Austria 2 ] 1Luthorcorp Austria

3 \Mirtucan Lustria ~ 3 2|Virtucon Austria
4 ASAP Utilities - Quick numbering of selected cells... 4 1lMammoth Pictures Belgium
Z — Geries settings B E 2|Big Kahuna Burger Belgium
6 | e Siargqﬁﬂn: 6 | 3|Smith And Co. Belgium
7 Imj’ema”t withs 7 4 Tt_m New-Flrm Belglu-m
8 i 8 1 videlectrix Bulgaria
9 | Restart count after r\l‘mber: 9| 2[voss Tavern Croatia
10| Fill up with leading ﬂv‘ﬂf 10| 2|Galaxy Corp Croatia
|11 | € Alphabetlowercase (a, b, cete) " |11 | 3|Sombra Corporation Croatia
112 | = 2 |12 | M awerty Logistics Croatia
113 | © Ajphabet ”_DEES_E_‘:ff_B_'E;fE'_’__ i 113 | 5|Globo-chem Croatia
14 o me — —— ; 14 6|Spacely Sprockets Croatia
15 l:]'_ Optiores N 15 1fChasers Czech Republic
| Restart numbering if the value in the IC_L[ 1} ] .
16 .| following column changes: | & 16 2|spade And Archer Czech Republic
117 | _""'--___‘___ - i 17| 1JRoboto Industries Denmark
Et] ™ Add value of chang 4 18] 2|praxis Carporation Denmark
19 5 19 3|Acme, Inc. Denmark
— I™ Add value of changing column after suffix ©
20| 1 |20 | 4lGeneral Products Denmark
21 Prefi: i 21 5|Water And Power Denmark
22 2 22 1|Fake Brothers Finland
E i 3 E 2{Demo Company Finland
24 Cell slignment: i 24| 3{widget Corp Finland
5 2 5 4|strickland Propane Finland
| 26 | | 26 | 1Mainway Toys France
|27 | Big T Burgers And Fries  France | 27| 2|Big T Burgers And Fries  France
28 limpys. France 28 3lKlimovs France

E A
i3 1D per country ikl Company Country Coul code hd

1

2 Luthorcorp Austria 2 [AT1 Luthorcorp Austria AT
3 Virfucon Ausiria AT - 3 |AaT2 Virtucon Austria AT
a4 ASAP Utilities - Quick numbering of selected cells... 4 |BE1 Mammoth Pictures Belgium BE
5 . 5 |BE2 Big Kahuna Burger Belgium BE

— [ Series settings P 1 ith And \ai
6 & Numbers Start yifth: 6 |BE2 Smith And Co. Belgium BE
7 { 7 |BE4 The New Firm Belgium BE
Incremet with: —

8 y 3 |BGL Videlectrix Bulgaria BG
9 = m\f"ba" 3 |HRL Moes Tavern Croatia HR
10 Fill up with leading s 10 |HR2 Galaxy Corp Croatia HR
11 . i 1 [HR3 Sombra Corporation Croatia HR
12 e == 12 |HRa Qwerty Logistics Croatia HR
13 € Aphabet uppercase BB Cooin) 13 |HRS Globo-chem Croatia HR
14 2 = e 14 [HR6 Spacely Sprockets Croatia HR
15, 15 |cZ1 Chasers Czech Republic [ov

3

=
@

|cZ2 Spade And Archer Czech Republic [ord
17 |DK1 Roboto Industries Denmark DK

following column changes:

7
\

B e g 6 e e e e e
e
m|o=
o
=

—
/lﬂa *" Options
Restart numbering if the value in the
16 { o
H
\
\

o

& ‘ |v Add value of changing column before prefix DK2 Praxis Corporation Denmark DK
19 i - DK3 [Acme, Inc. Denmark
E ~l"nmﬂ-!--a.l.u..e_n_fd"a”gm column a&fr_sffﬁ—x-"'— E DK4 General Products Denmark DK
21 R l— P | 21 |DKS \Water And Power Denmark DK
122 22 [Fi1 Fake Brothers Finland FI
| 23 | Uik | 23 |FI2 Demo Company Finland Fl
|24 Cell dignment: I—LI |24 F13 (Widget Corp Finland Fl
25 P | 25 |F1a Strickland Propane Finland Fl
| 26 | e — | 26 [FR1 Mainway Toys France FR
| 27| s France FR | 27 |FR2 Big T Burgers And Fries  France FR
28 France FR 28 IFR3 Klimpys France FR
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Example screenshot: 6 Example 6

A B c D E F B
1 ame hd oup hd 1 LETE hd Group hd
2 |Luthorcorp 2 |Luthorcorp [comp [A]
3 |Virtucony } - r 3 3 |Virtucon [comp [B]
ASAP Utilities - Quick numbering of selected cells... -
4 \Mamma H - 4 |Mammoth Pictures [comp [C]
5 |BigKahd | [~ Series settings 5 |Big Kahuna Burger [comp [D]
6 Smith Al € Numbers Start with: 1 | OK | 6 |Smith And Co. comp [E]
7 |The New th: 1 7 |The New Firm [comp [F]
2 Videlect l_ 2 |Videlectrix [comp [G]
9 MoesTa . - 9 |Moes Tavern [comp [H]
10 Galaxy d| ‘," . S Example: 10 |Galaxy Corp lcomp [1]
11 Sombra € Aphabet \n.‘*,mse (a,b, cetc) comp [4] 11 |Sombra Corporation [comp [J]
| ! comp [B] -
12 awerty [} « Alphsbet uppercase (4, B, C, etc.) T 12 |Qwerty Logistics [comp [K]
13 |Globo-cfy| v, yd comp [D] 13 |Globo-chem [comp [L]
14 Spacelyll| — ophere=" gmg % 14 |Spacely Sprockets comp [M]
15 Chasers Restart numbering if the value in the - comp [G] 15 |Chasers [comp [N]
16 |spade Alj| | flewing column changes: gmg [Dl']ﬂ 16 |Spade And Archer comp [O]
17 |Roboto || comp [J] 17 |Roboto Industries [comp [P]
- ™ Add value of changing column before prefix comp [K] - -
18 Praxis C{| comp U] 18 | Praxis Corporation [comp [Q]
15 |Acme, Ifi| | T~ Add value of changing column after suffix comp [ﬂ'\ﬂ"] 19 |Acme, Inc. comp [R]
20 I ""' ‘\\ ﬂ,‘; B?]] 20 |General Products comp [S]
21 Prefix: comp 21
o e comp 0]
2 Suffix: Ny 2
23 % 7 comp [5]
24 Cell alignment: "1...__/ -
25
% _—
27
28 28

Example screenshot: 7 Example 7

[ A | s | ¢ | o | E F G H | & | 8 | ¢ D
1| 1 [Field 1 |Field 2 Field 3 Field 4
2 6 78 17 111 2 6 78 17 111
3 19 37 22 97 3 19 37 2 97
4 108 'ASAP Utilities - Quick numbering of selected cells... ) S 108 62 104 54
5 116 - 5 116 86 94 95
6 52 || [ Series settings S 6 52 46 23 76
7 o & Numbers S‘E'tlﬁ"*“ 7 71 79 17 105
8 99 Incremeng with: 8 99 28 96 53
Bl roctort count after spbers | o |Field 1 Field 2 Field 3 Field 4
10 72 I % 7 10 72 85 31 67
1 1 Fili wihezcing mi‘.,”___v__, Fxample; Iﬂ 1 1 119 20 55
12 a4 " Alphabet lowercase (3, b, ¢ etc.) Field_1 12 44 59 48 98
(13 {~ Aphabet uppercase (A, B, C, etc) = 13|Field 1 Field 2 Field 3 Field 4
14 58 Field_4 14 58 81 43 1
15 39 || — options T 15 35 50 3 2
El Restart numbering if the value in the m Field_3 16 |Field 1 Field 2 Field 3 Field 4
7 112 following column changes: Fed 1 = 114 27 75 36
= a0 I~ Add value of changing column befare prefix Eiﬁ‘ﬁ = o 64 100 102
19 21 = 19 Fal 103 a1 4
20 113 I Add value of changing eslun after suffix EZE% 20 113 92 82 18
21 63 4 % Field 3 1 63 26 93 a5
2 13 Prefix: {‘ W}— EZE'? 2 13 83 77 3
23 74 Suffix: N, y, Field_2 23 74 101 40 124
24 50 _ = ;::gzi 2 50 16 120 61
25 Cell alignment: - (25 |Field 1 Field 2 Field 3 Field 4
26 32 26 32 51 65 2
27 69 TIIOTIGS 5 27 65 110 109 5
28 10 2 107 12 28 10 22 107 12
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Example screenshot: 8 Example 8

D A C

1 [ry——— - e ——
2| |Austria Luthorcorp 2] 1|Austria Luthorcorp

3 Virtucon e Virtucon
4] Belgium lammoth Pictures I 4| 2||Belgium Mammoth Pictures
N ASAP Utilities - Quick numbering of selected cells... 5 Big Kahuna Burger
2 — Series settings —————————————===""= -2 Smith And Co.

7 i 7 The New Firm

8 Bimics Siart)mh: l_l = 8 3| Bulgaria Videlectrix
9 | Imemer{‘ nith: l_l “ Cancel 9] 4| Croatia Moes Tavern
(10 Restart count after nigmber: l_ _,.r—LI [10] Galaxy Corp
| Fill up with leading ;h{fs: IE /E;ample: 11 Sombra Corporation
112 ] S, J 12| Qwerty Logistics
13  Mphabet lowercase (a, b, cetc.) e 13 Globo-chem

14 ” Alphabet uppercase (A, B, C, etc.) 3 14 Spacely Sprackets
115 ; |15 5|Czech Republic  |Chasers

16 [~ Options 6 16 Spade And Archer
17| Eoﬁiii'r:gngsr?‘”;;z:;alue nthe :l' ; |17 6|Denmark Roboto Industries
18| 9 |18 Praxis Corporation

19 [~ Add value of changing column before prefix ﬁ 13 Acme, Inc.

20 2 20 General Products
1| [~ Add value of changing column after suffix 3 T \Water And Power

22 15 22 7|Finland Fake Brothers
E b= S E Demao Company
24| Suffix: ﬁ 24 \Widget Corp

25 Cell dignment: l—;l inl 25 Strickland Propane
| 26 | 2 | 26| 8||France Mainway Toys

27 e e 27 Big T Burgers And Fries
P Klimay: L2l Klimay:

D E
Incom Corporation Spain Incom Corporation Spain
Allied Biscuit Spain Allied Biscuit Spain
~
21 ASAP Utilities - Quick numbering of selected cells... Widget Corp Spain
23 p— Rouster And Sideways  Spain
i [ Series settings n
28 e Globo-chem Spain
— % Numb Start H I
29 Fumbers ,}'ﬁh : Ziffcorp Spain
34 lnaeme"}e iz 1 Roboto Industries Spain
46 Restart count after ”‘#‘“ba” I Globex Corporation Spain
. s i i
48 Fill up with leading zéu:i Iz - JE'xampIe: Monks Diner Spain
45 T Krustyco Spain
50 " alphabet lowercase (3, b, c etc.) ngg; Galaxy Corp Spain
51 " Alphabet uppercase (4, B, C, etc.) ES_03 Demo Company Spain
ES_04 .
52 ES05 (Water And Power Spain
56 [~ Options ES_06 North Central Positronics Spain
= Restart numbering if the value in the ES_07 e .
i following column changes: ES_08 Qwerty Logistics Spain
66 Eg_f]l.g Moes Tavern Spain
67 [ Add value of changing column before prefix ES 11 Nordyne Defense Dynarr Spain
69 E5_12 (Western Gas &Electric  Spain
B I~ Add value of changing column after suffix Eg ﬁ Mammoth Pictures spain
91 rd %, ES_15 Flowers By Irene Spain
o | Prefix: ] 1 ES_18 . " .
95 \ ES_ ) E5_17 Sto Plains Holdings Spain
Suffix: ) 7 ES_18 .
102 N ES 19 Blammo Spain
112 3 ES_20 112
Cell alignment: = ES 21
113 Es 22 113
114 114
115 115
116 116,

104
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Random numbering of cells (without duplicates)

This utility fills the selected cells with unique random integers.

This can be useful if you want to quickly create a list of random numbers without
duplicates.

The lowest created number in the list is 1 and the largest number is the number of cells in
your selection.

[™ B R =L e T 0114 - Random numbering of cells (without duplicates).xlsx -
“_Hnme Insert Page Layout Formulas Data Review  View | ASAP Utilities
" w\'_"i [Ed sheets » §H Cotlumns & Rows ~ B} Numbers & Dates + €5 web ~
9 Range - [ Objects & Comments = A Text - € Information ~
Favorites & | Vision . §
Shorteut keys = | Control 58 Format ~ Jfe Formulas - [ File & System
Favorites [0 1. Eill empty cells in selection... | )
Al - W 2 Overwrite filled cells in selection... [
A [ B i= 3. Copyvalues to empty cells below filled cells in selection
1
| o | 4% 4. Fill up with leading zeros...
3 [ 5.Insert before and/or after each cell in your selection...
4 I 6. Fill ‘between values' linear in selection (vertical)
5 C»  7.Fill ‘between values' linear in selection (horizontal)
6 1=
=2 i & Quick numbering of selected cells.. [Ctri=Alt=Q)
8] 9. Random numbering of cells (without duplicates)
g 10. Ingert current date and time with seconds (Ctrl+Shift=D)
10 11. Insert current time with secands (Ctrl=Shift=T)
" 12, Insert workbook's path and name in header, footer or cell..
1121 13. Create a list of filenames and properties in a folder... [Ctri=Alt=F)
13
[ 14, Insert sheet(s) name in selected cell(s)
|14
15
16
17

=

e Insert Page Layout Formulas Data Review View ASAP Utilities

i |+ 0114 - Randem numbering of cells (without duplicates) xdsx -

[ sheets + | Columns & Rows ~  [#} Numbers & Dates = g% Web -
[ Range ~ [ Objects & Comments ~ [A|Text = |8 Information ~
Favorites & [l Vision Select
Shortcut keys Wl Control  ~ =i Fill~ (5] Format - f« Formulas - (5 File & System
Favorites Time saving tools
AL - |7
A | B C D E F G H

ER 7 16|
| 2| 2 20
=R 29 23
L4 ] 30 23
|5 a 24
| 6 | 32 12|
L7 1 2g
|8 | 3 21|
EX 10 E:
|10/ 9 5|
|11} 19 17|
12| 21 18|
| 13] 6 2
| 14| 34 26
|15 25 27
|16 13 15|

7 14 11|

18
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Insert current date and time with seconds
This utility inserts the current date and time into the active cell.
Unlike Excel's built in shortcut Ctrl+; this utility also inserts the seconds.

A B C

1 |Excel: 7-4-2013

2 |ASAP Utilities: |7-4-2013 23:40!
3

4
5

Insert current time with seconds
This utility inserts the time into the active cell.
Unlike Excel's built in shortcut Ctrl+: this utility also inserts the seconds.

A B c

1 Excel: 23:45
2 |ASAP Utilities: I 23:45:20!
3

4
5

Insert workbook's path and name in header, footer or cell...

This utility allows you to put the folder and filename of your workbook into your header,
footer or selected cells.

You can insert the following information in the selected cells:

= Path and filename
= Filename
= Path

The path and filename in the cell are automatically updated when you change the name or
location of your file.

Or you can insert the path and filename into:

= Header left section = Footer left section
= Header center section = Footer center section
= Header right section = Footer right section

The path and filename in the header or footer are automatically updated when the name or
location of your file changes.
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ASAP Utilities -

Insertin selected range: B2

(% path and flename

" Filename Cancel

" path

Insert full path and filename of current file in:
" Header left section
" Header center section
" Header right section
" Footer left section
" Footer center section
" Footer right section
With Excel 2000 the path and filename in the header or footer is not a dynamic link. If you

change the path and/or name of your document you have to update your header or footer.
The path and file name in the cell are automatically updated.

Create a list of filenames and properties in a folder...

This utility will create a list of all filenames in a specified folder.
This way you can for example import on a worksheet the names from all files on a cd-rom.

You can configure the following settings:

= The folder to be searched.

= Search subfolders.

= Create hyperlinks to the files.

= Show only certain file types. For example to report only Excel files you can enter "*.xI*'.

= Sort the results, for example by filename, foldername, date, etc.

= Show only files modified or created within the past specified number of days.

= Create the list of files in a new workbook or on a new worksheet in your current
workbook..

This utility reports the following information about the files:

= Parent Folder

= Filename

= Size (KB)

= Type

= Created (date)

= Last Accessed (date)

= Last Modified (date)

= Full name (foldername and filename together)

By default you can start this utility with the shortcut Ctrl+Alt+F.

Available tools 107
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Your last used settings will be remembered.

ASAP Utilities - List filenames in folder

— Report full path, flenames and properties

Folder:

| Co\Program Fies (x86)\ASAP Utiities\

¥ Include subfolders
W Create hyperlinks to the files

File types: Sortby:

™ Indude empty folders

I x

I~ Show only files modified or created the past:

1. folder, flename {ascending)

=]

I™ Show details

Choose Details

Where should the list be created?

' In & new workbook

" In a new worksheet

File Home Inset Draw  Page Layout Formulas  Data  Review View Help  ASAP Utilities
_& E‘j Edsheets~ B Columns & Rows ~ Mumbers 8 Dates v | B Web v [ import = {5} ASAP Unikties Options ~ (%) Online FAQ E]
footie s Vien | St ERonges ] Objects & Comments-~ BB information= | [GjExport= £ Find and run » utify e
Shomcutkeys < Contral | v (EFilv P Format « T Formulas R Fike & System « %, Startlast tool again 4 Registeredversion  the Day
Favartes Time saving tools Options and settings Intoananep  Tips s
Az ~ s
A [} ¢ o 3 ¥ 6 H ] K L M
1 25 files found in C:\Program Files (x86)\ASAP Utilities\*.* (16:36:26 on 10-10-2022)
2 parent fold - Filename ~|size(kB) +Type |- Created |- LastAccessed -|LastModifiec - | Folder and name -
3 [a0d_asaP Utilities to_the Excel menu.exe I09L1EXEFlle  15-6-202221:38 10-10-202215:22 24-3-202215:58 C:\Program Files [xB5]\ASAP Utilities\Add ASAP Utilities to_the Excel menu.cxe
4 Add ASAP Utilities to the Excel menu-0.bin T3BINFile  15-6-202221:38 8-10-202220:43 24-3-2022 15351 C:\Program Filles (x36)\ASAP dd ASAP U to the Excel menu-O.bin
5 Add ASAP Utilities to the Excel menu-1.bin 0,0 BINFile  15-6-202221:38 8-10-2022 20:43 24-3-2022 15:51 C:\Program Files [x86]\ASAP Util dd ASAP Utilities to the Excel menu-1.bin
& ASAP Utilities.xlam 6.763,3 XLAM File 15-6-202221:38 10-10-2022 16:35 6-10-2022 14:27 C:\Program Files [x85]\ASAP Utilities\ASAB Utilities.xlam
T ASAP Utilities User Guide.pdf 19.625,1 POFFile  15-6-202221:38 10-10-202215:22 6-10-2022 10:06 C:\Program Files [x85)\ASAP Utilities\ASAP Utilities User Guide.pdf
8 asap-uf 5.iC0 39,2 ICOFile  15-6-202221:38 10-10-2022 15:22 19-3-2022 21:14 C:\Program Files [x86]\ASAP tilities.ico
L] readme.txt 76 TXTFile  15-6-2022 21:38 10-10-2022 15:22 6-10-2022 12:08 C:\Program Files [x86)\ASAl At
1 Remove ASAP Utilities from the Excel menu.exe 1091 EXEFlle  15-6-202221:38 10-10-202215:24 24-3-202215:58 C:\Program Files [x86]\ASAP Utilities\Remove. ASAP Utilities from the Excel menu.exe
n Remove ASAP Utilities from the Excel menu-0.bin 74,5 BINFile  15-6-202221:38  810-202220:43 24-3-202215:51 C:\Program Filles (486 ASAP Utilities from the Excel menu-0.bin
12 Remove ASAP Utilities from the Excel menu-1bin 00BINFile  15-6-202221:38 6-10-202220:43 24-3-202215:51 C:\Program Files [x38]\ ities\Re ASAP Utilities from the Excel menu-1.
13 unins000.dat 70,9 0ATFile  15-6-202220:38 6-10-202220:43 7-10-202213:17 C:\Program Fills (xd6)\ dat
i unins000.exe 3.0929 EXEFlle  7-10-202213:17 10-10-202215:24 7-10-2022 13:17 C:\Program Files [x85]\ASAP Utilities\uninst00.exe.
15 unins000.msg 248 MSGFile 15-6-202221:39  §-10-202220:43 7-10-202213:17 C:\Program Files {x35]\ 000.msg
16 wversion_history.txt 1,7 TxTFile  15-6-200221:38 8-10-2022 20043 6-10-2022 12:07 C:\Program Files | 1\ P Utiliti sion_history.txt
17 certificate\  ASAP Utilities Certificate - & Must in Every Office BV.cer 15CERFile  15-6-202221:38  7-10-202213:17 24-9-202015:03 C:\Program Files (x85]\ASA® Utilities Certificate - A Must in Every Office BV.cer

18 |resources\,
18 |resources\,
20 |resources\
21 resources\
22 |resources\
23 |resources\
24 |resources\,
25 |resources\,
26 resources\
27 resources\

ASAP Utilities ribbon_es-es.xlam
ASAP Utilities ribbon fr-fr.xlam
ASAP Utilities ribbon_it-it.xlam
ASAP_Utilities ribbon_ja-jp.xlsm
ASAP Utilities ribbon_nl-nlxlsm
AsaP Utilities ribbon_pt-br.xlam
ASAP Utilities

bon_ru-ru.xlam
bon_zh-hans.xlam

3958 XLAM File
376,8 XLAM File
399,8 XLAM File
412,9 XLAMFile
400,56 XLAM File
464,5 XLAM File
388, 1 XLAM File
40,2 XLAM File
575,39 XLAM File
383,7 XLAM File

15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38
15-6-2022 21:38

1010-2022 13:10

7-10-2022 13:17
10-10-2022 13:11
10-10-2022 13114
10-10-2022 13:21
10-10-2022 13:24
10-10-202213:08
10-10-2022 13:20
10-10-2022 13:22
10-10-202213:23

1-10-2022 19:21 C:\Program Files (x85]\ASAP Utilities\resources\ASAP Utilities ribbon de-de.xlam
4-10-2022 07:42 C:\Program Files (x6]\ SAP Utilities ribbon en-us.xlam
1-10-202219:21 C:\Program Files [x86]\ASA AP Utilities ribbon
1-10-202219:21 C:\Program Files [x86]\ASA® Utilities\resources\asap utilities_ribbon
6-10-2022 12:06 C:\Program Files [x85]\ASAP Ui urces\ASAP Utilities ribbon itit
1-10-202219:23 C:\Program Files (x86]\ Utilities ribbon ja-jo.xlem
1-10-202219:21 C:\Program Files [x38]\ Utilities ribbon_nl-nl.xlam
1-10-202219:22 C:\Program Files [x86]\ASAR Utilities\resources\ASAP Utilitias_ribbon_pt-br.xlsm
1-10-2022 19:22 C:\Program Files [x85] i A Utilities ribbon ru-ru.xlam
1-10-2022 19:23 C:\Program Files [x38]\ Utilities ribbon zh-hansxlam

ieshr

P Uil

Insert sheet(s) name in selected cell(s)

This utility inserts the name of the worksheet into your selected range in each of your

selected worksheets.

You can for example use this to insert the sheet name into cell Al on every selected

worksheet.
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[0 I ARt 0025 - Inzert sheetis) name in selected celicidsm [Group] - Microsoft Excel = @ =B
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’, €© Py [Wsneets - @ Commns & Rows + 3 humbers & Dates - §3 web - 5 mport = A5AP nilities Options + -
Al £ Fange + (= Obiects & Comments - AlTot - @ irfomation - @Essort= | b Findandruna utilly
Favortes s Viion Seledt = info and
Shortcut bays + | Conigt - wiFme [ Fomat - o Formutan - SaFiessytem= b St~ ElStrtlstteolagain | el
Fasnenes Time sawng tosts aptions sna setng:
L =

lwmlu Bastien Mensink

Internet Solutions
ASAP Utities - Insert sheetis] name in selected cell)
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" Q| [y Eoreor Bommuanon . Bmmemavue- [CTeRm T e ——
2 hange - =] Objets & Comments - [A]text - @ omton - @bwont= b Fgansrmaviny |
gomna | wienlgaea o o 0 e e T osan
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3 B G| week1
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Columns & Rows

A collection of tools for columns and rows.

Conditional row and column select, hide or delete...

This utility allows you to select, hide or remove rows or columns based on a certain

condition.

You can use the following criteria to select, hide of remove the entire rows or columns:

= between

= not between

= equal to

= not equal to

= greater than

= |ess than

= greater than or equal to

= |ess than or equal to

= like (text, with use of wildcard
characters)

= not like (text, with use of wildcard

characters)

duplicate values (you can choose to

keep the first value)
unique values

odd rows

even rows

every n'th row number
odd columns

even columns

every n'th column number
empty cells

completely empty rows
completely empty columns

With the criteria for text and duplicate or unique values you can choose if you want the

utility to be case sensitive.

When looking for duplicates the program also searches in hidden cells in your selection,
with the other search options hidden cells are skipped.

Some people use this utility as an alternative for or addition to Excel's AutoFilter.

Example screenshot: 1 Conditional row and column select hide or delete

ASAP Utilities - Conditional row and column select, hide or delete

~

1. Search in: 2. Perform action on rows or columns?

Al:A1396 J * Rows " Columns
3. What to do with the entire row from each found cell:
™ salect ™ Hide & Delete

4, Search options:

between

not bebween

equal to

not equal to

greater than

less than

greater than or equal to

This utility searches For a specified
walue, and then selects, hides or
deletes the entire column or row where

this value is found.

when looking For duplicates the
program also searches in hidden cells in
your selection, with the other search
options hidden cells are skipped.

For more flexibility and options you can

use the utility:

Select » Select cells based on content,

formatting and more. ..

5}
— | nok like {text, with use of wildcards)

duplicate values
unigue valuss

odd rows

even rows

every n'th row number
empty cells

completely empty rows
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Example screenshot: 2 Create a list of unique brand names
A | B | c | D | E | F | G | H | | | J | K

Brand names
Rover

[Toyota
Mlitsubishi
Rover

Audi
Toy

e 1. Searchin: 2. Perfarm action on rows or columns?
Hyu This utility searches for a specified

) * Rows " Columns wvalug, and then selects, hides or I
AZALIEE B N : deletes the entire column or row where | £

this value is found,

ASAP Utilities - Conditional rew and celumn select, hide or delete

=)
[=]
=
D

=]
=
@

a
M
o

=

3. What to do with the entire row from each Found cell:

When looking for duplicates the
 Select  Hde {* Delete program also searches in hidden cells in | £
your selection, with the other search
options hidden cells are skipped.

@

T
=

c

=

T
=

=

&
]
=)
&

4, Search options:

| duplcate values =l For mars flexibiliey and options you can |
use the ukility:

o

=

o
2

e}

=

o
g

@
M
o

=3

I Case Sensitive

Select » Select cells based on content,
@& Keep the first value of each duplicate Formatting and more. ..
" Delete all duplicate values

Close ¥ auto close
|

©
[
ar
@

k|
m|=|o
[EI=NE]
@2 g
S = =

o
i}
=
£

=

1o
=
=
e

| ra [y
|| d
[
&
@

.
)

Mitsubishi
Ruover
Rover
Ruover
Ford
Chevralet
Mitsubishi

X}
@

I
[=]

)

I
)

)
@

I
=

m
x

ample screenshot: 3 Each brand listed once

A [ B [ ¢ [T o T E T F
Brand names
Fover
[Toyota
Mitsubishi
Audi
Chevrolet
Hyunday
Ford
Saab
Bentley
hazda
[ Jaguar
[“/0lkswagen
[“/alva

=1

[}

w

=

m

m

~

m

@

Advanced sorting...

This tool extends the options to sort your data.
You can sort on up to 5 columns at once. Furthermore you can sort on many more
properties than just the cell values.

With this tool you can sort by:

= Value = |talic

* Number format = Underline

= Cell Color = Strikethrough

= Cell Color Indexnumber = Text Length

= Font Color = Random order (shuffle)
= Font Color Indexnumber = Reverse order

= Font Size = Formula

= Font Name = Email address host (@...)
= Bold
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= Alphanumeric content based on the

numeric portions
= Value, ignore minus sign (-) in numbers
= Year-Month-Day
= Year-Day-Month
= Month-Day-Year

= Month-Year-Day
= Day-Year-Month
= Day-Month-Year

= Day of the week (start on Sunday)
= Day of the week (start on Monday)

1 n- Global Monthly Searches ocal Monthly Searches (Nethe}
2 |shop 0.06 13600000
3 e 072 1230000
4 |maker ASAP Utilities - Advanced sorting — )|
5 |makers Sort orientation: My list has: -
6 |bar & Top to bottom @ Header row L
7 |machines " Left toright " No header row -
8 |pot -
9 [table Sort by . -
10 [cup [“keywerd () | | Bad = (:_ :iw‘d‘”g I~ Case sensitive |
11 |bean Value .
(2green || menby ™ g |
13 [tables Keyword (A) = Cell Color Indexnumber .
Font Color
L ||zane Font Color Indexnumber =
15 |mug Then by Font Size )
o I LI Font Name )
17 |pots | Ialic
18 Then by Underline -
B <] | Strkethrough ]
19 |cake TextLength
- Random order (shuffie) —
20 |equipment Thenby Reverse order .
21 Formula
npany | =] | Email sdaress host (@..) —
22 |recipe Alphanumeric content based on the numeric portions .
23 |reci Walue, ignore minus sign () in numbers
| <= freqpes 3 c 1 ‘fear-Month-Day oK N
24 |break Lance Year-Day-Manth = g
Month-Day-Year
= cu-ps mugs Month-rear-Day ——
26 |grinder Day-Year-Month
" Day-Month-Year
27 Jreview Day of the week (start on Sunday)
28 |reviews Day of the week (start on Monday)
29 |roasters 0.08 201000
30 |buy 0.16 165000
31 |grinders 0.22 165000
32 |art 0.08 135000
33 [club 0.03 135000
D

| 1] bal Monthly Searches cal Monthly Searches (Neth¢]
2 |art 135000
3 |bar 1220000
4 |break 0.02 201000
5 |cake 0.01 301000
6 |cake recipe 0 90500
7 |club 0.03 135000
3 |coupons 0.19 110000
9 |french press 0.09 49500
10 |pictures 0.02 135000
11 |recipe 0.02 246000
12 |recipes 0.02 246000
13 |school 0.06 90500
14 |shop 0.06 13600000
15 |table 0.47 1220000
16 |tables 0.52 823000
17 |accessories 0.36 9300
18 |am 0.04 40500
19 |bags 0.17 33100
20 |baskets 0.06 49500
21 |bay 0.11 74000
22 |bean 0.1 823000
23 |bean grinder 0.27 6600
24 |bean grinders 0.34 4400
25 |bean prices 0.14 2900
26 |bean roaster 0.18 6600
27 |beanery 0.03 8100
28 |beans 0.1 673000
29 |beans for sale 0.52 3600
30 |beans onling 0.41 4400
31 |beans wholesale 0.41 5400
32 |berry 0.14 60500
33 |bot 0.08 3600
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Color each n'th row or column in selection...

Fill every n'th row or column in your selected range with a specified color. This method is
also known as 'color-banding' and 'alternate shading'.

This will improve the readability of tables with a lot of data.

You can specify a color, rows or columns and the steps, for example to make every second
row in your selection grey.

There are two methods to color the rows or columns:

= Standard coloring.
This has the option to skip hidden rows/columns.

= Conditional formatting (advanced).
With this option the colors will be automatically updated when you insert or remove
rows or columns. To remove the color, choose in the Excel menu 'Format' > 'Conditional
Formatting' then remove the condition that sets the alternate colors (by default
condition 1). If you use this option then the possibly existing conditional formatting will
be removed.

By default you can start this utility with the shortcut Ctrl+Alt+C.

Example screenshot: Example alternate row coloring

ASAP Utilities - Color each n'th row or column

Options

Color: 15 Ay . Give color to:
* Rows
Steps: 2

¥ Remove existing colors

" Columns

Color method:

* Standard cell coloring
I¥ Skip hidden rows/columns

" Conditional formatting (advanced)
With this option the colors will be automatically updated when you insert or
remove rows or columns. To remove the color choose in the Excel menu
‘Format’ > ‘Conditional Formatting’ then remave the condition that sets the
alternate colors {by default condition 1}.

Cancel

Detect and visualize adjacent data/group changes...

With this utility you can easily make the differences visible between groups of cells with the
same content.

You can do the following when the value in a row changes:

= insert an empty row

= insert a page break

= insert a border line below group.
= alternating colors per group.
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You can use this for example to identify different groups of data in your worksheet by
inserting a blank row when the value changes or inserting a line in between.

Your last used settings will be remembered.

Note:
This utility only works on the rows (data) in a single column.

Example screenshot: 1 Insert an empty row between groups

[ 1]
2
3
4 |austria /ASAP Utilities - Visualize data changes in column 51
| ™™ s -l -
7 |Belarus r A B C D E F G
8 [Belarus @ Emply rowfs): 1 K2 2005 22006 K2 2007 B2 2008 [d 2009
9 [Belgium = 2 |Austria Luthorcorp 2 31 14 a0 36
10 [elgium £ race ook 3 |Austria virtucon 59 30 37 54 49
11 |Belgium |mustria [General Forge And Foundry 37 10 42 55 51
" Border:
12 |Belgium
13 |Bulgaria Belarus Lexcorp 3 51 8 55 9
14 |Bulgaria 7 [Belarus |Zevo Toys 20 11 13 32 33
15 |Bulgaria 8 [Belarus Initech 10 15 17 438 10
16 [Bulgaria 9 [Belarus Gadgetron 51 a6 15 24 56
17 [croatia 10
18 |croatia 11 |Belgium [Mammoth Pictures 55 26 33 23 47
19 [croatia 4 12 [Belgium Big Kahuna Burger 35 a0 50 18 a
20 |croatia 13 [Belgium fSmith And Co. 43 2 47 7 B
21 |czech Republ ’ . 14 [Belgium [The New Firm 43 57 17 43 2
22 |czech Republ : 18
23 |caech Republ| | J— 16 [Bulgaria i 8 2 1 1 2
24 |Czech Republ ———————————————| | 17 |Bulgaria [Moes Tavern 59 29 17 14 31
25 [Denmark ,?&I 18 [Bulgaria Galaxy carp 32 16 1 7 36
26 |Denmark 19 [Bulgaria Burleigh And 31 7 36 20 8
27 [enmark £
28 |Denmark 21 |Croatia |Sombra Corporation 37 37 42 26 15
29 [Finland 22 |Croatia [Qwerty Logistics 30 29 1 21 14
30 [Finland L —23|croatia |Globo-chem 9 19 43 13 40
31 [Finland [Widget corp 21 24 [croatia lSpacely sprockets. 8 9 20 1 1
32 [Finland |strickiand Propane 8 |25
33 [France |mainway Toys 32 | 26 |czech Republic |chasers 32 32 59 44 1
34 |France Big T Burgers And Fries a2 27 |Czech Republic Spade And Archer 2 23 43 5 57
28 |Czech Republic _|Monarch Playing Card Co. 59 £ 34 19 u
29 |Czech Republic Roboto Industries 25 59 27 6 57
30
31 |Denmark Praxis Corporation 49 15 51 14 14
32 |Denmark |Acme, Inc. 36 a3 42 57 53
33 |Denmark General Products 4 21 43 56 52
| 34 |penmark |water And Power 1 13 49 57 6

Example screenshot: 2 Insert a pagebreak between groups

(ASAP Utilities - Visualize data changes in column 51
9
Range: AzALZL =] 29
[~ Visualize changes with:
 Empty row(s): .
2 Luthorcorp 40
3 |Austria Virtucon 37 54 43
1% Pagebreak 4 |mustria |General Forge And Foundry 37 10 22 55 51
 gorder 5 |Belarus Lexcorp 3 51 8 55 B
13 |Bulgaria 6 [Belarus |Zevo Toys 20 11 13 32 39
14 |Bulgaria = 7 [Belarus Initech 10 15 17 48 10
15 [Bulgaria ; 8 [Belarus Gadgetron 51 a5 15 2) 56
16 [Bulgaria A 9 [Belgium [mammoth Pictures 55 26 33 3 a7
17 [Croatia -~ 10 [Belgium |piz kahuna Burger 3 40 50 18 4
18 |Croatia el 11 [Belgium fsmith And co. 4 28 47 7 s
Dlesiz (e} 12 |Belgium rhe New Firm a3 57 17 a 23
20 |croatia 13 |Bulgaria i i 8 24 12 1 2
21 |czech Republic 14 |Bulgaria [Moes Tavern 59 29 17 14 31
22 |Caech Republic 15 |Bulgaria Galaxy Corp. 32 16 14 7 36
23 |Caech Republic i R 16 [Bulgaria Burleigh And EH 7 36 2 8
24 |Caech Republic 17 [croatia |sombra corporation a7 37 42 26 15
25 [Denmark 18 [Croatia lQwerty Logistics 30 29 1 21 1
26 [Denmark 19 [Croatia |siono-chem f) 13 43 FE] 40
e 20 [croatia spacely sprockets B s 20 1 1
28 |Denmark 21 |Czech Republic Chasers 32 32 59 44 1
29 |Finland 22 |Czech Republic Spade And Archer 2 23 49 5 57
30 [Fintand = 23 |czech Republic |Monarch Playing Card Co. 59 32 34 19 1
31 [Finland et cory 24 |Czech Republic __|Roboto Industries 3 59 27 6 57
32 [Finland |strickland Propane 25 [Denmark Praxis corporation 43 15 51 14 1
France |Mainway Toys 34 26 [Denmark JAcme, Inc. 36 EE] 42 57 53
France ig T Burgers And Fries 23 27 |Denmark General Products a 21 49 56 52
28 |Denmark |water And Power 1 1 4 57 5
29 |Finland Fake Brothers 43 1 2 48 42
30 |Finland [Damo Company 32 B 4 15 7
31 |Finland Jwidget Corp 22 51 11 4 23
32 |Finland |strickland Propane 8 6 10 a 13
33 |France [mainway Toys 34 6 4 19 27
34 |France Big T Burgers And Fries 42 50 29 53 55

114 Chapter 5



“Happiness inspires productivity” ASAP Utilities User Guide

Example screenshot: 3 Insert a border line between groups

|1
2
E]
4 |Austria | ASAP Utilties - Visualize data changes in column e 55 51
5 |Belarus
& [getarus || ™ e =1
7 [Belarus || -
8 [pelarus © Empty row(s): | 1|
9 [Belgium 2 |Austria 2 1 0
10 [Belgium PR 3 |austria virtucon 59 7 54
11 [Belgium o= | 4 |Austria |General Forge And Foundry 37 2 55
12 [Belgium  Border 5 [Belarus Lexcorp 3 51 2 55 9
13 |Bulgaria Thdmess 6 |Belarus zevo Toys 20 1 13 32 39
14 [Bulgaria @  Harlne 7 |Belarus initech 10 15 17 a8 10
15 |Bulgaria ; - £ hn 8 |Belarus Gadgetron 51 a6 15 2 56
16 [Bulgaria 2 md‘“"‘ 9 [Belgium [Mammoth Pictures 55 26 33 2 47
17 |croatia @ 10 [Belgium Big kahuna Burger 35 a0 50 18 4
18 |Croatia fa) 1 [Belgium [smith And Co. 4 28 a7 7 5
19 |croatia o 12 [Belgium [The New Firm 4 57 17 2 23
20 |croatia 13 [Bulgaria videlectrix B 24 12 11 2
% apply to column At (current regon)
21 |Czech Rey S i —— 14 [Bulgaria [Moes Tavern 59 2 7 1 31
22 |caech Rey “ 15 [Bulgaria Galaxy corp 32 16 1 7 36
23 |Crech Rellll | ~ avernating cole per rou 16 [Bulgaria Burleigh And 31 7 36 20 B
24 |Czech Rey — | |17 croatia [sombra Corporation 37 37 ) 26 15
25 [Denmark. : =1 %‘ 18 |Croatia Querty Logistics 30 29 1 21 14
26 [Denmark 19 |croatia Globo-chem B 19 a3 13 20
27 [penmark 20 |croatia [spacely sprockets B B 20 1 1
28 [Denmark 21 |Czech Republic_|chasers. 32 2 59 a 1
29 [Finland 22 |Czech Republic_[Spade And Archer 2 2 29 5 57
30fnland \L_——————————— 453 |csech Republic__|Monarch Playing Card Co. 59 2 En 19 1
31 [Finland idget Corp 24 |Czech Republic__|Roboto Industries 29 59 27 6 57
32 [Finland |§mck|and Propane 25 [Denmark praxis Corporation 49 15 51 1 14
33 [France Mainway Toys 32 26 |Denmark acme, Inc. 36 a3 2 57 53
34 [France Big T Burgers And Fries 43 27 |Denmark General Products a 2 29 56 52
26 [Denmark water And Power u 13 29 57 6
29 [Finland [Fake Brothers ) Y 2 a8 a2
30 [Finland [bemo company. 32 B a as 7
31 [Finland widget Corp 2 51 1 4 23
32 [Finland strickland propane 8 3 10 4 19
[ 33 [France [Mainway Toys. ) 5 1 19 27
34 [France Rio T And Frie o 50 29 3

Example screenshot: 4 Color banding per group

]
Z
3
4 [Austria | ASAP tiities - Visualize data changes in column -
5 [Belarus
6 [petarus | ™ AzALzL =l
7 [pelarus r
8 [Belarus € Emgty row(s):
9 [Belgium
T P
"  porder:
13
14
15 [Mammoth Pictures
16 Big Kahuna Burger 35 50 18 4
17 [smith And Co. 2 28 47 7 B
18 [The New Firm 2 57 17 43 2
19 3 2 2 n 2
20 59 2 17 1a 31
21 32 16 14 7 36
2 i 31 7 E 20 8
2 T DT |croatia sombra corporation 37 37 a2 26 15
2 | | 18 [croa uerty Logisti 30 29 1 21 1
% el cdler E 19 |croatia Globo-chem 9 19 a3 13 40
2 |V Remove existing colors 20 |Croatia |Spacely Sprockets. K 9 20 1 1
il & Color column A1 (arrent region) 4 oz E2 E2 = & i
28 2 [spade And Archer n 2 ) 5 57
€ Color entre row
29 2 [Monarch Playing Card Co. 59 2 34 19 1
30 — 2 [Roboto Industries 29 59 2 5 57
31 idget Corp 25 [penmark praxis Corporation a9 15 51 1a 14
32 [strickland Propane 8 26 [penmark Jacme, inc. 36 43 2 57 53
3 [mainway Toys 34| 27 [Denmark Jeneral products 4 21 19 56 52
34 [France Big T Burgers And Fries 42 28 [Denmark [ water And Power 1 13 ) 57 3
a3 1 2 a8 a2
3 8 4 45 7
2 51 1 1 2
8 5 10 1 19
33 |France Mainway Toys 34 5 a 19 27
34 [France [pigTBurgers And Fries 2 50 2 53 55
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Merge column data (join cells)...

This utility merges the data from the columns in your selection.
For each row in your selection the data from the adjacent columns will be concatenated
into the first cell in the row.

You can specify the following:

= Delimiter to put between the cell values
= Skip empty cells
= Use the value, formula or formatted value from the cells.

You can use this utility as a quick alternative to Excel's =CONCATENATE() function.

Example screenshot: Merge cell contents of selected columns into one cell

A B S D E F A B € D

1 ord |2 - - ~ BN keyword B 1 [- A [- B -
2 |tcoffee beans for sale 2 |+coffee +heans +for +sale
3 |tcoffee cups mugs 3 |+coffee +cups +mugs
4 |+coffee for sale 4 |+coffee +for +sale
5 |+coffee - - ~ 5 |tcoffee +cake +recipe
6 |tcoffee | ASAP Utilities - Merge columns i 6 |[+coffee +maker +review
7 |tcoffee e LD e Tnl e 7 |tcoffee +maker treviews
8 |+coffee 8 |+coffee +on +ine
9 |+coffee value: I + 9 |+coffee +shop +menu
10 |+coffee {ff  =line feed character (alt+enter) Cancel 10 |+coffee +machine +review
11 |+coffee Bl =EoeTREe 11 |+coffee +machine +reviews
12 |[+coffee - This utlity will ) 12 |+coffee +espresso +machine +sale
13 |+coffea :‘;Eg&iaﬁ:ﬁn in 13 |+coffee +espresso +maker
14 |+coffee I¥ Tanore all empty cells together in the first 14 |+coffee +makers +reviews
15 |+coffee W Ignore empty cells at the end cellof each row. 15 |+coffee +french +press +sale
16 [+coffee read cells as: 16 |+coffee +machines +reviews
17 |+coffee values (defauit) j' 17 |+coffee +pot +reviews
18 |+coffee . 18 [+coffee +able +hook
15 [rcoffee || ™ 19 |+coffee +table +books
20 |+coffee +coffee +heans +or +sale 20 |+coffee +weight Hoss

+coffee +cups +mugs . -
21 |+coffee tcoffes +for +sale 21 |+coffee +vending +machine
22 |+coffee +offee +cake +recpe 22 |+coffee +for +Hless

+coffee +maker +review
23 |+coffee teoffes +maker +reviews 23 |+coffee +machines +commercial
24 |+coffee 24 |+coffee +side +effects
25 |+coffee e — = 25 |+coffee +vending +machines
26 |+coffee burr grinder | 26 |+coffee +burr +grinder

Merge row data (selected cells)...

This utility merges the data from the rows in your selection.

For each column in your selection the data from the adjacent rows will be concatenated
into the first cell in the column.

You can specify a delimiter to put between the cell values.

You can use this utility as a quick alternative to Excel's =CONCATENATE() function.
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Example screenshot: Combine the data from the rows in your selection

AL - I« | Ernest Hemingway
A [ B I C [ D E

1 |Ernest Hemingway George Orwell Mark Twain Charles Dickens

2 |1899 1903 1835 1812

3 |United States India United States United Kingdom

4

5 ASAP Utilities - Merge row data (selected cells).. Pl X

6 This utility will combine the data in selected cells/rows together in the first cell

7 of each column. Example:

|alblcld|e] with separation "-"

8 |11213415] becomes |a-1lb-2|c-31d-4le-5]

5 Please enter a separation value below:

10

11

=
13
1

Al v fc | Ernest Hemingway, 1899, United States
A [ B C D E
1 |Ernest Hemingway, 1899, George Orwell, 1903, Indi Mark Twain, 1835, United Charles Dickens, 1812, Unjted Kingdom
=

3
4
5
6
)

Merge row data, separate cells by a line break

This utility merges the data from the rows in your selection and puts each cell value on a
new line.

For each column in your selection the data from the adjacent rows will be concatenated
into the first cell in the column.

You can use this utility as a quick alternative to Excel's =CONCATENATE() function.

Example screenshot: Merge row data, separate cells by a line break

A | B | c | D
' 1 |[Ernest Hemingway George Orwell Mark Twain Charles Dickens
2 |18s9 1903 1835 1812
3 |United States India United States United Kingdom
4
5
6
A B = D
Ernest Hemingway George Orwell Mark Twain Charles Dickens
1839 1903 1835 1812
| 1 |united States India United States United Kingdom
2|
&)
4
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Insert empty rows or columns in between...

This utility inserts a given number of empty rows or columns between every row or column
in your selection.

You can specify the following:

= |nsert between the rows or columns in your selection.
= The number of rows or columns to insert.
= To use the standard row height or columns width or specify an adjusted height or width.

Example screenshot: Insert empty rows or columns in between

I 1418 536 160214 19% §152.5147
ASAP Utilities - Insert between empty rows or columns [371.687
22,7957

Insert empty rows or columns in betwezn 50,6038
54708

31,4165

Number of rows to insert betwesn: 4 Cancel )88.4073
145155

49,1948

* Rows " Columns

& Use the standard row height

’7 Range: 81,3166
(" Use a custom row height: [az:ass . | [ #0721,08
J 1B17.9825

T T T AARESL T 36.4465

Ljubljana 13.63 | 499 6.799,82 19% 7312.64

Insert multiple empty rows at once...

This utility inserts multiple rows at once.
The utility inserts the specified number of rows above the active cell.

Normally if you want to insert multiple rows at once the standard procedure is to first
select multiple rows and then use the "Insert" command.

For example if you want to insert 10 rows between Al and A2, you first have to select rows
2:11 and then insert the rows.

With this utility you can now quickly insert multiple rows at once.

Example screenshot: Insert multiple empty rows at once

9 9
10

10 [ A54P Utilities - Insert multiple empty rows at once...

DS
1 21.
12 22 Haow many rows do you want to insert before row 117
13 23|
14 24

25
16 26
17 27
18 28
19 29
20 30
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View and manage hidden rows and columns...

Displays an overview of, and counts all hidden rows and columns within the used range on

your worksheet.

You can then easily pick the column and/or rows you want to unhide and make visible

again.

-
ASAP Utilities - View and manage hidden rows and columns

— Hidden columns (7)

— Hidden rows (18)

(mBE

oooooE

D
E
F
u
w

Al | Inverse

None

] 2z

a ==

{Unhide selected

This utilty shows al
hidden rows and
columns within the
used range
(A3:A79) of your
worksheet.,

Close

Delete all hidden rows and/or columns...

This utility removes all hidden rows and/or columns from in your current worksheet.

This can be useful if you want to clean up the file before distributing it.

Note:

If you have formulas with cell references to cells in the hidden rows or columns you first
have to update your formulas or replace them with the calculated results. If you don't do
this then the formulas give error values (#REF!) when the rows and columns are removed.

I I I I
ASAP Utilities - Delete all hidden rows and/or columns

Delete
¥ Hidden rows (56)
[¥ Hidden columns (4)

Cancel

Available tools
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Delete all empty rows

This utility removes all completely empty rows on your current worksheet.

Note:

The utility removes all rows without data within the used range in your worksheet.

It does not reduce the number of available rows in your worksheet. For every row that is
removed Excel automatically adds a new empty row at the end.

1
2 Austria Luthorcorp 2 31 14 40 36
3 Austria Virtucon 59 30 37 54 43
4 | Austria General Forge And Foundry 37 10 42 55 51
5
6 ASAP Utilities - Delete all empty rows == 55 9
7 32 39
8 e 48 10
@ Do you want to remove all completely empty rows on your worksheet? 24 56
23 47
Cancel i 18 4
| 7 5
43 23
16 |Bulgaria Videlectrix 24 12 11 2
17 Bulgaria Moes Tavern 59 29 17 14 31
18 Bulgaria Galaxy Corp 32 A B ' D E F G
19 |Bulgaria Burleigh And Stronginthearm 31 1 [ hd Compa hd 200 hd 2006 Kd 200 hd 2008 R4 2009 K4
20 2 Austria Luthorcorp 2 31 14 40 36
21 Croatia Sombra Corporation 37 3 Austria Virtucon 59 30 37 54 43
22 Croatia Qwerty Logistics 30 4 Austria General Forge And Foundry 37 10 42 55 51
23 Croatia Globo-chem 9 5 Belarus Lexcorp 3 51 3 55 9
24 Croatia Spacely Sprockets 8 6 Belarus Zevo Toys 20 11 13 32 39
25 7 Belarus Initech 10 15 17 48 10
26 Czech Republic  Chasers 32 8 Belarus Gadgetron 51 46 15 24 56
27 Czech Republic  Spade And Archer 22 9 Belgium Mammoth Pictures 55 26 33 23 a7
28 Czech Republic  Monarch Playing Card Co. 59 10 Belgium Big Kahuna Burger 35 40 50 18 4
29 Czech Republic  Roboto Industries 29 11 Belgium Smith And Co. 43 28 a7 7 5
30 12 Belgium The New Firm 43 57 17 43 23
31 Denmark Praxis Corporation 49 13 Bulgaria Videlectrix 8 24 12 11 2
32 Denmark Acme, Inc. 36 14 Bulgaria Moes Tavern 59 29 17 14 31
33 |Denmark General Products 4 15 Bulgaria Galaxy Corp 32 16 14 7 36
34 Denmark ‘Water And Power 11 16 Bulgaria Burleigh And Stronginthearm 31 7 36 20 8
35 17 Croatia Sombra Corporation 37 37 42 26 15
36 Finland Fake Brothers 49 18 Croatia Qwerty Logistics 30 29 1 21 14
37 [Finland Demo Company 32 19 Croatia Globo-chem 9 19 43 13 40
20 Croatia Spacely Sprockets 8 9 20 1 1
21 | Czech Republic Chasers 32 32 59 44 1
22 | Czech Republic Spade And Archer 22 23 49 5 57
23 |Czech Republic Monarch Playing Card Co. 59 32 34 19 11
24 Czech Republic  Roboto Industries 29 59 27 6 57
25 Denmark Praxis Corporation 49 15 51 14 14
26 Denmark Acme, Inc. 36 a3 a2 57 53
27 Denmark General Products 4 21 49 56 52
28 Denmark Water And Power 1 13 49 57 6
29 Finland Fake Brothers 43 1 2 48 42
30 Finland Demo Company 32 8 a 45 7

Delete all empty columns

This utility removes all completely empty columns on your current worksheet.

Note:

The utility removes all columns without data within the used range in your worksheet.

It does not reduce the number of available columns in your worksheet. For every column
that is removed Excel automatically adds a new empty column at the end.
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Autofit row height (also on merged cells)

This tool adjusts the row height in the selected cells so that you can read or print the entire
content of the cells.

Compared to Excel's built-in "AutoFit Row Height", this tool:

= works on merged cells too.
= ignores data in hidden columns for determining the row height.

In addition to the standard functionality in Excel this tool also adjusts the height properly
on merged cells (where 'wrap text' is set). In Excel itself the auto adjusting of the row height
often doesn't work properly on merged cells.

And unlike Excel itself, this tool adjusts the row height based on the visible cells in the row
only.

Any data in hidden columns in your selection is skipped. Excel's built-in "AutoFit Row
Height" does not exclude hidden columns so the row height is then also based on the
values in hidden columns.

Note:

If you change the contents afterwards, then you need to run this tool again to have the row
height adjusted.

(This it is not a tool that keeps working in the background and keeps adjusting the row
height when the content is changed.)

Al - fe | This tool adjusts the rowheight in the selected cells so
that you can read or print the entire content of the cells. B
=
A B c | o | E F G H 1 i
. 1 [This tool adjusts the rowheight in the selected
2 |In addition to the standard functionality in Excel thil
3 1 2 3 a4 5
4 6 7 8 9 10
5
6
7 B h .
- Al - J~  This tool adjusts the rowheight in the selected cells so
: that you can read or print the entire content of the cells.

[l »[>

= A B c [ b [ E F G H 1
12 This tool adjusts the rowheight in the selected
cells so that you can read or print the entire

| 1 |content of the cells.
In addition to the standard functionality in Excel
[this tool also adjusts the height properly on
merged cells (where 'wrap text' is set). (In Excel
itself the auto adjusting of the row height often
doesn't work properly on merged cells.)

1 2 3 4

6 7 8 9 10

-

T RSN
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Clean data and formatting...

This utility helps you to optimize and clean information that you have copied into Excel.

You can choose the following edits:

= remove all hyperlinks

= trim spaces (removes leading and

trailing spaces)
= remove all cell colors
= remove all font colors
= remove all borders
= unmerge cells
= apply standard font

Your last used settings will be remembered.

apply standard font size

no wrap-text

fix (text)numbers

autofit columns

autofit rows

remove all objects/images from your
worksheet

A B < D E F G H 1 K L
. official
Rank [ P | L e
1 itan t on
. ) 37,
2 1Tokyo  |Japan |Asia 2 2016
B 2|Shanghai | China  |Asia | ASAP Utilities - Clean data and formatting X
__Jonesi| In selected range: AL:F101
3|Jakarta |T— |Asia
4 — a — ¥ Remove all hyperlinks ¥ Apply standard font size
4|Delhi m Asia ¥ Trim spaces [V Mo wrap-text
2 M Remove all cell colors [+ Fix (text)numbers
s 5|Seoul Asia ¥ Remove all font colors [V Autofit columns
| Guangzn - ¥ Remove all borders Maximum width:
7 — W unmerge cels [ Autofit rows
e W Agply standard font Maximum height:
5 Asia
. 1n this worksheet: Before
2 ¥ Remove all objectsfimages
10 Ast2 -
North Cancel ‘ al | Invert ‘ hlone oK
1 America
South .21 242,93
12 mca 9 S
A B C D E F G
1 |Rank Metropolitan ‘Country Continent | Official population Year
2 1 Tokyo Japan Asia 37,832,892 2016
3 2 shanghai China Asia 34,865,252 2015
4 3 Jakarta Indonesia Asia 31,689,592 2015
5) 4 Delhi India Asia 26,454,000 2011
6 5 Seoul South Korea Asia 25,514,000 2016
7 6 Guangzhou China Asia 25,000,000 2015
8 7 Beijing China Asia 24,900,000 2015
9 8 Manila Philippines Asia 24,650,000 2018
10 9 Shenzhen China Asia 23,300,000 2015
n 10 Mexico City Mexico North America 21,650,668 2017
12 11 S&o Paulo Brazil South America 21,242,939 2016
13 12 Lagos Nigeria Africa 21,000,000 2014
14 13 Mumbai India Asia 20,748,395 2011
15 14 Cairo Egypt Africa 20,500,000 2012
16 15 New York City United States North America 20,320,876 2017
17 16 Keihanshin (Kyoto-Osaka-Kobe) Japan Asia 19,342,000 2010
18 17 Wuhan China Asia 19,000,000 2015
1ol a2 chanadn rhina Acia 12 100 nnn | 2015
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Drawing paper...

This tool allows you to specify the column width and row height of your cells in
centimeters, inches or pixels.

This is helpful if you use the Excel for drawing purposes, such as creating a flowchart or
when you design your garden or need to create a floor plan.

It can also be handy for quickly creating square cells.

Note:

Due to limitations of how precise you can set the width and height in Excel the actual width
and height might differ a tenth of a centimeter/inch.

The dimensions in pixels depend on your Windows display DPI settings.

Example screenshot: 1
A B © D E F G H | J K L Il M a

ASAP Utilities - Drawing paper

Updats the width and height of all cells on your workshest

3 Column width; 1 centimeters
Row height: 1 centimeters
4
Unit of measurement
5 & Centimeters " Inches " Pixels

[
Close

Example screenshot: 2
A B C|IDIE|F|G H J K L hl

1
2
3
|4 |
|5 . 5
g ASAP Utilities - Drawing paper
7 Updats the width and height of the selscted cells
=] Calumn width: 25 pizels
=] Row height: 25 pixels
10 Unit of measurement
11 " Centimeters  Inches % Pixels
12
13
14

Close oK
15

17
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Transpose column in multiple steps...

Transposes data from one column to several columns in steps.
Useful when you have to deal with a large amount of data in one column and have to

transpose every X rows.

Formulas and formatting will be preserved.

Example screenshot: Transpose column in multiple steps

A B C D E F G |
1 |Country
2 |Company - ~
3 2011 | ASAP Utilities - Transpase column in multiple steps
2 - several columns in steps. B
e e oo o ot oz oo
I @ve to transpose every X rows. 207 1205 209
% ai T4 a0 A1 412
10| 14| Selected range: AL:AG01
11 |Austria
12 fvirtucon === I
13| 59
14| 30
15 . el |
EAustria L
| 17 |Forge And Foundry
18| 37|
19| 10
El 2 P
21 |Belarus y
| 22 |Lexcorp y
23] 3
24| 51
25 8l
A B C D E G
1 |Count _Cumpsny 2011 2012 2013
2 Austria Luthorcorp 2 31 14
3 Austria Virtucon 59 30 37
4 Austria Forge And Foundry 37 10 42
5 Belarus Lexcorp 3 51 8
6 Belarus Zevo Toys 20 11 13
7 |Belgium Initech 10 15 17
8 Belgium Gadgetron 51 46 15
9 Belgium Mammoth Pictures 55 26 33
10 Belgium Big Kahuna Burger 35 40 50
11 |Bulgaria Smith And Co. 43 28 47
12 Bulgaria The New Firm 43 57 17
13 Croatia idelectri 8 24 12

Split long columns in order to save paper while printing.

i
ASAP Utilities - Split columns to a new worksheet

Range to split:

atAsoo - |

Number of rows in each column:
Mumber of columns on each page:
Insert page breaks between sets:

Copy cell-formatting: ™2

oK
ncel

_—
[ 4”3
7

This utility splits the columns to a new worksheet so that mare
information can be printed on a page.
This can save a lot of paper.

124
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Put together rows or columns from several sheets...

This utility will copy the specified columns or rows from each selected sheet, and combines
them into a new sheet.

You can for example put the data from F of each selected worksheet side by side on a new
worksheet.

Usage:
1. Select the desired worksheets from which you want to combine the data.
2. Start this utility and then select the column(s) or row(s) you wish to put together.

If you choose the option "Create dynamic links (cell references)", the new worksheet will
contain formulas with a cell reference to the original data. If you choose this option the
display of zero values on the new worksheet will be turned off. The display of zero values is
an Excel worksheet setting which you can also control with the "Vision Control" utility in
ASAP Utilities.

Example screenshot: Put together rows or columns from several sheets

ASAP Utilities - Put together rows or columns from several sheets *
Worksheets Put side by side or below each other on a new worksheet:
Vienna £ Tie vertically (I[) b
Dublin
New York 2 J Cancel
(= J  Last Colum
T
Copenhagen
Minsk {+ Tile horizontally (=)
Prague
™ Rows: J
& Rows: 2 - |:Lestrow

(" Entire sheet

Values or cell references:

{% Copy the values

al D ‘ S " Create dynamic links (cell references)

Copy the data in the spedified columns or rows from each of the 9 selected sheets, and put the data together on a new worksheet,
‘You can for example put the data from F of each selected worksheet side by side on a new worksheet,

20 Delete unused empty ending rows/columns

This utility will remove all empty unused rows and columns at the right and bottom of your
data range.
It is useful when the "Reset Excel's last cell" tool from ASAP Utilities can't reset the last cell.

You can use this utility when the end of your worksheet is (far) below or to the right of the
actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes
you to a blank cell below or to the right of the actual data.
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Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part
of each worksheet that is in use, meaning the section that contains data or formatting.
Sometimes the last cell of a worksheet may be beyond the range of your actual used data.
This issue may cause you to have a larger file size than necessary, you may print extra
pages, you may receive "Out of Memory" error messages, or you may experience other
unusual behavior. Clearing the excess rows and columns to reset the last cell can help to
resolve these issues.

You can locate the last cell of the active worksheet by pressing CTRL+END.".

Example screenshot: 1 Before

o B R
o @ =F =

Hdo-

i- 2= 0040 - Delete unused empty ending rows and columnsaxsx [Group] - Microsoft Excel

Insert Page Layout Formulas Data Review View ASAP Utilities

s

Favarites &

Favorites

Vision Select

Shortcut keys ~ | Control -

[ sheets + ] Columns & Rows ~

[#] Range = [ Objects & Comments = | A Text ~

L{gﬁ.Format -

=i Fill ~

) Numbers & Dates = €5 web -

J Formulas =

Time saving tools

1% mport -

| nformation ~ @] Export ~
[y File & System ~ b Start =

[%f ASAP Utilities Options =

B Find and run a utility

Start last tool again
Options and settings

@ Online FAQ

@0

‘7 Registered version
Info and help

KFD1048576 -
XEQ

I v
XET XEU

XER XES XEV XEW XEX XEY XEZ XFA XFB XFC XFD -
1
1048553
1048554
1048555
1048556
1048557
1048558
1048559
1048560 k-
1048561
1048562
1048563
1048564
1048565
1048566
1048567
1048568
1048563
1048570
1048571
1048572
1048573
1048574
1048575
1048576

M4 F M| 0L
Ready |

[

ASAP Utilities - Delete unused empty ending rows/columns

% Do you want to remove all unused empty rows and columns at the end
P of each selected worksheet?

4[]

02 03 05 /06

L] »

|[E=Em 100 (=) [} (+)
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Example screenshot: 2 After

P[.j\ =] - 2y | 0040 - Delete unused empty ending rows and columns.dsx [Group] - Microsoft Excel B T)
Home Insert Page Layout Formulas Data Review View ASAP Utilities & e = B £
", (5] [Edsheets » I Columns & Rows ~ (B} Numbers & Dates + §% Web ~ Emport - B ASAP Utilities Options = & Online FAQ
A ] Range ~ | Objects & Comments ~ |A|Text - & Information - @] Export ~ | b Find and run a utility @ mio
Favorites & Vision Select
Shorteut keys ~ | Control  ~ =i Fill~  [E Format ~ Jfe Formulas = [l File & System = p Start~ | [ Start last tool again § Registered version
Favorites Time saving tools Options and settings Info and help
K67 - fe| 714 -
A B C D E F G H 1 J K L M =
44 Osato Chemicals 242 381 120 878 330 110 983 478 861 278
45 Petrox Oil Company 457 758 256 211 652 659 547 539 731 437
46 Plow King 331 268 71 949 14 63 643 261 125 592
47 Primatech 627 385 801 411 765 834 452 63 937 94
48 Roxxen 277 639 616 355 37z 417 245 206 480 7
49 sample, inc 573 160 354 712 366 246 232 733 256 860
50 Sixty Second Avenue 460 195 304 938 242 797 501 807 971 588
51 Smith and Co. 213 928 317 633 335 695 131 939 220 781
52 Springshield 891 542 375 919 678 243 536 183 604 288
53 sto Plains Holdings 884 169 543 359 439 437 212 677 843 148
54 strickland Propane 387 958 384 59 602 974 979 419 391 770
55 Taco Grande 213 683 115 283 835 743 596 776 634 22
56 The Frying Dutchman 4 581 106 827 620 953 386 680
57 The New Firm 609 719 439 963 775 995 773 559
58 Three Waters 908 15 127 372 709 228 421 276
59 Thrift Bank 592 995 705 343 887 60 487, 780
60 Tip Top Cafe 841 717 97 338 458 735 259 . 563
61 Universal Export 21 301 932 643 928 345 675 325
62 Videlectrix 835 398 118 4 950 249 460 154
63 Virtucon 86 856 142 547 133 970 687 413
64 Wayne Enterprises 440 986 748 903 190 806 573 302
65 Widget Corp 26 123 943 656 788 261 460 542
66 Zevo Toys 18 162 235 1 697 863 586 725
Ezﬁfmrp 37 83 721 187 683 481 764 123
W [0l 02 03,04 05,06 %] [T« il ] >
Ready | | [EH|E 1003 (=) [} (+)

Reset Excel's last cell

This utility causes Excel to recognize the last used cell in your worksheet correct again.
You can use this utility when the end of your worksheet is (far) below or to the right of the
actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes
you to a blank cell below or to the right of the actual data.

Two indications that Excel doesn't recognize the last cell correctly are:
1. The end of your worksheet is (far) below or to the right of the actual range that is in use.
2. The scrollbars are very small but you don't have that much data.

Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part
of each worksheet that is in use, meaning the section that contains data or formatting.
Sometimes the last cell of a worksheet may be beyond the range of your actual used data.
This issue may cause you to have a larger file size than necessary, you may print extra
pages, you may receive "Out of Memory" error messages, or you may experience other
unusual behavior. Clearing the excess rows and columns to reset the last cell can help to
resolve these issues.

You can locate the last cell of the active worksheet by pressing CTRL+END".

By default this utility can be used with the shortcut Ctrl+Alt+R.
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A B 9 D E F

42287

42288

42289 ” ‘
42290 ASAP Utilities - Reset Excel's last cell u
42291

Fish Excel's last cell has been reset so that Excel recognizes the real last used
42293 cell again.

42294 The last used row has been reduced from row 42301 to row &7.
42295, The last used celumn has been reduced frem celumn H to column F.
42296

42297

42298

42299

42300

42301

42302

42303
(144 » ] Example /37

Ready |

Company [-1[Tr-01 [~[TR-02 [-[TR03 [~[TR-04 [~[TR-05 |~ ]

52 |SpringShield 39 75

53 Sto Plains Holdings 61 15 67 69

54 strickland Propane 13 45 42 66 27

55 Taco Grande 24 33 30 41 30

56 The Frying Dutchman

57 |The New Firm 36 42 46 65 75

58 Three Waters

59 | Thrift Bank

60 Tip Top Cafe 37 81 63 83

61 Universal Export

62 |Videlectrix 67 18 12 67 a0

63 Virtucon 25 19 12 11 20

64 |Wayne Enterprises

65 Widget Corp

66 Zevo Toys 53 53 13 59 14

67 |ziffcorp |

68
|14+ v v Example <¥J 41

Ready |
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Objects & Comments

A collection of tools for objects and comments.

Comment tools...

This is a collection of tools that can help you with cell comments.

Extract/report content of comments

= Place the value of the comment cell right next to the comment
= Create report in new workbook
(sheet name - cell address - range name - cell value - author - comment value)

Position and size of comments

You can do the following on the current worksheet or all worksheets in your workbook:

= Reset all comments to their original position
= Autofit/resize all comments

Set font and font size for comments

You can change the font and font size for all comments on the current worksheet or on all
worksheets in your workbook.

Search and replace in comments

You can replace text in all comments on the current worksheet or on all worksheets in your
workbook.

Note:
If you want to get the text from a comment into a cell you can also use the ASAP Utilities
worksheet formula =ASAPGETCOMMENT().

ASAP Utilities - Comment tools

Extract/report content of comments

¥ Place the value of the comment cell right next to the comment (on the entire sheet)

" Create report in new workbook
(sheet name - cell address - range name - cell value - author - comment value)

Position and size of comments
where:

[ Reset all comments to their original position
€ an= e ¥ this worksheet ok

I Autofitjresize all comments " all worksheets

Set font and font size for comments

where:
don't change [ dontche~] | & this worksheet oK

" all worksheets

Search and replace in comments
where:

old value:

(% this worksheet o
new value:

" &l worksheets

Close
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Add cell's value or formula to comment...

This tool adds the cell's value or formula as comment.

You can choose to add new comments, replace existing comments or add the cell's value at

the beginning or the end of an existing comment.

You can also specify to read the value of a cell to the left or right and use that value or
formula as comment.

ASAP Utilities - Use a cell's content as comment

Legacy Comments/Notes only {not threaded comments):
1. Use the cells:

* value " Eormula

2. Use the content of:
(¢ The cellitself

" & cell right from current cell 1 column(s) to th >
" Acellleft from current cell 1 column(s) to th >

3. If the cell already has a comment:

% Replace comment
" Place the cel's content at the beginning

" Place the cell's content at the end

4. Options

¥ Add/use username Bastien Mensink.

™ Reset comment to its original position

¥ Autofitjresize comment

5. For all cells with comments, show: (Excel Setting!)

" No comments or indicators

% Indicators only, and comments on hover (Current Excel setting)

" Comments and indicators

Cancel
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Select all objects on current worksheet

This utility selects all objects on your current worksheet.

These objects are for example shapes, text boxes, pictures, wordart, clip art, charts, forms

toolbar controls, control toolbox controls, etcetera.

A B|C|D|E|F|G|H|IT|J|K|L|M|N|O
1 A, B. C D E F. G. H I ). K L. M. N.
2 W01 41 66 17 30 50 17 94 15 g8 93 65 89 53 106
3 W02 82 22 83 60 60 15 95 69 49 61 7 3 78 149
4 W03 57 10 9 99 64 33 44 40 62 3 3% 88 35 113
5 woa 25 7 97 66 97 14 75 35 3 61 11 96 94 80
6 W05 20 20 90 62 13 10 95 22 31 58 6 11 52 14
7 W06 25 45 94 44 32 32 73 27 52 68 4 71 4 8
8 W07 94 66 86 9 100 97 70 8 38 91 30 66 20 134
9 W08 99 13 63 36 81 67 50 98 89 11 6 28 25 11
10 W09 38 42 72 66 76 49 79 66 6 37 34 43 38 385
1" W10 33 1 18 64 17 98 58 11 30 32 60 97 91 63
12 W11 65 1 65 7 8 55 62 29 6 93 80 19 60 40
13 wiz 13 4 16 31 81 81 28 10 100 11 72 33 12 356
14 W13 36 62 13 7 66 10 98 90 58 5 8 64 60 29
15 W14 34 82 52 8 67 64 82 36 99 78 73 80 86 88
16 W15 69 8 59 31 53 10 74 44 31 87 3 88 50 25
17
18
19
20
21 Button 10 ‘ Button 11 ‘ Button 12 ‘
22
23

<

A B|CID|E|[F|G|H[I|J|K[L[M|[N]O
1 A B. € D. EE F G H I J K _ L M. N
2 -F% W01 41 66 17 30 50 17 94 15 8 93 65 89 53 106
3 JWo02 82 22 83 60 60 15 95 69 49 61 7 3 78 149
4 JWO03 57 10 96 99 64 33 44 40 62 3 39 8 35 113
5 TWo0a 25 7 97 66 97 14 75 35 54 61 11 96 954 &
6 JWO05 20 20 90 62 13 10 95 22 31 58 6 11 52 14
i SWO06 25 45 94 44 32 32 78 27 52 68 4 71 4 8
8 % W07 94 66 86 9 100 97 70 8 38 91 30 66 20 134
9 SWo08 93 13 63 36 81 67 50 93 89 11 6 28 25 11
10 SWO09 38 42 72 66 76 49 79 66 6 37 34 43 38 85
1 % W10 33 1 18 64 17 958 58 11 30 32 60 97 91 68
12 % W11 65 1 65 7 8 55 62 29 6 93 80 19 60 400
13 % wi2 13 4 16 31 81 81 283 10 100 11 72 33 12 56
14 % W13 36 62 13 7 66 10 93 90 538 5 82 64 60 89
15 Fﬁ w14 34 82 352 8 67 ©64 82 356 99 78 78 80 86 88
16 g% Wi1s 69 g 59 31 53 10 74 44 31 &7 3 8 50 25(]1
17| 99
18 Ail N
19 2}

Available tools
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Delete all objects in selected worksheets

This utility removes all objects on your current worksheet.

The objects that will be deleted are for example shapes, text boxes, pictures, wordart, clip

art, charts, forms toolbar controls, control toolbox controls, etcetera.

A B|C|D|E|F|G|H|IT|J|K|L|M|N|O

1 A, B. C D EE. F. G. H I ). K. L. M. N.
2 W01 41 66 17 30 50 17 94 15 8 99 65 89 53 106
3 W02 82 22 8 60 60 15 95 69 43 61 7 3 78 149
4 W03 57 10 9 99 64 33 44 40 62 3 39 88 35 113
5 woa 25 7 97 66 97 14 75 35 5 61 11 9% 94 80
6 W05 20 20 90 62 13 10 95 22 31 58 6 11 52 14
7 W06 25 45 94 44 32 32 78 27 52 68 4 71 4 8
8 W07 94 66 86 9 100 97 70 8 38 91 30 66 20 134
9 W08 99 13 63 36 81 67 50 98 89 11 6 28 25 11
10 W09 38 42 72 66 76 49 79 66 6 37 34 43 38 &5
1" ‘W10 33 1 18 64 17 98 58 11 30 32 60 97 91 63
12 Wi11 65 1 65 7 8 55 62 29 6 93 80 19 60 40
13 w1z 13 4 16 31 81 81 28 10 100 11 72 33 12 36
14 Wiz 36 62 13 7 66 10 98 90 58 5 8 64 60 &9
15 Wwi4 34 82 52 8 67 64 82 36 99 78 73 80 86 88
16 W15 69 8 5 31 53 10 74 44 31 87 3 BB 50 25
17

18

19

20

21 Button 10 Button 11 Button 12

22

23

A B|C|D|E|F|G|H|IT|J|K|L|M|N|O

1 A. B. C. D E. F. G. H. I ). K. L. M. N.
2 W01 41 66 17 30 50 17 94 15 8 99 65 89 53 106
3 W02 82 22 8 60 60 15 95 69 43 61 7 3 738 149
4 W03 57 10 9 99 &4 33 44 40 62 3 39 88 35 113
5 woa 25 7 97 66 97 14 75 35 3 61 11 95 94 80
6 W05 20 20 90 62 13 10 9 22 31 58 6 11 52 14
i W06 25 45 94 44 32 32 78 27 52 68 4 71 a4 8
8 W07 94 66 86 9 100 57 70 8 38 91 30 66 20 134
9 W08 99 13 63 36 81 67 50 98 89 11 6 28 25 11
10 W09 38 42 72 66 76 49 79 66 6 37 34 43 38 &
1 W10 33 1 18 64 17 98 58 11 30 32 60 97 951 68
12 W11 65 1 65 7 8 55 62 29 6 93 80 19 60 40
13 wiz 13 4 16 31 81 81 28 10 100 11 72 33 12 56
14 W1z 36 62 13 7 66 10 98 90 58 5 8 64 60 &9
18 W14 34 82 52 8 67 64 82 36 939 78 73 80 86 88
16 W15 69 8 5 31 53 10 74 44 31 87 3 BB 50 25
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Delete all buttons on selected worksheets

This utility removes all buttons that are created via the forms toolbar from the selected

worksheets.
A B C D E F G H | J K L M| N O B

1 A. B C. D E F. G. H I ). K. L. M. N.
2 Wo1 41 66 17 30 50 17 94 15 & 99 65 B89 53 106
3 Wo2 82 22 83 60 60 15 95 69 49 61 7 3 78 149
4 W03 57 10 95 99 64 33 44 40 62 3 39 8 35 113
5 woa 25 7 97 66 97 14 75 35 54 61 11 96 954 80
6 W05 20 20 90 62 13 10 95 22 31 58 6 11 52 14
i W06 25 45 94 44 32 32 78 27 52 68 4 71 4 8
8 W07 94 66 86 9 100 97 70 8 38 91 30 66 20 134
9 W08 99 12 63 36 81 67 50 93 83 11 6 28 25 11
10 W09 38 42 72 66 76 439 79 66 6 37 34 43 38 385
" wio 33 1 18 64 17 9 58 11 30 32 60 97 51 68
12 W11 65 1 65 7 8 55 62 29 6 93 80 19 60 40
13 wi2 13 4 16 31 81 81 28 10 100 11 72 33 12 356
14 W13 36 62 13 7 66 10 93 S0 538 5 8 64 60 389
15 wi4 34 82 52 8 67 ©64 82 56 99 78 78 80 86 88
16 Wi1s 69 & 59 31 53 10 74 44 31 §E7 3 88 50 25
17

18

19

20

2 Button 10 | Button 11 Button 12|

22

23

<
A B|C|D|E|F|G|H|IT|J|K|L|M|N|O P

1 A. B C. D E. F. G. H I ). K. L. M. N.
2 W01 41 e6 17 30 50 17 94 15 € 99 65 89 53 106
3 W02 82 22 83 60 60 15 95 69 49 61 7 3 78 149
4 W03 57 10 9 99 64 33 44 40 62 3 3% 88 35 113
5 woa 25 7 97 66 97 14 75 35 53 61 11 95 94 80
6 W05 20 20 90 62 13 10 95 22 31 58 6 11 52 14
i W06 25 45 94 44 32 32 78 27 52 68 4 71 4 8
8 W07 94 66 86 9 100 97 70 8 38 91 30 66 20 134
9 W08 99 13 63 36 81 67 50 98 83 11 6 28 25 11
10 W09 38 42 72 66 76 49 79 66 6 37 34 43 38 85
11 W10 33 1 18 64 17 98 58 11 30 32 60 97 91 63
12 W11 65 1 65 7 8 55 62 29 6 93 80 19 60 40
13 wiz 13 4 16 31 81 81 28 10 100 11 72 33 12 36
14 W13 36 62 13 7 66 10 98 90 58 5 8 64 60 89
15 W14 34 82 52 8 67 64 82 56 99 78 73 80 36 88
16 W15 69 8 59 31 53 10 74 44 31 &7 3 88 50 25

Resize selected images or OLE objects (%)...

This utility resizes the selected images or OLE objects relatively to their original size.
The utility asks you to give a percentage. Based on this percentage the size is changed in
comparison to the original size (which is 100%).

Remove the border line from selected objects/images

This utility removes all lines from the selected objects, shapes and pictures.

Available tools
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Format

A collection of tools for formatting for data, copy formatting settings etc..

Copy a sheet's page and print settings...

With this tool you can easily copy the page and print settings from a worksheet to other
worksheets.

You can copy the following properties:

= Rows to repeat at top = Row and column headings
= Columns to repeat at left = Gridlines
* Print area Printing quality

= Header left Center on page horizontally
= Header right Orientation

= Footer left Draft quality

= Footer center Paper size

Footer right

Print comments

= Margin left First page number

= Right margin Print in black and white
= Center header Order

®= Top margin Zoom/scaling

Bottom margin
Header margin
Footer margin

Note:

Center on page vertically
Scale to fit page

The speed of this utility might vary, depending on the type of printer(driver) that is set as
default when the tool is executed.

Starting from Excel XP/2002 you can also insert a picture in the header or footer.
Unfortunately, this is something that cannot be copied to other worksheets by using a
macro. So, if you have a picture in the header or footer it will not be copied with this tool in
ASAP Utilities. From the Microsoft website: "The only way to work with pictures in headers
or footers for multiple worksheets is to select all the worksheets, and then insert a graphic
by using the Insert Picture dialog box (click the Insert Picture button), or format the graphic
by using the Format Picture dialog box (click the Format Picture button). The original
graphic file is needed for this procedure."
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3

32
- N
ASAP Utilities - Copy page and print settings
Source worksheet to read from: — Copy the following settings:

3 I Amsterdam LI o = ¥ Center on page horizontally
3 ) | ALE | ¥ Center on page vertically
- Copy to the following worksheets: ¥ Zoom{scaling
A e ¥ Rows to repeat at top ¥ Scale to fit page
y Dubiin ¥ Columns to repeat at left v Margin left
v g, ¥ print area ¥ Right margin

. ¥ Header left ¥ Top margin
4 thlxemnnurg ¥ Center header ¥ Bottom margin

H — ¥ Header right ¥ Header margin

45 ReMion ¥ Eooter left ¥ Eooter margin

4 LR [V Footer center [V Crientation

43 Vienna ¥ Footer right ¥ Draft quality

A8 v Row and column headings ¥ Paper size

IT: v Gridines ¥ Eirst page number

50 ¥ Print comments ¥ Order

5i Al | s | None ¥ Printing quality ¥ Printin black and white
iz

5 Active printer {might affect speed): Cancel

54 | Yerox Phaser 6121MFP#:2 on TPYM:

L

567

M 4 » M| Amsterdam . Copenhagen . Dublin . London . Luxermbourg Minsk _“New York . Prague . Vienna %3
Ready |

Insert workbook's path and name in header, footer or cell...

This utility allows you to put the folder and filename of your workbook into your header,
footer or selected cells.

You can insert the following information in the selected cells:

= Path and filename
= Filename
= Path

The path and filename in the cell are automatically updated when you change the name or
location of your file.

Or you can insert the path and filename into:

= Header left section = Footer left section
= Header center section = Footer center section
= Header right section = Footer right section

The path and filename in the header or footer are automatically updated when the name or
location of your file changes.
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’
ASAP Utilities -

Insert in selected range: B2
+ path and filename

" Flename

" Path

Insert full path and filename of current file in:
" Header left section

" Header center section

" Header right section

" Footer left section

" Footer center section

" Footer right section

Cancel

With Excel 2000 the path and filename in the header or footer is not a dynamic link. If you
change the path and/or name of your document you have to update your header or footer.

The path and file name in the cell are automatically updated.

Empty all headers and footers

This utility removes the contents of all headers and footers in the selected sheets.

Detect and visualize adjacent data/group changes...

With this utility you can easily make the differences visible between groups of cells with the
same content.

You can do the following when the value in a row changes:

insert an empty row.
insert a page break.

insert a border line below group.
alternating colors per group.

You can use this for example to identify different groups of data in your worksheet by
inserting a blank row when the value changes or inserting a line in between.

Your last used settings will be remembered.

Note:

This utility only works on the rows (data) in a single column.
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Example screenshot: 1 Insert an empty row between groups

1
T Austria Luthorcorp 2 31 14 40 36
3 |Austria L £ 4 49
4 |austria ASAP Utilities - Visualize data changes in column - 51
5 |Belarus Range: lm—d 3
6 |Belarus
7 |Belarus [~ Visualize changes with: —————————————————————
8 |Belarus % Empty row(s): 1 1] y
9 |Belgium lﬁ 2 |Austria Luthorcorp 2 36
10 |Belgium £ page break 3 |Austria |Virtucon 59 49
11 |Belgium i Austria General Forge And Foundry 37 10 42 51
-  Border:
12
13 |Bulgaria 5 e Belarus. Lexcorp 3 51 8 55 )
14 |Bulgaria 7 |Belarus Zevo Toys 20 11 13 32 39
15 |Bulgaria & |Belarus Initech 10 15 17 48 10
16 |Bulgaria 9 |Belarus Gadgetron 51 46 15 24 56
17 |Croatia 0
18 |croatia 11 [Belgium Mammoth Pictures 55 26 33 23 a7
19 |croatia v 12 [Belgium Big Kahuna Burger 35 40 50 18 4
20 |croatia 2 13 |Belgium jsmith And Co. 43 28 47 7 5
21 |czech Repu e . 14 |Belgium [The New Firm 43 57 17 a3 2
22 |Czech Repul : - 15
23 |czech Repul ® e T 16 |Bulgaria [Videlectrix 8 24 12 11 2
24 |czech Repul 17 |Bulgaria Moes Tavern 59 29 17 14 31
25 [Denmark cel l?gl 18 [Bulgaria Galaxy Corp 32 16 1 7 36
26 |Denmark 19 |Bulgaria Burleigh And inth 31 7 36 20 8
27 |Denmark 20
28 |Denmark 21 |Croatia [sombra Corporation 37 37 42 26 15
29 |Finland 22 |croatia Qwerty Logistics 30 29 1 21 14
30 |Finland e — 23|Croatia Globo-chem 9 19 43 13 40
31 |Finland Widget Corp 20 | 24 |Croatia Spacely Sprockets 8 9 20 1 1
32 |Finland strickland Propane g |25
33 |France Mainway Toys 34 | 26 |Czech Republic  |Chasers 32 32 59 44 1
34 |France Big T Burgers And Fries a2 | 2T |Czech Repul |Spade And Archer 22 23 49 5 57
28 |Czech Republic Monarch Playing Card Co. 59 32 34 19 11
29 |czech Republic Roboto Industries 29 59 27 6 57
30
31 |Denmark Praxis Corporation 43 15 51 14 14
32 |Denmark JAcme, Inc. 36 43 42 57 53
33 |Denmark General Products 4 21 49 56 52
34 |Denmark [Water And Power 11 13 49 57 6

Example screenshot: 2 Insert a pagebreak between groups

1
7 Austria Lutharcorp 2 31 14 40 36
3 |austria Jus 5 20 a7 sa. a3
4 |Austria ASAP Utilities - Visualize data changes in column - 51
5 |Belarus ,— 9
6 |Belarus anae: AzALzL J 39
7 |Belarus — Visualize changes with:
8 |Belarus © Empty row(s): 1 1
9 |Belgium 2 |Austria Luthorcorp 2 31 14 40 36
10 [Belgium 3 |Austria Virtucon 59 30 37 54 49
11 |Belgium * Page break 4 |Austria General Forge And Foundry 37 10 42 55 51
12 [Belgi " Border: 5 |Belarus Lexcorp 3 51 8 55 9
13 |Bulgaria 6 |Belarus Zevo Toys 20 11 13 32 39
14 |Bulgaria 7 |Belarus Initech 10 15 17 48 10
15 |Bulgaria 8 |Belarus Gadgetron 51 a6 15 24 56
16 |Bulgaria 9 i Mammoth Pictures 55 26 33 23 47
17 |croatia 10 Big Kahuna Burger 35 40 50 18 4
18 |croatia 11 Smith And Co. 43 28 47 7 5
19 |croatia 12 il The New Firm 43 57 17 43 23
20 |croatia 13 [Bulgaria Videlectrix 8 24 12 11 2
21 |czech Republic 14 |Bulgaria Moes Tavern 59 29 17 14 31
22 |czech Republic 15 [Bulgaria Galaxy Corp 32 16 14 7 36
23 |czech Republic 16 |Bulgaria Burleigh And Stronginthearm 31 7 36 20 8
24 |czech Republic 17 |Croatia [Sombra Corporation 37 37 42 26 15
25 18 |Croatia Qwerty Logistics 30 23 1 21 14
26 19 |Croatia Globo-chem El 19 43 13 40
27 20 |Croatia Spacely Sprockets 8 9 20 1 1
28 21 |Czech Republic Chasers 32 32 59 44 1
29 [Finland 22 |Czech Republic Spade And Archer 22 23 49 5 57
30 [Finland 23 |czech Republic h Playing Card Co. 59 32 34 19 11
31 [Finland 24 |czech Republic  |roboto Industries 29 59 27 6 57
32 [Finland strickland Propane 25 |Denmark Praxis Corporation 49 15 51 14 14
33 |France Mainway Toys 34 26 |Denmark Acme, Inc. 36 43 42 57 53
34 |France Big T Burgers And Fries 43 27 |Denmark General Products 4 21 43 56 52
28 |Denmark [Water And Power 11 13 43 57 6
29 |Finland Fake Brothers 49 1 2 43 42
30 [Finland Demo Company 32 8 a 45 7
31 [Finland \widget Corp 2 51 11 4 23
32 |Finland i d Propane 8 6 10 4 19
33 |France Mainway Toys 34 6 4 19 27
34 |France Big T Burgers And Fries 42 50 29 53 55
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Example screenshot: 3 Insert a border line between groups

1 1] E12005 Bd2006 B2007 B 2008
2 |Austria Luthorcorp 2 31 14 40 36
3 |Austria Lusi sa a0 2z 54 49
4 |Austria ASAP Utilities - Visualize data changes in column . 55 51
5 [Belarus l— 55 9
6 [Belarus et AzALzL J 32 39
7 |Belarus [ Visualize changes with:
8 [Belarus € Empty row(s): hE
9 [Belgium T = 2 Luthorcorp
10 [Belgium  Page breck 3 C Virtucon
11 [Belgium 4 |Austria General Forge And Foundry
12 i & Border: 5 [Belarus Lexcorp 3 51 8 55 9
13 |Bulgaria Style: Thidmess: 6 [Belarus zevo Toys 20 11 13 32 39
14 |Bulgaria  Hairine 7 [Belarus Initech 10 15 17 a3 10
15 |Bulgaria e = rf;Thin & [Belarus Gadgetron 51 45 15 24 56
16 [Bulgaria P - MT:;:M 9 [Belgium Mammoth Pictures 55 26 33 23 47
17 |croatia 10 |Belgium Big Kahuna Burger 35 10 50 18 a
18 |croatia 11 |Belgium |smith And Ca. a3 28 a7 7 5
19 [croatia 12 |Belgium [The New Firm 43 57 17 43 23
20 |Croatia 13 |Bulgaria |Videlectrix 8 24 12 11 2
21 |Czech Rej g ﬁ:z::J::ﬁ::rg:mmt'agm) 14 |Bulgaria Moes Tavern 59 29 17 14 31
22 |czech Rey - 15 [Bulgaria Galaxy Corp 32 16 14 7 36
23 |czech Rey ( Alternating color per grou: 16 |Bulgaria Burleigh And Stronginthearm 31 7 36 20 8
24 |Czech Rey 17 |Croatia [Sombra Corporation 37 37 42 26 15
25 [Denmark 18 |Croatia Qwerty Logistics 30 29 1 21 14
26 |Denmark 19 |Croa Globo-chem 3 13 43 13 40
27 [Denmark 20 |Croatia |Spacely Sprockets 3 9 20 1 1
28 |Denmark 21 |Czech Republic Chasers 32 32 59 a4 1
29 |Finland 22 |Czech i |Spade And Archer 22 23 a9 5 57
30 |Finland = 23 [Czech Monarch Playing Card Co. 59 32 34 19 11
31 |Finland 24 |Czech Roboto Ind 23 59 27 6 57
32 |Finland strickland Propane 25 |Denmark Praxis Corporation 43 15 51 14 14
33 |France Mainway Toys 34 26 |Denmark jAcme, Inc. 36 43 42 57 53
34 |France Big T Burgers And Fries 43 27 |Denmark General Products 4 21 49 56 52
28 |Denmark [Water And Power 11 13 49 57 6
29 |Finland Fake Brothers 49 1 2 48 42
30 |Finland Demo Company 32 8 4 a5 7
31 |Finland |Widget Corp 22 51 11 a 23
32 |Finland |Strickland Propane 8 6 10 a4 19
33 |France Toys 34 6 4 19 27
34 |France. Riz T Bureers And Frie a3 50 29 53 55

Example screenshot: 4 Color banding per group

11 B 2005 B 2006 Ed2007 Ed200s Ed2000 E
2 |Austria Luthorcorp 2 31 14 40 36
3 |Austria 58, 20 27 54 49
4 |Austria ASAP Utilities - Visualize data changes in column - 55 51
5 |Belarus ,— 55 9
6 |Belarus fanas: AzALZL J
7 |Belarus [ Visualize changes with: 1
8 [Belarus " Empty row(s): T (Austria Lutharcorp 2 14 40 36
9 |Belgium 3 |Austria [Virtucon 39 30 37 54 49
10 |Belgium £\ Page breck 4 |Austria General Forge And Foundry 37 10 42 55 51
11 |Belgium | 5 Lexcorp 3 1 8 35 £l
12 | W 6 zevo Toys 20 1 13 32 9
13 [Bulgaria || 7 Initech 10 15 17 48 10
14 [Bulgaria || 3 Gadgetron 51 46 15 24 56
15 [Bulgaria 9 [Mammoth Pictures 55 26 33 23 47
16 [Bulgaria 10 |Bel, Big Kahuna Burger 35 40 50 18 4
17 |Croatia 1" | [Smith And Co. 43 28 47 7 5
18 |Croatia | 12 |Belgium [The New Firm 43 57 17 43 23
19 |croatia || 13 videlectrix E 24 12 1 2
20 [croatia || 14 Moes Tavern 59 29 17 14 31
21 |czech rep 15 Galaxy Corp 32 16 14 7 36
22 |czech Repi 18 Burleigh And i m 31 7 36 20 8
23 |czech Repill | & wjernating color per araup: 17 |Croatia [sombra Corporation 37 37 42 26 15
24 [Czech Reps 18 |Croatia [Qwerty Logistics 30 29 1 21 14
25 [Denmark o ehs l?gl 19 |croatia Globo-chem 9 19 43 13 40
26 |Denmark I [V Remove existing colors 20 |Croatia [Spacely Sprockets 8 9 20 1 1
27 |Denmark | £ Color column A:I (current region) i [Chasers 32 32 59 44 1
28 [Denmark 22 [Spade And Archer 22 23 43 5 57
= {f 1 Color entire row =
29 |Finland || 23 Monarch Playing Card Co. 59 32 4 19 11
30 [Finland || — 24 Robote 2 59 27 6 57
31 [Finland idget Corp 25 k Praxis Corporation 49 15 51 14 14
32 |Finland Strickland Propane 8126 k |Acme, Inc. 36 43 42 57 53
33 [France Mainway Toys 3427 k General Products 4 21 49 56 52
34 [France Big T Burgers And Fries 42 28 |Denmark [water And Power 11 13 43 57 6
Fake Brothers 43 1 2 48 42
Demo Company 32 3 4 45 7
[Widget Corp 22 51 11 4 23
Propane 8 6 10 4 19
33 |France Mainway Toys 34 6 4 19 27
34 |France IBigTBurgsrsAnd Fries 42 50 29 53 55
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5 Transpose column in multiple steps...
Transposes data from one column to several columns in steps.
Useful when you have to deal with a large amount of data in one column and have to
transpose every X rows.

Formulas and formatting will be preserved.

Example screenshot: Transpose column in multiple steps

A B C D E F G H |
1 [Country
2 |Company . ~
3 2011 | A54P Utilities - Transpase column in multiple steps
[ - several columns in steps. B
7 Ttomsorp o oo o e bt oz 00
I @ve to transpose every X rows. 207 203 200
% ; T4 a0 a1 412
10| 14| Selected range: AL:AG01
11 |Austria
12 |virtucon =
13 ] 59)
14| 30
15 . el |
EAustria \
17 |Forge And Foundry
18 | 37|
19| 10
20 2 p
21 [Belarus y
22 |Lexcorp y
| 23 | 3
24| 51
25 8l
A B c D E F G
1 |Count _Cumpsny 2011 2012 2013
2 Austria Luthorcorp 2 31 14
3 Austria Virtucon 59 30 37
4 Austria Forge And Foundry 37 10 42
5 Belarus Lexcorp 3 51 8
6 Belarus Zevo Toys 20 11 13
7 |Belgium Initech 10 15 17
8 Belgium Gadgetron 51 46 15
9 Belgium Mammoth Pictures 55 26 33
10 Belgium Big Kahuna Burger 33 40 50
11 Bulgaria Smith And Co. 43 28 47
12 Bulgaria The New Firm a3 57 17
13 Croatia idelectri 8 24 12

6 The paper saver (split columns)...

Split long columns in order to save paper while printing.

ASAP Utilities - Split columns to a new worksheet

Range to splt: e J = |
Number of rows in each column: 50
Cancel
Number of columns on each page: [ =
2

Insert page breaks between sets:

Copy cell-formatting: I~

This utility splits the columns to a new worksheet so that more
information can be printed on a page.
This can save a lot of paper.
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Wrap text

This utility will wrap the text in the selected cells.
This will display long text or text with a manual line break in multiple lines in the cell.

Unwrap text

This utility will unwrap the text in the selected cells.
This will display long text or text with a manual line break on a single line in the cells.

Drawing paper...

This tool allows you to specify the column width and row height of your cells in
centimeters, inches or pixels.

This is helpful if you use the Excel for drawing purposes, such as creating a flowchart or
when you design your garden or need to create a floor plan.

It can also be handy for quickly creating square cells.

Note:

Due to limitations of how precise you can set the width and height in Excel the actual width
and height might differ a tenth of a centimeter/inch.

The dimensions in pixels depend on your Windows display DPI settings.

Example screenshot: 1

A E C D E F G H J K L h il (8]
1 ~

ASAP Utilities - Drawing paper

2 Update the width and height of all cells on your worksheset

3 Column width: 1 centimeters
Row height: 1 cenkimeters
I3
Unit of measurement
5 (% Centimeters ™ Inches ™ pixels

g
Closs

Example screenshot: 2

Unit of measurement

" Centimeters " Inches * pixels

A B C/D EF|G H J K L ]
1
2
3
|4
|5 ’
5 ASAP Utilities - Drawing paper
7 Update the width and height of the selected cells
g Calumn width: 25 pixels
E Row height: 75 pixels
10
il
12
13
14

Closs oK
15

16
17
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Place a border around each page

This utility places a border around each page on your worksheet.
The utility asks you up-front if you want to remove all existing borders first.

Delete all borders inside selection

This utility removes all borders between the cells in your selection.
Only the borders that possibly exist at the outer border of your selection will remain.

Use a significant number of decimals...

This utility changes the number format in your cells to show a significant number of
decimals.

The difference between this utility and general rounding is that it ignores the zeros that
come directly after the decimal separator.

For example if you enter the number 3, then the cells will be formatted to show at least 3
decimals, other than zero.

A cell with the value "12.0123123" is then shown as "12.0123" instead of "12.012".

A cell with the value "12.00002134" is then shown as "12.0000213" instead of “12.000".

Subscript the numbers in Chemical Formulas

This will subscript the numbers in chemical notations such as CSH10N402, Al(OH)3, AIF6Li3,
AlO2, AI(NO3)3, Au2(Se04)3, Ca(V04)2, H6TeO6, KAIMg3Si3012H2, Ca(NO3)2 - 4H20, etc.

It turns it into CgH1oN4O-, A|(OH)3, AlFsLis, AlO, A|(NO3)3, AUz(SEO4)3, Ca(VO4)2, HeTeOs,
KAlMggsigolez, CH(NOa)z . 4H20, etc.

This tool automatically detects which numbers should be formatted as subscript.

N

A B A B
| r— | p——
2 |csHiona02 2 [cHooN.0;
3 |aljoR)3 3 |Al[OH),
4 |alFsLi3 4 |AIF L,
s |aloz2 5 |alo,
6 |al{NO3)3 6 |al{NO;);
7 |Au2(se04)3 7 |Auy(Se0y)s
3 |ca{voa)2 8 [ca(vO,),
5 |HeTe0s 9 |HTe0,
10 |KAIMg35i3012H2 10 |KAIMg,5i,0,,H,
11 |ca(NO3)2 - 4H20 11 |Ca(NOy), - 4H,0
12 |cu(NO3)2 - 3H20 12 |Cu(NGs), - 3H,0
13 |Hg(Br03)2 - 2420 13 |Hg(Broy), - 2H,0
14 14
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Unmerge cells in selection

This utility will unmerge all cells in your selection.

In Excel XP and newer versions you can also click again on the "Merge and center" button
to unmerge the cells. The advantage of this tool ASAP Utilities is also that you can assign
your own shortcut to this action.

Center across selection (without merging)

This utility centers the values horizontally across the selected empty cells to the right.
It looks the same as when you merge the cells but it doesn't merge the cell contents nor
has the disadvantages of merged cells.

You can also do this in Excel via the cell properties. Right-click on the cell and choose
"Format Cells", select the "Alignment" tab and set the horizontal alignment to "Center
Across Selection".

Clean data and formatting...

This utility helps you to optimize and clean information that you have copied into Excel.

You can choose the following edits:

remove all hyperlinks

trim spaces (removes leading and trailing
spaces)

remove all cell colors

remove all font colors

remove all borders

unmerge cells

apply standard font

Your last used settings will be remembered.

apply standard font size

no wrap-text

fix (text)numbers

autofit columns

autofit rows

remove all objects/images from your
worksheet

142
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- =~

ASAP Utilities - Clean data and formatting

In selected range: A1:N51

[v Remove al hyperlinks W Apply standard font size
[v Trim spaces W Mo wrap-text

[v Remove al cell colors W Fix (text)numbers

[v Remove al font colors W Autofit columns

[v Remove all borders Maximum width:

v Unmerge cells W Autofit rows

[v apply standard font Maximum height:

In this worksheet: Sheetl (2)

[v Remove all objectsfimages

Cancel all ‘ Inverse ‘ Mone ‘

17 Remove all unused styles on every sheet

This utility removes all unused styles from every worksheet in your workbook.
In most of the times this fixes the problems when you get the message "Too Many Different
Cell Formats" in Excel.

What this message means is explained by Microsoft:
You receive a "Too many different cell formats" error message in Excel.
This problem occurs when the workbook contains more than approximately 4000 different
combinations of cell formats. A combination is defined as a unique set of formatting
elements that are applied to a cell. A combination includes all font formatting (for example:
typeface, font size, italic, bold, and underline), borders (for example: location, weight, and
color), cell patterns, number formatting, alignment, and cell protection.
Source: https://support.microsoft.com/kb/q213904/
N/~

/

T ASAP Utilities - Remove all unused styles on every sheet

$ 6153 78 8 65 $ 29§ 125 % 49 8 14

- aie e PPNRRPY an e

27

30
w—\/\: Do you want to remove the unused styles in all worksheets?
\/\/ 54
'\/\, } 26
/\/Q [ b
I™ iso remove unused but-n Excel styies

'\/\/\/ i H T 7 ] T an$ 102
‘/\./ S 61 % 788 [ 29 : & 125 : % 49 : § 14 ¢

| ASAP Utilities - Remove all unused styles on every sheet P
_\/\/ $ | s 27

b | There were 55 styles available in your workbook 0130.xsb.
/\—/ 5 o only 53 are in use. g 30 ¢
/\/\ | The following 2 styles were not in use and have been F

s 1 removed: s 54
~ Expenses fill

J - Cost of Sales fill L_
/\/ ] 3 s 26 ¢
Wi | .
\/\/s 18:s 11§ 30 S 95 625 395 102 ¢
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10:52:00 21-04-2022 2.000 HR 3.00
ASAP Utilities - Remove all unused styles on every sheet X

Problematic file with to many styles.xlsb

a There were 62871 styles available in your workbook 0130 -
Only 48 are in use,

The following 62823 styles were nat in use and have been
removed:

- Warning Text 4
- Warning Text 3
- Warning Text 2
-Total 4
-Total 3

~Total 2
-Title 4

-Title 3

~Title 2
-Percent95
-Percent 94
-Percent933

-Percent323
~Percent 922
-~ Percent 92
-Percent 9
~Percent 89

-Percent 863
~Percent 862

LLeuos srvscuze s Ay

Remove all validations in selected cells
This utility removes all validation-settings in the selected cells.

In Excel you can only do this on one sheet at a time.
With this utility you can now quickly do this on multiple sheets at once.

Remove all conditional formatting in selection

This utility removes all conditional formatting in the selected cells.Replace conditional
formatting with static formatting in selection

This tool replaces the conditional formatting in the selected cells with regular (static)
formatting.

The formatting, that has been applied via conditional formatting rules (number, font,
border and fill) is verified and then applied as regular (static) formatting.

The conditional formatting rules are then removed, but not the effects.

A practical example:

'We work a lot with conditional formatting, but our client wants us to "freeze" the format
(which means no more use of conditional formatting...) in order to have a classical Excel
format (mainly cell and font colors). The idea is to do the same thing as we can do with
formulas or calculations "copy > paste as values" but for conditional formatting.'

Note:
Data Bars and Icon Sets cannot be made static with this tool.
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G
Price Price Price Price Price
il Product ﬂ vendor 1 ﬂvendor2 ﬂ vendor 3 ﬂ vendor 4 vendor 5 ﬂ
2 |PR163
3 |PR130 22.93
4 |PR164 14.61 15.15
5 |PR152 21.46
6 |PR] — - —— Y
7 PR ASAP Utilities - Replace conditional formatting with static formatting in selection u
2 |PR
9 PR Do you want to replace the conditional formatting in selected cells with
10 |PR! standard/static formatting?
Conditional Farmat settings of Number, Font, Border and Fill will be
11 PR applied. Data Bars and Icon Sets cannot be made static with this tool.
12 | PR
13 |PR Continue?
14 | PR
15 |PR.
==
16 |PR!
L e e o -
18 |PR172 9 4 13.21
15 |PR161
20 |PR165
21 pR15R
EEA9-C-|=
Home Insert Page Layout Farmulas Data Review  View  ASAP Utilities
‘f‘ Cut o caion_ oA = %] B SiwrapTedt
153 Copy ~
Past, ST = = 55 | 55 Merge & Cente
o ymeath‘;\ter I b-|z [BA- | = E B Merge & Center
Clipboard B — = Fant Theme Colors™ lignment |
= E FEmEEEREN———7—
B2 - " =
c iitli G
Price Price Pri I I I I I I I
il Product ﬂ vendor 1 ﬂvendnrz ﬂ Vel
Standard Colors
2 |PR163
7 [ ]} fEEEEN
Mo Fill
4
5 | More Colors...
6 15.36 13.78
7 27.57 26.96
8 24.78 26.08
9 PR160 14.12 13.69 14.56 13.01
10 PR159 .
11 |PR154 :
12 |PR155 x

20 Remove all conditional formatting in selection

21

22

This utility removes all conditional formatting in the selected cells.

Remove all validations in selected cells

This utility removes all validation-settings in the selected cells.

In Excel you can only do this on one sheet at a time.
With this utility you can now quickly do this on multiple sheets at once.

Count and/or color duplicates in selection...

This utility tells you how many duplicate values there are in your selected range.
You can choose to paint all duplicate cells with a certain color.

Note:

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the

Available tools
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same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as
a duplicate.

Example screenshot: 1 Count and color duplicated values

A B C D E F
1 |Belgrade Paris
2 |Berlin Prague
3 |Bern Reykjavik
4 |Bratislava Riga
5 |Brussels Rome -~
] e st San Maring | Asup tilties - Count and/or color duplicates in selection...
7 |Budapest Sarajevo
3 |Copenhagen  Skopje
2 |publin Sofia o E:”y(uul‘JUv;f?anl to give the cells with a duplicate value a certain
10 [Helsinki Stockholm
11 [Kiew London
12 |Lisbon Prague Ves No
13 |Brussels. Tirana . .
14 |London Torshavn |
15 [Luxembourg  Vaduz
16 |Madrid Vienna
17 [Minsk Vilnius
18 |Moscow Warsaw
19 |Nicosia Yerevan
20 |oslo Zagreb 1
21
A B C E F
1 |Belgrade Paris
2 |Berlin Prague
== Reyigavik " 1ap utiities - Select a color X
4 |Bratislava Riga 4
5 |Brussels Rome L | Example:
6 |Bucharest San Marino |
7 P Sarajevo A
3 |Copenhagen  Skopje D |
9 |Dublin Sofia b |
10 [Helsinki Stockholm |
11 [Kiew London 1
12 |Lisbon Prague |
13 |Brussels Tirana
14 |London Torshavn |
15 [Luxembourg  Vaduz B |
16 |Madrid Vienna RGB value: 153 204 255
17 [Minsk Vilnius | HBXvalue: #99CCFF Edit colors
18 [Moscow Warsaw Epines 37
19 | Nicosia Yerevan b I I
20 [oslo Zagreb
21
22
A B C D E F
1 |Belgrade Paris
2 [Berlin
3 |Bern Reykjavik
4 |Bratislava Riga
5 Rome
6 |Bucharest San Marino
7 |Budapest Sarajevo ASAP Utilities - Count and/or color duplicates in selection X
3 |Copenhagen  Skopje
9 |Dublin Sofia
10 |Helsinki Stockholm n ?Et‘it.a\ofEdup\lcateva\ueswerefoundmthe selected 40
11 [Kiew
12 [Lisbon

13 Tirana b
14 Torshavn )
15 [Luxembourg  Vaduz

16 |Madrid Vienna

17 [Minsk Vilnius

18 |Moscow ‘Warsaw

19 | Nicosia Yerevan

20 |Oslo Zagreb

21

22

23

24
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Example screenshot: 2 Just count the duplicates without coloring them

A B C D E F A B C D E F
1 [eelgrade Paris 1 [Belgrade Paris
2 |Berlin Prague > |Berlin Prague
3 |Bem Reykjavik 3 |Bem Reykjavik
4 |Bratislava Riga 2 |Bratislava Riga
5 |Brussels Rome: 5 |Brussels Rome
6 |Bucharest  SanMari~~ 5 |Bucharest  SanMarin~
7 [Budapest Sarajevg ASAP Utiltes - Count and/or color duplicates in selection.. 7 |Budapest Sarajevo | ASAP Utilities - Count and/or color duplicstes in selection.. X
8 |copenhagen skopje —’ & |copenhagen  skopje
¢ |Dublin Sofia o Do you want to give the cells with a duplicate value a certain 9 |Dublin Sofia 0 Atotal of 6 duplicate values were found in the selected 40
10 |Helsinki Stockho cell color? 10 |Helsinki Stockholl cels
11 |Kiev London 11 |Kiev London
12 |Lisbon Prague F 1 12 |Lisbon Prague
12 |Brussels Tirana = 13 |Brussels ‘llregna
14 |London Térshavn ]| 14|London Torshavn |
15 |Luxembourg  Vaduz 15 [Luxembourg  vaduz
16 | Madrid Vienna 16 | Madrid Vienna
17 | Minsk Vilnius 17| Minsk Vilnius
18 | Moscow Warsaw 18| Moscow Warsaw
19 |Nicosia Yerevan 19 | Nicosia Yerevan
20|oslo. zagreb I 20|oslo Zagreb
21 21

Count duplicates and give each set of duplicates its own color

This tool counts and colors the duplicate values in your selection.
Each set of duplicated values is given its own unique color.

This helps to quickly find the duplicated values, by having a set of colors each of which can
readily be distinguished from one another.

Example:

If your selection contains 5 cells with the value "London" then those 5 cells will all get the
same color, for example blue. And if the value "Paris" exists in 3 cells then those 3 cells will
also get the same, but a different color, such as green.

Note:

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the
same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as
a duplicate.

N

A B A B
| 1 |tondon Belgrade 1 _Eelgrade
" 2 [Berlin Prague 2 Berlin Prague
3 |Bern Reykjavik 3 |Bern Reykjavik
| 4 |Bratislava Riga 4 |Bratislava Riga
| 5 |Paris Rome 5 |Paris Rome
| 6 |Brussels Paris. 6 | Brussels Paris.
| 7 |Budapest Sarajevo 7 Budapest Sarajevo
| 8 |copenhagen Skopje 3 Copenhagen Skopje
| 9 |publin Sofia 9 |Dublin Sofia
ﬂHElSinkl Stockholm 10 |Helsinki Stockholm
| 11 [Kiev London 11 |Kiev
| 12 |Lishon Prague 12 |Lisbon Prague
| 13 |Brussels Tirana 13 Brussels Tirana
| 14 |London London 14
| 15 |Luxembourg Vaduz 15 Luxembourg Vaduz
| 16 |Madrid Vienna 16 | Madrid Vienna
| 17 |Minsk London 17 |Minsk
| 18 |Moscow ‘Warsaw 18 Moscow Warsaw

19 |Paris Yerevan 19 |Paris Yerevan
| 20 |Oslo Zagreb 20 |Oslo Zagreb
| 21 |Copenhagen Moscow 21 Copenhagen Moscow
22 |skopje Vienna 1 22 Skopje Vienna

23 23
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Copy and apply cell's formatting settings...

With this utility you can copy certain formatting settings from one cell or the standard

formatting profile to other cells.

In Excel you can only copy all formatting settings. With this utility you can now choose to

only copy certain settings.

You can choose to apply one or more from the following properties:

= Number format

= Font

= Font size

= Font style

= Bold/underline/italic
= Font color

= Horizontal alighment
= Vertical alighment

Your last used settings will be remembered.

Text orientation
Wrap text

Cell color

Cell pattern

Cell pattern color
Locked

Hidden

ASAP Utilities - Copy the formatting attributes of a cell

Settings to copy: Read settings from

[v Mumber format (u:mm:ss) " standard formatting profile

I+ Font (Calibri) o~ cell:
I¥ Font size (11pt)
[¥ Font style (Bold)

¥ Boldunderline fitalic (YE3/NO/YES) Areiyssilgs e

e

I Font color (0}

[ Horizontal alignment (1)
I vertical alignment (-4107)
™ Text orientation

™ Wrap text (NO)

| sa:m23

[ cell color (55535)
[ Cell pattern
[ Cell pattern color

™ Locked (YES)
[ Hidden (NO)

All Inverse None cancel QK

25 Apply standard format to selected cells

This utility applies the standard formatting to your selected cells.

This standard formatting is defined in the formatting style "normal" in Excel.
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5.5.10 Numbers & Dates

A collection of tools for working with numbers, faster and easier calculations, processing,
etc..

1 Apply formula/calculation to selected cells...

With this utility you can quickly perform a calculation on the selected range.
For example quickly multiply all cells in your selection by 10 without having to add an extra
column and enter a formula to do this.

A formula will be built around the original formula or value in your cell. For example if you
have a formula '=(12*2)" in a cell and you use ASAP Utilities to apply the formula /24 the
result will be: '=(12*2)/24'.

The formula will be applied to all cells in your selection except for cells with errors, empty
cells, cells contain text or cells that contain an array formula.

If the new formula would result in an error you will get a warning upfront and no changes
will be applied.

Users of the non-English Excel versions can type in the formula in their local language. For
example in the Dutch version you can use the comma as decimal separator and the local
version of worksheet formulas, for example '+SOM(G20:G40)' instead of the English
'+SUM(G20:G40)".

There are many formulas you can enter such as for example '/1000', '+4', '*2,55', '*C33'.
This utility is also often used for unit conversions, such as for example converting
kilometers to meters.

The last 100 used formulas are remembered so you can easily re-use them.
By default this can be started with the shortcut Ctrl+Alt+l.
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Example screenshot: 1 Perform a quick calculation in selected cells

@ = 0101 - Apply formula - calculation to selected cells - Microsoft Excel
Home Insert Page Layout Formulas Data Review View ASAP Utilities
", © % [ sheets + i Columns & Rows ~ [} Numbers & Dates = g5 Web - & mport ~
3 [#] Range = [ Objects & Comments = [A|Text ~ &% Information = @] Export ~
My favorite | Vision Seledt
tools~ | Control - = Fill~ [5G Format - e Formulas ~ (81 File & System = b Start -
Favorites Time saving tools
B3 hd A a1
A [ B [ ¢ [ o [ E [ F [ 6 [ H [ 1T [ J 7
1 amount
2 site W1 FYES s ais Mk nac naz
3 A e ASAP Utilities - Apply formula/calculation
4 B 27
B ¢ = While applying the calculation a formula wil be built around the original
— formula or value in your cells.
6 D 29
7 E 35 For example if you have a cell with the formula '=12*2' and you apply with
T F 83 this tool the formula /24 then the new formula in the cell becomes =(12*
o1 2)f24.
9 G 16 L
10 H A There are many formulas you can enter such as for example '/1000', '+4, =
EEIE a4 2,55, %33,
Mz J 89 The 100 last used formulas will be remembered for re-use.
13 K 64
oL 37 || [ 000
15 M 73
16 N 61 Close I™ Skip hidden rows and columns
7 4] 100
18 P 43 e T ro _
19 Q 22 64 55 2 25 6 2
20 R 17 16 59 46 37 85 8
21 S 81 38 29 40 46 23 82
22 T k)| 98 6 37 23 92 23
23 u 27 100 70 91 50 30 kil
24 v 40 32 16 47 72 13 7 33 50
2. w 24 a7 24 AR A2 /Y 14 72 7l

Example screenshot: 2 The result

[E = L. D101 - Apply formula - caleulation to selected cells - Microsoft Excel
Home Insert Page Layout Formulas Data Review View ASAP Utilities
", [ 5] [=dsheets + [ Columns & Rows ~ (3} Numbers & Dates = §5 Web ~ (% mport -
A ] Range ~ | Objects & Comments ~ | Al Text ~ €. information - @] Export -
My favorite  Vision Select
tools~ | Control ~+ = Fill~ Format ~ Je Formulas - [l File & System = b Start *
Favorites Time saving tools
B3 - Jx | ={41)*1000
A B [ € [ b [ E ] F [ 6 [ H ] | [ J |
amount
site M1 M2 M3 4 M5 M6 M7 11} 1]

41000 26000 36000 54000 96000 1000 62000 70000 15000|
27000 31000 78000 51000 7000 44000 59000 23000 §1000|
69000 73000 93000 7000 50000 40000 79000 78000 22000
29000 76000 26000 38000 31000 64000 77000 0 54000|
35000 6000 91000 23000 94000 85000 79000 6000 55000
83000 93000 84000 28000 81000 31000 18000 13000 86000
16000 27000 36000 71000 40000 90000 92000 1000 T7000|
51000 65000 46000 35000 96000 9000 67000 25000 64000
44000 60000 6000 38000 15000 67000 11000 70000 14000|
§9000 78000 73000 22000 78000 75000 61000 60000 53000
64000 72000 49000 58000 92000 42000 92000 55000 93000|
37000 77000 14000 7000 2000 27000 43000 74000 §7000]
73000 12000 57000 17000 83000 14000 0 46000 69000|
61000 63000 40000 2000 21000 35000 76000 29000 £9000|
100000 41000 6000 7000 69000 67000 14000 36000 63000
43000 78000 14000 17000 76000 23000 1000 93000 92000|
22000 64000 55000 2000 25000 6000 2000 42000 52000
17000 16000 59000 46000 37000 85000 8000 46000 17000|
51000 38000 29000 40000 46000 23000 52000 96000 40000
31000 98000 6000 37000 23000 92000 23000 8000 84000|
27000 100000 70000 91000 50000 30000 31000 32000 66000
40000 32000 16000 47000 72000 13000 7000 33000 50000
24000 37000 54000 66000 63000 62000 14000 72000 7000

S RN R R S S R R RN
E<CHwWRTOTVOZErxc—IOTMOOT>
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Change formulas to their calculated values

This utility replaces the formulas in the selected cells with their calculated values.

The utility works the same as Excel's "Copy » Paste » Paste values" but in one step and it
also works with multiple selections at once.

Normally the utility changes the formulas to their calculated values in both visible and
hidden cells. If you have selected cells in a filtered list only the visible cells are changed.

As an example, a cell with the formula '=A2*(C19/12)" which has '124' as the calculated
result will be replaced with the value 124.

This can be useful, for example if you want to speed up the calculation of your workbook or
if you don't want someone to see the underlying formulas you used if you give the
workbook to somebody else.

By default you can start this utility with the shortcut Ctrl+Alt+P.

Example screenshot: 1 Change formulas to their calculated values

B2 - A =(105271,03
A | B [ ¢ 1 D [ E 1T F [ 6 ]
1 [Map Unit price Sold Total VAT Total inc. VAT
| 2 |Amsterdam 10,564 102 1.108,23 19% 1218 2568
3 |Andpeeal 1L 1204 280 140 19% ER3 EIE ~
[ 4 |Ank| ASAP Utilities - Change formulas to their calculated values
| 5 |Ath
% ge‘ Do you want to convert all Formulas in selected cells to their calculated valuss? — [;
erl Z
[ 8 |Bern
T Bral Cancel
| 10 |Bru
| 11 |Bu
112 |Bud
| 13 |Copli| W Disable undo {for perfarmance reasons)
| 14 |Dubl = = —
[15 |Helsinki 1832 €99 000y 5e 9% 1072100
| 16 [Kiev 12,27 724 §.881,53 19% 9617 2625
|17 |Lishon 109 614 681116 19% 7436 4465
| 18 |Ljubljana 13,63 439 5.799,52 19% 731264
19 [London 1.19 ] 984 35 19% 1083 7262

Example screenshot: 2 Formulas to values in a filtered list is something that you normally
can't do in Excel

B20 - A& =(12 921" 03
A B c | i) | E | F | 6 | H
1 |[map ~|_Unit price[~| Sold[~] Total[=| VAT[~| Total inc. VAT[~]
| 20 |Luxembourg 1331 946 12.588 33 18% 1354849
| 21 |Madrid 13,34 955 1273827 19% 1370680
| 22 |Minsk 11,61 987 11.457 13 19% 1245599
24 [Nicosif A5pp Utilities - Change formulas to their calculated values
Osla —
Reykj T ’ !
Do you wank ko convert all WISIBLE filtered formulas in selected cells to their
Sarale] | oyesy

Tallinng
Tdrsh Cancel

Y erew

Tfen o | | | e e e o] cofeaf o
A= |0|@ |0 || =] G o rodf o
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Convert unrecognized numbers (text?) to numbers

This utility changes the numbers that behave like text to real numerical numbers which
Excel recognizes.

You might have experienced that sometimes Excel treats numbers as text; they are left
aligned, they don't work in your formulas or don't sort properly.

This problem often occurs when data is imported or copied from other programs.

This utility will also help you get errors in your =VLOOKUP() formulas because Excel treats
the numbers as text and therefore can't find a matching value.

You can also use this utility to remove leading zeros from numbers or to make Excel
recognize empty cells properly as empty again.

Note:

This utility does not convert numbers with decimal separators different then specified in
the language settings in MS Windows or in the "International" options of your workbook.
For example often people in The Netherlands have problems with imported text files when
the numbers are stored as for example "120.00" where a point is used as decimal separator
instead of a comma.

In such a case you can use Excel to replace (Ctrl+H) the point (or whatever) to your decimal
separator to have Excel recognize the numbers correctly.

A B c D £ F G H 1
W company TRO1L TRO2 TRO3 TRO4 TRO5 TR06 TRO7
2 |ABC Telecom 0167 178 167 57 158
2 |BigKahuna Burger 0122 147 140 117 7
4 |BigT Burgers and Fries 0089 126 157 67 115
5 |Blammo 0114 118 108 81 95
6 |Charles Townsend Agency 0195 71 171 196 128
7 |chasers 0127 89 132 130 187
8 |Chez Quis 0118 193 135 148 57
3 |Cogswell Cogs 0184 178 83 103 154
10 |Foo Bars 0052 67 200 106 143
11 |Gadgetron 0150 50 82 182 55
12 |Globe Gym American Corp 0131 187 76 b2} 156
12 |Gringotts 0134 100 183 81 119
14 |Initrode 0055 196 29 166 146
15 [Input, Inc. 0141 110 121 136 86
16 |Klimpys 0175 178 126 84 70
17 |krustyco 0103 144 196 130 65
12 |Mainway Toys 0198 122 181 169 193
19 |Megadodo Publications 0151 68 60 76 112
20 |Mr. Sparkle 0121 34 152 133 164
21 |Niagular 0185 59 137 86 132
22 |Petrox 0il Company 0057 123 109 n 170
23 |Roxxon 0051 175 124 163 97
24 |sixty Second Avenue 0141 154 159 109 178
25 |Strickland Propane 0186 138 77 110 84
26 |Taco Grande 0151 198 115 100 155
27 Total 0 0 0 0 2673 3348
28
A B T D E F G H 1
E8l Company TR01 TRO2 TRO3 TR04 TRO5 TR06 TRO7
2 |ABC Telecom 167 178 167 57 158 190 129
3 |BigKahunaBurger 122 147 140 17 P2 173 102]
4 |BigT Burgers and Fries 29 126 157 67 115 167 136
5 |Blammo 14 118 108 21 95 172 as|
6 |Charles Townsend Agency 195 pi 171 196 128 56 14g|
7 |chasers 127 89 132 120 187 164 147]
& |chez Quis 18 193 135 148 57 11 113|
9 |cogswell Cogs 184 178 83 103 154 54 96|
10 |Foo Bars 52 67 200 106 143 93 102]
11 |Gadgetron 150 50 82 182 55 172 143
12 |Globo Gym American Corp 131 187 76 72 156 58 183
13 |Gringotts 134 100 183 81 115 185 161
14 |initrode 55 196 89 166 146 149 155
15 |Input, Inc. 141 110 121 136 86 191 52|
16 |Klimpys 175 178 126 84 70 152 174]
17 |Krustyco 103 124 196 130 65 170 134
18 |Mainway Toys 198 122 181 169 193 121 157]
19 |Megadodo Publications 151 68 60 76 112 93 112]
20 |Mr. Sparkle 121 8 152 133 164 108 92|
21 |Niagular 185 99 137 26 132 194 121
22 |Petrox 0il Company 57 123 109 17 170 62 13g]
22 |Roxxon 51 175 124 163 97 23 96|
24 |sixty Second Avenue 141 154 159 109 174 120 149
25 |strickland Propane 126 138 77 110 84 169 186
| 26 |Taco Grande 151 198 115 100 155 152 183|
27 Total 3208 3203 3280 2073 3086 3348 3315] gl
28
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Change values to text values (adding ' in front)

This utility changes all numbers in the selected cells to text values.

This is done by placing an apostrophe (') in front of each value.

Cells with formulas that have a numeric result will be filled with their calculated values.
Cells with text or a date are skipped.

Note:
If you want to spell out numbers you can use the utility "Spell numbers or amounts (EN, DE,
NL)".

Fill cells with their formatted value

This utility replaces the contents in the selected cells with their formatted value.

For example if you have a cell with the value "384216938" with the cell formatting "000 -
000 00 00" then it will be displayed as "038 - 421 69 38".

This utility will then fill the cell with the value "038 - 421 69 38".

This can for example be useful when you use mailmerge in MS Word because that reads the
value of the cell and ignores the cell formatting.

Example screenshot: Fill cells with their displayed value

B2 - b3 2042@8 B2 - '020- 42169 38
A B c D E F G H A B c D E
Bl Name -1 Phone ~ Bl Name - Phone ~
2 |Agustin 020- 4216938 2 |Agustin 020- 4216938
3 |Aiden 020 - 495 56 96 3 |Aiden 020 - 495 56 96
4 |Alejandro 020- 415 77 46 4 |Alejandro 020 - 415 77 46
5 |Alexander 020-72243 63 5 |Alexander 020-7224363
6 |Al U B 6 |Ali 020- 7618023
7 | af ASAP Utilities - Fill cells with theirf:)rmatted value ﬁ 7 |andrei 020 - 24549 07
8 |ar 8 |Arda 020- 1829395
9 |Ax @) Do want to replace the values in selected cells with their formatted 9 |Artem 020 - 286 60 72
10 |Be & values? 2 230001 10 |Bence 020-5133246
12 svtlllr" Ex:;wﬂpﬁl;:ﬂ;:\l[&?;?;]value[1,15] formatted as [EUR * #.##0, 11 [Benjamin 020 403 26 63
12 D 12 |Daan 020 - 255 44 02
13 | D 13 | Daniel 020-7142393
14 eg Cancel 14 |Eetu 020 - 865 12 44
15 Eq 15 | Emil 020 - 260 1154
16 |En | IR § 16 |Enzo 020- 2743592
17 |Erik 020-3736317 AT |Erik 020-3736317
18 |Ethan 020 - 466 27 58 18 |Ethan 020 - 466 27 58
18 |Francesco 020- 27046 93 19 |Francesco 020- 2704693
20 Georgi 020- 06147 70 20 |Georsgi 020 - 06147 70
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Change negative numbers to positive and vice versa...

With this utility you can change positive numbers to negative and negative numbers to
positive.
You can also make all numbers in your selection negative or positive.

You can choose from:

= Reverse positive and negative
= Make all numbers positive
= Make all numbers negative

This can also be useful if you have a balance sheet with debit and credit figures.

Note:
Cells with formulas will be skipped.

Example screenshot: Change negative numbers to positive and vice versa

~ DEBIT T CREDIT T | BALANCE |~
1 "

ASAP Utilities - Change positive and negative numbers

Change numbers in selected range:

¥ Make all numbers positive g L i
" Make all rumbers negative

Cancel
" Reverse positive and negative

91— 91

-10%5 105
-8 8
a0 a0
30 30

-46 46
42 42

This utility will change cells with numbers. Cells with formulas will be
skipped.

—w ;
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Move minus sign from back to front (e.g. 65- to -65)

This utility will corrects numbers that have a trailing minus for negative numbers.
For example a number such as "65-" will be converted into "-65" so that it is a number that
Excel recognizes and that you can use in your calculations.

This utility is especially useful when you have to deal with certain imported text files
because some (finance) system report negative numbers with the minus sign at the end.

~|amouNT [~ ~|amount [~
1164.00 1164.00
1495.00 1495.00
217.00 217.00
1886.00- 4 1886.00
2244.00- 2244.00
910.00 910.00
3643.00 3643.00
4322.00 4322.00
3700.00- -3700.00
3700.00 3700.00
652.00- 662.00
652.00 652.00
1495.00- -1495.00
4322 00- 4322.00
1164.00- 1164.00
910.00- 910.00
2244.00 2244.00
775.00- 775.00
775.00 775.00
1886.00 1886.00
3643.00- -3643.00
217.00- 217.00
$21008.00 $0.00

Use a significant number of decimals...

This utility changes the number format in your cells to show a significant number of
decimals.

The difference between this utility and general rounding is that it ignores the zeros that
come directly after the decimal separator.

For example if you enter the number 3, then the cells will be formatted to show at least 3
decimals, other than zero.

A cell with the value "12.0123123" is then shown as "12.0123" instead of "12.012".

A cell with the value "12.00002134" is then shown as "12.0000213" instead of "12.000".
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Subscript the numbers in Chemical Formulas

This will subscript the numbers in chemical notations such as CSH10N402, Al(OH)3, AIF6Li3,
AlO2, AI(NO3)3, Au2(Se04)3, Ca(V04)2, H6TeO6, KAIMg3Si3012H2, Ca(NO3)2 - 4H20, etc.

It turns it into CgH1oN4O-, Al(OH)3, AlFsLis, AlO, A|(NO3)3, AUz(SeO4)3, Ca(VO4)2, HeTeOs,
KAIMg3$i3012H2, Ca(NO3)2 - 4H,0, etc.

This tool automatically detects which numbers should be formatted as subscript.

A B A B
i Chemical Formulas g Chemical Formulas |4

1
2 |caH10N402 2 [CHy N0,
3 |al{oH)3 3 |Al{OH)s
4 |alF6Li3 4 |AIFgLis
5 |AlO2 5 |alo,
6 |Al(NO3)3 6 |al(NO,),
7 |Au2(Se04)3 7 |Au,(Se0,)s
8 |ca(vo4)2 3 |ca(vo,),
9 |HeTeO6 9 |HTeO;
10 |KAIMg3si3012H2 10 |KAIMg;Si503H;
11 |ca(NO3)2 - 4H20 11 |ca(NOs), - 4H,0

=
I

12 |Cu(NO3)2 - 3H20 Cu(NOs), - 3H,0
13 |Hg(BrO3)2 - 2H20

14

=
w

Hg(Bro,), - 2H,0

=
™

Convert percentages to numbers (e.g. 5% to 5)

This utility changes percentages to numbers by removing the percent sign (%).
For example 5% will be converted to 5.

Spell/write out numbers or amounts (EN, DE, FR, NL)...

This utility spells out the numbers in your selection.

For example the number "12.75" written out in English in the currency dollar becomes
Twelve Dollars and Seventy Five Cents.

This utility replaces the numbers in your selection with the written numbers.

You can choose to write out the numbers as numbers or as an amount (for example to use
on a check).

You can choose between the languages English, German, French and Dutch.

The default currencies are none, dollars or euro. You can also type in another currency.

If a number contains more than two decimals this function will spell out the number as if it
were rounded to two decimals.
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| 4| A B C D E F G
| 1| 27,00 27,00
| 2 | 76,00 76,00
| 3 | 22,00 22,00
i FASAP Utilities - Spell numbers or amounts (EN, DE, FR, NL)
% — Language
| 7| (% English " Dutch
i ~ German " French o |
[ 9 | 500 -
ﬂ 24— Currency
115 " pone & Dolars " Euro
12
E " custom: currency: Cent:
14| singular: IDoIIar ICent
| 15 | plural: W lm
16
| 17 The numbers in the cells you've selected will be spelled.
| 18 | The existing numbers will be replaced.
|19
| 20|
21|
| 22|
23
| 4| A B Z D E F G
| 1| 27,00 | Twenty-Seden Dollars and No Cents
| 2 | 76,00 | Seventy-Siz Dollars and No Cents
| 3 | 22,00 | Twenty-Twp Dollars and No Cents
| 4 | 82,00 | Eighty-TwolDollars and No Cents
| 5 | 91,00 | Ninety-One Dollars and No Cents
| 6 | 47,00 | Forty-Sevey Dollars and No Cents
| 7 | 86,00 | Eighty-Six Dollars and No Cents
| 8 | 228,00 | Two Hundred Twenty-Eight Dollars and No Cents
| 9 | 500.000,00 | Five Hundred Thousand Dollars and No Cents
| 10|  2.060,00 | Two Thousznd Sixty Dollars and No Cents
| 11| 5.421,00 | Five Thousgnd Four Hundred Twenty-One Dollars and No Cents
112 | 25,00 | Twenty-Fivlz Dollars and No Cents
| 13 | 45,00 | Forty-Five Bollars and No Cents
| 14 | 27,00 | Twenty-Seven Dollars and No Cents
| 15 | 4,37 | Four Dollarg and Thirty-Seven Cents
| 16 | 40,01 | Forty Dollays and One Cent
| 17 | 17,59 | Seventeen [Dollars and Fifty-Nine Cents
| 18 | 71,00 | Seventy-One Dollars and No Cents
119 | 22,56 | Twenty-Twp Dollars and Fifty-Six Cents
| 20 | 31,48 | Thirty-One [Dollars and Forty-Eight Cents
| 21 | 87,94 | Eighty-Seven Dollars and Ninety-Four Cents
| 22 | 28,56 TwenH—EiﬂLt Dollars and Fifty-Six Cents
23
2a
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Round numbers (not formatting, but changing)...

This utility replaces the numbers in the selected cells with the rounded values.
Instead of rounding the number by using cell formatting this tool will actually change the
value in the cells.

The utility will ask you to give a number to specify how to round, similar to Excel's
=ROUND() function:

= positive number: rounds a number to a specified number of digits.

= zero: rounds the value to the nearest integer.

= negative number: the number is rounded to the left of the decimal point for example to
tens, hundreds, thousands etc.

For example a cell with the value 105.326 rounded to 1 will be changed to 105.3, rounded
to 0 it will become 105 and rounded to -1 it will become 110.

Example screenshot: A Round the selected numbers to 2 decimals

B2 - Je | 24.2445129329178 B2 - 5| 244
A B £ D E F G A B

8l Product Rd Unit price i I 8 Product hd Unit price hd
2 |PR150 24.24451293 2 |PR150 24.24]
3 |PR151 18.99695096| 3 |PR151 13|
4 |PR152 21.79039309| 4 PR152 21.79|
5 |PR153 2309247953 5 |PR153 23.09|
6 |PR154 24.8849614 6 |PR154 24.88|
7 |PR135 14.86485274 7 |PR153 14.86|
g ASAP Utilities - Round numbers (not formatting, but changing)... l 2 é’ 8 |PRISS 20.28
9 |PR157 23.48

14 | Type the number of decimals to be left. 10 PR158 12.3]
P gl'tcygezfor two decimals, 1 for one, 0 for none, or -2 for hundreds, -3 for thousands, 11 |PR159 1018
2 12 |PR160 13.38|
1 13 |PR161 16.36|
1 sk ] [ cence 14 PR162 24.15
15 PR163 19.27
16 PR164 13.98811223 16 |PR164 13.99|
17 |PR165 23.77895425| 17 |PR165 23.78
18 |PR166 28.99466633 18 |PR166 28.99|
19 |PR167 26.3559675| 19 PR167 26.36)
20 PR168 2298237236 20 |PR168 22.98
21 PR169 13.28057304 21 PR169 13.28
22 |PR170 23.79538472| 22 |PR170 23.8]
23 |PR171 13.07028487| 23 |PR171 13.07]
24 \PR172 13.61567921 24 |PR172 13.62
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Example screenshot: B Round the selected numbers to the nearest integer (zero decimal

places)
B2 ~ fr| 24.2445129329178 B2 v [ f-| 24
A B c D E F G A B
8 Product A4 price hd | 1|
2 |PR150 24.24451293 2 |PR150 24]
3 |PR151 18.99695096| 3 |PR151 19|
4 |PR152 21.79039309) 4 |PR152 22|
5 |PR153 23.09247953 5 |PR153 23
6 |PR154 24.8849614/ 6 |PR154 25|
7 |PR155 14.86485274] 7 |PR155 15|
ASAP Utilities - Round numbers (not formatting, but changing)... (o | 8 |PRISS 2
9 |PR157 23
1 | Type the number of decimals to be left. 10 |PR158 12|
3 g:y;;e 2 for two decmals, 1 for one, 0 for nene, or -2 for hundreds, -3 for thousands, lPriss ol
0 12 |PR160 13
1 13 |PR161 16|
1 Lok [ concel 14 PR162 24|
ey 15 |PR163 19|
16 |PR164 13.98811228| 16 |PR164 14]
17 PR165 23.77895425| 17 |PR165 24|
18 PR166 28.99466638| 18 | PR166 29|
19 |PR167 26.3559675| 19 |PR167 26|
20 |PR168 22.98237236| 20 |PR168 23
21 PR169 13.28057804) 21 |PR169 13
22 |PR170 23.79538472| 22 |PR170 24f
23 |PR171 13.07028487| 23 |PRI71 13
.24 |pR172 13.61567921 24 |PR172 141

Example screenshot: C Round the selected numbers to the nearest multiple of 100

B2 ~ ﬁ'l 6231.99964316319
A C D E

8 Product g | 1|

2 |[PR130 6231.999643 2
3 |PR151 10998.76733 3 |PR151 11000
4 PR152 8238.861127 4 PR152 8200
5 |PR153 10549.57236| 5 PR153 10500
6 |PR154 1653.896839) 6 |PR154 1700|
7 |PR155 5485.215091] 7 |PR135 5500
ASAP Utilities - Round numbers (not formatting, but changing).. |2 [ 8 PRISG6 10500)
9 PR157 6700
1d | Type the number of decimals to be left, 10 PR158 2300
it S;(YF;E 2 for two decimals, 1 for one, 0 for none, or -2 for hundreds, -3 for thousands, 11 PR159 8200
2 12 |PR160 9800
1 13 |PR161 7200
1 & [ cance 14 PR162 7200)
ey 15 PR163 3700)
16 [PR164 4227.294648) 16 |PR164 4200
17 |PR165 10937.47868) 17 |PR165 10500
18 |PR166 10169.73459| 18 |PR166 10200
19 |PR167 4744.205856) 19 |PR167 4700
20 |PR168 5321.251651] 20 |PR163 5300
21 |PR169 7025.309549) 21 |PR169 7000
22 |PR170 2065.436871] 22 |PR170 2100
23 |PR171 3481.139743 23 |PR171 3500|
24 |PR172 3542.250081 24 |PR172 3500
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Fill up with leading zeros...

This utility fills the numbers in the selected cells up with leading zeros to a given length.
The utility will actually add the zeros and therefore change the data. If you only need the
number to be displayed as if they have leading zeros then it is better to use cell formatting
with a number format such as for example '000000'.

Numbers with decimals will be rounded to the nearest integer.

For example if you specify a length of 3 then a cell with the value 1 becomes 001, 34
becomes 034 and numbers greater than 100 will not be changed because they already have
a length of 3 characters or more

If a formula in your selection has a number as a result then the calculated value will be
filled it up with the zeros and the original formula is replaced.

A B C D E
8 Company Code
2 |ABCTelecom 69
3 |Big Kahuna Burger 140]
4 |Big T Burgers and Fries 50|
5 |Blammo 35|
6 |Cha —
7 |Chal ASAP Utilties - Fill up with leaging zeros.. (L5 [
8 |Chel Wha_t is the total length you would like the numbers to become, filed up with
| 3 |Cogy ‘::'dlenxga;eglis:ype 2 for 01, 4 for 0001 etc.
10 |Foo | (Numbers with decimals will be rounded to round numbers. Formulas wil be
11 | Gad)| converted to values.)
12 [Glof | 4
13 | Grinly Cancel
14 |Inity _ __
15 |Input; - 159
16 |Klimpys 23
17 |Krustyco 5l
18 |Mainway Toys Ly
19 |Megadodo Publications A B c
20 Mr. Sparkle I3 Company Code
21 | Niagular 2 ABCTelecom 0069
22 | petrox Oil Company 3 |Big Kahuna Burger 0140]
23 |Roxxon 4 |Big T Burgers and Fries 0050
24 Sixty Second Avenue 5 Blammo 0035
25 | strickland Propane 6 |Charles Townsend Agency 0154
26 Taco Grande 7 |Chasers Qi)
27 8 |Chez Quis 0122
19 Cogswell Cogs 0029
10 Foo Bars 0049
11 Gadgetron 0130]
12 Globo Gym American Corp 0145
13 |Gringotts 0174
14 |Initrode 0117
15 |Input, Inc. 0158
16 |Klimpys 0023
17 |Krustyco 0005
18 |Mainway Toys 0067
19 Megadodo Publications 0153
20 |Mr. Sparkle 0038
21 |Niagular 0107
22 Petrox Oil Company 0081
23 Roxxon 0052
24 Sixty Second Avenue 0020
25 |Strickland Propane 0120
26 Taco Grande 0036,
27

160
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Quick numbering of selected cells...

This utility helps you to quickly fill the selected cells with a series or numbered list.
The utility is flexible and offers several options to choose from.

You can configure the following settings:

Series setting:

= Create a series with numbers:

- The number to start with.

- The number to increment with.

- Restart counting after a certain value.

- Fill up the numbers with leading zeros to a specified length.
= Create a series based on the letters from alphabet in lowercase (a, b, c, etc.).
= Create a series based on the letters from alphabet in uppercase (A, B, C, etc.).

Options:

= You can specify to restart the counting if the value in a certain column changes. You can
use this for example if you have a list with city names and you want to restart the
counting when the name of the city changes. You can also specify to put the value of the
changing column in front of and/or after the value in the series.

= You can add a value in front of and/or after each value in the series. This way you can for
example create series with week numbers and add the text 'Week ' in front of each value
in the series.

= You can specify the cell alignment.

By default you can start this utility with the shortcut Ctrl+Alt+Q.

Example screenshot: 1 Example 1

A B c D E F A B
1 LENTE -Gmup | Ml Group
Luthorcorp Luthorcorp

:

4

21 |\wal Water And Power
Prefix:

22 |Fakf Fake Brothers

23 |De) &uiis Demo Company

24 |\Wid)| Wwidget Corp

Cell alignment: -

| 1
2 2 1]
3 |Virtucon | 3 |virtucon 2
4 |Ma| ASAP Utilities - Quick numbering of selected cells... 4 |Mammoth Pictures 3|
5 |Big i . 5 |Big Kahuna Burger 4
—T Series settings i "R -
6 Sl | & ympers startith : Wx 6 |Smith And Co. 5|
7 |Thi = 7 |The N Fi 1]
,E Incremep‘t with: 1 L) ,E EW, rm
2 |vid § 1 Cancel 2 |Videlectrix 2|
5 p
3 Mol Restart count after r‘:mhar. 5 L 9 Moes Tavern 3
i i - /
10 |Gall Fill up with leading ?E(ZS- 0 > eample: 10 |Galaxy Corp 4
11 Sor . SSmeaen ’ 1 [ M 11 |Sombra Corporation 5|
12 awf Alphabet lowercase (a, b, cetc.) ! 12 | Qwerty Logistics 1
13 Gld " Alphabet uppercase (A, B, C, etc.) 3 12 | Globo-chem 5|
4
14 5pq 5 14 |Spacely Sprockets 3|
Options 1
15 | Ch 15 |Ch: 4
Restart numbering if the value in the - 2 asers
16 |Spq following column changes: 3 16 Spade And Archer 5
17 |Rol : 17 |Roboto Industries 1
18 Pral I Add value of changing column before prefix 1 18 |Praxis Corporation 2|
18 Al | e of chanaing comm after s H 19 | Acme, Inc. 3
20 |Gel e 4 20 |General Products 4
5
1 21 35
2z 22 1]
3
2 23 2
i 24 3|
2 25 4
26 5
27 1]
2

25 |Stri Strickland Propane
26 |Ma Mainway Toys

27 |Big Burgers Big Burgers

28 Klimpvs 28 Klimpvs
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Example screenshot: 2 Example 2

E B C
| 1 b mpany m Country
2 Luthorcorp Austria 2 1|Luthorcorp Austria
3 |Virtucon Austria 3 2|Virtucon Austria
4 —— 3 4 3|Mammoth Pictures Belgium
5 ASAP Utilities - Qu\ck-num bering_uiieled.ed cells... 5 4|Big kahuna Burger Belgium
] [ Series settings - 6 5|smith And Co. Belgium
7 * Numbers Starpith: 7 6The New Firm Belgium
8 Incremsf:t with: 8 F|videlectrix Bulgaria
9 Restartcomntafier ;‘meer: 9 B|Moes Tavern Bulgaria
10 b 10 9|Galaxy Corp Bulgaria
Fill up with leading Jegos: - .

11 ., : 11 10fSombra Corporation Croatia
12 " Alphabet lowercase (a, b, cetc.) 1 * 12 11jawerty Logistics Croatia
13  Aphabet uppercase (&, B, C, etc) i 13 12|Globo-chem Croatia
14 4 14 13|Spacely Sprockets Croatia
15 — options g 15 14|Chasers Czech Republic
16 Restart numbering if the value in the l__l 7 16 15|Spade And Archer Czech Republic
17 fallowing column changes: g 17 16|Roboto Industries Czech Republic
18 10 18 17|Praxis Corporation Denmark
19 [~ Add value of changing column before prefix E 19 18|acme, Inc. Denmark
20 I~ Add value of changing column after suffix 13 20 19)General Products Denmark
21 }? 21 20fWater And Power Denmark
22 Prefix: l— 16 22 21|Fake Brothers Finland
23 Suffix l— ]1_; 23 22|Demo Company Finland
24 12 24 23|widget Corp Finland
5 Cell alignment: | b 5 24|strickland Propane Finland
26 2 26 25|Mainway Toys France
27 T 27 26|Big T Burgers And Fries  France
28 Titimony: Erance | 28 270klimny Erance

Example screenshot: 3 Example 3

5 D E F B
.  re—
" 2 |Luthorcorp 2 Luthorcorp [o10
3 |Virtuc N 3 |Virtucon 020
4 |Mamm ASAP Utilities - Qu-ick numbeing of selected cells... 4 |Mammoth Pictures 020
5 BigKall | series settings 5 |Big Kahuna Burger 040
6 |[Smith & Numbers 6 |Smith And Co. (050
7 The Ne 7 |The New Firm 010
8 |Videlef Restart count after hmber: 8 |Videlectrix 020
9 MoesT } i N 9 |MoesTavern 030
10 | Galaxy! Filup with leading e 10 | Galaxy Corp 010
11 | Sombri ( Aphabet lowercase (a, b, c etc.) 11 |Sombra Corporation (050
12 |Qwe 12 Qwerty Logistics 010
13 Glubzl R i’ 13 Globz‘;hei\ 020
14 |Spacel — Options 14 |Spacely Sprockets 030
15 |Chaser] | | Restart numbering if the value in the [ =] | o= 15 |Chasers 040
16 |Spade f | | folowing column changes: g£ 16 Spade And Archer 050
17 |Roboti 050 17 Roboto Industries 010
18 [praxis || | | A4d value of changing column before prefix gzlg 18 Praxis Corporation 020
19 Acme. b | [~ aqd value of changing column after suffic 030 19 Acme, Inc. 050
20 |Generd | Egg 20 General Products 040
21 |Water )| | prefix: l— 010 21 Water And Power 050
22 |Fake Bl | o o ——— o 22 Fake Brothers 010
23 \Demo 040 23 |Demo Company 020
24 |widge{ | | celldignment: = o= 24 |widget Corp 020
25 |Strickld)| 020 25 |Strickland Propane 040
26 |Mair y 1oy 26 Mainway Toys (050
27 |Big Burgers. | | 27 Big Burgers 010
28 | Klimoy: | | | 28 |[Klimpvs. 020
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Example screenshot: 4 Example 4

D B z
| 1] hd Company ountry
2 ] Austria 1|Luthorcorp Austria

3 [\ ity Austria ~ 2|Virtucon Austria

4 ASAP Utilities - Quick numbering of selected cells... 1|Mammoth Pictures Belgium
E I ——— B 2|Big Kahuna Burger Belgium
6 | b Siar;qﬁth: 3|Smith And Co. Belgium

7 Imema"‘twm 4 Tt_|e New-Flrm Belglu_m

8 i 1|videlectrix Bulgaria
9| Restart count after w‘mber: 1[Moss Tavern Croatia
10 Fill up with leading Z\r\ﬂ\s 2|Galaxy Corp Croatia
|11 | £ Alphabetiowercase (a, b, cete) " 3|Sombra Corporation Croatia
|12 | = 2 4lawerty Logistics Croatia

13 " Ajphabet IJ_DEES_G_@_E-&EE-_)_‘ 1 5|Globo-chem Croatia
14| o me — — ; 6|Spacely Sprockets Croatia

15 w_ EPEE . 15 1|Chasers Czech Republic
] Restart numbering if the value in the IC__I 1) ] .

16 fallowing calumn changes: | 16 2|spade And Archer Czech Republic
17| """--__,‘_____ < i / 17| 1|Roboto Industries Denmark
|18 | I Add value of cha 4 18| 2|Praxis Corporation Denmark

19 5 19 3|Acme, Inc. Denmark

I Add value of changing column after suffix ©
20| 1 20 4|General Products Denmark

21 Prefi: i 21 5|Water And Power Denmark

22 2 22 1|Fake Brothers Finland
E i 3 E 2|Demo Company Finland
24| Cell slignment: i 24| 3|widget Corp Finland

5 2 25 4|strickland Propane Finland
| 26 | | 26 | 1|Mainway Toys France
| 27| Big T Burgers And Fries  France | 27| 2|Big T Burgers And Fries  France

28 limpvs. France 28 3lKlimovs France

Example screenshot: 5 Example 5

E A B G]
| 1] 3 1D per cou hd Company ountry
2| Luthorcorp Austria 2 |aT1 Luthorcorp Austria

3 Virtucon Austria AT 3 |aT2 Virtucon Austria

a4 ASAP Utilities - Quick numbering of selected cells... 4 |BE1 Mammoth Pictures Belgium BE

5 e 5 [BE2 Big Kahuna Burger Belgium BE
- [~ Series settings o —— N N
| 6 | Gl Startlyﬂm: l—l | 6 [BE3 Smith And-Co. Belg!um BE

7 ! 7 |BE4 The New Firm Belgium BE

Increment with: l—l - - -

8 1 8 |BG1 Videlectrix Bulgaria BG
| 9 | Reestart count after m‘J‘mbar: l— | 9 |HR1 Moes Tavern Croatia HR
10| Fill up with leaing M‘uf: [o =] |10 |HR2 Galaxy Corp Croatia HR

11 N e 11 |HR3 Sombra Corporation Croatia HR
12| B naE e g 12 |HRa Qwerty Logistics Croatia HR
13| " Aphabet uppercase tArB,Coom) | 1 13 |HRS Globo-chem Croatia HR

14 ,a n_- = N % 14 [HR6 Spacely Sprockets Croatia HR

™ Options "
el /”P e numbering if the value in the [ =] V‘l\ 15 feet chasers Czech Republic €7

16 ! follawing column changes: 1y 16 [CZ2 Spade And Archer Czech Republic cZ
17| . % 3 | 17 |DK1 Roboto Industries Denmark DK
(18| ||| ¥ Addvalue of changn cobmn before prefix 3 |18 [DK2 Praxis Corporation Denmark DK

15 s P ’ 15 K3 acme, Inc. Denmark DK
| 20| ~|ﬁn‘m'!'-E-I-u-.E.n_Y,rij"_aﬂgmg mlumn-af:fr_sljfﬁ—x_-‘—' i -# E DK4 General Products Denmark DK

21 R --l_““-— i 21 |DKS \Water And Power Denmark DK

22 2 22 |Fi1 Fake Brothers Finland Fl
E it 3 E F12 Demo Company Finland Fl
24 | cell dlignment: I—L[ i 24 |FI3 (Widget Corp Finland Fl

25 2 25 |Fi4 strickland Propane Finland FI
| 26| e e — | 26 |[FR1 Mainway Toys France FR
| 27| T Burgers And Fries  France FR | 27 |FR2 Big T Burgers And Fries  France FR

28 Klimpy: France FR. .28 IFR3 Klimpoy: France FR

Available tools
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Example screenshot: 6 Example 6

z D E F A B
1 1 QETE Group k4
2 |Luthorcorp 2 |Luthorcorp [comp [A]
3 |Virtucory - - r 3 3 |Virtucon [comp [B]
ASAP Utilities - Quick numbering of selected cells... -
4 Mamma - - 4 |Mammoth Pictures [comp [C]
5 |BigKahy | — Series settings = 5 |BigKahuna Burger [comp [D]
6 |SmithAf| | Numbers startwith: [~ | x| & |Smith And Co. comp [E]
7 |The New I 1 7 |The New Firm [comp [F]
8 |Videlect I_ Cancel 2 |videlectrix comp [G]
9 MoesTa . - 9 |Moes Tavern [comp [H]
10 Galaxy Q| ‘t’— S, S Example: 10 |Galaxy Corp lcomp [1]
11 Sombra € Alphabet lowgrease (s, b, c ete.) comp [4] 11 |Sombra Corporation [comp [J]
i ! comp [B] -
12 awerty i\ « Alphsbet uppercase (8, B, C, etc.) T 12 |Qwerty Logistics [comp [K]
13 |Globo-cli| v, y 4 comp [D] 13 |Globo-chem [comp [L]
14 |spacelyl| — ophere=" 2:g % 14 |Spacely Sprockets comp [M]
15 Chasers Restart numbering if the value in the comp [G] 15 |Chasers [comp [N]
16 |spade Alj| | flewing column changes: g:g [Dl']ﬂ 16 |Spade And Archer comp [O]
17 |Roboto I comp [J] 17 |Roboto Industries [comp [F]
- ™ Add value of changing column before prefix comp [K] - -
18 | Praxis C{/| comp U] 13 | Praxis Corporation [comp [Q]
15 |Acme, | | T~ Add value of changing column after suffix Ery [[L]"] 13 |Acme, Inc. comp [R]
20 Generall/| ""' %2, g:g [l 20 |General Products comp [S]
21 Prefix:
refix: 7 fomel
22 Suffix: \ l]_:i
3 3
23 N 7
21 Cell alignment: "1...__-’ -
25
26 _
27
28

Example screenshot: 7 Example 7

| A | e | ¢ | o | E F G H | & | 8 | ¢ D
1 1 [Field 1_|Field_ 2 Field 3 Field 4
2 6 72 17 111 2 6 72 17 111
3 19 37 42 97 3 19 37 42 97
4 108 [ 3 4 108 62 104 54
ASAP Utilities - Quick numbering of selected cells...
5 116 - — 5 116 86 94 95
6 52 | Series settings " = 6 52 46 33 76
7 7 & pumbers sartgitn: [T N ok 7 7 7 117 105
8 99 Incremen with: [t H 8 99 28 96 53
H ] - - - -
9 Restart count after nimber: |_" §f Cancel 9 |Field 1 Field 2 Field 3 Field 4
,
10 72 - '\ ;s 10 72 85 31 67
Fill up with leading zergs: [g + ‘E) .
11 11 e e, J 11 11 119 80 s5
12 a4 " Alphabetlowercase (2, b, cetc.) Field_1 12 a4 59 48 98
13 Ty = 13 Field 1 Field 2 Field 3 Field 4
14 52 Field_4 14 58 81 43 1
15 39 || — options :::z:é 15 39 50 3 2
16 Restart numbering if the value in the - Field_3 16 |[Field_ 1 Field 2 Field 3 Field_4
= 114 following column changes: :::H o 14 27 5 i
18 20 Field_2 18 30 64 100 102
I~ Add value of changing column before prefix Ficld_3
19 21 ot 19 21 103 41 4
20 113 [™ Add value of changing eslun after suffix Ee:g_é 20 113 92 82 18
ie
21 63 7 * Fiekd 3 21 63 26 93 a5
22 12 Prefix: 1 |_'—Fie‘d H E‘E:g_? 22 13 83 77 3
- i
2 7 Suffix: N va Field_2 23 74 101 40 124
N - =
24 50 il Field_3 2 50 16 120 61
Cell alignment: P2 A A A A
25 g 2 | - 25 Field 1 Field 2 Field 3 Field 4
26 22 26 32 51 65 2
27 69 TIIOTIGS 5 27 69 110 109 5
28 10 22 107 12 28 10 22 107 12
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Example screenshot: 8 Example 8

D A C
I 0 county county - e ——
2| |Austria Luthorcorp 2| 1f|Austria Luthorcorp
3 Virtucon 3 Virtucon
| 4 | Belgium Mammoth Pictures I 4] 2|[Belgium Mammoth Pictures
5 | ASAP Utilities - Quick numbering of selected cells.. N Big Kahuna Burger
o [~ Series settings ————————————— === 2 Smith And Co.
7 r 7 The New Firm
8 Cliates SE""MW l_l 8 3||Bulgaria Videlectrix
| 9 | Imemerlr{ s l_l 9 | 4||Croatia Moes Tavern
10| Restart count after nimber: l_ (10 Galaxy Corp
11 Fill up with leading ;b(‘ns: IE / . | Sombra Corporation
12 | Rea, i J 112 Qwerty Logistics
13 " Mphabet lowercase (a, b, cetc.) ; 13 Globo-chem
14 " Aphabet uppercase (A, B, C, etc.) 3 14 Spacely Sprackets
|15 | ; 115 5||Czech Republic  |Chasers
16 [~ Options 6 16 Spade And Archer
|17 | I;:@ﬁﬁ;g&;gn;iﬂﬂ;:;a\ue nthe :I' ; 17| 6|[Denmark Roboto Industries
|18 | 9 18| Praxis Corporation
|19 | [~ Add value of changing column before prefix ﬁ 19| Acme, Inc.
20 2 20 General Products
21| [~ Add value of changing column after suffix 3 1| \Water And Power
22 15 22 7|Finland Fake Brothers
E b= S E Dema Company
24| Suffix: ﬁ 24 \Widget Corp
25 Cell dignment: l—;l inl 25 Strickland Propane
| 26 | 2 | 26 | 8|[France Mainway Toys
27 e — 27 Big T Burgers And Fries
28 Klimny: P Klimay:
D E A B C
1 be hd Compa B Co T
Incom Corporation Spain 11]Es o1 Incom Corporation Spain
Allied Biscuit Spain " (19 |Es_02 Allied Biscuit Spain
|21 ASAP Utilities - Quick numbering of selected cells... | 21ES 03 Widget Corp Spain
23 23 |ES_04 Rouster And Sideways  Spain
28| e e« 28| ES_05 Globo-chem Spain
29 | O lmms Start‘y% ' 29 ES_06 Ziffcorp Spain
E l"aemer‘f lE E ES_07 Roboto Industries Spain
46 | Restart count after nimber: 46 |ES 08 Globex Corporation Spain
ﬁ Fill up with leading z‘éu:s: ﬁ ES_09 Monks Diner Spain
49| > |49 [ES_10 Krustyco Spain
50 " Alphabet lowercase (s, b, c etc.) 50 |ES_11 Galaxy Corp Spain
51| " Alphabet uppercase (4, B, C, etc.) |51 ES 12 Demo Company Spain
52| |52 |ES_13 [Water And Power Spain
56 | [~ Options |56 [ES_14 North Central Positronics Spain
[57] et b e vober e Eii=e 57es 15 Querty Logisics  Spain
66 | E5_09 | 66 |[ES_16 Moes Tavern Spain
67| I~ Add value of changing column before prefix EZ{? |67 |[ES_17 Nordyne Defense Dynarr Spain
69 ES_12 69 [ES_18 [Western Gas & Electric  Spain
78 | I add yaive “Fmang""_g_c_“l‘m" after suffix Eg'ﬁ 78| ES 19 Mammoth Pictures Spain
E o ;'/ ‘\‘ Eg_ll.g E ES_20 Flowers By Irene Spain
95| ’ OE- E5_17 |95 [ES_21 Sto Plains Holdings Spain
102 EriE WS Ny 102|Es_22 Blammo Spain
12 cagmens [ 3] |52 i
113 Es 22 113
114 114
115 115
116 116,
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15 Random numbering of cells (without duplicates)

This utility fills the selected cells with unique random integers.

This can be useful if you want to quickly create a list of random numbers without
duplicates.

The lowest created number in the list is 1 and the largest number is the number of cells in
your selection.

H D=2 T (= 0114 - Random numbering of cells (without duplicates).xlsc -
“_ Home  Insert  Pagelayout  Formulas  Data  Review  View | ASAP Utilities
" O [T sheets + { Columns & Rows ~  [F} Numbers & Dates ~ &% web +
A #] Range * [x] Objects & Comments = [AText - | Information =
Favorites & | Wision Select :
Shorteut keys = | Control  ~ |i=i Fill=|  [Gg Format ~ S Formulas - (R File & System
Favorites [0 1. Fill empty cells in selection... e
AL - M 2 Overwrite filled cells in selection... [
A [ B 1= 3. Copyvalues to empty cells below filled cells in selection
% % 4. Fill up with leading zeros...
ER [ 5.Insert before and/or after each cell in your selection...
z I 6. Fill ‘between values linear in selection (vertical)
| 5 | T 7.Fill between values' linear in selection (horizontal)
15| i= 8. Quick numbering of selected cells... (Ctri=Alt=Q)
% BF 9. Random numbering of cells fwithout duplicates)
g | |E 10. Insert current date and time with seconds (Ctrl=Shift=D]
| 10| ©  11.Insert current time with seconds (Ctrl+Shift=T)
|11 2! 12 Insertworkbook's path and name in header, footer or cell...
1121 [ 13. Create a list of filenames and properties in a folder... (Ctri=Alt+F}
i 4 5 14.Insert sheet(s) name in selected cell(s)
| 14|
115
|16
17
10

-
a9~ 1 > 23 T |+ 0114 - Randem numbering of cells (without duplicates) xlsx -
e

Insert Page Layout Formulas Data Review View ASAP Utilities

N -
", © % [ sheets - i Columns & Rows ~  [#} Numbers & Dates ~ €5 Web -
A [# Range = [ Objects & Comments = | A Text ~ |8 Information ~
Favorites & [l Vision Select
Shortcut keys Wl Control  ~ =i Fill~  [E3) Format - f Formulas - [ File & System
Favorites Time saving tools
AL - |7
A | B C D E F G H

ER 7 16|
| 2| 2 20
=R 23 23
L4 ] 30 23
|5 4 24
| 6 | 32 12|
L7 1 28
|8 | 3 21
EX 10 8|
|10/ 9 5|
|11} 13 17|

12 21 18]
| 13] 6 2

14 34 26
|15 25 27
|16 13 15|

7 14 11|

18

16 Convert/recognize dates...

This utility helps you to convert the not recognized dates in the selected cells.

Sometimes Excel treats dates as text. This problem often occurs when data is imported or
copied from other programs. The problem is often caused by a difference between the date
formats in your data and the local settings on your computer.
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When Excel doesn't recognize these dates are left aligned, the cell formatting to display the
dates doesn't work and you can't use them in your calculations.

With this utility you can quickly convert them so that Excel recognizes them as proper
dates.

The text-date values all have to be constructed in a similar logical way in order for this
utility to convert them.

Your last used settings will be remembered.

A B [ ¢ [ o | E [ F [ & | H |
[JANUARY 23 11
JANUARY 24 11

ASAP Utilities - Convert/recognize dates

Date format in selected cells:

[
=
r
=
c
x

L JANUA [rommm ] [space |[d | [space =] [vv - |

JJANUA]

IANUA Language: |Engllsh j Cancel 1
10 |FEBRUA, \
?FEERU f example (today): January 17 11 i
|12 JFEBRUAY Convert to: e b
13 |FEBRUAY
14 [FEBRUAY | |4 =lf- =jmm =il =flyyyy = hd hd hd |
15 |FEBRUA|

example (today):  17-01-2011

&
i}
m
o
A
=

b=}
i
m
fus]
ps)
=

{* Use number formatting for dates (recommended)

=
]
m
m
a
c

" Write out dates as text

©
i
m
fus}
ps)
=

(]
=1
]
m
fus]
A
1=
]

I™ Skip the first row in the selected range (header)

i
! Example: In your selection, the date "JANUARY 23 11' becomes '23-01-2011'

JEEEEREENS
i}
m
m
)
o

FEBRUARY 20 11 |

Change Julian dates to normal dates

This tool will convert Julian dates to normal dates.

A Julian date is sometimes used in the computer industry to refer to a date format that is a
combination of the current year and the number of days since the beginning of the year.
For example, January 1, 2011 is represented as 2011001 and December 31, 2011 is
represented as 2011365. Note that this format is not based on the Julian calendar.

Besides the yyddd and yyyyddd the JD Edwards (AS/400) cyyddd format is also supported
by this tool. Their system adds a 0 or 1 in front of the year representing the century (0 =
1900, 1 = 2000, Jan 15, 1910 is 010015, Jan 15, 2010 is 110015).
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D
Julian date Julian date JD Edwards (AS/400)
| 1 yyyyddd B
2 1998001 98001 098001
3 1998091 98091 098091
4 1998181 98181 098181
5 1998271 98271 098271
6 1998361 98361 098361
7 2012001 12001 112001
8 2012091 12091 112091
9 2012181 12181 112181
10 2012271 12271 112271
% ASAP Utilities - Change Julian dates to norma‘l;hes — g‘
s
14} @ Do you want to convert all Julian dates (yyddd or yyyyddd) in your
15 ¥' celection to 'standard' Excel dates?

3 If you are using JD Edwards Julian Dates, they need to have a length of &
16 {cyyddd the Julian date is preceded by a0 or 1, 0 for a year in 1900 and 1
17 for a year in 2000}

18
19
20 Cancel
21
22

Julian date

|1 yyyyddd K yyddd B

2 1/1/1998 1/1/1998 1/1/1998]
3 4/1/1998 4/1/1998 4/1/199g|
a 6/20/1998 6/20/1998 6/30/1938
B 9/28/1398 9/28/1998 9/23/193g]
6 12/27/1998 12/27/1998 12/27/193§)
7 1/1/2012 1/1/2012 1/1/2012)
8 3/31/2012 3/31/2012 3/31/2012|
El 6/29/2012 6/29/2012 6/29/2012)
10 9/27/2012 9/27/2012 9/27/2013)
1 12/26/2012 12/26/2012 12/26/20
12

13

168
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5.5.11 Text

A collection of tools for working with text values.

1 Insert before and/or after each cell in your selection...

This utility adds a value in front of and/or at the end of the content of each cell in your
selection.
The utility will show you an example of the resulting values.

You can specify the following:

= The value to insert before at the front of each cell

= The value to add at the end of each cell

= Use the value, formula or displayed (formatted) value from the cells.
= |Include hidden cells

= Skip empty cells

The 'reset’ button clears the insert before and after values and resets the options to their
default values. This can be useful because this tool always remembers your previous
settings.

You can also use this utility to build a formula around the current values.

Example screenshot: 1

A B C D
4
2 [+shop 0.06 13600000

3 [+machine 1 072 1830000
_ 4 |+maker ASAP Utilities - Insert at beginning and/or end

5 [+makers

bRizhat 2dd before: | x 1B
7 |+machines J

§ |+pot [ tcaffes =l
9 |+able 2dd after: T P
10 [+cup =

11 [+bean I j

12 |+green {fy  =line feed character (alt+enter)

13 [+tables {tab} = tab character

14 [+beans

211: :mug treat cells as: S
7#"{:?— [ values (default) -] ——
_18 |+cups I Indude hidden cells
5::35? — [V skip empty cells Reset I
21 [+company — G

22 |+recipe +coffee +shop

23 |+recipes +coffes +machine

24 |+break +coffee +maker
25 |+cups +mugs i:?;:: :‘g‘:{ms

26 [+grinder +coffee +machines

27 |+review +coffee +pot

28 |+reviews +eoffes +able
29 |+roasters — —

30 [+buy 016 7165000

31 [+grinders 0,22 165000

32 |+art 0,08 135000

EE) P nna EEET
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Example screenshot: 2

B B D
I Keyword B3 Competition Bl Global Monthly Searches B Local Monthly Searchd]
2 |+coffee +shop 0,08 13600000
3 |#coffee +machine 0,72 1830000
| 4 |#coffee +maker 0.52 1830000
5 |#coffee +makers 0.5 1500000
6 [+coffee +bar 0.09 1220000
7 |#coffee +machines 0,76 1220000
8 |+coffee +pot 044 1220000
9 |+coffee +table 047 1220000
10 |#coffee +cup 0.13 1000000
| 11 |#coffee +bean 0.1 823000
12 |+coffee +green 0.26 823000
| 13 |+coffee +tables 0.52 623000
14 |+coffee +beans 0.1 673000
15 |#+coffee +mug 017 550000
16 |+coffee +mugs 0,19 550000
17 |#coffee +pots 0.37 450000
18 |+coffee +cups 0,17 368000
19 |+coffee +cake 0.01 301000
| 20 |#coffee +equipment 0.77 301000
21 |#coffee +company 0.07 246000
22 |+coffee +recipe 0.02 246000
23 |+coffee +recipes 0,02 246000
24 |+coffee +break 0.02 201000
25 |+coffee +cups +mugs 0,19 201000
26 |#coffee +grinder 0.19 201000
27 |+coffee +review 02 201000
28 |+coffee +reviews 0,25 201000
| 29 |#coffee +roasters 0.08 201000
30 |+coffee +buy 0.16 165000
31 |+coffee +grinders 0,22 165000
32 |+coffee +art 0,08 135000
ETR P n A 42cnnn

Change to UPPERcase

This utility makes all text in your selected cells uppercase.
For example 'this is a test' becomes 'THIS IS A TEST'.

This can be useful with for example city names, article codes and postal codes.

A B C
il Company B city B country hd
2 [lexcorp bern switzerland
3 |mammoth pictures brussels belgium
4 |videlectrix sofia bulgaria
5 [sombra corporation 7asreh croatia
A B C
6 |chasers 1 B Hdi B count
7 |praxis corporation M. Company ity ountry
2 |LEXCORP BERN SWITZERLAND
8 [fake brothers
- 3 |MAMMOTH PICTURES BRUSSELS BELGIUM
9 |mainway toys
4 |VIDELECTRIX SOFIA BULGARIA
10 |charles townsend agency
11 [the frying 5 |SOMBRA CORPORATION ZAGREB CROATIA
6 |CHASERS PRAGUE CZECH REPUBLIC
12 [three waters
. 7 |PRAXIS CORPORATION COPENHAGEN DENMARK
13 [universal export
8 |FAKE BROTHERS HELSINKI FINLAND
14 |acme corp
- 9 |MAINWAY TOYS PARIS FRANCE
15 [wayne enterprises
16 [tip top cafe 10 |CHARLES TOWNSEND AGENCY LONDON GREAT BRITIAN
- - 11 |THE FRYING DUTCHMAN ATHENS GREECE
17 [omni consimer products
12 |THREE WATERS BUDAPEST HUNGARY
13 |UNIVERSAL EXPORT DUBLIN IRELAND
14 |ACME CORP ROME ITALY
15 |WAYNE ENTERPRISES LUXEMBOURG LUXEMBOURG
16 |TIP TOP CAFE 0sLO NORWAY
17 |OMNI CONSIMER PRODUCTS MOsCow RUSSIA
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Change to lowercase

Make all text in your selected cells lowercase.
For example 'This Is A Test' becomes 'this is a test' .

9 |m,

A B C
il Company B country B city [~ |
2 |LEXCORP BERN SWITZERLAND
3 MAMMOTH PICTURES BRUSSELS BELGIUM
4 VIDELECTRIX SOFIA BULGARIA
5 |SOMBRA CORPORATION ZAGREB CROATIA
6 (CHASERS DRAGLIE C7ECH REDIIRLIC
C
7 PRAXIS CORPOI
Ci 2 Count Ci
8 | FAKE BROTHERS —— Rdmity B city |
2 lexcorp bern switzerland
WAY TOYS - N
—————————————— 3 mammoth pictures brussels belgium
10 |CHARLES TOWNSEND AGE| - - - N
—————— 1 4 videlectrix sofia bulgaria
11 | THE FRYING DUTCHMAN - -
—_— | 5 sombracorporation zagreb croatia
12 THREE WATERS
————————————— b chasers prague czech republic
13 |UNIVERSAL EXPORT - -
14aCMECORP | 7 praxis corporation copenhagen denmark
——_—————— & fake brothers helsinki finland
15 \WAYNE ENTERPRISES - N
————— 1 9 mainway toys paris france
16 TIPTOP CAFE
———————————————— 10 charles townsend agency london great britian
17 |OMNI CONSIMER PRODU(Q -
e 11 the frying dutchman athens greece
12 three waters budapest hungary
13 universal export dublin ireland
14 lacme corp rome italy
15 wayne enterprises luxembourg luxembourg
16 tip top cafe oslo norway
17 omniconsimer products moscow russia

Start first word with Uppercase

This utility changes the first character in each of the selected cells to a capital.
The rest of the characters will be unaffected.
For example 'this is a test' is changed to 'This is a test'.

w

A B C
il Company ﬂ Country ﬂ City ﬂ
2 |lexcorp bern switzerland
3 |mammoth pictures brussels belgium
4 videlectrix sofia bulgaria
5 sombra corporation zagreb croatia
6 chasers Aramu zach ranuhli
7 |praxis corporati & e
Ci 2 Ci it hd Ci e
8 fake brothers ompany n ey . I .
- 2 Lexcorp Bern Switzerland
mainway toys - -
. .| 3 Mammoth pictures Brussels Belgium
10 |charles townsend agency| - - - -
- 4 del Sofia Bulgaria
11 |the frying dutchman - -
——— | 5 Sombra corporation Zagreb Croatia
12 three waters -
- 6 |Chasers Prague Czech republic
13 universal export — -
7 Praxis corporation Copenhagen Denmark
14 |acme corp - "
—————— | B Fake brothers Helsinki Finland
15 |wayne enterprises - -
— 1 9 Mainway toys Paris France
16 tip top cafe —
— — {10 Charles townsend agency London Great britian
17 'omni consimer products —
S ————— 11 The frying dutchman Athens Greece
12 Three waters Budapest Hungary
13 Universal export Dublin Ireland
14 Acme corp Rome Italy
15 Wayne enterprises Luxembourg Luxembourg
16 Tip top cafe Oslo Norway
17 Omni consimer products Moscow Russia
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Make first character Uppercase, the rest lowercase

This utility changes the first character in each of the selected cells to a capital. The
remaining characters will be converted to lowercase.
For example both the text 'THIS IS A TEST' and the text 'this is a test' is changed to 'This is a

test'.

A B
Ll Country [- =
2 VIENNA AUSTRIA
3 | MINSK BELARUS
4 BRUSSELS BELGIUM
5 SOFIA BULGARIA
5 ZAGREB FROATIA A
8 COPENHAGEN 2 |vienna Austria
9 |HELSINKI 3 |Minsk Belarus
10 PARIS 4 |Brussels Belgium
11 LONDON 5 sofia Bulgaria
12 | ATHENS 6 |zagreb Croatia
JE3) BUDAPEST 7 |Prague Czech republic
14 DUBLIN 8 |Copenhag Denmark
15 ROME 9 |Helsinki Finland
16 LUXEMBOURG N
10 Paris France
irjosio 11 London Great britian
12 Athens Greece
13 |Budapest Hungary
14 |Dublin Ireland
15 |Rome Italy
16 |Luxembourg Luxembourg
17 Oslo Norway

Start Each Word With Uppercase

This utility will start each word in the selected cells with a capital.
All other characters will be converted to lowercase.
For example the text 'new york' is changed to 'New York'.

You can use this as a quick alternative for Excel's =PROPER() function. There is however a
difference. This utility only converts the first letter of every word (the first word and
everything after a space) to uppercase. But Excel's =PROPER() also capitalizes all letters in
the text that follow any character other than a letter.

This utility can be useful with for example city names.

A B C
i
2 |lexcorp minsk belarus
3 |mammoth pictures brussels belgium
4 |videlectrix sofia bulgaria
5 sombra corporation zagreb croatia
6 |chasers = L
T |praxis corporatios & 2 5 =
E Company B country B city -
8 fake brothers "
- 2 |Lexcorp Minsk Belarus
9 |mainway toys 3 Pictures Brussels Belgium
10 charle%tnwnsend agency| n - Sofia Bulgaris
11 [the frying dutchman 5 Sombra Co Zagreb Croatia
i lhrree waters 6 Chasers Prague Czech Republic
13 |universal export 7 Praxis C Copenhagen Denmark
14 |acme corp - 8 |Fake Brothers Helsinki Finland
E wayne E 9 | Mai Toys Paris France
3 % 10 |Charles Townsend Agency London Great Britian
171123 warehousing | 11 The Frying Dutchman Athens Greece
12 Three Waters Budapest Hungary
13 Universal Export Dublin Ireland
14 |Acme Corp Rome Italy
15 |\Wayne Er Luxembourg Luxemb
16 Tip Top Cafe oslo Norway
17 |123 Warehousing ‘Warsaw Paland
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Change Case (with options)...

This tool changes the text in the selected cells to uppercase, lowercase or other common
capitalizations.

You can change the text in selected cells to:

= |lowercase

= UPPERCASE

* tOGGLE cASE

= Sentence case (first letter of each sentence in uppercase)

= Glossary case (first letter of each sentence in lowercase)

= Capitalize Each Word (Optionally make the first letter of each word uppercase, and the
rest of the word lower case. And if required you can specify the characters (in addition to
a space) that indicate that a new word starts.)

Options:

= Choose to preserve all capitalized text (useful in converting glossaries with
abbreviations).
= Set words to preserve/exclude.

A B 5 D E
1 Ompa - R Count -
2 |lexcorp bern switzerland
3 |mami AsAp Utilities - Change Case -
4 |videl —
5 |som — Change the text in selected cells to:
6 |chase " lowercase
7 |prax " UPPERCASE
g |fake
9 " tOGGLE cASE

main

~ Sentence case, (Firstletter of each sentence in uppercase.)

10 |charl
11 [the T " Glossary case (first letter of each sentence in lowercass)
12 |thregll | & Capitaiize Each Word
13 |unive

[ Make first letter of each word uppercase, and the rest of the word lower case.
15| iy Any of the following characters (in addition to a space) indicates that a new word starts:
15 [wayn
16 [tip t

-

17 Jlomn ct
18 [data
19 [allied | — options

20 |trans [ Preserve all capitalized text
21 |exte (useful in converting glossaries with acronyms)

22 |nordy - Preserve the following words (separated by a comma):

23 |unitg] |
24 |\barry|
|
H

25 |thrift
26 |sto pl
27 |luth Cancel |

28 |zevo

29 |big ki ==

30 |moes tavern sofia bulgaria
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Spell/write out numbers or amounts (EN, DE, NL)...

This utility spells out the numbers in your selection.

For example the number "12.75" written out in English in the currency dollar becomes

Twelve Dollars and Seventy Five Cents.
This utility replaces the numbers in your selection with the written numbers.

You can choose to write out the numbers as numbers or as an amount (for example to use

on a check).
You can choose between the languages English, German and Dutch.

The default currencies are none, dollars or euro. You can also type in another currency.
If a number contains more than two decimals this function will spell out the number as if it
was rounded to two decimals.

[ 4] A B c D E
| 1| 27,00 27,00
| 2] 76,00 76,00
3 22 00 22.00
I ASAP Utilities - Spell numbers or amounts (EN, DE, NL)
% Language
| 7 | + English " putch " German [ !
| 8
9| Currency Cancel
% " none # Dollars « Euro
112 " custom: Currency: Cent:
% singular: W ,F
(15| plural: [poliars Cents
6]
7 The numbers in the cells you've selected will be spelled.
% The existing numbers will be replaced.
20 =—=
|2 3148 348
| 22 | 87,94 87,94
|23 | 28,56 28.56
24 I
[ 4] A B c D E
| 1| 27,00 | Twenty Seven PDollars and Mo Cents
| 2] 76,00 | Seventy Six Dbllars and No Cents
=N 22,00 | Twenty Two Dullars and No Cents
4] 82,00 | Eighty Two Ddlars and MNo Cents
| 5| 91,00 | Ninety One Ddllars and No Cents
| 6 | 47,00 | Forty Seven Dpllars and No Cents
| T | 86,00 | Eighty Six Dolars and Mo Cents
| 8 228,00 | Two Hundred “Jwenty Eight Dollars and No Cents
|9 500.000,00 | Five Hundred ‘Jhousand Dollars and Mo Cents
110 | 2,00 | Two Dollars arld No Cents
|11 60,00 | Sixty Dollars and No Cents
|12 5.421.000,00 | Five Million Fouir Hundred Twenty One Thousand Dollars and No Cents
|13 | 25,00 | Twenty Five Dollars and No Cents
14 45,00 | Forty Five Dollars and No Cents
| 15 | 27,00 | Twenty Seven Dollars and Mo Cents
|16 4,37 | Four Dollars agd Thirty Seven Cents
| 17 | 50,01 | Fifty Dollars ayd One Cent
18] 17,59 | Seventeen Dolars and Fifty Nine Cents
119 | 71,00 | Seventy One ollars and No Cents
20 2256 | Twenty Two Dyllars and Fifty Six Cents
|2 31,48 | Thirty One Dolars and Forty Eight Cents
| 22| §7.94 | Eighty Seven Bollars and Ninety Four Cents
|23 | 28,56 | Twenty Eight Wollars and Fifty Six Cents
24
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Convert/recognize dates...

This utility helps you to convert the not recognized dates in the selected cells.

Sometimes Excel treats dates as text. This problem often occurs when data is imported or
copied from other programs. The problem is often caused by a difference between the date
formats in your data and the local settings on your computer.

When Excel doesn't recognize these dates are left aligned, the cell formatting to display the
dates doesn't work and you can't use them in your calculations.

With this utility you can quickly convert them so that Excel recognizes them as proper
dates.

The text-date values all have to be constructed in a similar logical way in order for this
utility to convert them.

Your last used settings will be remembered.

A B [ ¢ [ o [T E [T F T &6 [ H ]
[JANUARY 23 11
JANUARY 24 11

ASAP Utilities - Convert/recognize dates

Date format in selected cells:

[moomm —_~|[space ~][d =] space =] [vy |

EENSENEE
=
2
=
[y
>

[ ANUA Language: |Eng“sh j ﬂ
% EEEEE example (today): January 17 11
£ FEBRUL Convert to: s
13 |FEBRU.

example (today): 17-01-2011

=
n
o
@
3
=

o
n
o
m
o
c

)
i
m
fus]
ps)
=

=
]
o
m
a
c

¥ Use number formatting for dates (recommended)

)
i
m
fus]
ps)
=

" Write out dates as text

o
]
o
m
a
c

~
=1
]
o
m
]
o

I skip the first row in the selected range (header)

Example: In your selection, the date 'JANUARY 23 11' becomes '23-01-2011'

FEBRUARY 20 11 |

([pamamomal o ra] o ma] ma
INEEEREEES
il
m
o)

o
c
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Delete leading and trailing spaces
This utility removes all spaces from the beginning and end of the values in your selected

cells.

For example if you have a cell with the value " Excel " then this utility changes the value to
"Excel" without the spaces at the front and end.

A B C A B C
il B company B country - o B company B country -
2| 527 Lutharcorp Austria 2 527 Luthorcorp Austria
2 501 Lexcorp Belarus 3 501 Lexcorp Belarus
4| 528 Zevo Toys Belarus 4 528 Zevo Toys Belarus
5 502 Mammoth Pictures Belgium 5 502 Mammoth Pictures Belgium
6| 529  BigKahunaBurger Belgium 6 529 Big Kahuna Burger Belgium
7 503 Videlectrix Bulgaria ¥ 503 Videlectrix Bulgaria
8 530 Moes Tavern Bulgaria 8 530 Moes Tavern Bulgaria
o |504 Sombra Corporation Croatia 9 504 Sombra Corporation Croatia
10 531 Querty Logistics Croatia 10 531 Querty Logistics Croatia
11 [505 Chasers Czech Republic q 1 505 Chasers Czech Republic
12 532 Spade And Archer Czech Republic 12 532 Spade And Archer Czech Republic
13 |506 Praxis Corporation Denmark 13 506 Praxis Corporation Denmark
14 533 Acme, Inc. Denmark 14 533 Acme, Inc. Denmark
15 [507 Fake Brothers Finland 15 507 Fake Brothers Finland
16 534 Demo Company Finland 16 534 Demo Company Finland
17 |508 Mainway Toys France 17 508 Mainway Toys France
18 535 Big T Burgers And Fries France 18 535 Big T Burgers And Fries France
19509 Charles Townsend Agency  Great Britian 19 509 Charles Townsend Agency  Great Britian
20 536 Gringotts Great Britian 20 536 Gringotts Great Britian
21|510 The Frying Dutchman Greece 21 510 The Frying Dutchman Greece
22 537 Input, Inc. Greece 22 537 Input, Inc. Greece
23511 Three Waters Hungary 23 511 Three Waters Hungary
24 538 Megadodo Publications Hungary 24 538 dod icati Hungary
25 512 Universal Export Ireland 25 512 Universal Export Ireland

Delete leading, trailing and excessive spaces

This utility removes all spaces except for single spaces between words in the selected cells.
All the spaces at the beginning and end of each cell value will be removed and all repetitive
spaces will be replaced by a single space.

For example the value ' Lennox Street 141' will be replaced with 'Lennox Street 141"
This utility is a quick alternative for Excels =TRIM () function.

Example screenshot: 1 Before

A B c
NAME STREET cImy
Company D Marigold Avenue 43 Dublin
Company K ~ Raymond Strest 85 Dublin

Company J Moyle Road 158 "~ < Dublin -
Company By Eccles Street 25 London
Company C  Benson Street 34 London
Company Q Céide Le Fanu 43 g London
Company F 5 Balfe Street g\ # Amsterdam
Company H z Mespil Road 46 New Yok
Company A g Lennox Street 141 MNew York
11 |Company E " McDowell Avenue k23 New York
12 |Company | Glenaulin Park 83 " Mew York
13 |Company N Duke Street 23~ New York
14 | Company P Rathdown Villas 56 Prague

15 |Company G X Crinan Strand , 93 A Minsk

16 Company M X Bunting Road 6 Copenhagen

w0~ ot |k =

=
=

17 |Company L Merton Road 18 Luxembourg
18 |Company O Ganville Road 22 « Vienna N
19 [
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Example screenshot: 2 Strip the leading, trailing and duplicated spaces

Example screenshot:
A B

|

3 After

\ c |
NAME STREET CITY
Company D Marigold Avenue 43 Dublin
Company K Raymond Street 85 Dublin
Company J Moyle Road 158 Dublin
Company B Eccles Street 25 London
Company C Benson Street 34 London
Company Q Céide Le Fanu 43 London
Company F Balfe Street 6 Amsterdam
Company H Mespil Road 46 New York
Company A Lennox Street 141 MNew York
Company E McDowell Avenue 23 MNew York
Company | Glenaulin Park 83 New York
Company N Duke Street 23 MNew York
Company P Rathdown Villas 56 Prague
Company G Crinan Strand 93 Minsk
Company M Bunting Road 6 Copenhagen
Company L Merton Road 18 Luxembourg
Company O Ganville Road 22 Vienna

- I= 0087 - Delete leading, trailing and excessive spacesxls [Compat
e Home Insert Page Layout Formulas Data Reviewr View ASAP Utilities
', © [ sheets + [ Columns & Rows ~  [#} Numbers & Dates = g5 Web - % tmport ~
A ] Range = | Objects & Comments « || A Text = €% Information = ] Export -
2 ) P
My favorite | Vision Select }
tools ™ Control - =i Fillv [zl Format - 4 1.Insert before and/or after each cell in your selection...
Favorites Time savi A* 2, Change to UPPERcase
B2 - J | Marigold Avenue 4 ™ 3. Change to lowercase
A [ B [ C A 4. Start first word with Uppercase
il NAME STR_EET CITY Aa 5. Make first character Uppercase, the rest lowercase
2 Company D Marigold Avenue 43 Dublin §
3 |Company K Raymond Street 85 Dublin A 6. Start Each Word With Uppercase
4 |Company J MMoyle Road 158 Dublin '’ 7. Spellwrite out numbers or amounts (EN, DE, KLJ...
5 |Company B Eccles Street 25 London -
6 Company C Benson Street 34 London Sp 8 Convert/recognize dates...
| 7 Company Q Céide Le Fanu 43 London B 9. Delete leading and trailing spaces
8 |Company F Balfe Street 6 Amsterdam
' 9 | Company H Mespil Road 46 New  York ] 10. Delete leading, trailing and excessive spaces
10 Company A Lennox Street 141 New York #5311, Advanced character remove or replace...
| 11 Company E McDowell Avenue 23 New York €2 12, Replace accented characters (3, & fi etc)..
12 |Company | Glenaulin Park 83 MNew York
[ 13| Company N Duke Street 23 New York [A] 13. Dejete all text characters (a-7] in selected cells
14 | Company P Rathdown Villas 56 Prague 1 14. Delete all pumbers in selection
| 15 |Company G Crinan Strand 93 Minsk |l 15. Remove ending carriage return (alt < enter character)
16 |Company M Bunting Road 6 Copenhagen
17 |Company L Merton Road 18 Luxembourg il 16, Delete number of leading characters...
18 |Company O Ganville Road 22 Vienna i 17. Delete number of ending characters...
;g :A 18. Delete all after a given number of characters...
21 X* 19, Make last character superscript
22 X: 20, Make last character subscript
23
24 = 21.Reverse text in selected cells
25
26

Clean data and formatting...

5 Asap

b Find

This utility helps you to optimize and clean information that you have copied into Excel.

You can choose the following edits:

remove all hyperlinks

trim spaces (removes leading and

trailing spaces)
remove all cell colors
remove all font colors
remove all borders
unmerge cells

apply standard font

= apply standard font size

" no wrap-text

= fix (text)numbers
= autofit columns

= autofit rows

= remove all objects/images from your

worksheet

Available tools
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Your last used settings will be remembered.

A B € D E F G H 1 K L
. Official
Rank Me_tmp"l Country (Exiificag populati | Year
1 itan t on
, oo |Mpn [ams (RS g
B 2|Shanghai | China  |Asia | ASAP Utilities - Clean data and formatting X
__Jonesi| In selected range: AL:F101
3|Jakarta |T— |Asia
4 ] — ¥ Remove all hyperiinks [V Apply standard font size
~ 4|Delhi m Asia I¥ Irim spaces [V No wrap-text.
2 M Remove all cell colors [+ Fix (text)numbers
s 5|seoul Asia ¥ Remove all font colors ¥ Autofit columns
4 Guangzh e ¥ Remove all borders Maximumn width:
7 i ¥ Unmerge cells [V Autofit rows
e W Agply standard font Maximum height:
s Asia
i ee In this worksheet: Before
e ¥ Remove all objectsfimages
10 stz -
North Cancel ‘ Al | Invert ‘ None oK
1 America
South- . e
12 America (9
A B C D E F G
1 |Rank Metropolitan ‘Country Continent | Official population Year
2 1 Tokyo Japan Asia 37,832,892 2016
3 2 Shanghai China Asia 34,865,252 2015
4 3 Jakarta Indonesia Asia 31,689,592 2015
5 4 Delhi India Asia 26,454,000 2011
6 5 Seoul South Korea Asia 25,514,000 2016
7 6 Guangzhou China Asia 25,000,000 2015
8 7 Beijing China Asia 24,500,000 2015
9 8 Manila Philippines Asia 24,650,000 2018
10 9 Shenzhen China Asia 23,300,000 2015
n 10 Mexico City Mexico North America 21,650,668 2017|
12 11 S&o Paulo Brazil South America 21,242,939 2016
13 12 Lagos Nigeria Africa 21,000,000 2014
14 13 Mumbai India Asia 20,748,395 2011
15 14 Cairo Egypt Africa 20,500,000 2012
16 15 New York City United States North America 20,320,876 2017
17 16 Keihanshin (Kyoto-Osaka-Kobe) Japan Asia 19,342,000 2010
18 17 Wuhan China Asia 19,000,000 2015
1ol 12 channdn China Acia 12 100 nnn | 2015

Find and/or replace in all sheets...

With this utility you can find and/or replace in all worksheets at once.

This makes it easier to find information across you entire workbook.

The results will be displayed in a list and you can quickly activate a cell from this list. You
can replace the results one by one or replace them all at once.

One of the advantages in comparison to Excel's default search and replace capabilities is
that this utility makes is easier to deal with the special characters line feed (Alt+Enter),
carriage return and tab.

You can use the following codes to search for these special characters or use them as
replacement: {If} = line feed (Alt+Enter/ascii code 10), {cr} = carriage return (ASCIl code 13),
{tab} = tab character.

Another advantage is it doesn't have Excel's length limit. In Excel you can receive the error
"Formula is too long". Excel finds what you are looking for but you cannot replace it. This
error has nothing to do with formulas; you can also get it if your cells contain only text. In
such a case you can use ASAP Utilities to replace the text, because this utility does not have
that limitation.
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You can configure the following settings:

= Find what: the information to search for. You can use the ? and * wildcard characters;
use ~? and ~* to find the ? and * characters.
= Replace with: the value to replace the search value with.
= Find/replace in:
- All worksheets
- Current worksheet
- Selected range
= Search: by rows or by columns
= Look in: formulas or values.
= Match Case
= Match entire cell contents

By default you can start this utility with the shortcut Ctrl+Alt+H.

Your last used settings will be remembered.

Example screenshot: 1

ASAP Utilities - Find and/or replace in all sheets

You can use the following codes for spedial characters:

Search for:

You can use the ? and * wildcard characters; use ~? and ~* to find the ? and * characters.

{If} =line feed (alt+enter/asdi code 10), {c} = carriage return (ASCII code 13), {tab} = tab character

Replace with:

[2012
Findjreplace in:
% all worksheets
" Current worksheet

" Range (A1:K67)

2013

Search By Rows = Close

Find all

Lookin: | Values
[~ Match Case

[~ Match entire cell contents

=l

Replace

;

Replace Al

Fold out >>
Select a row to jump to the found cell: Results found: 18
Sheet  Cell Value  Formula  Display  Action -
01 N2 2012 012
01 122 2012 012
01 N48 2012 012
02 N2 2012 012
02 Y22 2012 012
02 N48 2012 2012
03 N2 2012 012
03 122 2012 012
03 N48 2012 2012
04 N2 2012 012 |

Example screenshot: 2

ASAP Utilities - Find and/er replace in all sheets

You can use the following codes for spedial characters:

Search for:

You can use the ? and * wildcard characters; use ~? and ~* to find the ? and * characters.

{If} = line feed (alt+enter fasdi code 10), {cr} = carriage return {ASCII code 13), {tab} = tab character

Replace with:

[Press ALTHENTER {if}to insert the line break
Find/replace in:
& All worksheets
(" Current worksheet

" Range (NZ;Y22;N43)

Select a row to jump to the found cell:

[Press ALTHENTER to insert the line break

Search By Rows = Close

Eind all

:

Lookin: | Walues
[™ Match Case

[™ Match entire cell contents

Results found:

=l

Fold out >>

il
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Advanced character remove or replace...

This utility removes or replaces certain characters in your worksheet or selected cells.
You can pick one or more characters from a list, including numbers, letters, special
characters, symbols, tabs, new line characters (enters) and invisible spaces and characters.

A few practical examples of this utility:

= remove all line breaks such as carriage returns and linefeeds (Alt+Enter) from your data
= remove invisible characters

= extract numbers from text

= remove everything except for certain characters

Several buttons allow you to quickly select or deselect certain characters.
Your last used settings will be remembered.

Note:

You can use the following codes to use these special characters as replacement: {If} = line
feed (Alt+Enter/ascii code 10), {cr} = carriage return (ASCIl code 13), {tab} = tab character.
If you have selected only one single cell then the utility will edit all the cells on your
worksheet.

Example screenshot: Remove or replace certain characters in selected cells in Excel

ASAP Utilities - Advanced character removal/replace
— — The characters to
T TN f( F<lFpldlx el - Felols }
ANr rer) r-rore My & i Fw CE My Ca ([ removeor replace
My Ty C= IF'> TR Tf Mz Tz T¢ Ty TeE Te s \ in selected cells
e 4 K+ 2 IF's Fa T T e - e s ITs ” th
My rt M, et Ch M T M= . Mt FCa s gver over them
I rt r- rarfulfCi Ty T FCe CrCi Ca Ts to see their name
r-F« . Fe Cv My F~F" My Co Fi Ca Cs
r - Ty Fe Cw Tk T T s T» i Ta s
ra r o o Fx 1 Te ' [C Frw e Ta e
r r M ‘e 'y r'm Ffe. TeCwICR Cad To
v r F2 F'e FCz Tn O, T- T2 T 6 Fe Ma
r r s Fe 'l FTe Ff F=—TFTe« Ce To Ce [Ca
r r Fr«a e Ty Cep O, O T~ CATCS6 Ce Ca
v [y s Tt 1 Feq O ™= T FA e e Ty
ra T FCs Fy C~ T Tt T Te FCTA T6 TCe TCp Quickly select all or no
s C# C7z Tk C_ Cs T+ C> - FCAT=x TCe My .
M+ Fs M ML M° Mt T Fe e F& Mo i characters or inverse
L Frd FwCes Tm FTa Tu T T r+ C& Co Ci 3 your selection
\i T FCae T: n e Ty T8 T T Te o0 i /
LM s Fole Fw Mo Ti T2 Fe 6 T _,"7/
i v v
1,2,3.. ab,c. 48,0, ‘: ] Al | Hone | Inyerse | i‘—‘
J— ey |/ Perform action on: s i Replace each selected
= Q_y i i S :i character with: 1 Leave blank to remove
—— onstan | |
% Invisible | Line breaks - ,I | Ol Formuas i J K‘ selected characters-
/ e
" Enter a value to replace
B ¥ Auto dose o characters with
\ \C
K Toggle buttons to turn groups \ Remove or replace in
of chararacters on or off constants, formulas or both
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Example screenshot: Remove or replace certain characters

(" ASAP Utilties - Advanced character removal/replace )
r r9rcrf<rfefCd T Cell - FETo Ca
I rCL M)y =T FCe Oy O i Cp Ce C¥ C&
Fe Fr F=C>TFRrR Cf Tz T2 Te T TE e Co
Cv Cy O+ C: Os T O C [Te - [Ce F8 s
P rt r, FelCr Ch O F e O, i TCa s
I rt - rarfuv i Ky O Fe Ty T Ta s
- C- 0. e Tv ) T~ T T Ce [ Ta e
r -/ FefCwrlik Co K Ts T TE Fa s
rar FCo o Cx Tl Fe T T FCwle Ca e
T £ F1FCe Cy r'm 0 FCe FeCwCH C& Cao
W T T2 TCf Dz Cn O, -T2 T lTo e [Ta
T C 3 TCe Nl Fe s C= T« Tz 6 T Ma
r C Csa Cw Oy TCp . T T2 TATS Ce Ta
M [ [Os Tt 0] Cq O O™ [CATC8 Cé My
Fa - Fe Ty C~Tr Tt T Te TAT6 Fe [Mp
C#e T M7 Tk T s [T T 7 FTA Tx [e [Ny
N+ s s L T Tt T Fee T TA T [T
Fe4 F%wTCes T'm Na Tu T T T+ TE 0 i
Fr re C: On b Tv T8 Tz T2 T CO0 i
CUF T FTolMe Tw Te Y M2 g T0 i

o= [z =2 A [ nme |||
spaces —— Perform action on: @T::ifawﬁ?«ms:e\acmd
¥ constants
e ‘ I~ Formulas
Close ¥ Auto dose oK

Replace accented characters (3, €, 1 etc.)...

This utility replaces all accented characters in the selected cells with the non-accented

version.

Bother lower- and uppercase accented characters will be replaced with the non-accented

version in lower- or uppercase.
The utility works on both vowels and consonants.

For example the character é will be replaced with e, fi replaced with n and A replaced with

A.

You can customize the characters and your last used settings will be remembered.
By pressing the "Reset" button you can revert to the default settings for the accented and

replacement characters.

-
ASAP Utilities - Replace accented characters

— Accented characters (space delimited):

replace with  replace with  replace
[ sacazas25a55582208 *[a [ Annannnnonfpnn *[n CEEAEEEaaaEa6a66845488
[ 6bbs *[p [ 6os6sa605068868806085 7| o [F

[ ceeececs N [ 608 *[p [ eezezeeee

|d‘dddddgdd.d *|d |q’ *|a ARAAARARARAAAAAAAAAAA
ciEeficeciiepicdld 7 & [freeere »[r

[f »[f [ ¢esidsesssss »[ g

[aacaas g [ trerterert » [t

[ AnARbhoh *[h [Guouoatytoddouaarrey * [ u

I »[ [wvo *[y GGOOG0UG006G00UEI0UE0
[ 345 » [y [ o [ w o i B B B D 00 D 0 6D 6 D 6D OB
[TekRkk [k FITTIIITIvY v

| I *[ [ s »[x |

[ dmmm [ m [ 22222222 »[ 3 |

For example when replacing the character ‘&' with the character ‘a', it wil replace ‘&' with ‘a' and ‘A" with A’

¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥

BRRERERRRRERAL

Vihen the characters are replaced it wil besides the lower case character alsa replace the uppercase version with the replacement
character in uppercase. et

Replace in range: AL:AD4800 = ‘ ‘

= |

Available tools
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Delete all text characters (a-z) in selected cells

This utility will remove all letters from the values in the selected cells.

All letters from the alphabet (abcdefghijklmnopgrstuvwxyz), both uppercase and lowercase
will be removed from every cell in your selection. Cells with a formula will be skipped.

If you have selected only one single cell then the utility will edit all the cells on your
worksheet.

For example a cell with the value '8011LB' will be replaced with '8011".

=
>
o
.
ig
@

:
| 2 [iHe6101 2 66101
3 [Exe756a 3 67564
4 |om7721 4 7721
5 |vigrs 5 1875)
6 [Tk16a70 6 16470)
7 |waoia 7 3914
& |NL9ss 8 9958
9 |zmala4125 3 44125)
10 [upso7e 10 5078
11 [1ISNNS6146 1 56146)
12 |[BMNY43626 12 49626
13 |psvazzes 13 32799
14 [vevkas 14 85|
15 [VIRQ30921 15 30921
16 |HTNE1039 16 61029
17 |wR16756 17 16756
18 [aws366 18 5966
19 [vwpP2407 19 2407
20 |maz6016 20 26016
21 |T9192 21 3193
22 [wvB7813 2 7813
23 [zGB67789 23 67789
24 |KKP12242 24 12249
25 |wugaisg 2 4159
26 |HYD47744 2% 47744
27 |uiasa2 a7 3542)
28 |cF12940 28 12940
29 |NUSB26261 29 26261
30 |FiRise3ss 30 56389)
31 [eviszer 31 15761
32 13se72 32 35972
33 |RQFz12451 33 13451
A _NLAIY 2RA 34 22A)

Delete all numbers in selection

This utility will remove all numbers from the values in the selected cells.

The numbers 1, 2, 3,4, 5,6, 7,8, 9 and 0 will be removed from every cell in your selection.
Cells with a formula will be skipped.

If you have selected only one single cell then the utility will edit all the cells on your
worksheet.

For example a cell with the value '8011LB' will be replaced with LB'.
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—
1 [ 1
' 2 [iHe6101 "N

3 |Ex67564 3 [Ex
4 [om7721 1 |om
5 |vis7s 5 |v

6 [Tk16470 6 [Tk

7 [iwasia 7 |w
8 |nL9sss 3 |NL

9 [zmaras1as 9 [zmaL
10 |upso7s 10 up
11 [1sNNS6146 11 [1snn
12 |BMNY49626 12 [BMny
13 |psv3279s 13 |psv
14 [vFykas 14 |vevk
15 |viRQaoez1 15 [vira
16 |HTNG1039 16 |HTN
17 |WR16756 17 [wr
18 [aws966 13 |aw
19 |vwoP2407 19 [vwop
20 |maz6016 20 [wa
21 [iT9192 21|
22 [wvB7813 22 [wve
23 |zGB67789 23 [zeB
24 |kxp12242 24 [kkp
25 [wuGa159 25 |wug
26 |HvDa7744 26 |uvD
27 |uiasaz 27 |

28 |cF12940 28 |cF
29 |[NUSB26261 29 |nuse
30 |FIRIS6389 30 |FIRt
31 |er15761 31 [ev
32 135972 32

33 |RaFz13451 33 |rarz
A Iy 2RA 4 IHwWY

Remove ending carriage return (Alt+Enter)
This utility removes the carriage returns (Alt+Enter character) that are at the end of in each

cell in your selection.

If you want to remove or replace all carriage returns/linefeeds, you can use the "Advanced
character remove or replace..." utility.

1
Lexcorp 2 |Lexcorp Minsk Belarus
2 Minsk Belarus 3 h Pictures Brussels i
3 h Pictures Brussels lgium 4 |videlectrix Sofia I
\Videlectrix 5 |Sombra Corporation Zagreb Croatia
G |Chasers Prague Czech Republic
4 Sofia Bulgaria 7 |Praxis Corporation Copenh Denmark
5 [Sombra Corporation Zagreb Croatia 8 [Fake Brothers Helsinki Finland
6 |Chasers Prague Czech Republic 9 |Mainway Toys Paris France
7 |Praxis Corporation Copenh Denmark 10 [Charles Townsend Agency |London Great Britian
§ |Fake Brothers Isinki Finland 11 [The Frying Dutchm: Athens Greece
Mainway Toys France 12 |Three Waters Budapest Hungary
9 Paris 13 [Universal Export Dublin Ireland
10 |Charles Townsend Agency |London Great Britian 14 [Acme Corp Rome Italy
Greece 15 [Wayne Enterprises Luxembourg Luxembourg
11 [The Frying Dutchman Athens 16 |Tip Top Cafe Oslo Norway
12 [Three Waters Budapest Hungary 17 (123 Warehousing Warsaw Poland
Universal Export 18 [Omni Consimer Products  |Bucharest Romania
13 Dublin Ireland 19 [Data Systems Moscow Russia
lAcme Corp 20 |allied Biscuit Belgrade Serbia
14 Rome Italy 21 [Transworld Consortium Bratislava Slovakia
15 |Wayne Enterprises Luxembourg Luxembourg 22 |Extensive Enterprise Ljubljana Slovenia
16 |Tip Top Cafe Oslo Norway 23 [Nordyne Defense Dynamics Madrid Spain
17 123 Warehousing ‘Warsaw Paoland 24 |United Fried Chicken Stockholm Sweden
18 |Omni Consimer Products  |Bucharest Romania 25 [Barrytron Bern Switzerland
19 |Data Systems Moscow Russia 26 [Thrift Bank Ankara Turkey
20 [Allied Biscuit Belgrade Serbia 27 |sto Plains Holdings Kiev Ukraine
21 [Transworld Consortium Bratislava Slovakia 28 |Luthorcorp Vienna Austria
22 |Fxtansive Fntarnrise Liuhli Slnvenia 29 17evn T Minsk I
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Delete number of leading characters...

This utility removes a given number of characters from the front of the selected cells.

The utility works on both cells with numbers and text. Cells with dates will be skipped.
If a cell has a formula or an array formula then it will first be replaces with its calculated

value and then the characters will be stripped.

You can for example use it to quickly remove the first two characters from all the selected

cells.

Example screenshot: Delete leading characters

A B & D
i
2 |AACAL 123 Warehousing
3 |AAD2333 Wayne Enterprises
4 |ABD1603 Chasers
5 [aBD7TZE - - !
5 |aBE2240 | ASAP Utilities ? x
7 |ACB4294 | How many characters at the start of the value in every cell in your
2 |accazag | selection would you like to delete?
o |aDBasss |
10 |ADB554
L Cancel | q
12 |ADE345 Mainway Toys |
13|AEB3139  [Three waters |
14 |AEB628 Springshield
15 |[AEC1076 Zevo Toys
16 |AEE30 Barrytron
17 |BAA1138 Praxis Corporation
18 |BAE265 Mammoth Pictures
19 |BBE2882 Fake Brothers
20 |BCC252 Thrift Bank
21 |BCC2693 Nordyne Defense Dynamics
22 |BCD4435 Sombra Corporation
23 |CAA135 Qwerty Logistics
24 |CBC959 Lexcorp
25|CBD1413 Omni Consimer Products
26 |CCD2581 Big T Burgers And Fries
27 |CEB596 Big Kahuna Burger
28 |DBCA792 Megadodo Publications
25 | DCC3906 United Fried Chicken
30 | DCCE002 Blammo
31 |DCD4351 Luthorcorp

A

uCompa

41

2333

1609

726

2240

4294

2729

3498

554

3048

345

3139

628

1076

1138

265

2882

2693

4435

135

959

1413

2581

596

4792

3906

6002

4351

123 War
(Wayne £
Chasers
[Acme Ct
Spade A
Sto Plair
Charles
Moes Ta
Gringott
Extensiv
Mainwa
Three W
Springst
Zevo Tor
Barrytro
Praxis C
Mammo
Fake Brc
Thrift Bz
Nordyne
Sombra
Qwerty
Lexcorp
Omni Cc
BigTBul
Big Kaht
Megado
United F
Blammo
Luthorce
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Delete number of ending characters...

This utility removes a given number of characters from the end of the selected cells.

The utility works on both cells with numbers and text. Cells with dates will be skipped.
If a cell has a formula or an array formula then it will first be replaces with its calculated

value and then the characters will be stripped.

You can for example use it to quickly remove the last four characters from all the selected

cel

Is.

Example screenshot: Delete characters from the end

A B E D A
+ e ST | [—
2 |224p Lexcorp Minsk Belarus 2 224(Lexcorf
3 |148u Mammoth Pictures Brussels Belgium 3 148[Mamm
4 194K |videlectrix Sofia Bulgaria 4 194|videlec
5 (184G |Sombra Corporation Zagreb Croatia 5 184|sombr:
6 [16M haser: Prague Caech Republ 6 16 Chaser:
"7 |57 ASAP Utilities - Delete number of ending characters... B 7 576|Praxis ¢
i How many characters at the end of the value in every cell in your selection | F— 8 139Fake Br
L would you like to delete? N 9 351|Mainw;
10| 1 an 10 540(Charles
11 " 182(The Fry
12| B 12 89|Three \
13 T 13 135(|Univers
14 (5300 |Acme Corp Rome Italy 14 530[Acme C
15 |259D |Wayne Enterprises Luxembourg Wﬂs 259|Wayne
16 |103S Tip Top Cafe Oslo 16 103(Tip Top
17 [244aC 123 Warehousing Warsaw Poland 17 244123 Wa
18 185l Omni Consimer Products  |Bucharest Romania 18 185[0Omni C
19 |a7s Data Systems Moscow Russia 19 A7|Data Sy
20 (1730 IAllied Biscuit Belgrade Serbia 20 173(Allied £
21 (389X Transworld Consortium Bratislava Slovakia 21 369 Transw
22 |195D Extensive Enterprise Ljubljana Slovenia 22 195||Extensi
23 11y Nordyne Defense DynamicgMadrid Spain 23 11{Nordyn
24 279U United Fried Chicken Stockholm Sweden 24 279|United
25 (163U Barrytron Bern Switzerland 25 163(Barrytn
26 |77V Thrift Bank Ankara Turkey 26 FiThrift B
27 [736T 5to Plains Holdings Kiev Ukraine 27 736||Sto Plai
23 [133P Luthorcorp Vienna Austria 28 133|Luthorc
29 [96W [Zevo Toys Minsk Belarus 29 96(Zevo Tc
30 [127¢C Big Kahuna Burger Brussels Belgium 30 127||Big Kah
31 |213) Moes Tavern Sofia Bulgaria 31 213|Moes T
32 (1562 Qwerty Logistics Zagreb Croatia 32 156[Qwerty
33 |3128 ISpade And Archer Prague Czech Republ 33 312|Spade
24 |aasn Arme lnc Canenhagen__ | Nenmark kYl 235larme. |

Delete all after a given number of characters...

This utility removes all characters that come after a given length in the selected cells.

The utility works on both cells with numbers and text. Cells with dates will be skipped.
If a cell has a formula or an array formula then it will first be replaces with its calculated

value and then the characters will be stripped.

You can for example use it to quickly remove everything after the first 10 characters in your
data range.

You can use this as a quick alternative for Excel's =LEFT() function.

Available tools
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Example screenshot: Keep the first characters

A
11 hd Compan

1 1
2 |1146L Lexcorp Minsk Belarus 2 1145 Lexcorp
3 [1033VMWP  [[Mammoth Pictures Brussels Belgium 3 1033|Mammot!
4 [1118UH |Videlectrix Sofia Bulgaria 4 1118|Videlectr
5 |1513YVE ISombra Corporation Zagreb Croatia 5 1513[Sombra C
6 [1003RPG Chasers Prague Czech Repub 6 1003|Chasers
7 [1614I1CLB Praxis Corporation Copenhagen Denmark T 1614|Praxis Col
8 [ Asap Utilities . |2 ] 8 1003}rake Brot
9| — 5l 1086 Mainway
10 [2] | After which character number would you like to delete the rest of the textin 10 1177\ charles T
— every selected cell?
11 |1 | For example with 4 the value [this is a test] becomes [this]. M 1514{The Fryin
1 12] 12 1069 Three Wa
13 13 1503|Universal
E Y 14 1043[Acme Cor
15 15 1206]Wayne Er
16 |1126GV Tip Top Cafe Oslo Norway 16 1126 Tip Top C
17 [1613STQN 123 Warehousing ‘Warsaw Poland 17 1613[123 Ware
18 |1717MWLD  |Omni Consimer Products  |Bucharest 18 1717|Omni Cor
19 |1639W Data Systems Moscow Russia 18 1639 Data Syst:
20 [1200FDXWD |Allied Biscuit Belgrade Serbia 20 1200{Allied Bis
21 [1149ZE Transworld Consortium Bratislava Slovakia 21 1149 Transwor
22 |1045CVPX Extensive Enterprise Ljubljana Slovenia 22 1045|Extensive
23 [11450XV Nordyne Defense Dynamics Madrid Spain 23 1148|Nordyne
24 |1167HHT United Fried Chicken Stackholm Sweden 24 1167|United Fr
25 |1226RDQBC  |Barrytron Bern Switzerland 25 1226{Barrytron
26 |1684HFX Thrift Bank Ankara Turkey 26 1684| Thrift Barn
27 |138SIAEI |Sto Plains Holdings Kiev Ukraine 27 1385|5to Plain:
28 [11051GCP Luthorcorp Vienna Austria 28 1105fLuthorcor
29 [1496XSN [Zeva Toys Minsk Belarus 29 1496[Zevo Toy:
30 [1467AGC Big Kahuna Burger Brussels Belgium 30 1467|Big Kahur
31 [1353)vH Moes Tavern Sofia Bulgaria H 1353|Moes Tav
32 |1243YEHU Qwerty Logistics Zagreb Croatia 32 1243 Qwerty L«
33 |1185W) ISpade And Archer Prague Czech Repub 33 1185[Spade An
4 [1192m Acme o i h Denmark A 11920acme_inr

22 Subscript the numbers in Chemical Formulas

This will subscript the numbers in chemical notations such as CSH10N402, Al(OH)3, AIF6Li3,
AlO2, AI(NO3)3, Au2(Se04)3, Ca(V04)2, H6TeO6, KAIMg3Si3012H2, Ca(NO3)2 - 4H20, etc.

It turns it into CgH1oN4O-, Al(OH)a, AlFsLis, AlO, A|(NO3)3, AUz(SEO4)3, Ca(VO4)2, HeTeOs,
KAlMgasiaolez, CB(NOa)z . 4H20, etc.

This tool automatically detects which numbers should be formatted as subscript.

N

A B A
e | ——
2 |caH1ona02 2 [CiHoN,0,
3 |al{oH)3 2 [al{oH),
4 |alF6Li3 4 |alFLi,
5 |alo2 35 A|02
6 |al{NO3)3 & [AI{NOs);
7 |Au2(se0a)2 7 |aus(se0,)s
2 |ca(voa)2 8 |ca(vo,),
9 |HsTeos 9 |H,Teo,
10 [KAIMg3si3012H2 10 |KAIMg,Si,0;H,
11 |ca(NO3)2 - 4H20 11 |ca(NO.), - 4H,0
12 |cu(NO3)2 - 3H20 12 |cu(NOy), - 3H,0
13 |Hg(Bro3)2 - 2H20 13 [Hg(BrOs); - 2H,0
14 14
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Make last character superscript

This utility makes the last character superscript in your selected cells.

For example a cell with the value 'm3' will be changed to 'm3'.

A B 5 D E A B C D E
il Company volume 1 2
2 |Lexcorp 1966 m3 2 |Lexcorp 600 1966 m*
3 |Mammoth Pictur 340/ m2 1080 m3 3 [Mammoth Pictur 240 m* 1080 m’
4 |videlectrix 290 m2 1013 m3 4 |videlectrix 290|m* 1013 m*
5 |Sombra Corporat] 830|m2 2849 m3 5 |Sombra Corporat] 830|m* 2849 m*
6 Chasers 300 m2 915 m3 6 |Chasers 300|m* 915 m*
7 |Praxis Corporatig 690 m2 2090 m3 7 |Praxis Corporatid 690|m* 2030 m*
8 |Fake Brothers 720 m2 2476 m3 8 |Fake Brothers 720|m* 2476 m*
9 |Mainway Toys 430|m2 1508 m3 9 [Mainway Toys 430|m* 1508 m*
10 |Charles Townsen 810|m2 3069 m3 10 |Charles Townsen 810|m* 3069 m*
11 | The Frying Dutch 750|m2 2977 m3 11 | The Frying Dutch 750m* 2977 m*
12 | Three waters 700 m2 2269 m3 12 |Three Waters 700|m* 2269 m*
13 |Universal Export 650 m2 2020 m3 13 |Universal Export 650|m* 2020 m*
14 |Acme Corp 770 m2 2997 m3 14 |Acme Corp 770|m* 2997 m*
15 |Wayne Enterprist 310/m2 1084 m3 15 | Wayne Enterpriss 310|m* 1084 m’
16 |Tip Top Cafe 670 m2 2112 m3. 16 | Tip Top Cafe 670|m* 2112 m*
17 |123 Warehousin 840|m2 2761 m3 17 |123 Warehousing 840|m* 2761 m*
18 |Omni Consimer § 830|m2 2748 m3 18 |Omni Consimer R 230/m* 2748 m*
19 | Data Systems 830|m2 2911 m3 19 | Data Systems 830|m* 2911 m’
20 |Allied Biscuit 820|m2 3265 m3 20 |Allied Biscuit 820/m* 3265 m’
21 |Transworld Cons: 520/m2 3320 m3 21 |Transworld Cons 920|m* 3320 m*
22 |Extensive Enterp| 350 m2 1260 m3 22 |Extensive Enterp 350/m* 1260 m*
23 |Nordyne Defens 820|m2 2750 m3 23 |Nordyne Defens 820/m* 2750 m’
24 |United Fried Chi 480|m2 1915 m3 24 |United Fried Chi 4230/m* 1915 m’
25 |Barrytron 910|m2 3535 m3 25 |Barrytron 910/m* 3535 m*
26 | Thrift Bank 540|m2 1809 m3 26 | Thrift Bank 540/ m* 1809 m*
27 |Sto Plains Holdin 520|m2 1735 m3 27 |Sto Plains Holdin 520/m* 1735 m’
28 |Luthorcorp 650 m2 1972 m3 28 |Luthorcorp 650/ m* 1972 m’
29 Zevo Toys 570(m2 1869 m3 29 |Zevo Toys 570|m* 1869 m*
30 |Big Kahuna Burge 960|m2 3538 m3 30 |Big Kahuna Burge 960|m* 3538 m*
31 Moes Tavern 510|m2 1835 m3 31 |Moes Tavern 510/m* 1835 m’
32 |Qwerty Logistics 550|m2 2136 m3 32 |Qwerty Logistics 550(m* 2136 m’
33 |Spade And Arche 290 m2 886 m3 33 |Spade And Arche 290|m* 886 m*
34 Acme. Inc Nl m2. 2279 m3. 34 |acme lnc 60 m? 2279 m*

24 Make last character subscript

25

This utility makes the last character subscript in your selected cells.

A B A B
1 1
2 |ve * 2 v
3 |vp 3 vy
4 |vr 4 v
5 |o2 5 |0,
6 6
7 7

Reverse text in selected cells

This utility reverses the text in the selected cells.

For example "Excel' becomes 'lecxE' and '123456' becomes '654321".

:
&

i

g
z

Excel is Excellent

tnellecxE si lecxE

1002

2001

zyxwvutsrgp

IASAP Utilities

seitilitU PASA

123456789

987654321

g

001

am-lcnm;:-um‘A
r
N

oo |~ |en | & [ | =
i

Available tools
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Sort values inside each cell in selection...

This tool sorts the contents of each cell in your selection.

You can choose if the cell contents are:

Separated by a space
Separated by a comma
Separated by a comma + space

Separated by a line break (Alt+Enter)

Or enter your own separator

You can sort either ascending (A-Z) or descending (Z-A)

Tip: You can also use this on a (temporary) extra column in preparation to identify duplicate
cell values.

27

29

36

A

Meontgomery, Alabama
Juneau, Alaska
Phoenix, Arizona

Little Rock, Arkansas
Sacramento, California
Denver, Colorado
Hartford, Connecticut
Dover, Delaware.

Tallahassee ASAP Utilities - Sort values inside each cell in selection..

Atlanta, Ge

Baise, Idah " Space

 Comma

% | ¥ comma +Space
Des Moinet
Topeka, Ka| - 2, order
Frankfort, k
Baton Roug
Augusta, M '

li ¥ Reverse order!

Boston, Ma

Lansing, Mi
st. Paul, Mi =

(" Ascending (A to Z)
" Descending (Z to A)

1. The values within each cell are delimited by:

" Semicalon

" Line break (Alt+Enter)

" Other:

Jackson, M
Jefferson City, Missouri
Helena, Montana

Lincoln, Nebraska

Carson City, Nevada
Concord, New Hampshire
Trenton, New Jersey
Santa Fe, New Mexico
Albany, New York
Raleigh, North Carolina
Bismarck, North Dakota
Columbus, Ohio
Oklahoma City, Oklahoma

A

Alabama, Montgomery
Alaska, Juneau
|Arizona, Phoenix
Arkansas, Little Rock
california, Sacramento
(Colorado, Denver
Connecticut, Hartford
Delaware, Dover
Florida, Tallahassee
(Georgia, Atlanta
Hawaii, Honolulu
Idaho, Boise

Hlinois, Springfield
Indiana, Indianapolis
lowa, Des Moines
Kansas, Topeka
Kentucky, Frankfort
Louisi: Baton Rouge

Maine, Augusta
Maryland, Annapolis
Massachusetts, Boston
Michigan, Lansing
Minnesota, St. Paul
Mississippi, Jackson
Missouri, Jefferson City
Montana, Helena
Nebraska, Lincoln
Nevada, Carson City

New Hampshire, Concord
New Jersey, Trenton
New Mexico, Santa Fe
New York, Albany

North Carolina, Raleigh
North Dakota, Bismarck
Ohio, Columbus
Oklahoma, Oklahoma City
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5.5.12

Formulas

A collection of tools for working with formulas.

Change formulas to their calculated values

This utility replaces the formulas in the selected cells with their calculated values.

The utility works the same as Excel's "Copy » Paste » Paste values" but in one step and it
also works with multiple selections at once.

Normally the utility changes the formulas to their calculated values in both visible and
hidden cells. If you have selected cells in a filtered list only the visible cells are changed.

As an example, a cell with the formula '=A2*(C19/12)" which has '124' as the calculated
result will be replaced with the value 124.

This can be useful, for example if you want to speed up the calculation of your workbook or
if you don't want someone to see the underlying formulas you used if you give the
workbook to somebody else.

By default you can start this utility with the shortcut Ctrl+Alt+P.

Example screenshot: 1 Change formulas to their calculated values

B2 - A =(10527"1,03
A | B [T D [ E 1 F [ 6 ]
1 |Map Unit price . Sold Total VAT Total inc. VAT
| 2 |Amsterdam 1054] 102 110523 19% 1218 2568
3 | Andpeeal 1L 1204 A0 1,40 109 GEALEIE:
| 4 |Ank] ASAP Utilities - Change formulas to their calculated values |
| 5 |Ath |
% ge‘ Do you wank ko convert all Farmulas in selected cels to their calculated values? |- 1E
ol b
[ & |Een 1
T Bral Cancel 1
E Bru i
EINEY |
| 12 |Bud| |
i Coj [¥ Disable undo (for performance reasons) b
| 14 [Dutl — — — —
iHe\Sm(l 143 (2] 100007 58 19% 10721,00
| 16 |Kiev 1227 724 8.658153 19% 9617 2825
| 17 |Lisbon 11,09 614 B.811,16 19% 7436 4465
| 18 |Ljubljana 1363 499 B.799 82 19% 731264
18 1London 11.19 a8 964,35 19% 1083.7262

Example screenshot: 2 Formulas to values in a filtered list is something that you normally
can't do in Excel

B20 - A =(1232)",03
A B C ] i} [ E ] F [ 6 [ H
1 |Map ~|__Unit price[~| Sold[~] Total[~| VAT[~| Total inc. VAT[~]
| 20 | Luxemnbourg 13,31 946 12,558 33 18% 1354349
21 |Madrid 13,34 955 1273827 19% 13706 80
Minsk 1151 957 11.457 18 18% 12455 99
Micosi

sl ASAP Utilities - Change formulas to their calculated values
slo —

Reykj
Sarajes
Tallinng
Tarsh
Y erew

Da you want ko convert all YISIBLE filkered formulas in selected cells to their
values?

Cancel

e e | e | L f o o] cof v s o e
=0 @)~ o =] oo ra) o) G| =k

n
3
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Apply formula/calculation to selected cells...

With this utility you can quickly perform a calculation on the selected range.
For example quickly multiply all cells in your selection by 10 without having to add an extra
column and enter a formula to do this.

A formula will be built around the original formula or value in your cell. For example if you
have a formula '=(12*2)" in a cell and you use ASAP Utilities to apply the formula /24 the
result will be: '=(12*2)/24".

The formula will be applied to all cells in your selection except for cells with errors, empty
cells, cells contain text or cells that contain an array formula.

If the new formula would result in an error you will get a warning upfront and no changes
will be applied.

Users of the non-English Excel versions can type in the formula in their local language. For
example in the Dutch version you can use the comma as decimal separator and the local
version of worksheet formulas, for example '+SOM(G20:G40)' instead of the English
+SUM(G20:G40)".

There are many formulas you can enter such as for example '/1000', '+4', '*2,55', '*C33'.
This utility is also often used for unit conversions, such as for example converting
kilometers to meters.

The last 100 used formulas are remembered so you can easily re-use them.
By default this can be started with the shortcut Ctrl+Alt+l.

Example screenshot: 1 Perform a quick calculation in selected cells

My favorite | Vision Select

=] B 0101 - Apply formula - calculation to selected cells - Microsoft Excel
m Home  Inset  Pagelayout  Formulas  Data  Review  View | ASAP Utilities
', © [ sheets + [ Columns & Rows ~  [#} Numbers & Dates = g5 Web - 1% mport -
b [#] Range = [ Objects & Comments = [ A Text ~ €3 Information = [d] Export ~

tools~ | Control - = Fillv [ Format - J Formulas = (43 File & System = b Start ~
Favorites Time saving tools
B3 - A a1
A [ B [ ¢ [ o T E T F [ 6 [T H T 17 T 37

1 amount
| 2 site M1 FYES Y naa e nac naz

3 A 41 ASAP Utilities - Apply formula/calculation

4 B 27
5 | c 69 While applying the calculation a formula will be built around the original
—— formula or value in your cells,
|6 D 29

7 E 35 For example if you have a cell with the formula '=12*2' and you apply with
s | F 83 this tool the formula /24’ then the new formula in the cell becomes =(12*
s @ = 2)/24.

10 H 51 There are many formulas you can enter such as for example 'f1000', '+4, "=
EEIE m 2,55, %33,
o The 100 last used formulas will be remembered for re-use.
(12, J 89
43 K &4
4] L 37 [ =2000
|15 M 73
| 16 | N 61 Close [ skip hidden rows and columns
|17, © 100
|18 P 43 g i
119 Q@ 22 64 55 2 25 6
|20 R 17 16 59 46 37 85
|21 S 81 38 29 40 46 23
|22 T 3 98 6 37 23 92
|23 U 27 100 70 91 50 30
|24 Vv 40 32 16 47 72 13

o w 24 a7 a1 33 /2 an
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Example screenshot: 2 The result

Custom formula error message...

o~ |= D101 - Apply formula - calculation to selected cells - Micrasoft Bxcel
m Home  Inset  Pagelayout  Formulas  Data  Review  View | ASAP Utilities
" O [ sheets + [ Columns & Rows ~ B Numbers & Dates - &5 Web ~ Emport -
b ##] Range - [ Objects & Comments - [ A|Text ~ & nfarmation = (@] Export
My favorite | Vision Select
tools~ | Control ~ =i Fill~ [ Format~ Jx Formulas ~ [sg File & System = b Start~
Favorites Time saving tools
B3 - £ | =(41)*1000
A B [ ¢ [ o [ € [ F T & 1T H [ 717 71T 317
1 amount
| 2 site M1 M2 M3 M4 M5 M6 M7 it M9
(3| A 41000 26000 36000 84000 96000 1000 62000 70000 15000
|4 B 27000 31000 78000 51000 7000 44000 59000 23000 §1000
| 6 | C 63000 73000 93000 7000 50000 40000 79000 78000 22000|
|6 D 29000 76000 26000 38000 31000 64000 77000 0 54000
L7 E 35000 6000 91000 23000 94000 85000 79000 6000 55000
|8 F 83000 93000 84000 28000 81000 31000 18000 13000 86000
| 9 | G 16000 27000 36000 71000 40000 90000 92000 1000 77000
|10 H 51000 68000 46000 35000 96000 9000 67000 25000 64000
| 11 I 44000 §0000 6000 38000 15000 67000 11000 70000 14000
[12] J 89000 78000 73000 22000 78000 75000 61000 60000 53000
[13] K 64000 72000 49000 58000 92000 42000 92000 55000 93000
| 14| L 37000 77000 14000 7000 2000 27000 43000 74000 87000
|15 M 73000 12000 57000 17000 §3000 14000 0 46000 69000
| 16 | N 61000 83000 40000 2000 21000 35000 76000 29000 89000
17| O 100000 41000 6000 7000 69000 67000 14000 36000 63000
|18 P 43000 78000 14000 17000 76000 23000 1000 93000 92000
|18] @ 22000 64000 55000 2000 25000 6000 2000 42000 52000
|20 R 17000 16000 59000 46000 37000 85000 8000 46000 17000
[ 21] s 81000 38000 29000 40000 46000 23000 82000 96000 40000|
|22 T 31000 98000 6000 37000 23000 92000 23000 8000 84000
| 23 | u 27000 100000 70000 91000 50000 30000 31000 32000 86000
|24 V 40000 32000 16000 47000 72000 13000 7000 33000 50000
25 w 24000 37000 84000 66000 63000 82000 14000 72000 7000|

This utility makes it easy to display a custom error message for formulas that produce an

error.

Instead of an error such as #N/A or #VALUE!, you can have your own (more logical) error

message displayed when a formula results in an error.

For example, if you have a VLOOKUP formula but no result is found then the formula will
then display the value #N/A. You use can this utility to tell Excel what it should display when
the formula results in an error, for example to display nothing (an empty result) when no
result is found or a user friendly message such as "country not found".

This utility wraps an =IF(ISERROR(old_formula),[value in case of error],old_formula) formula
around the existing formulas. You can do this manually, but it is easier and faster with help

of ASAP Utilities.

This utility has two advantages compared to writing the =IF(ISERROR()) formula manually:
1. It is easier and quicker because you don't have to type in the formula.
2. You can also use this utility on a range of cells with different formulas.

Available tools
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Example screenshot: Hide or replace error values

TN

A B c D E F G H | J A B c
B Name -1 Age hd B Name -1 Age hd
2 | Agustin a8 2 |Agustin 48
3 Aiden #NJA 3 |Aiden =
4 |Alejandro 21 4 |Alejandro 21
5 |Alexander 42 | ASAP Utilities - Custom formula errar message 5 |Alexander 42
EoAl & Errors to replace in your selection: 6 ali =
7 |Andrei 24 7 |Andrei 24
8 Arda #N/A e 8 |Arda -
9 |Artem a7 #NAME? 9 |Artem 47
10 |Bence 40 Wﬂf‘ 10 |Bence 40
11 |Benjamin 43 #NUM! 11 |[Benjamin 43
12 Daan #NJA AL 12 |Daan =
i3 Daniel e Alternative text for the error message: [ Daniel i
14 |Eetu 30 | N 14 |Eetu 30
15 |Emil 34 15 |Emil 34
16 Enzo0 = [V skip existing ISERROR() formulas 16 [Enzo =
17 Erik #NJA You can make the field with the alternative error message 17 |Erik -
18 |Ethan #N/A blank to hide all errors. 18 |Ethan -
19 |Francesco 22 19 |Francesco 22
20 |Georgi 37 20 |Georgi 37
21 |Georgios 31 21 |Georgios 31
22 |Giorgi 30 22 |Giorgi 30
23 |Hans 42 23 |Hans 42
24 |Iker 42 24 |iker 42
25 |lvan 34 25 |lvan 34
26 |Jack 21 26 |Jack 21
27 llacob #N/A 27 |Jacob -

Transpose data with formulas...

This utility will transpose your data and preserves the cell references.
Unlike the standard Excel methods which changes the cell references when the data shifts,
this utility will not change the cell references in your formulas.

Example screenshot: 1 Before

B1 - A =Sheet1lA10
A | B [ C | D | E [ F [ G [
value |Amsterdam !Ankara Athens Belgrade Berlin Bern
formula used: |=Sheet?/A10 |=Sheet!!B10 | =Sheet1IC10 |=Sheet1ID10 |=Sheet1!E10 |=Sheeit!F10

EE

L

Example screenshot: 2 The result, all cell references have been preserved
AT - A& =Shest1IA10
A [ ] [ c [
formulalused:

value
[Amsterdam
Ankara
Athens
Belgrade
Berlin

Bern
Bratislava

EE

=
=1

=
=

=
=

=
o

=
=

Copy formulas without changing their cell references...

This utility copies all formulas without changing the cell references.

Normally Excel adjusts the cell references if you copy your formulas to another location.
You would then have to "fix" all cell references with a dollar sign (for example change Al to
SAS1) to keep the cell references the same.

With this utility you can now easily copy your formulas to another location without Excel

192 Chapter 5



“Happiness inspires productivity” ASAP Utilities User Guide

having the cell references changed and without the need of adjusting the cell referenced
first.
Besides the formulas this utility will also copy the formats, comments and validation.

Change formula reference style (e.g. Al to $Al etc.)...

This utility will change the formula reference style in the formulas you your selected cells.

You can change the reference style to:

= Relative referencing (A1)

= Relative rows and absolute columns (SA1)
= Absolute rows and relative columns (AS1)
= Absolute referencing (SAS1)

For example a cell with the formula '=A1*(B12/100)' changed to absolute referencing
becomes '=SAS$1*($B$12/100)".

The advantage of this utility is that you can quickly change the reference style in multiple
formulas at once.

ASAP Utilities - Change formula reference style

Selected range: E11iG16 =k

Change to:
@+ Relative referencing

(" Relative row and absolute column
(" Absolute row and relative column
(" Apsolute referencing

Example: $A%1 -> A1

|

Replace the range names used in formulas with their cell
references (on selected sheets)

This utility replaces the range names, used in formulas in the selected sheets, with their cell
references.

For example if you have a value in cell C10 with the range name 'quantity' and you used a
formula such as '=A1*quantity’, then this utility will replace that formula with '=A1*C10".
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Example screenshot: 1 Select the sheets and start the utility and the range names will be
replaced with their cell references

c2 - Jfx | =A2*unit_price*dollar_to_eura
A B C D E F G H

1  quantity worthinUSD  worthin EUR
2 236 5118,DDD| £ 34,286!
3 263 $131,500 €93,929
: ASAP Utilities - Replace the range names used in formulas with their cell refere... @
6 2
7 Do you want to replace the range names used in the formulas by their
3 ¥ cell references on all 1 selected werksheets?
9 25
10 2
11 11 Cancel
12 2
13 162 S81,000 €57,857
14 194 $97,000 €69,286

139 469,500 £49,643

260 $130,000 €92,857

67 $33,500 €23,929

152 $76,000 €54,286
19 $197,500 £141,071
20 S38.000 £27143

=A2*Definitions!$AS1*Definitions!SAS2

c2 -
A B c
1 | quantity worthinUSD  worth in EUR
2 236 $118,000] € 84,286!
3 263 $131,500 €93,929
4 105 $52,500 €37,500
5 28 514,000 €10,000
6 93 $46,500 €33,214
7 25 $12,500 €8,929
8 40 $20,000 €14,286
9 253 $126,500 €90,357
10 260 $130,000 €92,857
1 110 55,000 €39,286
12 290 $145,000 €103,571
13 162 581,000 €57,857
14 194 $97,000 €69,286
15 139 $69,500 €49,643
16 260 $130,000 €92,857
17 67 $33,500 €23,929
18 152 $76,000 €54,286
19 395 $197,500 €141,071
piil 76 £2R 000 £27143

Example screenshot: 2 A report with the changes that were made

D

E F G H

A B c D E F

1 |sheet ICell value Original formula New formula

2 After B2 118000 =A2*unit_price =A2*Definitions!SAS1

3 After c2 '584,285.?1 =A2*unit_price*dollar_to_eu=A2*Definitions!SA31*Definitions|SAS2
4 After B3 131500 =A3*unit_price =A3*Definitions!SAS1

5 After C3 "$93,928.57 =A3*unit_price*dollar_to_eu =A3*Definitions!SAS1*DefinitionsISAS2
6 After B4 352500 =Ad*unit_price =A4*Definitions!SAS1

7 After c4 '53?,500.00 =Ad*unit_price*dollar_to_eu=A4*Definitions!SAS1*Definitions|SAS2
8 After B5 14000 =A5*unit_price =A5*Definitions!SAS1

9 After €5 "$10,000.00 =A5*unit_price*dollar_to_eu=A5*Definitions!SAS1*DefinitionsISAS2
10 After B6 46500 =A6*unit_p =AG*De ons!SAST

11 After Co 7533,214.29 =A6*unit_price*dollar_to_eu=A6*Definitions!SAS1*Definitions|SAS2
12 After B7 12500 =AT7*unit_price =A7*Definitions!SAS1

13 After C7 "$8,928.57 =A7*unit_price*dollar_to_eu=A7*Definitions!SAS1*DefinitionsISAS2
14 After BS 20000 =A8*unit_price =Ag*Definitions!SAS1

15 After 8 '514,285.?1 =A8*unit_price*dollar_to_eu=A8*Definitions!5A31*Definitions|SAS2
16 After B9 126500 =A9*unit_price =A9*Definitions!SAS1

17 After 9 "$30,357.14 =A9*unit_price*dollar_to_eu=A9*Definitions!SAS1*DefinitionsISAS2
18 After B10 130000 =A10*unit_price =A10*Definitions!SASL

19 After c10 '592,357.14 =A10*unit_price*dollar_to_e =A10*Definitions!SAS1*Definitions!SAS2
20 After B11 55000 =Al11%unit_price =Al1*Definitions!SAS1

21 After C11 "439,285.71 =Al11*unit_price*dollar_to_e=A11*Definitions!SAS1*Definitions!SAS2
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Rebuild array formulas

This utility will re-enter all formulas in your selected cells as array formulas.

When you enter an array formula you have to press Ctrl+Shift+Enter instead of just Enter to
insert the formula. You must do this the first time you insert the array formula into your
worksheet and whenever you edit it. If you do this correct then Excel will display the

formula between curly braces {}.
If you have forgotten to do this it can be a tedious task to select each cell, edit it and then

press Ctrl+Shift+Enter to have it properly inserted as an array formula.
This utility automates this process.

Insert an apostrophe (') in front of each formula in the
selected cells

This tool inserts an apostrophe (') in front of each formula in the selected cells, which turns
them to text.

Note:

To turn the changed formulas to actual calculating formulas again, you can use the
following tool from ASAP Utilities:

"Numbers & Dates » Change not recognized numbers (text?) to numbers"

Bookl - Microsoft Excel ‘ = ‘ El iﬁ-‘
t Formulas Data Review  View | ASAP Utilities o @o@ =
| Columns & Rows = (3} Numbers & Dates ~ €5 Web ~ (S mport ~ A ASAP Utilities Options » @ Online FAQ
| Objects & Comments = [A|Text = €% Information ~ @] Export = b Find and run a utility @ o
i Format ~ Je Formulas ~ (g File & System ~ b Start ~ & Re-run last utility @ Registered version

Time savi o 1. Change formulas to their calculated values (Cirl=Alt=F) _he‘p

2. Apply formula/calculation to selected cells.., [Ctri=Alt=]) L ¥

D E 3. Custom formula errar message... tEIA

4, Transpose data with formulas...
5. Copy farmulas without changing their cell references...

6. Change formula reference style (e.0. Al to SAL etc)...

7. Replace the range names used in formulas with their cell references (on selected sheets)
8. Rebuild array formulas

9. Insert an apostraphe [ in front of each formula in the selected cells

10. Report the formulas used in the worksheets in your workbook

11. Insert ‘international’ formula...

12. Insert function from the ASAP UHilities library...

13. Correct the link to the ASAP Utilities worksheet functions

LErRBE-hdark ¢&
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Report the formulas used in the worksheets in your
workbook

This tool will report all formulas used in the worksheets on your workbook.

The report shows the following information:

= Sheet; The name of the worksheet the formula is on

= Cell; The cell address the formula is in. You can click on the address to jump to it, it is a
hyperlink.

= Value; The calculated result

= Displayed value; The displayed result. This uses the cell's number format.

= Formula; The formula

A B G D E
1 |D:\Projects\Example.xls
2 |Sheet cell Vvalue Displayed value  Formula
3 Start N1 59 ) =COUNTIF(D:D;3)
4 Start Q1 0,98305085 98,3% =(N1-U1)/N1
5 |Start Ti 0,01694915 '0,016543153 =U1/N1
6 Start Ul 1 1 {=COUNT((D2:D562=3)*(F2:F562="")*(F2:F562))}
7 |Start 02 en-us en-us =E2
8 Start P2 nl-nl nl-nl =F2
o lesam  1a slnlalin =lalalan —AAENI 1R ORI NE AR MDA

Insert "international” formula...

With this utility you can insert a formula in "international" notation into the selected cells.
An "international" formula is a formula that uses English worksheet formula names, a
comma as list separator and a point as decimal separator.

This utility can be very useful if you do not use an English version of Excel or if you use
different country settings.

On the Internet you can find an enormous quantity of example formulas for Excel. Most
examples on the Internet and in Excel books use the "international" formula notation.
With this utility you can now easily use such formulas, independent from your Excel version
or country settings. ASAP Utilities converts them automatically to be used in your Excel
version.

For example if you use the Dutch version of Excel with the Dutch country settings in
Windows, then this utility translates the "international" formula
"=SUMIF(A2:A13,">50")*1.19" automatically to "=SOM.ALS(A2:A13;">50")*1,19" when you
insert the formula.

You can use this utility for both regular- and array formulas.
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Example screenshot: Easily paste English formulas into your local Excel version

A3 - e
[ A [ B C D
1 Random date Random time Random date + time

Random date between Random time between
Jjan 1, 2000 - jun 28, 2013 08:00:00 - 17:00:00

ASAP Utilities - Insert "international” farmula

Insert an “international” formula in all cells in your selection.

Many example in books and on the Internet are written in the “international™
English notation. With this utility you can insert them without the need to
translate them to your local Excel version and regional settings first,

Use English formulas, a comma as list separator and the Al reference style for
the formula.

Formula to insert in range: A3
=R ANDEETWEEN(DATE(2000, 1, 1), DATE(2013,6, 28))

| [

[ Insert as array formula

Cancel

alalalalalalalalala
I I E A bl il il bl Rl el

20

M
A3 =ASELECTTUSSEN(DATUM(2000;1;1);DATUN(2013;6;28))
[ A [ B C D

1 Random date Random time Random date + time

Random date between Raondom time between

2 jan 1, 2000 - jun 28, 2013 08:00:00 - 17:00:00

3| Aug 12, 2011]

4

5

6

Insert function from the ASAP Utilities library...

With this utility you can insert a formula from the ASAP Utilities functions library into the
active cell.

The ASAP Utilities functions library includes the following functions:

=ASAPCELLCOLORINDEX(ce11)

Returns the color index number of the cell.

If you afterwards change the color in the cell, you have to press Ctrl+Alt+F9 to have the
formula recalculated.

Parameters:

= cell = The cell to get Excel's number for the fill color
from.
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=ASAPCOUNTBYCELLCOLOR(reference, color index nr)

Counts the number of cells in the given range that have a certain fill color.
If you afterwards change the fill color in any of the referenced cells, you have to press
Ctrl+Alt+F9 to have the formulas recalculated.

Parameters:

= reference = The range of cells to search in.
" color _index nr = The cell that has the fill color to count,
or the color index number (1-56) from Excel.

=ASAPCOUNTBYFONTCOLOR(reference, color_index nr)

Counts the number of cells in the given range that have a certain font color.
If you afterwards change the font color in any of the referenced cells, you have to press
Ctrl+Alt+F9 to have the formulas recalculated.

Parameters:

= reference = The range of cells to search in.
" color_index nr = The cell that has the font color to count,
or the color index number (1-56) from Excel.

=ASAPCOUNTCHAR(within text, find text)

Counts the number of times a character occurs in a text
This way you can for example count the number of commas in a cell. This function is case
sensitive.

Parameters:

* within text = The text containing the character you want to
count.

* find text = The character to count the occurrences of. This

has to be a single character.

=ASAPCOUNTSHADES(zeference)

Counts the number of colored cells in your range.
If you afterwards change the fill color in any of the referenced cells, you have to press
Ctrl+Alt+F9 to have the formulas recalculated.

Parameters:

= reference = The range of cells to count the number of cells
that have a fill color.
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=ASAPEXTRACTFILENAME(text, optional path_ separator)

Returns the file name from a full path and filename. By default the formula uses a backslash
(\) as separator, but optionally you can specify another separator.

For example =ASAPEXTRACTFILENAME("D:\Projects\Archive\Client 1\Balance.xls") returns
"Balance.xls".

Parameters:

= text = The value or cell address from which you want to
extract only the file name.

" path _separator = The path separator. Optional, if omitted a
backslash (\) 1s used.

=ASAPEXTRACTFOLDERNAME(text, optional path separator)

Returns the folder name from a combined filepath and filename. By default the formula
uses a backslash (\) as separator, but optionally you can specify another separator.

For example =ASAPEXTRACTFOLDERNAME("D:\Projects\Archive\Client 1\Balance.xIs")
returns "D:\Projects\Archive\Client 1".

Parameters:

= text = The value or cell address from which you want to
extract only the folder name.

" path separator = The path separator. Optional, if omitted a
backslash (\) 1s used.

=ASAPEXTRACTNUMBERS(text)

Returns the numbers from a text string.
For example the formula =ASAPEXTRACTNUMBERS("8011 LB") returns 8011.

Parameters:

* text = The value or cell address from which you want to
extract the numbers from.

=ASAPFILENAME()

Returns the name of your workbook. This is the name of the workbook without the filepath
(folder).
For example "Balance.xls".

=ASAPFILEPATH()

Returns the filepath (the folder) where your workbook is stored.
For example: "D:\Projects\Archive\Client 1".
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=ASAPFILEPROPERTIES(property name or id)

Returns the value of one of the built-in document properties for the current workbook.
You can refer to document properties either by index value or by their English name.
The following list shows the available built-in index values and document property names:

1 Title 16 Number of Characters *

2 Subject 17 Security

3 Author 18 Category

4 Keywords 19 Format

5 Comments 20 Manager

6 Template 21 Company

7 Last Author 22 Number of Bytes *

8 Revision Number 23 Number of Lines *

9 Application Name 24 Number of Paragraphs *

10 Last Print Date 25 Number of Slides *

11 Creation Date 26 Number of Notes *

12 Last Save Time 27 Number of Hidden Slides *

13 Total Editing Time * 28 Number of Multimedia Clips *
14 Number of Pages * 29 Hyperlink Base

15 Number of Words * 30 Number of Characters (with spaces) *

* Excel isn't required to define values for every built-in document property.

If Microsoft Excel doesn't define a value for one of the built-in document properties,
reading the Value property for that document property results in an error.

You have to press Ctrl+Alt+F9 to have the formula recalculated.

Example:
=ASAPFILEPROPERTIES("Last Print Date")

Parameters:

" property name or id = The id or English name of the built-in
document property.

=ASAPFONTCOLORINDEX(cel11)

Returns the color index number of the font of a cell.
If you afterwards change the font color in the cell, you have to press Ctrl+Alt+F9 to have the
formula recalculated.

Parameters:

* cell = The cell to get Excel's number for the text color
from.
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=ASAPFULLFILENAME()

Returns the full filename of your workbook. This is the name of the workbook including the
folder (filepath) where it is saved.
For example "D:\Projects\Archive\Client 1\Balance.xls".

=ASAPGETCOMMENT(ce11)

Returns the text from the comment a cell.
If you afterwards change the comment in the cell, you have to press Ctrl+Alt+F9 to have the
formula recalculated.

Parameters:

= cell = The cell to get the text from the comment from.

=ASAPGETDOMAIN(text, optional show protocol = False)

Returns the (sub)domain from a given hyperlink (website address/url).

For example if cell Al contains the value "https://www.asap-utilities.com/download-asap-
utilities.php" then these are the formula results:

=ASAPGETDOMAIN(A1) returns "www.asap-utilities.com"

=ASAPGETDOMAIN(A1;TRUE) returns "https://www.asap-utilities.com"

Parameters:

" text = The value or cell address from which you want to
extract the domain.

* show _protocol = Optional, logical value, if omitted the
default is FALSE. If TRUE this function will also return the
protocol of the link, which is the part before the domain
such as http://, ftp:// etc..

=ASAPGETFONTNAME(cel1)

Returns the name of the font in a cell.

If you afterwards change the font in the cell, you have to press Ctrl+Alt+F9 to have the
formula recalculated.

This function does not recognize formatting if it is applied via conditional formatting.

Parameters:

= cell = The cell to get the font from.
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=ASAPGETFONTSIZE(ce11)

Returns the font size of a cell.

If you afterwards change the font size in the cell, you have to press Ctrl+Alt+F9 to have the
formula recalculated.

This function does not recognize formatting if it is applied via conditional formatting.

Parameters:

= cell = The cell to get the font size from.

=ASAPGETFORMULA(ce11)

Returns the formula of a cell.

Parameters:

= cell = The cell to get the formula from.

=ASAPGETINDENTLEVEL (cel1)

Returns the indent level for the cell.

Parameters:

= cell = The cell to get the indent level from.

=ASAPGETHYPERLINK(cell, optional text no_link)

Returns the hyperlink from a cell. The hyperlink can be one of the following types:

- existing file or web page

- place in your document

- e-mail address

If you afterwards change the hyperlink in the cell, you have to press Ctrl+Alt+F9 to have the
formula recalculated.

Parameters:

*= cell = The cell to read the hyperlink from.

" text no link = Optional, this text will be displayed if the
cell doesn't have a hyperlinks. If omitted, the formula will
give an empty result for cells without hyperlinks.
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=ASAPGETHYPERLINK(cell, optional text no_link)

Returns the hyperlink from a cell. The hyperlink can be one of the following types:

- existing file or web page

- place in your document

- e-mail address

If you afterwards change the hyperlink in the cell, you have to press Ctrl+Alt+F9 to have the
formula recalculated.

Parameters:

= cell = The cell to read the hyperlink from.

" text no link = Optional, this text will be displayed if the
cell doesn't have a hyperlinks. If omitted, the formula will
give an empty result for cells without hyperlinks.

=ASAPGETNUMBERFORMAT(ce11)

Returns the number format of a cell.
If you afterwards change the number format in the cell, you have to press Ctrl+Alt+F9 to
have the formula recalculated.

Parameters:

= cell = The cell to get the number format from.

=ASAPISBOLD(reference)

Returns TRUE if the cell is bold or FALSE if it isn't.
If you afterwards change the bold setting in the cell, you have to press Ctrl+Alt+F9 to have
the formula recalculated.

=ASAPISFORMULA(ce11)
Returns TRUE if the cell has a formula or FALSE if it doesn't.

=ASAPLOADIMAGE(image fullname, optional width in pixels, optional
height_in_pixels)

Inserts the specified image as an object and puts it at the left-top of your cell.

To update the image, you can replace the formula with a new image name.

To remove the image you have to remove both the formula and the image. (The image isn't
removed if only the formula is removed.)

You have to press Ctrl+Alt+F9 to have the formula recalculated.

Example:
=ASAPLOADIMAGE("D:\products\images\art782.gif")
=ASAPLOADIMAGE("https://www.asap-utilities.com/upload/images/8.0/tip-of-the-day.png ")

Available tools 203



ASAP Utilities User Guide “Save hours in Excel”

Parameters:

* image fullname = The full path and file name of an image of
the type that Excel supports.

" width_in pixels = Optional. You can specify the width
pixels. If omitted, the width will be proportionally based
on the image's height.

" height in pixels = Optional. You can specify the height in
pixels. If omitted, the height will be the height of the
cell the formula is in.

=ASAPMERGECELLS(reference, optional delimiter = "", optional
skip_empty cells = True)

Joins several text strings into one text string.

An easy alternative for the Excel =CONCATENATE() function. The benefit of this

ASAP Utilities function:

- You can specify a range to join, for example "A1:G1".

- The numberformat of the values will be used. For example, if a cell has the value
"12.23072" and the number format is to display only one decimal then this function uses
the value "12.2".

- You only have to specify a delimiter once.

- By default empty cells will be ignored.

Parameters:

= reference = A contiguous range of cells to join the values
from. When reading the cell values, their number format will
be used.

" delimiter = Optional, a character to insert between the cell
values. If omitted then no delimiter is used.

" skip empty cells = Optional, is a logical value: to skip
empty cells = TRUE or omitted; to include empty cells in the
result = FALSE.
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=ASAPRANDOMPASSWORD(optional length = 8, optional use symbols =

Returns a random string that can be used as a password.
This function will return a strong password which contains of:

= both uppercase and lowercase letters
* numbers
= special characters, such as ~l@#S$%"*()[]\/<>:-=+_

Parameters:

True)

= length = Optional, the length of the password. If omitted,
then the length will be 8 characters. If the length given is

less than 8, still a password of 8 characters will be
returned.

" use_symbols = Optional, is a logical value: to use special
characters in the password = TRUE or omitted; to create a

password without special characters = FALSE.

=ASAPREGEXMATCH(read value, regular expression, optional ignorecase)

Returns TRUE if the value matches the regular expression and FALSE if it does not.

Parameters:

" read value = The text to be tested against the regular

expression.

" regular expression = The regular expression to test the text

against.

®= ignorecase = Optional. Specifies case-insensitive matching.

If omitted it is assumed to be FALSE.

Examples:

value expression result formula

Molenweg 242 [0-9]+ TRUE =ASAPREGEXMATCH(A2, B2)
Today's offer is $99.00 [0-91*\.[8-9]+[0-9]+ TRUE =ASAPREGEXMATCH(A3, B3)
The appointment is at 15:00 \d{2}\:\d{2} TRUE =ASAPREGEXMATCH(A4, B4)
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= ASAPREGEXEXTRACT(read value, regular expression, optional ignorecase)

Returns the text that matches the regular expression.

Parameters:

" read value = The text to be tested against the regular
expression.

" regular expression = The regular expression to test the text
against.

®= ignorecase = Optional. Specifies case-insensitive matching.
If omitted it is assumed to be FALSE.

Examples:

value expression result formula

Molenweg 242 [0-9]+ 1 =ASAPREGEXEXTRACT (A2, B2)
Today's offer is $99.00 [0-9]1*\.[0-9]+[0-9]+ 99.00 =ASAPREGEXEXTRACT (A3, B3)
The appointment is at 15:00 \d{2}\:\d{2} 15:00 =ASAPREGEXEXTRACT (A4, B4)

= ASAPREGEXREPLACE(read value, regular expression, replacement value,

optional replace_all, optional ignorecase)

Returns a modified version of the text string based on a regular expression.

Parameters:

" read value = The text to be tested against the regular

expression.

" regular expression = The regular expression to test the text
against.

" replacement_value = The text to replace the matched groups
with.

" replace_all = Optional. Specifies to replace all matches. If
omitted it is assumed to be TRUE.

®= ignorecase = Optional. Specifies case-insensitive matching.
If omitted it is assumed to be FALSE.

Examples:
value ‘ expression replacement result formula ‘
Molenweg 242 [8-9]+ 200 Molenweg 200 =ASAPREGEXREPLACE (A2,B2,C2)
Today's offer is $99.00 [8-9]1*\.[@-9]+[B-9]+  49.99 Today's offer is $49.99 =ASAPREGEXREPLACE (A3,B3,C3)
The appointment is at 15:00 \d{2}\:\d{2} 10:30 The appointment is at 10:30 =ASAPREGEXREPLACE (A4,B4,C4)
The color is (green) \(([A-Za-z]+)\) red The color is red =ASAPREGEXREPLACE (A4,B4,C4)
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=ASAPSHEETNAME(optional reference)

Returns the name of the worksheet this formula is used on.

Parameters:

= reference = Optional, a cell on the sheet that you want to
get the name from. If omitted then the name of the current
sheet is returned.

=ASAPSPELLNUMBER(ByVal number, optional strLanguage = "EN", optional
blnCurrency = False, optional strSingular, optional strPlural, optional

strComma, optional strCentSingular, optional strCentPlural)

Returns a spelled-out number or amount.

A few examples if cell Al contains the value 142.23

=ASAPSPELLNUMBER(A1,"EN", TRUE, "Dollar", "Dollars", , "Cent", "Cents") returns One
Hundred Forty-Two Dollars and Twenty-Three Cents

=ASAPSPELLNUMBER(A1,"EN", FALSE,,,"Comma") returns One Hundred Forty-Two Comma
Twenty-Three Hundredths

=ASAPSPELLNUMBER(A1,"NL") returns honderdtweeénveertig en drieéntwintig
honderdsten

=ASAPSPELLNUMBER(A1,"FR", TRUE, "euro", "euros", , "cent", "cents") returns cent
quarante-deux euros et vingt-trois cents

=ASAPSPELLNUMBER(A1,"DE", TRUE, "Euro", "Euros", , "Cent", "Cent") returns
einhundertzweiundvierzig Euros und dreiundzwanzig Cent

If a number contains more than two decimals this function will spell out the number as if it
was rounded to two decimals.
A practical example where this function can be useful is to write out amounts on cheques.

Parameters:
" number = The number or cell with a number you want to spell.
= language = Optional, text string representing in which

language the number is spelled out: English = EN or omitted,
Dutch = NL, German = DE, French = FR.
= currency = Optional, logical value: to spell the number as a

currency TRUE; to spell the number just as a number =
FALSE or omitted. For example spell the number 2 as "two
dollars and no cents" or just "two".

" cur_singular = An optional text string for the currency
spelled singular. For example "dollar".

" cur_plural = An optional text string for the currency

spelled plural. For example "dollars".
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= comma = An optional text string for the decimal separator
used. For example the comma sign (",") or point (".") or the
word "comma". If omitted then it will be automatically
filled depending on the given language: English = "comma",
Dutch and German = "komma".

" cur_cent singular = An optional text string for the word
used with currency for the amount behind the comma,
singular. For example "cent".

" cur_cent plural = An optional text string for the word used
with currency for the amount behind the comma, plural. For
example "cents".

=ASAPSTRIPNUMBERS(text)

Removes all numbers from a text string and removes all spaces at the beginning and end of
the result.
For example the formula =ASAPSTRIPNUMBERS("8011 LB") returns "LB".

Parameters:

= text = The value or cell address from which you want to
strip the numbers.

=ASAPSUMBYCELLCOLOR(reference, color index nr)

Adds the cells that have a certain fill color.
If you afterwards change the color in any of the referenced cells, you have to press
Ctrl+Alt+F9 to have the formulas recalculated.

Parameters:

= reference = The range of cells to search in.
" color_index nr = The cell that has the fill color to sum, or
the color index number (1-560) from Excel.

=ASAPSUMBYFONTCOLOR(reference, color_ index nr)

Adds the cells that have a certain font color.
If you afterwards change the font color in any of the referenced cells, you have to press
Ctrl+Alt+F9 to have the formulas recalculated.

Parameters:

= reference = The range of cells to search in.
" color_index nr = The cell that has the font color to sum, or
the color index number (1-56) from Excel.

Example screenshot: 1
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ASAP Utilities - Insert a function from the ASAP Utilities library

Function library | Remarks on calculation and distribution ]

Insert the following function into cell Al:

ASAPEXTRACTMUMEERS
ASAPFILENAME
ASAPFILEPATH
ASAPFILEPROPERTIES
ASAPFONTCOLORINDEX
ASAPFULLFILEMAME

ASAPGETDOMAIN
ASAPGETFONTMAME
ASAPGETFONTSIZE
ASAPGETFORMULA
ASAPGETFORMULAINT
ASAPGETHYPERLIMNK
ASAPGETINDENTLEVEL
ASAPGETMUMBERFORMAT
ASAPISBOLD

=ASAPGETCOMMENT (cell)
Returns the text from the comment a cell,

If you afterwards change the comment in the cell, you have to press Ctrl+Alt+F9 to have the formula

recalculated.

Parameters:
# cell = The cell to get the text from the comment from.

ASAPGETCOMMENT J

Bl

Cancel

3

[~

Example screenshot: 2 Calculate the sum of cells that have a specific color

B10 - A& =ASAPSUMBYCELLCOLOR(B12:K17:612)
A BT CcTDTETFITGTHT T TJITKT L ] M
«se back  Read the description of this formula on our website sn»

=ASAPSUMBYCELLCOLOR()

Calculates the SUM of the cells that have a certain fill color.

Example 1

Use the ASAPSUMBYCELLCOLORY() formula to sum the values of the yellow cells:
We use B10 in the formula to have the formula count the cells with the same cell color as cell B10

: Formula used in B9:
=ASAPSUMBYCELLCOLOR({B12:K17:812)

3% 81 76 11 103 88 12 105 20
18 73 B4 56 41 101 84 28 77
92 27 91 58 36 64 46
102 30 519 9 T 7
63 40 61 32 8 &1 44
5 13 12 40088 19 3

Example screenshot: 3 Retrieve the comments

D8 - A =ASAPGETCOMMENT(BS)
A | B [c] D [ E [ F

1 |ses back  Read the description of this formula on our website »s»

2 =ASAPGETCOMMENT()
EX
4] Returns the comment-text frge] P03t this when the
——| price changes
6 Example
| 7 | Cells with comment ./ Comment contents: Formula used in column D
| & | Test Update this when the price changes =ASAPGETCOMMENT(BS)
| 9 | 500 b {Is this correct? SAPGETCOMMENT{BS)
| 10| 19% {Verify with Paul \SAPGETCOMMENT(B10)
| 11| 35 \Enter your age =ASAPGETCOMMENT(B11)

12
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Download an example workbook that shows how to use these extra functions

We have created a workbook (in English) that shows practical examples of how to use all
these extra worksheet functions:
https://www.asap-utilities.com/functions-workbook.php

Important information on when Excel makes calculations and recalculations.

Excel usually recalculates formulas only if the value in one of the referenced cells changes.
For example, if you use the formula =ASAPSUMBYCELLCOLOR() and only change the color in
the referenced cells, Excel does not recalculate the formula because the value in the cells
has not changed.

If Excel does not automatically recalculate the formulas, you can manually trigger the
recalculation of the formulas using Excel's built-in shortcut keys F9 or Control+Alt+F9.

Important to know when sharing a file with these functions.

If you use one or more of these functions from ASAP Utilities in your workbook, there are a

few things important to know when sharing the file with others:

= Anyone who wants to use the features of ASAP Utilities also needs ASAP Utilities. You
can easily recognize these functions because their names start with "ASAP."
If you are not sure if you have used a function from ASAP Utilities, you can easily look it
up. For example, by searching the formulas in all worksheets at once for "ASAP*("
(without the quotes). This can be done quickly in ASAP Utilities via:

ASAP Utilities > Range » Find and/or replace in all sheets...

= |f someone without ASAP Utilities needs to start using the file then you can change the
formulas to their calculated values. This can be done in Excel via Copy > Paste as values
or with ASAP Utilities via:

ASAP Utilities » Formulas » Change formulas to their calculated values

= |f you see "HNAME?" as the result of the function, it means that either there is a typo in
the function name or Excel cannot find that function from ASAP Utilities.
If you received the file from someone who had ASAP Utilities installed in a different
folder, you can easily restore the link to the functions via:

ASAP Utilities » Formulas » Correct the link to the ASAP Utilities worksheet
functions

Dynamic array formulas and spilling

The following functions can be used in dynamic array formulas and support spilling (if your
Excel version supports it too):

= ASAPCELLCOLORINDEX() = ASAPEXTRACTNUMBERS)()
= ASAPCOUNTCHAR() = ASAPFONTCOLORINDEX()
= ASAPEXTRACTFILENAME() = ASAPGETCOMMENT/()

ASAPEXTRACTFOLDERNAME() ASAPGETDOMAIN()
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= ASAPGETFONTNAME() = ASAPGETNUMBERFORMAT()
= ASAPGETFONTSIZE() = ASAPISBOLD()

= ASAPGETFORMULA() = ASAPISFORMULA()

= ASAPGETFORMULAINT/() = ASAPSPELLNUMBER()

= ASAPGETHYPERLINK() = ASAPSTRIPNUMBERS()

= ASAPGETINDENTLEVEL

Useful links from Microsoft about Dynamic array formulas:

= Microsoft: Excel functions that return ranges or arrays
https://support.microsoft.com/en-us/office/excel-functions-that-return-ranges-or-
arrays-7d1970e2-cbaa-4279-b59¢c-b9dd3900fc69

= Microsoft: Dynamic array formulas and spilled array behavior
https://support.microsoft.com/en-us/office/dynamic-array-formulas-and-spilled-array-
behavior-205c¢6b06-03ba-4151-89a1-87a7eb36e531

= Microsoft: Dynamic array formulas vs. legacy CSE array formulas
https://support.microsoft.com/en-us/office/dynamic-array-formulas-vs-legacy-cse-array-
formulas-ca421flb-fbb2-4c99-9924-df571bd4f1b4

= Microsoft: Dynamic array formulas in non-dynamic aware Excel
https://support.microsoft.com/en-us/office/dynamic-array-formulas-in-non-dynamic-
aware-excel-696el164e-306b-4282-ae9d-aa88f5502fa2

Correct the link to the ASAP Utilities worksheet functions

This tool can be used to correct the reference in your workbook to the ASAP Utilities
worksheet functions.

This can be useful if your workbook is used on another computer where ASAP Utilities is
installed in a different folder. For example, the default installation folder of ASAP Utilities
differs between a 32-bit and 64-bit Windows version.
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5.5.13 Web

A collection of tools to help you with data imported from websites, hyperlinks, HTML code

and more.

1 Clean data and formatting...

This utility helps you to optimize and clean information that you have copied into Excel.

You can choose the following edits:

= remove all hyperlinks
= trim spaces (removes leading and

trailing spaces

)

= remove all cell colors
= remove all font colors
= remove all borders

= unmerge cells

= apply standard font

Your last used settings will be remembered.

apply standard font size

no wrap-text

fix (text)numbers

autofit columns

autofit rows

remove all objects/images from your
worksheet

A B £ D E F G H 1 K L
. Official
Metropol Continen .
Rank N ‘Country populati | Year
itan t
1 on
L] ) 37,
5 1{Tokyo Japan |Asia 5 2016
3 2|shanghai | China Asia ASAP Utilities - Clean data and formatting Pad
__donesi| In selected range: ALF101
3[Jakarta |7 |Asia
4 ¥ Remove all hyperiinks [ Apply standard font size
4|Delhi India  |Asia ¥ Trim spaces [V No wrap-text
s Delhi  |India |Asia
e: Lih W Remoye all cell colors ¥ Fix (textnumbers
1] )
5 5|seoul e W Remove all font colors ¥ Autofit columns
Guangzh I Remove all borders Maximum wicith:
6 Asia
7 ou — ¥ Unmerge cells [V Autofit rows
e W Apply standard font Maimum height:
s Asia
- In this worksheet: Before
9 Asia
v Remove all objectsfimages
Asia
10 .
] o | 8| e | e
1 America
South 21,242,393
south, 21,242,93 2016/
12 America |3
A B C D E F G
1 |Rank Metropolitan ‘Country Continent | Official population Year
2 1 Tokyo Japan Asia 37,832,892 2016
3 2 Shanghai China Asia 34,865,252 2015
4 3 Jakarta Indonesia Asia 31,689,592 2015
5 4 Delhi India Asia 26,454,000 2011
6 5 Seoul South Korea Asia 25,514,000 2016
7 6 Guangzhou China Asia 25,000,000 2015
8 7 Beijing China Asia 24,900,000 2015
El 8 Manila Philippines Asia 24,650,000 2018|
10 9 Shenzhen China Asia 23,300,000 2015
1 10 Mexico City Mexico North America 21,650,668 2017|
12 11 S3o Paulo Brazil South America 21,242,939 2016
13 12 Lagos Nigeria Africa 21,000,000 2014
14 13 Mumbai India Asia 20,748,395 2011
15| 14 Cairo Egypt Africa 20,500,000 2012
16 15 New York City United States North America 20,320,876 2017
17 16 Keihanshin (Kyoto-Osaka-Kobe) Japan Asia 19,342,000 2010
18 17 Wuhan China Asia 19,000,000 2015
1ol e rhanadn rhina Aciz 12 100 nnn | 2015
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Remove all HTML tags in the selected cells...

This tool will strip all HTML tags in the selected cells, such as for example <br>, <p>, <font>,
<script>, etc..
Besides removing the tags, you can choose to:

= Keep existing line breaks
= Add line breaks at the end of tags such as <br/>, </p>, </h1> etc..

In addition it will also convert encoded characters such as &nbsp; and &amp; to normal
characters.

Descriptich:<br><br=USB 3.0 is the new standard for super speed Universal Serial Bus, U!

ASAP Utilities - Remove HTML tags

[¥ Add alinebreak at the end of tags such a <br/, </p*, </h1z etc.

[ Preserve existing line breaks

Cancel

ard for super speed Universal Serial Bus, U!

Decode all URL and HTML encoded text

This utility decodes all URL-encoded text in your selected cells.

This can be useful when you use Excel for example to analyze reports with website statistics
or keyword performances.

The utility will replace the "+" character with a space and it decodes any %## encoded
character in the cells.

It will also decode named HTML entities such as &nbsp; and &euro; and it will decode a
string of text such as %c3%84 and %c3%a7 and unicode characters such as &#169; and
&#8220;.

This utility will for example decode the text "http%3A%2F%2Fwww%2Emicrosoft%2Ecom"
to "http://www.microsoft.com", which is more readable.

URL encoding is used when text is place in a query string in the URL to avoid that it gets
mixed up with the address of the website and it is usually placed behind a question mark (?)
in the address. This technique is often used when the internet browser sends data via a
form on the website to the web server.

The cells in your selection with formulas are skipped.
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"

A | [ A

1 URL encoded data: 1 URL ded data, now d ded and readable:
| 2 |random¥20sorting 2 |random sorting
2 |makef20all%20text%20lowercase 3 |make all text lowercase
4 |nttp%3A%2F%2Fwww%2Ew3schools%2Ecom Thttp:,’/www.stchools.com
| 5 |nttp%3A%2F%2Fwww%2Emicrosoft¥h2Ecom Thttp:,’/www.microsoﬂ.com
. 6 |mountain%20bike%20action E mountain bike action
.7 |mountain?%20bike%20shops 7 |mountain bike shops
2 |mountain%20bike%20racing | 8 |mountain bike racing
' 9 |mountain%20bike%20frame ' 9 |mountain bike frame
| 10 |http%3A%2F%2Fwww.asap-utilities.com%2Fdownlogl.pt E http://www.asap-utilities.com/download.php
ibastien%dﬂasap»utilities.com 11 |bastien@asap-utilities.com
| 12 |method+%27add%27+o0f+object+#27commandbarcorgrol 12 |method 'add" of object '‘commandbarcontrols’ failed
| 13 [Excel+limitations%2Fspecifications 13 [Excel limitations/specifications
| 14 |http%3A%2F%2Fen.wikipedia.org%2Fwiki%2FElephayt E http://en.wikipedia.org/wiki/Elephant
15 |http%3A%2F%2Fru.wikipedia.org/wiki/%D0%A1%D0% EB' 15 |http://ru.wikipedia.org/wiki/Cnon
16 |http%3A%2F%2Far.wikipedia.org/wiki/%Da%81%DI%BA% 16| http://ar.wikipedia.org/wiki/Js
| 17 |http%3A%2F%2Fbg.wikipedia.org/wiki/%D0%A1%D0%BB ?http:,f,lbg.wikipedia.org,’wiki,’CnoH
18 |http%3A%2F%2Fzh.wikipedia.org/wiki/%E8%B1%A1 E http://zh.wikipedia.org/wiki/

13 |http%3A%2F%2Fel.wikipedia.org/wiki/%CE%I5%CEXBBY 19 |http://el.wikipedia.org/wiki/EAEdavrac

20 20

21 =

Extract hyperlinks...

This utility extracts the hyperlink addresses from the selected cells and/or extracts them

from all shapes on your worksheet.

You can choose to insert the address into the cell itself or in the column right next to the

cell or shape.
The shape can be an autoshape, freeform, OLE object, or picture.

Your last used settings will be remembered.

Note:

You can also use the ASAP Utilities worksheet function =ASAPGETHYPERLINK() to read the

hyperlink address from a cell.

214

Chapter 5



“Happiness inspires productivity”

ASAP Utilities User Guide

A

AP Excel Information

Application Professionals

Chip Pearson

Contextures

DataPig Technologies - Video's with Excel tutorials

ASAP Utilities - Extract hyperlinks
—__ T ]

[~ Get the hyperlinks on current
¥ selected 27 cells

[~ Place the hyperlink-text in:
" the cel itself

' the column right next to the cellfshape

This utility will retrieve the address from the hyperiink.

icrosoft’s

icial Excel

Daily Dose of Excel (tip!

The Spreadsheet Page Blog

PTS Blog (Excel Charts]

Methods in Excel

The Ken Puls Blog

Smurf on Spreadsheets

Code For Excel And Outlook, Excel category
Excel Hero

Excel Unusual, Science, engineering, games

A

AP Excel Information

Application Professionals

Chip Pearson

Contextures

DataPig Technologies - Video's with Excel tutorials
David McRitchie

Deci

n Models - The Excel Calculation Site

ExcelGuru.ca

ExcelUser.com

The Spreadsheet Page (formerly J-Walk)
JKP Ads Excel articles

Jon Peltier (charts

Automation

articles.com
OzGrid

Ron's Excel Page
Vertex42

Microsoft's Official Excel blog
Daily Dose of Excel (tip!
The Spreadsheet Page Blog

PTS Blog (Excel Charts]

Methods in Excel

The Ken Puls Blog

Smurf on Spreadsheets

Code For Excel And Outlook, Excel category
Excel Hero

Excel Unusual, Science, engineering, games

B C D E F G
http://www.andypope.info/index.htm
http://www.appspro.com/
http://www.cpearson.com/excel.htm
http://www.contextures.com/index.html
http://www.datapigtechnologies.com/
http://www.mvps.org/dmcritchie/excel/excel.ntm
http://www.decisionmodels.com/
http://www.excelguru.ca/
http://www.exceluser.com/
http://spreadsheetpage.com/
http://www.jkp-ads.com/Articles/ExcelArticles.htm
http://peltiertech.com/
http://www.oaltd.co.uk/
http://www.officearticles.com/excel/index.htm
http://www.ozgrid.com/
http://www.rondebruin.nl/
http://www.vertex42.com/
http://blogs.office.com/b/microsoft-excel/
http://www.dailydoseofexcel.com/
http://spreadsheetpage.com/index.php/blog/
http://peltiertech.com/WordPress/
http://www.blog.methodsinexcel.co.uk/
http://www.excelguru.ca/blog/
http://smurfonspreadsheets.wordpress.com/
http://www.codeforexcelandoutlook.com/blog/category/excel/
http://www.excelhero.com/blog/
http://excelunusual.com/

Activate hyperlinks (create from cell values)...

This utility adds a hyperlink in the selected cells based on content of the cell.
You can use this for example to transform website- or email addresses into clickable
hyperlinks.

You can configure the following settings:

Font format:

= Keep the existing font format in the cells.
= Use Excel's default format for hyperlinks (blue underlined)

Available tools
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Hyperlink type:

= Use the =HYPERLINK() formula. This is recommended if you have a lot of hyperlinks in
your file or if you use a shared workbook.
= Regular hyperlinks (via the cell properties)

Your last used settings will be remembered.

/

A B B D A
MLl Links to websites: MM Links to websites:

.andypope.info/index.htm www.andypope.info/index.htm
www.appspro.com/ www.appspro.com/
http://www.cpearson.com/excel.htm http://www.cpearson.com/excel.htm

2
| 3 |
EX
http://www.contextures.com/index.html 5 |http://www.contextures.com/index.html
— 1 6|
17|
L8|
1 9|
0

- " —— http://www.datapigtechnologies.com,
ASAP Utilities - Activate hyperlinks.

hi http://www.decisionmodels.com,
hi] | Creatss a hyperlink based on the values in selected cells, The cell will then http://www.excelguru.ca,
h contain dickable hyperlinks to for example websites or documents, (s i 1 s e e e
10 | 10 | hitp://spreadsheetpage.com,
11 |h] | [~ Font format 11 |http://peltiertech.com
12 |h " Keep original 12 | http://www.oaltd.co.u
13 |h 13 | http://www.ozgrid.com
1 * Excel's default for hyperlinks (blue underlined) 14 |www.rondebruin.nl/
15 15 |www.vertex42.com/
16 — Hyperlink type 16 | blogs.office.com/b/microsoft-excel
17 £~ Use =HYPERLINK( formula 17 |www.dailydoseofexcel.com/
18 recommended for large datasets and shared workbooks 18 |spreadsheetpage.com/index.php/blog/

19 | peltiertech.com/WordPress/
20 | www.blog.methodsinexcel.co.uk/

* Regular hyperlink (via the cell properties)

|21 | 21 |www.excelguru.ca/blog/

2 gsmuﬁonspreadsheets.wordpress.com[
|23 | | 23 |excelunusual.com/

24 24

| 26 |C:\Users\Test\Documents\101121.1PG | 26 |C:\Users\Test\Documents\101121.1PG
| 27 |C\Users\Test\Documents\133730.PG | 27 |C:\Users\Test\Documents\133730.1PG
| 28 |Ci\Users\Test\Documents\135006.1PG | 28 | C:\Users\Test\Documents\135006.1PG
| 29 |C:\Users\Test\Documents\150850./PG | 29 |C:\Users\Test\Documents\150850.1PG
30 |C:\Users\Test\Documents\122905.1PG | 30 |c:\Users\Test\Documents\122905.1PG
|31 |C\Users\Test\Documents\125233.1PG | 31 |C:\Users\Test\Documents\125233.1PG

34 |support@asap-utilities.com

35 |download@asap-utilities.com

Change all hyperlinks to =HYPERLINK() formulas

This utility will change all hyperlinks in cells to =HYPERLINK() formulas on the selected
worksheets.

The current hyperlink address will be use for the hyperlink part. The text from the screen
tips will be lost because screentips are not supported by the =HYPERLINK() formula.

Workbooks in Excel can become slow when they contain too much 'normal’ cell with
hyperlinks. The =HYPERLINK() formula does not have that problem.

Note:
If the hyperlink address exceeds 255 characters the cell will be skipped, because that is the
maximum length allowed by Excel in the =HYPERLINK() formula.
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Remove all hyperlinks in selected cells

This utility will remove all the hyperlinks in the selected cells.

Note:
This utility will remove regular hyperlink that are set via the cell options. It will not remove
=HYPERLINK() formulas.

Export selection as HTML table to clipboard...

Export your selected range as a table in clean HTML-code to the clipboard so that you can
easily paste it into your webpage.

This utility has advanced options and is recommended to all web developers.

Your last used settings will be remembered.

Example screenshot: Export your range in clean HTML format

A B C 0 E F G H | J

Ll Country Company 2011 2012 2013

2 |aust b n = 31 -

3 |nust{ ASAP Utiites - Export as HTML table to dipboard - .

4 |Aust " -

Settings I Generated HTML code | Eerras

5 |Bela) ALEL2L =]

6 |Bela [ Table, row and column settings [ Use cell formatting: ——————————————

7 |aelg i l— Cell padding: 3 ¥ cell color [+ Font color Table comment <1— -3

8 Border: 4  Cellspacing: 0 ¥ Afgnment

9 [V Bold, underlined and italic

10 Align: 4
Tl [ Cellsettings —————

11 | Frame: - = SRS [V write each <td> on a new line
2 ! ¥ nowrap |¥ Character encoding

Rules: -

& I ¥ Place &nbsp; in empty cells [ Ne line breaks (blog/forum
13 cobledass= [ Bzl

14 | ¥ Detect hyperlinks

15 f <td dass= Taget ek 7] This utility produces dean
— <tr dass= l— - and easy to use HTML code

16 |Croat| ™ even of your table.

17 |croaf| ¥ Eont (if no stylesheet used) The code s copied to your
| ! [ Use first row as table head (<th=) Eont name: Size: d'DbD:Efd- 50 you can easily

lﬁ lﬁ = it |r;to your
Tahoma hd 2 hd locument.

E | I Detect column width We assume you know the

20 | I Detect row height How to exporty ——————————— basics of HTML.

21 Align rows: ————————————  values (12)

2 b |  Formuas (=3¢)

23 Vertical:
o erocal 2 (= As displayed (EUR 12,00) _ -
= Close | oK |

25 .

na
=2}

N
=

Finland General Products 4 21 49|

Cinland Wiatar And Dawar 1 12 aal

2
B

Visit our website for more Excel tips and tricks

This utility will open our website (www.asap-utilities.com) in your default internet browser.

Note:
The website is in English.
This only works if you are connected to the Internet.

https://www.asap-utilities.com
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5.5.14 Information

Collection of "Information" tools

1 Fast calculation on selected cells...

This utility performs a fast calculation on the selected data range.

The utility shows you the following information:

the number of selected cells
the number of numeric cells
the number of text cells

the number of blank cells
the sum

the average

the minimum value

the maximum values

the number of duplicates (values that appear more than once)
the number of unique values
values that appear only once

You can choose to have a new workbook created with these results.

Note:

The following rules apply for counting the duplicates and unique values:

The utility is case sensitive which means for example that "Excel" and "EXCEL" is not the
same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as
a duplicate.
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Example screenshot: 1

A B c D E F G

El Name .7 -
2 | Agustin 48 ~
3 |aiden 31 || ASAP Utilities - Fast calculation
4 |Alejandro 21 Datarange
5 |Alexander 42 IVEZ:EEI
6 |Ali 23
7 |Andrei 24 Selected cells:
8 |Arda 24 Mumeric cells:
10 |Bence 40

- Blnks: L o
11 |Benjamin 43
12 |Daan 37 S 2097
13 Daniel 33 || Average:
14 |Eetu 30 Minimum value: El
15 |Emil 34 | i v
oo o | P
17 Erik 0 | i
ol than 21 || Uriue vaiues:
19 |Francesco 22 WValues that appear only once:
20 |Georgi 37
21|Georgios i Close Create a workbook nith these resuts
22 |Giorgi 72
23 |Hans 42
24 |Iker 42
25 |lvan 34
26 |Jack 21
27 |Jacob 41
28 |Jakub 32
20 [1knn A

Example screenshot: 2

A B C D E
B
2

3 |Austria Jvirtucon 59 30 37
£ | e ASAP Utilties - Fast calculation 42
5 |Belarus 8
6 [Belarus Data range 13
7 |pelgi |7A2:A121 ‘ 7
8 jeelaum 4| soected ol w2
9 [Belgium 33
10 |Belgium Numeric cells: l:l S0
11 [puigaria | Textces: L o |f o
12 |Bulgaria Blanks: I:l L 17
13 [Croatia Sum: l:| | 12|
14 [Croa 17,
15 |Croatia 14
Tllresiie Minimum value: ] =
17 |croatia Maximum value: l:l 42!
18 [croatia Dupicates: [ w1
18 |Czech Repulll| |nigue values: 43
20 Ceech REpUR . 12t appear anly oncer . o=
21 [Denmark 59
22 |Denmark 43
23 [Denmark Close Create a workbook with these results 34
24 D k 27|
25 [Denmark 51
26 [Finland lacme, Inc. 36 43 42
Finland General Products 4 21 49!
[water And Power 11 13 49
Eabe Rrathare q 1 B

Available tools
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File and selection info...

This utility will show you some information about your file, worksheet and current

selection.

The utility shows the following information:

= Filename

= File size

= Date modified
= Number of sheets

= Name of the active sheet
= Used range address

= Last row
= Last column
= Total cells in the used range
= Total cells with formulas

= Total cells with blanks

= Total cells with constants

A z] [ E F
il Count i Compa i 20 - 1 20 -
2 |Austria Luthorcorp 2 31 14}
j 2:2::: ‘F’:’E: ASAP Utilties - File and selection info... . e |
5 |Belarus Lexcol
6 |Belarus ZevoT "'7  Filename: Ci\Projects\ASAP
7 |Belgium Initec WV Utilities\Examples\0169 - File and selection infouxlsx
8 [Belgium Sadge Modiic B i
9 Belgium Mam Sheets: 2
10 |Belgium BigKa
11 |Bulgaria Smith | C:::Er;:;:b gisélltzl
12 Bulgaria The N Last row: 121
13 |Croatia Videld Last column: 5
14 Croatia Moes Total cells: g0
Formulas: 0
15 | Croatia Galax: Blanks: 4
16 | Croatia Burleig)| Constants: 601
17 Croatia Sombr| E:;i?;l: g
18 |Croatia Qwert] Text: 244
19 | Czech Republic Globos MNumbers: 357
20 |Czech Republic Spacel Active cells 0
21 |Denmark Chase Column number: 1
22 Denmark Spade Row number: 2
&3 Denmark Mong Selected range: A2EB
24 | Denmark Roboti Columns: 5
25 Denmark Praxis; Rows: 7
26 |Finland Acme, Cells: 3
27 |Finland Generd
28 |Finland Water
29 |Finland Fake B
30 Finland Demo b
31 |Finland ‘Widget Corp 22 51 11
32 Finland Strickland Propane 8 6 10
33 France Mainway Toys 34 [ 4
34 France Big T Burgers And Fries 42 50 29
35 |France Klimpys 41 40 20!

Total cells with errors

Total cells with logical values
Total cells with text values
Total cells with numbers
Active cell's address

Column number of the active cell
Row number of the active cell

Selected range's address

Number of columns in the selected

range

Number of rows in the selected range
Number of cells in the selected range
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Copy the path and filename of current workbook to clipboard

This will put the path and filename of your current workbook to the clipboard. You can then

paste it into another application.

This can for example be useful if you're working on a file and want to inform a colleague

and tell him/her in an email where he/she can find the file.

Get the page number of the active cell

This utility mentions the page number of the page where the active cell is located.

An example of when this is useful is when you only want to print certain pages.

s N
[&]] e - 4 - S+ 45 0265 Copythe path and filename of current workbook to clipboard.dsx M.. ‘ Table T | [E=R =
MUme Insert Page Layout Formulas Data Review View ASAP Utilities Design & 0 = g 2

q Q E Sheets ~ [ Columns & Rows ~ ﬁ"ﬂj Mumbers & Dates ~ -;‘é Web - ﬁ[mport ~ & ASAP Utilities Options - @ Online FAQ
[ Range - [=] Objects & Comments ~ [A] Text |1 nformation | @] Export - | b Find and run a utility @ o
Favorites & Vision Select B
Shortcut keys ~ | Control = =i Fill ™ Format + Je Formulas - [Z 1. Fast calculation on selected cells... version
Favorites Time saving tools Bi 2, File and selection info... elp
Al - { Jx ‘ Country 53 3. Copythe path and filename of current workbook to clipboard i
A B C D E [#' 4. Getthe page number of the active cell A
1 K company K201 E21 H201: B B 5. Count and/or color duplicates in selection...
2 |Austria Luthorcorp 2 31 14, . . =
- - ] 6 Countthe different unique values in selection 3
3 |Austria Virtucon 59 30 37,
2 Austria Farge And Foundry P 0 2 £y, 7. Count number of characters in selected cell
& lRalarnc Lavenrn a =1 =l |6 & create a list of all built in warkhank nransrties fitls author ste

A B C D E F

il Country B company B3 2011 Ed2012 Ed2012 E3
6697 |France Mainway Toys 34 6 4
6698|France Big T Burgers And Fries 42 50 29
6699 France Klim| taa ar o
5700 France petrd ASAP Utilities - Get the page number of the active . SRES
6701|Great Britian lcharl
6702 Great n Gring e
6703 Great Britian Globe @ The page number of cell AG701 is 143,
6704 |Great Britian Taco
6705 Greece The A
6706|Greece Input
6707 |Greece Foo B
6708 |Greece Cngsvm - ” 11
6709 |Hungary Three Waters 9 54 1
6710|Hungary Megadodo Publications 25 41 52
6711 Hungary Mr. Sparkle 47 12 16
6712 |Hungary Sixty Second Avenue 40 53 1
6713|Ireland Universal Export 37 37 a6
£714 liraland Initrada 27 2 55
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Count and/or color duplicates in selection...

This utility tells you how many duplicate values there are in your selected range.
You can choose to paint all duplicate cells with a certain color.

Note:

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the

same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as
a duplicate.

Example screenshot: 1 Count and color duplicated values

A 8 c D E F
1 [Belgrade Paris.
2 |Berlin Prague
3 [Bemn Reykjavik
4 |Bratislava Riga
5 |Brussels Rome |
@ San Marino | Asup tilities - Count and/or color duplicates in selection
7 |Budapest sarajevo
& |Copenhagen  skopje
o | e o Da you wantto giv t cllswith 3 duplicte alue 2 cartain
10 |Helsinki Stockholm
11 |Kiev London
12 |Lisbon Prague Yes No
13 |Brussels Tirana
14 |London Térshavn |
15 |Luxembourg  Vaduz
16 |Madrid Vienna
17 | Minsk Vilnius
12 |Moscow Warsaw
12 |Nicosia Yerevan
20 |oslo Zagreb I
21
A 8 c D E F
1 [Belgrade Paris.
2 |Berlin Prague
== = ASAP Utilities - Select a color X
4 |Bratislava Riga
5 |Brussels Rome HEEEERR Example:
5 [Bucharest san Marino
7 ssaevo | H N W
& |copenhagen skopje |
9 |Dublin sofia - u EEEEN
10 |Helsinki stockhoim | [l [ | H B —
11 |Kiev London |
12 |Lisbon Prague |
13 [Brussels Tirana ) | [ | [ | [ |
14 |London Térshavn
15 |uxembourg. veaz | I I EEEN
16 |[Madrid Vienna | RGB value: 153 204 255
17 |Minsk Vilnius | HBXvalue; #99CCFF Edit colors
18 |Moscow warsaw G 37
12 |Nicosia Yerevan |
20|oslo zagreb I
21
22
A 8 = D E F
1 [Belgrade Paris.
2 |Berlin
3 [Bern Reykjavik
4 |Bratislava Riga
5 Rome
5 |Bucharest san Marino
7 sarajevo ASAP Utilties - Count and/or color duplicates in selection. X
& |copenhagen  skopje
9 |Dublin sofia
o R Bl o Atotsl of § Quplcte values were found I th sected 40
11 |Kiev
12 |Lisbon
13 Tirana
14 Térshavn
15 |Luxembourg  Vaduz
16 |Madrid Vienna
17 | minsk vilnius
12 |Moscow Wwarsaw
12 |Nicosia Yerevan
20|oslo zagreb
21
22
23
24
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Example screenshot: 2 Just count the duplicates without coloring them

A B C D E F A B £ D E
1 |Belgrade Paris 1 |Belgrade Paris
2 |Berlin Prague 2 |Berlin Prague
3 |Bern Reykjavik 3 |Bern Reykjavik
4 |Bratislava Riga 4 |Bratislava Riga
5 |Brussels Rome 5 |Brussels Rome
6 |Bucharest San Mari=~ & |Bucharest San Marin~
7 |Budapest Sarajeva ASAP Utilties - Count and/or color duplicates i selection... 7 |Budspest Sarajevo | ASAP Utities - Count and/or color duplicates in selection... X
3 |Copenhagen  Skopje # 4 |Copenhagen  Skopje |
9 |Dublin sofia o Do you want to give the cells with a duplicate value a certain 9 |Dublin Sofia 0 Atotal of 6 duplicate values were found in the selected 40
10 [Helsinki Stockhol cell color? 10 [Helsinki stockhol cells.
11 |Kiev London 11 |Kiev London
12 |Lisbon Prague o5 12 |Lisbon Prague
13 Tirana - 13 |Brussels Tirana
14 |London Torshavn T 14 |London Torshavn
15 |Luxembourg ~ Vaduz 15 |Luxembourg  Vaduz -
16 [Madrid Vienna 16 |Madrid Vienna
17 [Minsk Vilnius 17 [Minsk Vilnius
18 |Moscow ‘Warsaw 18 |Moscow ‘Warsaw
19 [Nicosia Yerevan 19 |Nicosia Yerevan
20 |Oslo Zagreb 1 20 |0slo Zagreb 1
21 21

Count duplicates and give each set of duplicates its own color

This tool counts and colors the duplicate values in your selection.
Each set of duplicated values is given its own unique color.

This helps to quickly find the duplicated values, by having a set of colors each of which can
readily be distinguished from one another.

Example:

If your selection contains 5 cells with the value "London" then those 5 cells will all get the
same color, for example blue. And if the value "Paris" exists in 3 cells then those 3 cells will
also get the same, but a different color, such as green.

Note:

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the
same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as
a duplicate.

N

A B A B
"1 [tondon Belgrade 1 Jtondon’ 1 Belgrade
|2 [Berlin Prague 2 Berlin Prague
' 3 [Bern Reykjavik 3 Bern Reykjavik
| 4 [Bratislava Riga 4 Bratislava Riga
| 5 |Paris Rome 5 Paris Rome
| 6 |Brussels Paris 6 Brussels Paris
| 7 [Budapest Sarajevo 7 |Budapest Sarajevo
| 8 |copenhagen  Skopje 8 Copenhagen  Skopje
| 9 |Dublin Sofia 9 Dublin Safia
| 10 |Helsinki Stockholm 10 Helsinki Stockholm
| 11 [Kiev London 11 Kiev
| 12 |Lisbon Prague 12 Lisbon Prague
| 13 |Brussels Tirana 13 Brussels Tirana
| 14 |London London 14
| 15 |Luxembourg Vaduz 15 Luxembourg Vaduz
| 16 |Madrid Vienna 16 Madrid Vienna
| 17 |Minsk London 17 Minsk
| 18 [Moscow Warsaw 18 Moscow Warsaw
|19 |Paris Yerevan 19 Paris Yerevan
| 20 |oslo Zagreb 20 Oslo Zagreb
|21 |Copenhagen  Moscow 21 Copenhagen  Moscow
22 [skopje Vienna ! 22 Skopje Vienna

23 23
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Count the different unique values in selection

This utility tells you how many different unique values there are in your selected range.

It counts the values that appear only once in your selection.
You can choose if you want include the hidden cells in your selection.

Note:

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the

same.

If your selection contains formulas then this utility compares the calculated values. This
means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as

a duplicate.
=
1

i
6 |Brussels |zevo Tou 20, 11 13
7 |Brussels ASAP Utilities - Count the different unique values in selection
10 |Copenhagen
15 |London Do you want to count the number of different unique values in your selection?

16 |London ;

17 [Luxembourg Cancel
18 [Madrid

21 [Nicosia

22 |Oslo

24 |prague [¥ Countin visible cells only

26 [Reykjavik g‘

E Rome (Water And Power 11 13 49!
30 |sarajevo Demo Company 32 8 4
31 [skopje [Widget Corp 22 51 11,
33 |Stockholm Mainway Toys 34 6 4
36 |Vaduz Petrox Oil Company 23 55 32
37 |Vienna Charles Townsend Agency 31 27 35
39 [warsaw Globo Gym American Corp 20 21 36,
40 [Yerevan Taco Grande 18 59 10
41 [Zagreb The Frying Dutchman 22 25 16,

F
| 91

4 |Bern Forge And Foundry 37 10 42
6 |Brussels Zevo Toys 20 11 13
7 |Brussels Initech 10 15 17
10 |Copenh Big Kahuna Burger 35 40 50!
15 [London Galaxy Corp 32 16 14/
16 |London ASAP Utilities - Count the different unique values in selection e3m|] 36
17 |Luxembourg 42!
18 [Madrid _ 1]
21 |Nicosia Iﬁ Your selection contains 19 different unique value(s). 59
22 |oslo - 43
24 |Prague 27
26 [Reykjavik 42!
28 [Rome 49
30 |sarajevo ——Tr 4]
31 |Skopje (Widget Corp 22 51 11
33 |stockholm Mainway Toys 34 6 4
36 [Vaduz Petrox Qil Company 23 55 32,
37 |Vienna Charles Townsend Agency 31 27 35
39 |Warsaw Globo Gym American Corp 20 21 36
40 [rerevan Taco Grande 18 59 10
41 |Zagreb The Frying Dutchman 22 25 16,
42
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Count number of characters in selected cell

This tool will tell you how many characters there are in your active cell.
For example if the cell contains the value 'Microsoft Excel' this tool will tell you it is 15
characters.

In your worksheet you can also use Excel's worksheet function =LEN().

| B2 - b3 ‘ Monarch Playing Card International
F G
1
2 Maonarch Playing Card Inter 59
3 Tirana Big T Burgers And Fries 42 50 29,
4 Vienna Charles Townsend Agency 31 27 35
5 Warsaw Gloha Gum American Coen 20 21 26
6 Zagreb ASAP Utilities - Count number of characters in selected cell g
7 Luxembourg
8 |Prague e
9 Sofiai |ﬂ/\ The value in your active cell (B2) contains 34 characters.
10 |\ Vaduz -

11 Copenhagen

13 | Prague

14 Bern “"FGrge And Foundry 37 0 7]
15 Budapest Mammoth Pictures 55 26 33
16 Madrid Qwerty Logistics 30 29 1
17 Oslo Spade And Archer 22 23 49
18 Riga General Products 4 21 49!
19 Rome ‘Water And Power 11 13 49
20 |san Marino Fake Brothers 439 1 2
21 Dublin Smith And Co. 43 28 47
29 [ctnobhnlm [V True 34 e ”

Create a list of all built in workbook properties (title, author
etc.)

This utility creates a report with all document properties.
A new workbook will be created which lists all the properties from your workbook (title,
author, etc.).

I A | B
1 [File properties from: |0174 - Report built in workbook properties.xlsx
2 |Title: Example to report document properties
3 Subject: Screenshat example to report document properties
4 Author: Bastien Mensink
5 Keywords: document properties, meta information
6 Comments: my comments go here
7 | Template:
8 Lastauthor: Bastien Mensink
9 Revision number:
10 Application name: Microsoft Excel
11 Lastprint date: 18-12-2012 15:04:33
12 Creation date: 15-5-2007 7:25:22
13 Last save time: 27-3-2013 15:26:17

14 Total editing time:
15 Number of pages:
16 Number of words:
17 Number of characters:

18 |Security: 0
19 Category: Screenshots

20 Format:

21 Manager:

22 Company: A Must in Every Office BV

23 Number of bytes:

24 Number of lines:

25 Number of paragraphs:

26 Number of slides:

27 Number of notes:

28 Number of hidden Slides:

29 Number of multimedia clips:

30 Hyperlink base:

31 Number of characters (with spaces):
32 Content type:

33 Content status: Completed
34 |Language:

35 Document version:
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Create a list of all range names in the workbook

This utility creates a report with all named ranges in your workbook.

A new workbook will be created which lists all the names ranges within your workbook and
their cell references.
Starting from Excel version 2007 this utility will also report the name comments.

Create a list of all sheet names

This utility creates a report with the names of the sheets in your workbook.
A new workbook will be created which lists all the names of the sheets in your workbook.

Note:
You might also be interested in the "Create an index page with links to all sheets
(clickable)..." utility.

Report the formulas used in the worksheets in your
workbook

This tool will report all formulas used in the worksheets on your workbook.

The report shows the following information:

= Sheet; The name of the worksheet the formula is on

= Cell; The cell address the formula is in. You can click on the address to jump to it, it is a
hyperlink.

= Value; The calculated result

= Displayed value; The displayed result. This uses the cell's number format.

= Formula; The formula

A B C D E
1 D:\Projects\Example.xls
2 Sheet Cell Value Displayed value  Formula
3 |Start N1 59 ) =COUNTIF(D:D;3)
4 Start Q1 098305085 98,3% =(N1-U1)/N1
5 |Start T1 0,01694915 '0,016545153 =U1/N1
6 Start U1 1 1 {=COUNT({D2:D562=3) *(F2:F562="")*(F2:F562))}
7 |Start 02 en-us en-us =E2
8 |Start P2 nl-nl nl-nl =F2
a Ciaes A clnlalas clnlalaa —AAQNINDDADNING ~AONI D A
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Create a list of all type of cell values

This utility creates a new workbook that reports the data types of your current worksheet.
The new workbook is a copy of your worksheet without the actual data but where the cells
with formulas, numbers, text and external links are marked with different colors.

The following colors are used to display which information is stored in a cell:

= Blue: Formula

= Yellow: Number
= Green: Text

= Red: External link

This can for example be useful to quickly see the structure of your worksheet and see
where formulas are used.

Create a list of filenames and properties in a folder...

This utility will create a list of all filenames in a specified folder.
This way you can for example import on a worksheet the names from all files on a cd-rom.

You can configure the following settings:

= The folder to be searched.

= Search subfolders.

= Create hyperlinks to the files.

= Show only certain file types. For example to report only Excel files you can enter "*.xI*'.

= Sort the results, for example by filename, foldername, date, etc.

= Show only files modified or created within the past specified number of days.

= Create the list of files in a new workbook or on a new worksheet in your current
workbook.

This utility reports the following information about the files:

= Parent Folder

= Filename

= Size (KB)

= Type

= Created (date)

= Last Accessed (date)

= Last Modified (date)

= Full name (foldername and filename together)

By default you can start this utility with the shortcut Ctrl+Alt+F.
Your last used settings will be remembered.
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ASAP Utilities - List filenames in folder X

— Report full path, flenames and properties
Folder:
[ oProgram Files (xae)\ASAP Utiitizs\

¥ Indude subfolders ™ Include empty folders
[V Create hyperlinks to the files

File types: Sortby:
[ == | 1. folder, flename (zscendng) |

I show orly fles modified o created the past:

[ Show details Choose Details

Where should the list be created?

% In a new workbook € Ina new worksheet

Fle  Home Inset Draw Pagelayout Formulas Data  Review View Help  ASAP Utities

_‘* EL BT sheets > FIE Columns 8 Rows = Numbers 8 Dates~ | @ Web ~ [ import~ [} ASAP Utifities Options ~ | (Z) Online FAQ ﬁ
oot v | e | E3Renge= € Objects& Comments~ | [A] Tt~ BB Information= [} Export = ) Find and run a utility @ nfo w‘;
Sheortcut keys ~ | Control v Eenv i Format + Jx Formulas~ B Fieasytem~ > sun % Start last tool again @, Registered vession | the Day
Favontes Time saing tools Options and settings 1at0 ana help Tips trcks
a3 v &
A ] c o E F s H ] K L M
1 les found in C:\Program Files (x86)\ASAP Utilities\*.* (16:36:26 on 10-10-2022)
2 Parent Fold - Filename ~|Size(KB) ~|Type |- |Created |- lastAccessed |~ Last Modifiec - | Folder and name -
3 ladd asap utiliies to the Excel menu.exe 30911 EXEFile  15-6-202221:38 10-10-202215:22 :58 C:\Program rilas (x8S]\ASAP Utilities\Add ASAR Utilities to the Excel menu.exe
4 Add ASAP Utilities ta the Excel menu-0.bin I3 BN 15-6-2022 2138 §-10-2022 20:43 C:\Program Files [x86]\ASAP Utilities\Add ASAP s to the Excel menu-0.bin
H Add ASAP Utilities to the Excel menu-Lbin QUBINFile  156-202221:38 §-10-202220:43 C:\Program Files [x86]\ASAP Utilities\Add ASAP Utilities to the Excel menu-Lbin
6 ASAP Utilities xlam 6.763,3 XLAM File 15-6-202221:38 10-10-202216:35 6-10-202214:27 C:\Program Files (x35]\ASAP Utilities\ASAP Utilities slam
7 ASAP Utilities User Guide.pdf 19.625,1 POF File  15-6-202221:38 10-10-202215:22 6-10-2022 10:06 C:\Program Files (x36]\ASAP Utilities\ASAP Utilities User Guide.pdf
8 asap-utilities.ico 39,2 ICOFile  15-6-202221:38 10-10-202215:22 19-3-2022 21:14 C:\Program Files [x86)\ASAP Utilities\ tilities.ico
¢ readme.t 76 TTFile  15-6-202221:38 10-10-202215:22 6-10-2002 1208 C:\Program Files [86]\ASAP .t
0 Remove ASAP Utllities from the Excel menu.exe 30911 EXEFile  15-6-202221:38 10-10-202215:24 emove ASAP Utllities from the Excel menu.exe
n Remove ASAP Utilities from the Excel menu-0.bin 745 BINFile  156-20222138  8-10-202220:43
2 Remove ASAP Utilities from the Excel menu-Lbin 00 BINFile 15620222138 8-10-202220:43 C:\Program Files (x86]\ASAP \ ASAP Utilities from the Excel menu-Lbin
13 unins000.dat 70,9 DATFile  15-6-2022 2038 6-10-202220:43 7-10-202213:17 C:\Program Files [x86)\ASAP dat
i unins000.exe 3.092,9 EXEFlle  7-10-202213:17 10-10-202215:24 7-10-202213:17 C:\Program Files [

]\ASAP Utilities\unins000.exe

15 unins000.msg. 248 MSGFile 15-6-202221:39  8-10-202220:43 7-10-2022 13:17 C:\Program Files (x86]\A5AP msg

6 version_history.txt 17 TXTFile  15-6-202221:33  8-10-202220:43 17 Ci\Program Files [x86)\ASAP history.txt

17 certificate\  ASAP Utilities Certificate - A Must in Every Offics BV.car 15 CERFile  15-6-202 71138 7-10-202213:17 C:\Program Files [x86]\ASAP Utilities\certificate\ASAD rtificate - A Must in Every Office BY.cer
18 resources\  ASAP Utilities lam 395,8 XLAM File 15-6-202221:38 10-10-202213:10 1-10-202219:21 C:\Program Files [x35]\ASAP Utilities\resources\ASAP Utilities ribbon de-de.xlam

19 resources\  ASAP Utilities s.xlam 376,8 XLAM File 15-5-202221:38 7-10-202213:17 4-10-202207:42 C:\Program Files (x36]\ASAP Utilities\ \ASAP Utilities ribbon en-us.xlsm

20 resources\  ASAP Utilities ribbon es-esxlam 3998 XLAM File 15-6-202221:38 10-10-202213:11 1-10-202219:21 C:\Program Files [x86]\ASAP Utilities ribbon eses.xlam

21 resources\  ASAP Utilities ribbon fr-fr.xlam 412,9 XLAMFile 15-6-202221:38 10-10-2022 13114 1-10-202219:21 C:\Program Files [x86]\ASAP Utilitizs\resources\ASAP Utilities ribbon fr-fr.xlam
22 resources\  ASAP Utilitie: 400,6 XLAM File 15-6-202221:38 10-10-202213:21 6-10-202212:06 C:\Program Files [x86]\ASAP UTilities\résources\ASAP_Utilities ribbon it-itxlam
23 resources\  ASAP Utilities ribbon js-ip.xlam 464,5 XLAM File 15-6-202221:38 10-10-202213:24 1-10-202213:23 C:\Program Files [xB6]\ASAP Utilities) \ASAP Utilities ribbon ig-ip.xlsm
24 resources\  ASAP Utilities ribbon nk-nl.xlam 38,1 XLAMFile 15-6-202221:38 10-10-202213:08 C\Program Files (x86)\ASAP P utilities ribbon nl-nlxlam
25 resources\  ASAP utlities nibbon pt-br.xlam 401,2 XLAM File 15-6-202221:38 10-10-202213:20 C:\Program Files (x8]\ASAP Utilities\resources\AsaP_Utilities ribbon pt-br.xlam
%
7
28

resources\  ASAP Utilities ribbon ru-ru.xlam 575,9 XLAM File 15-6-202221:38 10-10-202213:22 1-10-202219:22 C.\Program Files (x86)\ASAP \ASAP_Utilities ribbon ru-ru.xlam
resources\  ASAP Utilities ribbon th-hans xlam 3837 XLAM File 15-5.2022 21:38 10-10-202213:23 1-10-2022 19:23 C:\Program Filas [x36]\ASAP AP Utilities ribbon zh-hans.xlam
2
30
31

Display selection type

This utility tells you the type of the selection you have selected.

These are English names, the utility uses the programming code TypeName(Selection) to
get the name.

This can for example be range, chart, rectangle, etc. and it can be useful if you are
programming and need to know how something is called.
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Count number of sheets
This utility tells you how many sheets there are in your workbook.

1 uivaua SutTe LUl P auun ar ar e

18 |Croatia Qwerty Logistics 30 29 1‘
19 Czech Republic  Globo-chem 9 19 43
20 Czech Republic  Spacely Sprod ASAP Utilities - Count number of sheets

21 |Denmark Chasers

Zlnenmark _ |Spade And A3 B Vourworkbook contains:

23 Denmark Monarch Pla '

24 Denmark Roboto Indus| 19 workshests

25 Denmark Praxis Corpot g;}l‘;g;(els.ﬂ dialogs

26 Finland Acme, Inc. 0 International Macro Sheets

27 Finland General Prad| 0'MS Excel 4.0 Macros

2llFinland  |Water And g Total number of sheets: 119

29 |Finland Fake Brother:

30 |Finland Demo Compa

31 Finland Widget Corp

32 Finland Strickland Prg|

33 France Mainway Toy i

24 | Eronen Bin T Brirmors And Crinc 2 =n 20!
W 4+ M| | Result / Luthorcorp . Virtucon .~ Forge And Foundry . Lexcorp . Zevo Toys . Initech . Gadgetron

Ready |

Find bad cell references (#REF!)

This utility selects all cells on your worksheets that have a formula with a bad cell
references.
Excel displays the value #REF! in such cells.

Find too narrow columns (####)

This utility will inspect your worksheet for columns that are too narrow to display the
contents.

When a column is too small to display a number or date, Excel will show cross hatches
(####) in the cell instead of the actual value.

Especially when your worksheet contains a lot of data then this utility can be useful.

Note:
The utility only reports columns that are too small to display numbers or dates.

Display your screen resolution

This utility shows you what your current screen resolution is.
The screen resolution is set in the "Display Properties" in Windows.

For working in Excel generally the bigger these numbers are, the better. This is because you
then show more information on your screen at once.

ASAP Utiliies ===

\0\ Your current screen resolution is: 1680 by 1050 pixels
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Display the country settings of your computer

This utility will display a few of the country settings from your computer.

The utility shows you the following settings that your computer uses:

= the decimal separator;

= the thousand separator;

= the date separator;

= the order in which the dates are shown (for example day-month-year or month-day-year,
etc.)

We have created this utility so you can quickly view this information because it is
sometimes difficult to quickly find this information on a computer where these settings are
blocked by the IT department.

- N
ASAP Utilities - Display the country settings of your comp... Lﬁ

@ Your decimal seperator is:
WY Vourthousand separator is:
Your separator for dates is:

Your order of datesis: "day month year'

Create a list of all add-ins

This utility creates a report with information from the installed add-ins.

A new workbook will be created which lists all installed add-ins, their names, location, type
and whether they are active or not.

Example screenshot: Create a list of all add ins

A B C o E
1 Title Active Name Full name Type
2 analysis ToolPak FALSE ANALYSIZXLL C\Program Files (x86)\Microsoft Office 2007\0ffica 12\LIBRARYWANALYSIS\ANALYS32.XLL Add-In
3 Analysis ToolPak - VBA FALSE ATPVBAEN.XLAM C:\Program Files (x86)\Microsoft Office 2007\ 0ffice 12\LIBRARYNANALYSIS\ATPVBAENXLAM  Add-In
4 ASAP Utilities TRUE ASAP Utilities.xla C\Program Files (xB6)\ASAP Utilities\ASAP Utilities xla Add-1n
5 Conditional Sum Wizard FALSE SUMIF.XLAM C\Program Files (x86)\Microsoft Office 2007\0ffica 12\ LIBRARY\SUMIF.XLAM Adid-In
& Ewro Currency Tools FALSE EUROTOOLXLAM C:\Program Files (x86)\Microsoft Office 2007\ 0ffice 12\ LIBRARY\EUROTOOL XLAM Add-In
7 Internet Assistant VBA FALSE HTMLXLAM C\Program Files (xB6)\Microsoft Office 2007\0ffice 12\ LIBRARY\HTMLXLAM Add-In
& Lookup Wizard FALSE LOOKUP.XLAM C:\Program Files (x86)\Microsoft Office 2007\0Ffice 12\ LIBRARY\LOCKUR, XLAM Add-In
8 Solver Add-in FALSE SOLVER.XLAM ©:\Program Files [x&6)\Microsoft Office 2007\OFfice12\LIBRARY\SOLVER\SOLVER XLAM Add-In
10 ASAP Utilities library component  TRUE ASAP_Utilities.adConnect not available COM Add-In

List all fonts in new workbook

This utility reports all fonts that are available in Excel on your computer.

A new workbook is creates that shows all font names and an example of the display of the
fonts.
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You can use this for example as a quick reference to see the fonts available, or to see how
text will look in certain fonts.

@

. - N
=] EREE e (eiE e E=E]
“ Home Insert Page Layout Formulas Data Review View ASAP Utilities o @ =@ =
", © [ sheets + [ Columns & Rows ~ (4} Numbers & Dates + g5 Web - (% mmport ~ [ ASAF Utilities Options = & Online FAQ
A [#] Range ~ | Objects & Comments = [AText ~ |€2 Information -| @] Export~ | b Find and run a utility @ o
Favorites & Vision Select B -
Shortcut keys ~ | Contral -~ =i Fill = [z Format - Je Formulas = [ 1 Fast calculation on selected cells... version
Favorites Time saving tools Bfi 2, File and selection info... nelp
A2 M I | E3 3. Copythe path and filename of current workbook to clipboard v
ENE|
4. Get the page number of the active cell
| A B
1 MS Excel - Available fonts: 3§ 5. Count and/or color duplicates in selection...
2 - :
3 |Cambria abedefshijkimnopgrstuvwiyz ABCDEFGHIKLMNOP| 1 & Count the different unique values in selection
4 | calibri : abedefghijkimnopqrstuvwixyz ABCDEFGHUKLMNOPQR “% 7. Count number of characters in selected cell
5 |Agency FB dbcdfgiemsparsturwncyz ABCOEFEHLIKLNROPIRSTUVWXYT 1234567890 { |8 & Create alist of all built in workbook properties (title, author etc.)
6 Aharoni : abedefghijklmnopqrstuvwxyz ABCDEFGHIJKLM | 5. Createalistoran e workbook
7 |Algerian | ABCDEFGHIIKLMNOPORSTUVIXYZ ABCDEFGHLI| — = o o lrengenames e werkios
. Andalus abedefghijklmaopqrstuvyz ABCDEEG Mvore = 10, Create a list of all sheet names
¥] 11 Reportthe formulas used in the worksheets in your workbook
9 |Angsana New TVWYZ 15870
Ty, [R—— . . vanrz sl | 12 Create a list of all type of cell values
11 Aparajita © abedefehijdmnopgrstnvwyz ABCDEFGHIKLMNOPQRSTUVW | 13, Create a list of filenames and properties in a folder... (Ctrl+Alt+F)
12 |Arabic Typesetting : sbedeizhgkluzopmtumayz ABCDEFGHIKLMNCPQRSTUVWIVE 123438 [ 1y Display selection type
13 Ar!al abcdefghukltnnnpqrstuvwxyz ABCDEFGHIJKLMNC B 15. Count number of sheets
Arial Black : abedefghijklmnopgrstuvwxyz ABCDEFGH
1 16, Find bad cell references [#REF))
15 |Arial Narrow - abedefghikimnopqrefuvwxyz ABCDEFGHIKLMNOPQRSTUY io) 17, Find too narrow columns (##£5)
16 Ar!al Rm-.mded MT Bold : abcdefgﬂuklmnopqrstuvwxyzABGDEFGHIJK[ & 18. Display your screen resalution
17 Arial Unicode M5 : abcdefghijkimnopgrstuvwxyz ABCDEFGHIJKLMNY i
18 |Baskerville OId Face : abedefehiimnopqrstuyz ABCDEFGHIELMNOF 19 Display the countny settings of your computer
19 |Batang abcdefehijmne parshrrwsyz ABCDEFGHUELM B 20, Create a list of all add-ins
20 |BatangChe : abcdefehi jklmnoparsturwiyz ABCDEFGHITELMNG 4y 21 List ail fonts in new warkbook
21 |Bauhaus 83 : abodekghijil y VI TUTWATL TX3 1101070 FS TF Yo"
22 |Bell MT abedefghijklmnopgrstuvwryz ABCDEFGHIKLMNOPQRSTUVWXYZ 1234367590 $€ |@%5%"
23 |Berlin Sans FB : abedefghikimnopgrstuvxyz ABCDEFGHIKLMNOPORSTUVWXYZ 1234567830 5€ 1@# S9ea* 0=+
24 |Berlin Sans FB Demi ‘abedefghijbimnop grstuvwiyz ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890 $€ 10#5%A*()=+
25 Bernard MT Condensed : abedeighijkimnopgrstuvwxyz AB(DEFGHITKLMNOPQRSTUVWXYL 1234567890 $€ | @#$% Q=+
26 Blackadder ITC ey s oy B CORFGHY IR LATHC T GHASTUT WYL oy sorspe 5E B33 (r
27 Bodoni MT : shedefzhijlmnopgrennyz ABCDEFGHITKLMNOPQRSTU VWX YZ 1234367800 $€ |@#6% 4 (j)=+
28 |Bodoni MT Black hedefghijkl ABCDEFGHIJELMNOPQRSTUVWXYZ 1234567890 $€ |@#8% )=+
29 |Bodoni MT Condensed  abedeishiikimmopqrsturayz ABUDEFGHIKLMNOPQRSTIVWTZ 1234567390 € 1@HI% )=+
30 |Bodoni MT Poster Compressed aboieighikimmoparsteriny ACIERRLIELMVONISTOYNYTE 25 667300 3£ | @ 2285 ~ D=~
31 |Bock Antiqua : abedefghifklmnopgrstuvwiyz ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890 $€ 1@#6% )=+
32 |Bookman Old Style abedefghijklmnopgratuvenxyz ABCDEFGHIJEKLMNOPQRSTUVWXYZ 1234567890 3€ [@#5% )=+
Bookshelf Symbal 7 DAL T R e AN GFSENS /7 - A AT XyaaaiiuonAisasasasiaeadn] MmNPsPashT B
33 FFTG
34 Bradley Hand ITC 2 SR LMNESPER ST A 2 124 SEFE50 £2 | BEET T (I =+
25 8 itanmic Bald L. iz A TIMAYT 4 s
14"« v | Available fonts Sheet? . sheet3 .~ id 0 TR
Ready | | [ M 100 ()
\
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5.5.15 File & System

Collection of "File and System" tools

1 Save file and create backup...

This utility saves your file and automatically creates a backup copy in a given folder.

ASAP Utilities will add the date and time to the filename of the backup copy so that you can

easily see when it was saved.

For example if you have a file named "Sales.xlIs" then the name of the backup copy will be

for example "Sales (backup 2012-08-24 15.28.12).xls".

Example screenshot: Save the file and create a backup copy

r
ASAP Utilities - Save file and create backup...

-

— Do you want to save the current fle as:

F:\ProjectsMarathon \Paris\Scheduie. xdsx

— And save a backup of the fik as:
" Backup folder:

* Current file's folder

F:\Projects\MarathonParis\Schedule (backup 2014-11-20 14, 17.09).xdsx

Cancal

2 Savefile as... and use the first cell as the suggested filename

This tool will launch Excel's "save as..." dialog and uses the value of the first filled cell on
your worksheet as the suggested filename.

A1 - £ | Time saved by using ASAP Utilities

A

Time saved by using ASAP Utilities

1
2
3 First measured usage: 26 oktober 2012 Total time saved in ho
4 Lastr r
7
5 actud (X1 Save As - = L
6 Totall ()( ) [T Users » Test » Deskaop » [ #3 | [ Search Deskiop 2|
— — 1
8 Nam Organize v New folder e @ |po
3 Exten “ Name Date modified Type ~|E
=0 et ~F (S Export 9-11-201212:09 File f \‘E‘ 1
I Expo -11- ile fol )
11| Star] P Deskiop = it L
12 puttl S J 0003 - Move or resize selected range.xlsx 5-2-2013 10:25 Micros
12 sele o ] 0005 - Inverse selectionlsx 5-2-2013 10:54 Micros |
% RecentPlaces = —
14 Exten| ] 0006 - Merge selection of selected areasix.. 5-2-201312:03 Micros
15 sele " ] 0007 - Select cells based on content, for..  20-11-201215:5  Micro:
16 Changl| .ooe ] 0009 - Select adjacent cells below active ..  5-2-2013 1214 Micros
[ Documents 1
IS | 0010 - Select adjacent cells in column wit.. 5-2-2013 12:31 micre: ||
18 Rese =5 el ] 0011 - Extend selection to the last used ro..,  5-2-2013 1335 Micros
. fal 7
19 Quid etures ] 0012 - Bxtend selection to the last used c..  5-2-2013 1318 Microe ||l
20 Dete B8 Videos (B ANLE €nlt oalle e s laemmrt e €3 313 13.50 pnd T
21 Info. ~ [ | 3 r
22 [Sort | =l |
23 |Desel Save as type: [ Excel Workbook (*xisx) L IE
24 Move A
25 [l Authers: Bastien Mensink Tags: Add atag
26 | Chand)|
= visid [ Save Thumbnail 1
28 Inserf :
30 Combaeee —
—
31 Insert before and/or after each cell in your selection... 9
32 Inverse selection... 9

2

w
N
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Rename current file...

Rename your current file without having to close it first.

A B c D E F G H J
1 GETE u Age hd
2 |Agustin 43
3 Aiden 31
4 Alejand < ™
5 Alexd (] ASAP Utilities - Please specify a new name and/or location: =)
6 Ali - + Search Deskh |
7 Tanad W) ‘ Iz < Users » Test » Desktop » v| ,ll Search Desktop P
3 Arda Organize v New folder = v @
9 |Arten p = . pr
10 genc]| [E]MicosoftErcal (o Moe Date medified Type E
11 Benja Export 9-11-201212:09 Filefol
12 Daan -7 Favorites ~| #0003 - Move or resize selected rangexlsx  5-2-2013 10:25 Micros
13 Dani B Desktop 7| 0005 - Inverse selection.dsx 5-2-2013 10:54 Micros
14 Eetu) & Downloads 1] 0006 - Merge selection of selected areasx.. 5-2-201312:03 Micros
15 Emil il RecentPlaces —  [E]0007 - Select cells based on content, for..  20-11-201215:56  Micros
i 1] 0009 - Select adjacent cells below active...  5-2-201312:14 Micros
G i -4 Libraries ] 0010 - Select adjacent cells in column wit... 5-2-2013 12:31 Micros
16 |thag ) Documents ] 0011 - Extend selection to the last used ro...  5-2-2013 13:35 Micros
19 Frang)| o Music Ay _mn nn e nmonn o = rrmomon .
20 Georf ad| 9| I | b
21 Georj File name: M
22 Giorg
93 Hans Save as type: Inaw name (" .xlsx) ']
24 \ker Authors: Bastien Mensink Tags: Add atag
25 lvan
26 Jack
28 Jakub,
29 Jakup a5 |
30 James 37 |

Reopen current file without saving changes

This utility closes your current workbook without saving the changes and then it opens the
last saved copy of your file.

This can be useful when quickly want to revert to the last saved version of your workbook.
Which can be for example when you made temporary or incorrect changes that you don't
want to save.

Export selection or active sheet as new file...

With this utility you can save your selected data range or the entire worksheet as a new file.
You can choose not to include hidden cells in your export.

The data can be exported in the following file formats:

= Excel 97-2003 Workbook (*.xIs)

= Excel Workbook (*.xIsx)

= Excel Binary Workbook (*.xlsb)

= Formatted text (space delimited)

= Tab delimited text file

= Tab delimited unicode text file

= CSV (comma separated value or custom separated)

= CSV unicode, UTF-16LE / UTF-8 (comma separated value or custom separated)
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You can also use the CSV option to create your own custom separated file by setting your
own field separator, field encloser and decimal separator. This way you can for example
create pipe (|) delimited text files.

You can also choose to copy the information directly to your clipboard in the following
formats:

= tab delimited
= space delimited

You can choose to export the contents of the cells as:

= Values (for example 12)
= Formulas (for example =3*E6)

= As displayed (for example EUR 12,00)

Your last used settings will be remembered.

sarceiona S0mora Lorporation 159 190 a3 Z1b 24
Corg== L 338
“ord ASAP Utilities - Export selection or worksheet X |:
f'd Export data | Export chart or range as image |

Zor Savein: E
~6rd Export: How to export: 39c
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" Entire sheet: Start
% Range:

¥ Do not export hidden cells

File format:
" Excel 97-2003 Workbook (*.xls)

& Excel Workbook (=.3dsx)

" Excel Binary Workbaok (*.xlsb)
" Formatted text (space delimited)
" Tab delimited text file

" Tab delimited unicode text file
" Copy to clipboard (tab delimited)

¢ Copy to cipboard (space delimited)

 yalues (12)
" Eormulas (=3°E6)
© As displayed (EUR 12,00)

-

" C8V (comma separated value)
or custom separated:

= Curent fie's
 Solcer
£ Excels default fie location

¢~ Current defait
foider

7 Add the exported fle to the
recent files list in the Files-menu

¥ Close window after export

Close ‘ ook

el 5]

~
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-
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By

sl

&
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I¥ Do not export hidden cells

' As displayed (ELR 12,00)

¢~ Current default
falder

st
wadrid |ABC Telecom | [ 288 66 [ | 16|
Barcelona Sombra Corporation 159 196 53 216 27
Corg== L 33¢
@ ASAP Utilities - Export selection or worksheet X |:
:[," Exportdata | Export chart or range as image |
o Export: How to export: & Current fie’s 150
@ " Entire sheet: Start ¢ Values (12) folder @
B @ Range: (a0 ||| ¢ romes (-3e9) " Bxces default file location

| =

5 &)
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File: format:
(" Excel 97-2003 Workbook (%.xs)

" Excel Workbook (*.xisx)

" Excel ginary Workbook (*.xlsb)
" Formatted text (space delimited)
" Tab delimited text file

" Tab delimited unicode text file

" Copy to dipboard (tab delimited)

" Copy to dipboard (space delimited)

(_

* 3V {comma separated value)
or custom separated:

Fields separated by: -
Fields endosed by: —
Decimal separator: N

Unicode V¥V |uTF8 =

(~ Open the exportin Windaws
Motepad instead of saving t,

[ Add the exported file to the
recent files list in the Files-menu

IV Close window after export

s
il

N

Y 4

E RIS L [ 5

rid

|ABC Telecom

288
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Export worksheets as separate files...

With this utility you can save all or the selected worksheets in your workbook as separate
files.
You can choose a folder in which you want the worksheets to be saved.

The worksheets can be saved in the following file formats:

= Excel Workbook (*.xIsx)

= Excel Binary Workbook (*.xlsb)

= Excel 97-2003 Workbook (*.xls)

= CSV (Comma delimited) (*.csv)

= CSV unicode (Comma delimited) (*.csv)

= Text (Delimited by semicolon ;') (*.txt)

= Text unicode (Delimited by semicolon ';') (*.txt)
= Text (Tab delimited) (*.tsv)

= Text unicode (Tab delimited) (*.tsv)

= Formatted Text (Space delimited) (*.prn)
= Text (Pipe (]) delimited) (*.txt)

= Text unicode (Pipe delimited) (*.txt)

= Text (Delimited by tilde '~') (*.txt)

= Text unicode (Delimited by tilde "~') (*.txt)
= Web Page (*.htm, *.html)

= Single File Web Page (*.mht, *.mhtml)

= PDF (*.pdf)

Your last used settings will be remembered.

Example screenshot: 1

24| cueamvouu sou o s 103 e L w 22,
25| 2023-03-07 110 111 Az &7 100 22 g2 7.
26| 2023-10.29 ASAP Utilities - Export worksheets as separate files... X
27 |Total Export falder
28 The selected worksheets will be saved in the export location with the name of the worksheet as
50 flename
e Ci\Projects\Marathon) Sromee
El] -

32 [ Open this folder in Windows Explorer after expart
33
34 Warksheets to export: File format:
35 = [ Excel Binary Workbook (=.xisb) ~|
36 Excel Workbook (*.xdsx;
e Excel Binary Workbook (*.xdsb

Excel 97-2003 Workboak (*.xs)
38 €8V (Comma delimited) (*.csv)

Text (Delmited by semicolon '}) (%, tt)
39 Text (Tab delimited) (*.tsv)
40 Formatted Text (Space deimited) (< prr)

Text (Delmited by pipe ') (= txt)
1} Text (Delimited by tide '~) (*.bct)
42 vieh Page (= htm, = him)

Single Fie Web Page (~mht, *mhtmi)
43 POF (=.pdf)
44
e Use non standard settings:
46 o
a7 I
48 =
49
50 If the file already exists:
51 b [ overnrite E NN
52
= al Invert None — =
54

7

55 !

Amsterdam Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York ‘ Prague Vienna
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Example screenshot: 2

4| evesmvouu 1eu cen 1ur 103 e ") w e

25| 2023-09-07 110 111 a= P 100 22 182 a7l

5 | 029 | ASAP Utilities - Export worksheets as separate files... x

— Expart folder
The selected worksheets will be saved in the export location with the name of the worksheet as
20 flename.

0| C: Projects Marathon|

32 [V Open this folder in Windows Explorer after expart

[ File format:

| Excel Binary workbook (*.xisb)
I ur

[¥ Do not export hidden cells

L]

— How to export:
& Values only

£ Values and formuias

50 If the file already exists:

518 ’7 Overnrite E NN
4

s3] Al Tnvert Mone Concel |

55 i i i i i |

i
Amsterdam Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York Prague Vienna

Example screenshot: 3

25| 2023-09-07 119 1 as 7 109 Ee 162 1071
26| 2023-10.29 ASAP Utilities - Export worksheets as separate files... x
27 | Total — Export folder
28 | The selected worksheets wil be saved in the export location with the name of the worksheet as
20 filename.
30 o
0| :Projects\Marathon) .
31| =
32 |V Open this folder in Windows Explorer after expart
33
34 | [ File format:
35 | | csv (comma delmited) (=.csv) ~|
22 ¥ Unicode UTF-8 -
37
38_ ¥ Do not export hidden cells
=) — How to export:
40| @ yvalues (12)
4 (o I Ei
2 Eormuias (=3E5)
43 " Ag displayed (EUR 12,00)
il
= [ Usenonstandard setbngs: —————————————
— I Figlds enclosed by:
gol
a7 I Decimal separator:
48 | I™ Alternative file extension:
49
50/ 1f the file already exists:
= ’7 Overnrite =l (T T
52|
= al Tnvert None Cancel |
54
55| f f f f "

i
Amsterdam | Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York | Prague Vienna
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Example screenshot:

23| fuss-u-us 119 111 a3 os 195

25 105 1)

26| 2023-1029 1= za 2a 212 122
27 Total | 3; . Marathon

20| @ New

« > - 2
o O Name -
33 B97) Amsterdam.csv
37| 1 Copenhagen.csv
=3 £37] Dublin.csv

40| London.csv

B3] Luxembourg.csv
2 ) Minskcsr

E39) New York.csv

45 | 8 Prague.csv

48: 87 Vienna.csv

9 items

<« Projects > Marathon

121 ans as.

TN sort

Date modified Type

Microsoft Excel C...

Microsoft Excel C...

Microsoft Excel C...

Microsoft Excel C...

Microsoft Excel C...

Microsoft Excel C...

Microsoft Excel C...

Microsoft Excel C...

Microsoft Excel C...

2 Search Marathon

2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB

2KB

Amsterdam | Copenhagen | Dublin | London

Ready [E® 1o Accessibilit: Good to go

Find and remove external links...

Luxembourg | Minsk | NewYork | Prague | Vienna |

This utility shows the links in your workbook to other files and it allows you to remove

them.

When a link to another workbook exists in a formula and the link is removed, then the

formula will be replaced with its calculated value.

-
ASAP Utilities - Find and remaove external links...

Select the links in your workbook to break:

C:\sersiTest\Documents'Sort random + sart in-cell, xlsx
C:\UsersiTest\Documents\Expense trends budget1. xlsx

C:\Users\Test\Documents'\Report. xlsx

Inverse

MNone |

C:\WsersiTest\DocumentsTest data - MAC Addresses, xlsx

C:\sers\Test\Documents\Count duplicates and give each set of duplicates its own color.xlsb

C:\Users\Test\DocumentsHelping Excel users since 1999, xlsx

Create a workbook with these results

Cancel

Change Excel's default file location (browse)...

With this utility you can easily change Excel's default file location.
This is the folder that Excel uses by default when it opens or saves files.

You can also change this folder in Excel via File > Excel Options > Save > Default file

Available tools
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location).
The disadvantage of changing this in Excel is that you have to type in the full path manually.
This utility makes it easier by letting you browse and pick the folder from the list.

Set default path to current file

This utility will set the default folder to the path of your workbook.
This causes the dialogs for opening and saving files to start in this folder the next time you
use them.

¢ .
ASAP Utilties - Set default path to current file ==

I’ - "‘ Do you want to set the current default path to:
&Y D:\Projects\Marathon! Paris\'?
~ This causes the dialogs for opening and saving files to start in this
folder the next time you use them.

.‘ Cancel 1
i i i

Display the full path and file name in the title bar

This utility displays both the folder and the name of your workbook in Excel's title bar.
An example of when this is useful is when you work on files with similar names but stored
in different folders.

Note:

The information isn't automatically updated.

You have to run the utility again if you, change the filename, change the folder where the
file is stored, open a file or create a new one or restart Excel.

If you use this utility often it is useful to include it in your favorites menu and assign a
shortcut to it.

B AutoSave (@ Off) L:\Projects\ASAP Utilities\Screencast\ExceN\0D03 - Move o resize selected rangexisx

File Home Insert Draw Page Layout Formulas Data Review View Help  ASAP Utilities

_& E‘E[ a:cli ET Sheets~ | H Columns & Rows ~ := Numbers & Dates~ | @ Web ~
o - . . B .
Favorites & Vision | Select | L0 Range ¥ Objects & Comments Text [i@) Information
Shortcut keys~ Centrol - i Fill [ Format ~ Jx Formulas ~ [ File & System
Favorites Time saving tools
Al vt i
A B c D E F G H 1 J K

0|~ ot W
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Display file name in title bar

This utility displays the name of your workbook in Excel's title bar.
This is what Excel would normally show in the title bar.

B AutoSave (@ Off) 0003 - Move or resize selected range.xlsk ™

File Home Insert Draw Page Layout Formulas Data Review View Help ASAP Utilities

_& E‘E{ a:cli 7 sheets~ | [P Calumns & Rows ~ := Numbers & Dates~ | @ Web ~
Favorites & vison | Select EARange~ ¥ Objects & Comments ~ Text v [@ Information ~
Shortcutkeys ~  Contral - (i Fil~ [ Format ~ i Formulas ~ [ File & System
Favorites Time saving tools
AL v I
A B c D E F G H 1 J K

@~ o B W

Close and delete current file

This utility will close your current workbook and delete it.
If possible then the file will be sent to your Recycle Bin. If that is not possible then you will
be asked if you want to permanently delete the file.

Close all saved files

This utility closes all files that have been saved.
Only the files that have been saved and not changed thereafter will be closed.

This can be useful, for example when you have opened a lot of files, looked without making
any changes, and then quickly want to close them all together.

Close multiple files at once...

This utility makes it easier to close multiple files at once.
The utility shows a list of all open workbooks and you can choose which once to close.

When you start the utility then by default all files except for the active workbook are
selected to be closed.

You can set the utility give you a warning before a file is closed from which the changes
haven't been saved yet. In such a case you can choose to save the file first before it is
closed, not save the changes, or cancel the closing of it.

The utility is useful when you work with a lot of files that are opened in Excel and for
example when you want to close all files, except for a few.
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'
ASAP Utilities - Close multiple files at once...

— Files to dose:

0
rs\Test\Desktop\0213 - F11 Toggle Full Screen.xdsx

est\Desktop}0003 - Move or resize selected range. dsx

‘est\Desktop\0091 - Delete number of leading characters. xisx
‘estiDesktop\0168 - Fast calaulation on selected cells.xdsx
‘est\Desktop\0198 - Export selection in HTML format.xisx
est\DesktopTest-1.xls

py a sheet's page and print settings. xlsb

esktop\0088. xis
C:\Jsers\Test\Desktop\Arrow. xisx

v show full path in file names

Close all open files without saving changes

This utility closes all workbooks without saving any changes or asking you if you want to
save them.

Note:
Pay good attention when you use this utility because it will also close files that might not
have been saved.

Add current file to recent files list

This utility will add your current file to Excel's recent files list.
This is useful when Excel doesn't add an opened file to the list. This can happen for example
sometimes when you open a file by double-clicking on it in the Windows Explorer.

Clear recently used files list in the Excel menu

This utility will reset the recent files in the Excel menu.

This can be useful if you don't want other people on your computer to see which files you
have been working on.

Remove all macros (VBA code) from current file

This utility removes all macros (vba-code) from your current workbook.

This can be useful if you want to clean up your workbook before you give it to someone
else.

It can also be useful when you get a macro-warning when you open a workbook but you
don't use any macros from the file.
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Note:
This utility will only remove the macros in the VBA project. Excel 4.0 macro-sheets and Excel
5.0 dialogs are not removed.

Macro/VBA information (beta, English)...

This utility shows you information on the macro's that are in a workbook.

You can quickly see the references the vba-project has, view the modules and you can
export the code or remove the comment lines in your code.

This utility is in English because the Visual Basic Editor and the vba macro code is also in
English.

Resize the Excel window to standard screen resolutions...

This utility allows you to change the size of the Excel window to the most commonly used
screen resolutions.

This way you can easily test and see how your document or application will look on
computers with different screen resolutions.

Note:
The maximum size of the window is limited (by Excel) to your current screen resolution.

P Search (Alt4

File Home Insert Draw Page layout Formulas Data Review \View Help  ASAP Utilities

_& E—"E[ H.:Cli @";Sheeftsv H2 Columns & Rows ~ 'E Numbers & Dates ~ @ Web ~ Dr\ Irmport ~
& - v v L ion -
Eavorites & Vision | Select | i Range %7 Objects & Camments Text [i@ Information (5 Export
Shartcutkeys ¥ Control - [ Filt~ i Format ~ Jfx Formulas ~ B File & System ~ | [> Start~
Favorites Time saving tools
v Jx
A B C D E F G H 1 K L M
1
L "
2
3
4 ASAP Utilities - Resize the Excel window X
£l Resize the window to the folowing resolution:
6 1920 x 1080 pixels S oK
7 1280 x 800 pixels -
1230 x 854 pixels
& 1280 x 950 pixels Close
g9 1280 x 1024 pixels
10 1366 x 768 pixels
1400 x 900 pixels
1 1400 x 950 pixels —
12 1400 x 1050 pixels
1440 x 900 pixels
13 1600 x 300 pixels
14 1600 x 1024 pixels
1600 x 1200 pixels
15 1680 x 1050 pixels
18 1920 x 1200 pixels
17 2048 x 768 pixels
2560 x 1024 pixels
18 2560 x 1080 pixels
19 2560 x 1440 pixels
2560 x 1600 pixels
20 2880 x 1800 pixels
21 3200 x 1200 pixels
3200 x 1800 pixels
22 3280 x 1050 pixels
23 3360 x 1050 pixels
3440 x 1440 pixels
24 3840 x 2160 pixels
25 3840 x 2400 pixels
4096 x 2160 pixels -
26 5120 x 2330 pixels hd
27
28
29
30
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Save current file (developers)...

This utility enables you to save your workbook if saving is disabled by a macro.
It does this by ignoring the workbook's Workbook BeforeSave event.

Create a list of all add-ins

This utility creates a report with information from the installed add-ins.

A new workbook will be created which lists all installed add-ins, their names, location, type
and whether they are active or not.

Example screenshot: Create a list of all add ins

A B C o E
1 Title Active Name Full name Type

2 analysis ToolPak FALSE AMALYSIZXLL C\Program Files (x86]\Microsoft Office 2007\0fficalZ\LIBRARYWANALYSIS\ANALYS32XLL Audd-In
3 Analysis ToolPak - VBA FALSE ATPVBAEN XLAM &\Program Files [x86)\Microsol ft Office 2007\ 0Ffica 12\ LIBRARYVANALYSIS\ATOVBAEN XLAM  Add-In
4 ASAP Utilities TRUE ASAP Utilities.xla C:\Program Files (xB5]\ASAP Utilities\ASAP Utilities.xla Add-In
5 Conditional Sum Wizard FALSE SUMIF.XLAM C:\Program Files |x86)\Microsoft Office 2007\0ffice 12\LIBRARY\SUMIF XLAM Add-In
6 Ewro Currency Tools FALSE FUROTOOLXLAM C:\Program Files (x86)\Microsoft Office 2001\ 0ffical 2\ LIBRARVEUROTOOL XLAM Addn
7 Internet Assistant VBA FALSE HTMLXLAM C:\Program Files |xB6)\Microsoft Office 2007\0ffice 12\LIBRARY\HTMLELAM Add-In
& Lookup Wizard FALSE LOOKUP.XLAM C:\Program Files (x86)\Microsoft Office 2007\0ffica 12\ LIBRARY\LOOKUR. XLAM Add-In
8 Solver Add-in FALSE SOLVER.XLAM ©:\Program Files [x&6)\Microsoft Office 2007\Office 12\ LIBRARY\SOLVER\SOLVER XLAM Add-In

10 ASAP Utilities library componant  TRUE ASAP_Utilities.adConnect mot available COM Add-In

Reload all installed add-ins (rebuilds the menu)

This utility rebuilds the Excel menu.
The worksheet- and the chart menu bar (the main menu bars) are reset and then all active
add-ins will be reloaded.

Create a list of filenames and properties in a folder...

This utility will create a list of all filenames in a specified folder.
This way you can for example import on a worksheet the names from all files on a cd-rom.

You can configure the following settings:

= The folder to be searched.

= Search subfolders.

= Create hyperlinks to the files.

= Show only certain file types. For example to report only Excel files you can enter "*.xI*'.

= Sort the results, for example by filename, foldername, date, etc.

= Show only files modified or created within the past specified number of days.

= Create the list of files in a new workbook or on a new worksheet in your current
workbook.

This utility reports the following information about the files:

= Parent Folder
= Filename
= Size (KB)
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= Type

Created (date)

= Last Accessed (date)

Last Modified (date)

Full name (foldername and filename together)

By default you can start this utility with the shortcut Ctrl+Alt+F.
Your last used settings will be remembered.

ASAP Utilities - List filenames in folder x

— Report fll path, flenames and properties ———————————
Folder:
| Criprogram Files (xa6)\ASAP Utiites\

¥ Include subfolders ™ indude empty folders

W Create hyperlinks to the files

File types: Sort by:

[ == 1. folder, flename (ascending) |

I~ Show only files modified or created the past:

—

™ show details Choose Details

Where should the list be created?

@ In & new workbook " In anew worksheet

File  Home Inset Draw Pagelayout Formulas Data Review View Help  ASAP Utilities

<

Fdshests~ B Columns & Rows = Mumbers & Dates~ | 2 Web~ [ import~  {E) ASAP Urilities Options

)

foots | Vien | st E3fanges ¥ Obiscts& Commente~ | (At + Bctormation  Ghepon~ | O Findanduon sty | ©infa o

Shotcutkeys>  Contol |~ [HFiI~ FE3 Format - fx Fomulas = BB File & System = [> Start = *, Start last tool again €} Registered version | the Day

Favorites Time saving tools Options and settings It 304 help Tips ks
A3 ~ il
A ] c ] € F [ H ] K L M

1 25 files found in C:\Program Files (x86)\ASAP Utilities\*.* (16:36:26 on 10-10-2022)
2 ParentFold - - size(KB) - |Type [v/Created [~ LastAcressed - Last Modifiec - | Folder and name -
3 ladd asap unilmies to the Excel menu.exe 3.091,1 EXEFlle  15-6-202221:38 10-10-202215:22 24-3-2022 15:58 C:\Program Files (x86[\ASAR Utilities\Add ASAP Utilities to the Excel menu.exe
4 Add ASAP Utilities to the Excel menu-0.bin TIABINFile  15-6-200221:38 8-10-2022 2043 24-3-202215:51 C:\Program Files (x36]\ASAP Utilities\Add ASAP Ut 10 the Excel menu-0.bin
s Add ASAP Utilities to the Excel menu-Lbin 0,0 BINFile  15-6-202221:38 8£10-202220:43 24-3-2022 C:\Program Files (x36]\ASAP Utilities\Add ASAP Utilities to the Excel menu-Lbin
6 ASAP Utilities.xlam 6.763,3 XLAM File 15-6-202221:38 10-10-202216:35 6-10-2022 14:27 C:\Program Files [x86]\ASAP Utilities\ASAP Ut
7 ASAP Utilities User Guide.pdf 19.625,1 PDFFile  15-6-202221:38 10-10-202215:22 6-10-2022 10:06 C:\Program Files [x35]\ASAP UNilities\ASAP Utilities User Guide.pdf
] 33,2 1COFile  15-6-202221:38 10-10-2022 15:22 19-3-2022 21:14 C:\Program Files [x36]\ASAP Utilities) tilities.ico
] resdme.tet 76 TATFile  15-6-202221:38 10-10-2022 15:22 6-10-2022 12:08 C:\Program Files (x86]) Utilities\readme.tit

10 Remove ASAP Utilities from the Excel menu.exe 3.091,1 EXEFlle | 15-6-202221:38 10-10-2022 15:24 24-3-2022 15:58 C:\Program Files (x85]\ASAP Utilities\Remove ASAP Utlities from the Excel menu.exe

n Remove ASAP Utilities from the Excel menu-0.bin 74,6 BINFile  15-6-202221:38 8-10-2022 2043 24-3-202215:51 C:\Program Files (x36]\ASAP L ASAP_utilities from the Excel menu-D.bin

12 Remove ASAP Utilities from the Excel menu-1bin DOBINFile 156202221338 8-10-202220:43 24-3-202215:51 C:\Program Files (x86]\ASAP | A ASAP Utilities from the Excel menu-Lbin

13 unins000.dat 70,9 DAT File  15-6-202221:38 8-10-2022 20:43 7-10-2022 13:17 C:\Program Files [x88]\ASAP L 3 O it

in 3.092,9 EXEFile  7-10-202213:17 10-10-2022 15:24 7-10-2022 13:17 C:\Program Files [x35[\ASAP Utilities\unins000.exe

15 248 MSGFile 15-6-202221:39 8-10-2022 2043 7-10-2022 13:17 C:\Program Files [x35]\ASAP | i msg

16 version_history.txt 1,7 TXTFile  15-6-202221:38 8-10-2022 20:43 6-10-2022 1 C:\Program Files [x86]\ASAP Utilities\version_history.txt

17 |certificate\  ASAP Utilities Certificate - & Must in Every Office BV.cer 15 CERFile  15-6-202221:38 7-10-2022 13:17 24-9-202015:03 C:\Program Files [x85]\ASAP Utilities\cert: te\ASAP Utilities Certificate - A Must in Every Office BV.cer
18 |resources\  ASAP Utilities ribbon de-de.xlam 395,8 XLAMFile 15-6-202221:38 10-10-202213:10 1-10-202219:21 C:\Program Files [x35]\ASAP Utilities\re

19 |resources\  ASAP Utilities ri 5.x) 376,8 XLAMFile 15-6-202221:38  7-10-202213:17 4-10-202207:42 C:\Program Files [x36]\ASAP L

20 |resources\  ASAP Utilities ribbon es-esxlam 399,8 XLAM File 15-6-202221:38 10-10-202213:11 1-10-202219:21 C:\Program Files [x36] utilit

21 |resources\  ASAP Utilities ribbon fr-fralam 412,9 XLAM File 15-6-202221:38 10-10-202213:14 1-10-202219:21 C:\Program Files [x86]\ASAP Utilities\resources\ASAP Uilities ribbon fr-fi

22 |resources\  AsAP Utlities ribbon it-itxlam 400,56 XLAM File 15-6-202221:38 10-10-2022 13:21 6-10-2022 12:06 C:\Program Files (x86]\ASAP Utilities\resources\ASAP_Utilities ribbon

23 resources), ASAP Utilities ribbon ja-jp.xlam 464,5 XLAM File 15-6-2022 21:38 10-10-2022 13:24 1-10-2022 1! C:\Program Files [x86]\ASAP | \ASAP Utilities ribbon ja-jp.xlam
24 resources), ASAP Utilities ribbon_nl-nl.xlam 3881 XLAM File 15-6-2022 21:38 10-10-2022 13:08 1-10-2022 19:21 C:\Program Files [x86]\ASAP | \ es\ASAP Utilities ribbon_nl-nl.xlam
25 |resources\  ASAP Utilities ribbon pi-br.xlam 401,2 XLAMFile 15-5-202221:38 10-10-2022 13:20 1-10-202219:22 C:\Program Files [x85]\ASAP Utllities\resources\ASAP Utilities ribbon_pt-br.xlam
26 |resources\  ASAP Ulilities ribbon ru-ru.xlam 575,9 XLAMFile 15-6-202221:38 10-10-202213:22 1-10-202219:22 C:\Program Files [x35]\ASAP | ces\ASAP Utilities ribbon ry-ru.xlam
27 |resources\  ASAP Utilities ribbon th-hans.xlam 383,7 XLAMFile 15-6-202221:38 10-10-202213:23 1-10-202219:23 C:\Program Files (x35]\ASAP Utilities\ ces\ASAP Utilities ribbon zh-hans.xl
)

28

30

3
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Easily create a lot of folders based on the values in selected

cells...

This utility allows you to quickly create multiple folders, based on the cell contents.

The utility asks you to pick a folder. In this folder it will then create a new folder for each

cell in your select and used the value in the cell for the folder name.

Example screenshot: 1 Create folders from cell values

A B [ ¢ [ o [ & [ F [ & [ W [ 1 ]
| 1 [Amsterdam
|2 |Andorra la Vella
| 3 [Ankara
4 [Athens r
[ |Belorade =)
5 {pertn G =[T = Proje. » Moro > Aol o E
|8 [Bratislava File Edit View Tools Help / i
| 9 |Brussels |
10 |Bucharest Organize »  Include in library = £Sharawith - » s« A1 @
| 11 [Budapest Projects " B
12 |Copenhagen . Amsterdam Ljubljana Sofia
[13 |Dublin Marathon | AndomalaVella || London Stockholm | |
|14 [Helsinki Amsterdam Anksra Luxembourg Tallinn i
2 lbeD Andoralalella Athens Madrid Thilisi -
EEEiL=hor Ankara - ) L
37 |Ljubljana Belgrade Minsk Tirana
[18 |London Athens ‘E | Berlin | Moscow Térshavn 1
|19 [Luxembourg Belgrade Bemn Nicosia Vaduz i
[ L T Bty Bratislava Oslo Vienna L
L2 fuinsi fer : : ]
57 [Moscow russels Paris Vilnius
[23 |Nicosia Bratislava Bucharest Prague Warsaw 1
| 24 [Oslo Brussels | Budapest | Reykjavik Yerevan |
| Eans Bucharest Copenhagen Riga Zagreb L
| 26 |Prague Budapest Dubl R i
(27 |Reykjavik e . Dublin | Rome i
[28 |Riga penhagen Helsinki San Marino i
[ 29 |Rome Dubiay | Kiev | Sarajevo |
| 30 |San Maring Helsinki Lisbon Skopje |
| 31 |Sarajeve Ko ad |
| 32 |Skopje 44 jtems i
[33|Sofia l |
34 |Stackholm |
35 |Tallinn
Emlisi 44 Eems & Computer E
(37 [Tirana | " " " " " " "

Example screenshot: 2 Create folders and subfolders by using the backslash character in

the cells
A B | ¢ | b | E | F | 6 | H | 1

_1 |Amsterdamisub 1 -

_ 2 |Amsterdamisub 2

_ 3 |Amsterdamisub 3 —

_4 |Amsterdamisub 4 @u'l .« Mara... » Amst... »

5 |Amsterdamisub & = - -

"6 |Amsterdamisub & File Edit View Tools Help 1
"7 |Londomsub 1 Organize v > 3~ I @ |
London\sub 2 |
_9 |Londomsub 3 Projects i Jsubl 1
10 [Londonisub 4 T Marathon

11 |London\sub & —\ Amsterdam Z::i 1
12 |London'sub 6 bl N |
13 |New Yorkisub 1 subd 1
14 |New Yorklsub 2 =¥z Isub5 |
15 |New York\sub 3 sub3 M sub6 |
716 [New Yorkisub 4 sub4 s |
17 |New Yorkisub 5 b5 1 |
18 |New Yorkisub 6 -
19 |Paris\sub 1 sub6 1
20 |Paris\sub 2 Lenden 1
21 |Paris\sub 3 New York P
22 |Paris\sub 4 Paris |
23 |Paris\sub & = |
24 |Paris\sub 6 ‘ngapore = 1
25 |Singapore\sub 1 6 items i
726 |Singaporetsub 10 |
27 |Singaporetsub 2 |
28 |Singapore\sub 3 6 items M Computer |
29 |Singapore\sub 4 s
30 |Singapore\sub 5

31 |Singaporetsub 6

22 |Sinnannralsih 7
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5.5.16 Import

A collection of tools that help you with importing and merging data.

1 Insert Excel file...
With this utility you can import an Excel file into your workbook.
The sheets of the imported file will be placed at the end of your workbook.

If the name of a sheet already exists then an incrementing number between parenthesis ()
is added to the end of the name.

Note:
Any macros that might exist in the file that is imported are ignored and not imported.

2 Insert (delimited) text file...

With this utility you can import a (delimited) text file into your worksheet at the position of
your active cell.

You can configure the following settings:

= How are the fields in the text file separated:

- space - exclamation mark (!)

- tab - other: you can specify a custom
- comma (csv) delimiter

- semicolon (;) - not separated

- pipe(])

Text qualifier: none, ' or "
Start import at row
File origin
= Date settings
- The utility uses the date settings as set in the Regional Settings in the Windows
control panel.
= Field settings
- Let Excel detect the field types (default)
- Treat all fields as text values (this can for example help when you have problems
with leading zeros that are lost).
= Settings used to recognize numeric data
- Decimal separator
- Thousand separator
- Trailing minus for negative numbers
= Options
- AutoFit column widths
- Remove leading and trailing spaces
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Your last used settings will be remembered.
Example screenshot: Import a delimited text file

ASAP Utilities - Insert (delimited) text file x

[ How are the fields in the text file separated?
" space © ppe (D

b © exclamation mark (1) ‘
Cancel
& comma (csv) € other: Q‘

£ semicolon () € not separated élf;gﬁﬁm
cell A1
I Treat consecutive delimiters as one
Text qualifier: l—_,,
Start import at row: 1
File origin: Windows (ANST) -
[ Date settings

4= Regional Settings from the control panel: D-M-Y
£ Let Excel detect the format

— Field settings
& et Excel detect the field types (default)

" Treatall fields as text values

| Settings used to recognize numeric data
Deciml separator:

Thousands separator: ' =l

I~ Traiing minus for negative numbers

— Options
W AutoFit column widths

|¥ Remoye leading and trailing spaces

Insert dBASE file...

This utility inserts a dBASE file into your worksheet at the position of your active cell.

Insert text file separated by space...

This utility inserts a space separated text file into your worksheet at the position of your
active cell.

Insert text file separated by tab...

This utility inserts a tab separated text file into your worksheet at the position of your
active cell.

Insert text file separated by comma (csv file)...

This utility inserts a comma separated text file (CSV) into your worksheet at the position of
your active cell.
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Insert text file separated by "|" (pipe/bar)...

This utility inserts a pipe (|) delimited text file into your worksheet at the position of your
active cell.

From Wikipedia: Although not as common as commas or tabs, the vertical bar can be used
as a delimiter in a text file. The symbol "|" has various names.
Source: https://en.wikipedia.org/wiki/Vertical bar

Insert text file separated by "!" (exclamation mark)...

This utility inserts a text file that is delimited by an exclamation mark (!) into your
worksheet at the position of your active cell.

Insert text file (with options)...

This utility inserts a text file into your worksheet at the position of your active cell.
The Excel "Text Import Wizard" will ask you to specify how the file is built.

& AutoSave (@ off) 0193.xlsx - Saved ~

File Home Insert Draw Page layout Formulas Data Review View Help ASAP Utilities

_& E‘Ef a:&\ Ff Sheets~ | [ Columns & Rows ~ = Mumbers & Dates~ @ Web ~ 55 ASAP Utilities Options~ (%) Online FAQ

Fovortesf Vo | Select | EdRange” | ¥ Objects & Comments - Text - [ nformation « B 1 Insert Excel fie...
Shortcut keys~ Control - £ Fil - [ Farmat = Jfx Formulas ~ [ File & System ~ [ 2. Insert (delimited) tet file... rersian
Favorites Time saving tools 3p
EE 2. Ingert dBASE file...
AL3 V) f Bl 4. Insert text file separated by space...
2 E C D H b S L I [ 5. Insert text file separated by tab.. E

1 ) Company Country

2 527 Luthorcorp Austria [ 6.Insert text file separated by comma (csv file)...

3 501 Lexcorp Belarus [El 7. Insert text file separated by ' (pipe/bar)...

B sty s

6 | 529 Big Kahuna Burger Belgium [Fl 9. insert text file (with options)...

g S03{videlectrix Bulgaria IEy 10. Merge and/or import multiple files.

8 530 Moes Tavern Bulgaria =

9| 504 Sombra Corporation Croatia &l 11. Create a list of filenames and properties in a folder..

10| 531 QwertyLogistics Croatia

11 505 Chasers Czech Republic

12 532 Spade And Archer Czech Republic

13] 1

14

15|

16|

17|

18 |

19|
20|
21|
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Company
527 Luthorcorp
501 Lexcorp
528 Zevo Toys
502 Mammoth Pictures
529 Big Kahuna Burger
503 Videlectrix
530 Moes Tavern
504 Sombra Corporation
531 Qwerty Logistics
505 Chasers
532 Spade And Archer

«

Organize ~

> |

Austria
Belarus

Belarus
Belgium
Belgium
Bulgaria
Bulgaria
Croatia

Crnatia

Open

> v

> Libraries » Documents > Export

New folder
O Name

[ 0193 _datatsv

Date modified Type Size

23-3-2022 20:31 TSV File

v C £ Search Export

File name: | 0193_data.tsv

| Al Excel Fies (s

Cancel

Company
527 Luthorcorp
501 Lexcorp
528 Zevo Toys
502 Mammoth Pictures
529 Big Kahuna Burger
503 Videlectrix
3530 Moes Tavern
504 Sombra Corporation
531 Qwerty Logistics
505 Chasers
532 Spade And Archer

Austria
Belarus

Belarus
Belgium
Belgium
Bulgaria
Bulgaria
Croatia

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that your data is Delimited.
If this is corredt, choose Next, or choose the data type that best describes your data.
Original data type
Choose the file type that best describes your data:
- Characters such as commas or tabs separate each field,
() Fixed width - Fields are aligned in columns with spaces between each field,

Croatia
Czech Repub
Czech Repub

Start import at row: | 1 2| File grigin: | 65001 : Unicode (UTF-§)

[ My data has headers.

Preview of file C:\Users\Moby\Documents\Export\0193_data.tsv.

f0€Praxis CorporationDenmark
s33&cme, Inc.Denmark
E07Fake BroshersFinland
s34Demo CompanyFinland
[p08Mainway ToysFrance

CTFERERR

Cancel

Einish
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W@~ oG W -

A B T D E F G J
1D Company Cou
527 Luthorcorp Austria
501 Lexcorp Belarus
528 Zevo Toys Belarus
502 Mammoth Pictures Belgium Text Import Wizard - Step 2 of 3
529 Big Kahuna Burger Belgium
503 Videlectrix Bulgaria ;mls:‘:f;:\:ﬁ you setthe delimiters your data contains. You can see how your text is affected in the
530 Moes Tavern Bulgaria
504 Sombra Corporation Croatia ﬁ‘:‘:rs
o " a
ety Lot oot mapup Dscmicton () Tsa consecte eimiters s one
532 Spade And Archer Czech Repub D;::::a Text gualifier:
ol [ other:
Data preview
0€ [praxis Corpozation Penmark
33 fpome, Inc enmark
07 [Fake Brothers inland
24 pemo Company inland
08 paimvay Toys rance
Cancel < Back MNext >
A B C D E F G J
1D Company Country
527 Luthorcorp Austria
501 Lexcorp Belarus
528 Zevo Toys Belarus
502 Mammoth Pictures Belgium
529 Big Kahuna Burger Belgium
503 Videlectrix Bulgaria
530 Moes Tavern Bulgaria
504 Sombra Corporation Croatia
531 Qwerty Logistics Croatia
505 Chasers Czech Republic
532 Spade And Archer Czech Republic
506 Praxis Corporation Denmark
533 Acme, Inc. Denmark
507 Fake Brothers. Finland
534 Demo Company Finland
508 Mainway Toys France
535 Big T Burgers And Fries France
509 Charles Townsend Agency
536 Gringotts
510 The Frying Dutchman
537 Input, Inc. Greece
511 Three Waters Hungary
538 Megadodo Publications Hungary
512 Universal Export Ireland
539 Initrode Ireland
513 Acme Corp Italy
540 Springshield Italy
514 Wayne Enterprises Luxembaourg
541 Blammo Luxembourg
515 Tip Top Cafe Norway
516 123 Warehousing Poland
517 Omni Consimer Products Romania
518 Data Systems Russia
519 Allied Biscuit Serbia
520 Transworld Consortium Slovakia
521 Extensive Enterprise Slovenia
522 Nordyne Defense Dynamics Spain
523 United Fried Chicken Sweden
524 Barrytron Switzerland
525 Thrift Bank Turkey
526 Sto Plains Holdings Ukraine

?

Merge and/or import multiple files...

This utility will merge multiple files from a folder together into one new file. You can also

use it to import multiple files at once into your workbook.

Excel has no built-in method for merging files. It can therefore be time consuming and

Available tools
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frustrating if you for example need to import or merge 200 Excel or CSV files. Fortunately
you can use ASAP Utilities to do this quick and easy.

You can configure the following settings:

= Start the import from a certain row, with the option to make an exception for the first
file. This can be useful if you have files with fieldnames and only want these listed once.

= |Import the files into your current workbook or a new workbook.

= Create a new worksheet for each file, or merge the data into one new sheet. With this
second option the data from the files will be placed below each other.

You can import/merge the following file formats:

= CSV, comma delimited

= Text, space delimited

= Text, tab delimited

= Text, pipe (|) delimited

= Text file, semicolon (;) delimited

= Text file, delimited by specified character
= dBASE

= Excel*

= Lotus 123*

= Quattro Pro*

Only data from the active sheet is imported

*

Your last used settings and chosen folder will be remembered.

Example screenshot: Import multiple files

ASAP Utilities - Merge/import multiple files X
Import fles of type: -
(% CSV, comma delimited € dBASE
™ Text, space delimited " Excel*
Cancel
" Text, tab delimited " Lotus 123%
" Text, pipe ([} delimited " Quattro Pro®
(" Text fie, semicolon (;) delimited * Only data from the
five sheet
” Text file, delimited by: l_ acive shee
oz [ windows (ans1) |
¥ Treat consecutive delimiters as one

Paste
o ()
I~ Start the import from row: [ rm
Import to:
" This workbook & A new workbook
" Create a new worksheet for each file:

-

r
(% Merge the data into one new sheet: 0202022

v Put filename in column A
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Create a list of filenames and properties in a folder...

This utility will create a list of all filenames in a specified folder.
This way you can for example import on a worksheet the names from all files on a cd-rom.

You can configure the following settings:

= The folder to be searched.

= Search subfolders.

= Create hyperlinks to the files.

= Show only certain file types. For example to report only Excel files you can enter "*.xI*'.

= Sort the results, for example by filename, foldername, date, etc.

= Show only files modified or created within the past specified number of days.

= Create the list of files in a new workbook or on a new worksheet in your current
workbook.

This utility reports the following information about the files:

= Parent Folder

= Filename

= Size (KB)

= Type

= Created (date)

= Last Accessed (date)

= Last Modified (date)

= Full name (foldername and filename together)

By default you can start this utility with the shortcut Ctrl+Alt+F.
Your last used settings will be remembered.

Example screenshot: Create a list of filenames and properties in a folder

ASAP Utilities - List filenames in folder X
Report full path, filenames and properties -
Folder: oK
| Ci¥Program Fies (x86)\A5AP tiities\ ()
cancel
¥ Indude subfolders I~ Indude empty folders
v Create hyperlinks to the files
File types: Sortby:
[ == 1. folder, fiename (ascending) |
I show only files modified or created the past:
I Show details Choose Details

Where should the list be created?

* In & new workbook " In a new worksheet
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Fle  Home Insert Draw Pagelayoul Formulas Data Review View Help  ASAP Utilties
_& i sheets~  HE Calumns & Rows = Mumbers & Dates~ | @ Web [ import~  {E} ASAP Utilities Options = (7) Online FAQ: %L
Favorites & Vion | Select  EdRanges ¥ Objects & Comments>  [A] Text - [ Information (b Export~ [ Find and run o utility @D info Tpat
Shortcutkeys+  Control v Erie A Format ~ i Formulas + R Fite & system > [> Stan v %, Start last tool again @, Registered version | the Day
Favorites Time saving tools Options and settings Infe and help Tips tricks.
A3 v £
A ] € o | € P 6 H ' ] K L M
1 25 files found in C:\Program Files (x86)\ASAP Utilities\*.* (16:36:26 on 10-10-2022)
2 ParentFold -~ Filename ~ Size (KB) - Type |~ Created = Last Accessed | - | Last Modifiec ~ Folder and name -
3 |add _asap utilities to_the Excel menu.exe 3.091,1 EXEFlle  15-6-202221:38 10-10-2022 15:22 24-3-202215:58 C:\Program Files (x86]\ASAP Utilities\Add ASAP Utilities to_the Excel menu.exe
4 0.5in TLABINFile  15-6-202221:38 8-10-2022 043 24-3-202215:51 C:\Program Files [x35)\ASAP Utilities\Add ASAP Utilities to the Excel menu-0.bin
5 Add ASAP Utilities to the meny-1bin 00 BINFile  15-6-202221:38 8-10-2022 20:43 24-3-202215:51 C:\Program Files [x36) ASAP Utilities to the Excel menu-Lbin
6 ASAP utilities.xlam 6.763,3 XLAMFlle 15-6-202221:38 10-10-2022 16:35 6-10-202214:27 C:\Program Files [x6]\A: \ASAR Utilities.xlsm
7] ASAP_Utilities user Guide.pdf 19.6251 POFFile  15-6-202221:38 10-10-202215:22 6-10-2022 10:06 C:\Program Files (x36)\ASAP Ulities\ASAP Utilities User Guide.pdf
8 39,2 ICOFile  15-6-202221:38 10-10-2022 15:22 19-3-2022 21:14 C:\Program Files [x86]\ASAP Utilitiec\asap-utilities.ico
L] 7.6 TXTFile  15-6-2022 21:38 10-10-2022 15:22 6-10-202212:08 C:\Program Files [x86)\ASAP Utilities\readme.txt
10 Remove ASAP Utilities from the Excel menu.exe 3.091,1 EXEFille  15-6-20222] 10-10-2022 24-3-202215:58 C:\Program Files [x85]\ASAP Utilitias\Remove ASAP Utilities from the Excel menu.exs
n Remove ASAP utilities from the Excel menu-0.bin 74,6 BINFile  15-6-202221:38 8-10-2022 2043 24-3-2022 1551 C:\Program Files (x86]\ASAP Utilities\Remove ASAP utilities from the Excel menu-0.5in
12 Remave ASAP Utilities from the Excel menu- 00 BINFile  15-62022271:38 8-10-202220:43 24-3-202215:51 C:\Program Files [x86]\ASAP Utilities\Remove ASAP Utilities from the Excel menu-Lbin
13 unins000.dat 70,9 DAT File  15-6-202221:38 8-10-2022 20:43 7-10-2022 13:17 C:\Program Files [x88]\ASAP Utilities\unins000.dat
14 unins000.exe 3.092,9 EXEFlle  7-10-202213:17 10-10-202215:24 7-10-202213:17 C:\Program Files [x86]\ASAP Utilities\unins000.exe
15 unins000.msg 248 MSGFile  15-6-202221:39  8-10-2022 2043 7-10-2022 13:17 C:\Program Files [x35|\ASAP. 000.msg
16 version_history txt L7TATFile  15-6-202221:38 8-10-2022 20:43 6-10-202212:07 C:\Program Files [x86]\AS# history.txt
17 |certificate)  ASAP Unilities Certificate - A Must in Every Office BV.cer 15 CERFile  15-6-202221:38  7-10-202213:17 24-8-202015:03 C:\Program Files [x86]\A \ P utilities Certificate - A Must in Every Office BV.cer
18 |resources\  AsaP utilities ribbon de-de.xlam 395,8 XLAM File 15-6-202221:38 10-10-202213:10 1-10-2022 19:21 C:\Program Files [x86]\ASAP Utilities\resources\asaP utilities ribbon de-de.xlam
19 resources), ASAP Utilities ribbon en-us.xl 376,8 XLAM File 15-6-202221:38  7-10-2022 13:17 4-10-2022 07:42 en-us.xlam
20 resources), ASAP Utilities ribbon_es-es.xlam 399,8 XLAM File 15-6-202221:38 10-10-2022 13:11 1-10-202219:21 C:\Program Files [x86)\ASAP Utilities\rs AP Utilities ribbon_es-es.xlam
21 |resources\  ASAP Utilities ribbon fr-frxlam 412,95 XLAM File 15-6-202221:38 10-10-2022 13:14 1-10-2022 19:21 C:\Program Files [x85]\ASAP Utilities\resources\ASAP Utilities ribbon_fr-fr.xlam
22 |resources\  ASAP Ulilities ribbon it-it:xlam 4006 XLAM File 15-6-202221:38 10-10-202213:21 6-10-2022 12:06 C:\Program Files [x35)\ASAP Utilitiesre P Ulilities ribbon it-it.xlam
23 |resources\,  ASAP Utilities ribbon ja-ip.xlam 4645 XLAM File 1-10-202219:23 C:\Program Files [x86)\ASAP Utilities\resources\ASAP Utilities ribbon js-ip.xlam
24 |resources\,  ASAP Utilities ribbon_nl-nl.xdsm 388,1 XLAM File 1-10-2022 19:21 C:\Program Files [x36)\ASAP Utilities\r Utilities ribbon_nl-nl.xlsm

25 resources\
26 |resourcesy,
27 resources\

AsAP_utilities ribbon pt-br.xlam
ASAP Utilities ribbon ru-ru.xlam
ASAP Utilities ribbon sh-hans.xlam

401,2 XLAM File
575,9 XLAM File
383,7 XLAM File

15-6-2022 21:38
15-6-2022 2
15-6-2022 21:38

10-10-2022 13:20
10-10-2022 1
10-10-202213:23

1-10-202219:22 C:\Program Files [x8§]\ASAP Utilities\resources\ASAP Utilities
1-10-2022 19:22 C:\Program Files (x86)\ASAP Utilities\re P_Utilities
1-10-202219:23 C\Program Files (x35)\ASAP Utilitiechr AP Utilities

ribbon_pt-braxlam
ribbon_ru-ru.xlam
ribbon_th-h
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5.5.17 Export

A collection of tools that help you with the exporting of data and pictures or charts in
various file formats.

1 Export selection or active sheet as new file...

With this utility you can save your selected data range or the entire worksheet as a new file.
You can choose not to include hidden cells in your export.

The data can be exported in the following file formats:

= Excel 97-2003 Workbook (*.xls)

= Excel Workbook (*.xIsx)

= Excel Binary Workbook (*.xlsb)

= Formatted text (space delimited)

= Tab delimited text file

= Tab delimited unicode text file

= CSV (comma separated value or custom separated)

= CSV unicode, UTF-16LE / UTF-8 (comma separated value or custom separated)

You can also use the “CSV” option to create your own custom separated file by setting your
own field separator, field encloser and decimal separator. This way you can for example
create pipe (|) delimited text files.

You can also choose to copy the information directly to your clipboard in the following
formats:

= tab delimited
= space delimited

You can choose to export the contents of the cells as:

= Values (for example 12)
= Formulas (for example =3*E6)
= As displayed (for example EUR 12,00)

Your last used settings will be remembered.
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ASAP Utilities - Export selection or worksheet

Export data I@cportd’\art or range as image |
save in:

— Export ——————————————————— — How toexportt ——————————————————) ¢ Current file’s
€ Entire sheet: Start  yalues (12) ok

% Range: AL:1120 J © Formulas (=378) " Excels defalit file location

[ Do not export hidden cells ™ As displayed (EUR 12,00) £ Current default
folder

— File format:

" Excel 97-2003 Workbook (*.xds)  dBASE TV £ Open the export in Windons
Notepad instead of saving it

 CSV (comma separated valug)

@ Excel Workbook (% xsx) o -
or custom separated:

 Excel Bnery Workbook (*,xeb)
Felds seperatedby: [
€ Formatted text (space delimited) "
P — Fields endosed by — A e cpored o e
s recent fies list n the Fies-menu
€ Tab demited unicade text fle B
© Copy to cipboard (tab delimited) Ll P [ore =]

W Close window after export

© Copy to cipboard (space delimited)

ASAP Utilities - Export selection or worksheet

Export data |§xportmartnr range as image |
savein:

[~ Bxport: L & Current fle's
" Entire sheet: Start € yalues (12) folder

@ Range: ALI120 J £ Eormulas (=378) ™ Excel's default file location

[¥ Do not export hidden cells & s displayed (EUR 12,00) ¢ Current default
Tolder

— File format:

" Excel 97-2003 Workbook (*.xs)  dBASE IV ¢~ Open the export in Windows
Natepad instead of saving it,
@ CSV (comma separated value)

or custom separated:

" Excel Workbook (* )

 Excel Ginary Warkbook (%, sb)
Fedsseparatedby: [,

 Formatted text (space delimited) e separatea By :

( Tab delimted text fie oS > Acd the exported fle o the
recent files listin the Files-menu
Decimal separator:
 Tab delmited unicode text fle Bt
Jose window after export

" Capy to ciphoard (tzb delimited) Ltz

" Copy to dipboard (space delimited)

Close | oK I

Export selection as HTML table to clipboard...

Export your selected range as a table in clean HTML-code to the clipboard so that you can
easily paste it into your webpage.

This utility has advanced options and is recommended to all web developers.

Your last used settings will be remembered.
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Example screenshot: Export your range in clean HTML format

F G H | J

A

2 |Austr Lusth 2 21 a4

3 |aust] ASAP Utilities - Export as HTML table to clipboard - - a

4 ABUST Setings | Generated HTML cade | Range to expart;

3 |[Fl: - ALELZL &

5 Table, row and column settings Use cell formatting:

7 Width: ’7 Cell padding: ,72 ¥ Cell color [+ Font color Table comment <!- —=

Border: [ 1 Celspecing: [ g ' alignment
[¥ Bold, underlined and italic
Align: =
Cell setti
Frame: = < seines [ Write eath <td> on a new ine
¥ nowrap [¥ Character encoding

Rules: -
=] ¥ Place fnbsp; in empty cells [Coinensds diariuy
<table dass= [ B
[¥ Detect hyperlinks
<td dass= Target: ’M—L‘ This utility produces dean
PR Dlani and easy to use HTML code
= I~ even of your table.
W Font (if no stylesheet used) The code is copied to your
[¥ Use first row as table head (<th> . . dipboard, so you can easily
Us (<th=) Font name: Size: E= i e
- Tahoma hd 2 hd document,
I Detect column width e assume you know the
I Detectrow height How to export: basics of HTML.
Align rows: " values (12)
FrEnL =] " Formulas (=3"E8)
Vertical: -
eriea 5 as displayed (EUR 12,00)
Close
el +3 |
27 [Finland General Products 4 21 49'

98 |zintand Wiatar And Dawiar 1 12 aal

Export selected chart or range as image (file)...

With this utility you can save your selected range or chart as a picture in GIF-, PNG-, JPG-,
TIF or EMF-format.

You can use the following file formats:

= GIF: Recommended when your selection or chart has only a few different colors. Perfect
for publications on the internet.

= JPG: Recommended when your selection of chart has a lot of different colors (asin a
photo). Perfect for publications on the internet.

= PNG: Better quality then JPG, but not yet supported by all software (email). Works in all
recent internet browsers.

= EMF: A vector graphic in EMF (enhanced version of WMF) format can be scaled and fully
edited in MS Office and other Windows applications.

Your last used settings will be remembered.

Note:

When you export a large range or a large chart a part of the exported image might be
truncated or colors might be lost. This is not an ASAP Utilities bug, Excel has a limit on the
size of the exported images. This limit depends on your Windows and Excel version
(Microsoft KB185001).

In some cases when your image gets truncated then exporting your image as EMF file might
be a solution.
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PRODUC |

Frames

Disc Brakes, Front
Caliper Brakes, Front
Disc Brakes, Rear
Caliper Brakes, Rear
Saddles

Forks

Brake Cables
Shifter Cables

Rear Sprockets
Front Sprockets
Handle Bars

Brake Levers

Seat Posis

Handle Bar Clamps
Saddle Bags
Spokes

Rims

Tires

Grips

Grip Tape

Pads

Chains

Derailers

Quick Release Hubs

ASAP Utilities - Export selection orworksheet

TOTAL AND TOP 5 PRODUCTS

OUARITFR 2

Export data Export chart or range as image

Export selected charts as:

" GIF

PG

= BNG

o EMF

Scale:

Recommended when your selection or chart has only a few different colors, Perfect for

publication on the internet.

Recommended when your selection of chart has a lot of different calors (as in a photo).

Perfect for publication on the internet.

Better quality then JPG, but not yet supparted by all software (email). Waorks in all recent

internet browsers.

A vector graphic in EMF (enhanced version of WMF) format can be scaled and fully edited
in M5 Office and other Windows applications.

100% (Default)

OQUARTEFR 3

OUARTFR 4

Save in:

* Current file's folder

" Excel's defauilt file location

" current default folder

[ Open exported image with
default viewer

¥ Close window after export

Close oK
30 26 33 38 126
208 177 229 260 874
356 303 392 445 1495
219 284 323 1084

258

TOTAL AND TOP 5 PRODUCTS
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Export worksheets as separate files...

With this utility you can save all or the selected worksheets in your workbook as separate
files.
You can choose a folder in which you want the worksheets to be saved.

The worksheets can be saved in the following file formats:

= Excel Workbook (*.xIsx)

= Excel Binary Workbook (*.xlsb)

= Excel 97-2003 Workbook (*.xls)

= CSV (Comma delimited) (*.csv)

= CSV unicode (Comma delimited) (*.csv)

= Text (Delimited by semicolon ;') (*.txt)

= Text unicode (Delimited by semicolon ';') (*.txt)
= Text (Tab delimited) (*.tsv)

= Text unicode (Tab delimited) (*.tsv)

= Formatted Text (Space delimited) (*.prn)
= Text (Pipe (]) delimited) (*.txt)

= Text unicode (Pipe delimited) (*.txt)

= Text (Delimited by tilde '~') (*.txt)

= Text unicode (Delimited by tilde "~') (*.txt)
= Web Page (*.htm, *.html)

= Single File Web Page (*.mht, *.mhtml)

= PDF (*.pdf)

Your last used settings will be remembered.

Example screenshot: 1

2% | susa-ve-uu acu P avs IvE) 4 Y 1 22

35| 2023-09-07 11a a1 as P 1am 22 152 07!

26| 2023-10-29 ASAP Utilities - Export worksheets as separate files X
EliTotal Expart falder
28 The selected worksheets will be saved in the export location with the name of the worksheet as
29 flename
30 C:\Projects\Marathon\ Browse
31 =
32 I Ogen this folder in Windows Explorer after expart
33
3 Worksheets to expart: Fie format:
35 [ Excel Binary workbook (=.xisb) ~|
36 Excel Workbook (* xsx
= Excel Binary Workbook (*.xisb!

Excel 97-2003 Workboak (*.xs)
38 — €SV (Comma delimited) (*.csv)

T JLre) Text (Delimited by semicolon '}) (*. txt)

& Text (Tab delimitec) (=.tsv)
40 New York Formatted Text (Space delmited) (*.prm)

Text (Delmited by pipe ') (%, bxt)
41 FEils Text (Delmited by tide '~) (*.txt)
2 Web Page (*htm, = htm)

Single Fie Web Page (mht, *.mhtmi)
43 POF (*.pdf)
44
= Use non standard settings:
46 C
a7 =
48 ||
42
50 If the fle already exists:
51 b [ overnrite =l |
52
53 al Invert None cancel -
54

;

55 !

Amsterdam Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York ‘ Prague Vienna

Example screenshot: 2
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8| cvea-vouu 1eu 2o 1ur 13 1 1 w £
25 | 2023-09-07 119 111 a= a7 1ae 22 163 an7)
26| 2023-10-29 | ASAP Utilities - Expart worksheets as separate files... X
27Total | et folder
28 The selected worksheets will be saved in the export location with the name of the worksheet as
20 flename.
30| —
| C:'Projects\Marathon Tz
31 =
32| ¥ Open this folder in Windows Explorer after export
33
3 4: — o export: [ File format:
35| [ ExcelBinary Workbook (*.xisb) |
22 I Unicade
37
— W Do not export hidden cells
38
24l [ How to export:
40 @ Yalues only
a4
| — " values and formuias
3 € As displayed (EUR 12,00
a4
=l [ Use non standard settings:
16| o5 [
47| r [
43 | T
49
=l If the fle already exists:
sl [ overwrite BN
52 | _
= Al Tnvert None - |

I
Amsterdam Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York Prague Vienna

Example screenshot: 3

25 | 2023-09-07 110 111 y &7 100 29 1Ra 107!
26| 2023-10-29 | ASAP Utilities - Export worksheets as separate files... X
27 [Total | et folder
28 | The selected worksheets wil be saved in the export lacation with the name of the workshest as
20 filerame.
30 Sre—

| C:'Projects Marathon, .
31 =
32 | V¥ Open this folder in Windows Explorer after export
33
3 4: [ File format:
35 [ csv (comma delmited) (=.cv) |
gol = - [ Unicode UTF-3 -
37 Dubin ur
= Landon [¥ Do not export hidden cells
= [ How to export:
20l @ Values (12)
A " Formul E
oo Eormuias (=3E6)
43' " Ag displayed (EUR 12,00)
44
& - Use non standard settings:

g I Figlds endlosed by:
46
47: I” Decimal separator:
48| I Alternative file extension:
49
50 1f the file already exists:
51: """"" Overwrite 21N o i A
52 | " _
53 Al Tnvert None - |

i
Amsterdam Copenhagen ‘ Dublin | London | Luxembourg ‘ Minsk | New York Prague Vienna

Copy selection as values to clipboard

This utility copies the values of the selected cells to your clipboard.

You might experience that Excel sometimes resets the range you have copied and then you
cannot past the information without first having to copy it again.

This utility puts the values of the selected range in your clipboard and can make it easier to
copy the information.

Sometimes Excel puts double quotes (") around the data when you want to paste it into
another application. This utility doesn't do that and can be useful in such cases too.
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Example screenshot: 1 Standard copy in Excel can cause double quotes around the data

A B c D E
Time saved per tool
1 (estimated, in seconds)
Total time saved

F G

2 |(in minutes) [ A
z _(r'i:‘";':;:)b 7] Untitled - Notepad [E=E]
4 |First measure File Edit Format View Help
excel standard copy can cause "quotes” -
5 Lastmeasured | aroind multi-line strings:
6 |Total time sa
7 Totaltimesay |“1ype saved per tool{estimated, in seconds)”
8 Hourlyrate: ||"Total time saved(in minutes)"
Time saved by using Asap utilities
9 First measured usage:
10 Last_measured usage:
Total time saved in minutes:
" Total time saved in hours:
12 Hourly rate:
13
14
15
16
17
18
19
20 =
« »
2 1
22

Example screenshot: 2 The result of copying with ASAP Utilities

A B c D E
Time saved per tool
1 |(estimated, in seconds)
Total time saved

F G

{in minutes)

-
| Untitled - Notepad
Time saved by 4 s

oo = |

First measurel File Edit Format View Help

2
3
4
Time saved per tool(estimated, in seconds)
5 Lastmeasure Total time saved(in minutes)
6 Total time say |Time saved by using asap utilities
7 Totalti First measured usage:
otaltime sa| ast_measured usage: |

8 Hourly rate: Total time saved in minutes:

Total time saved in hours:

Hourly rate:

Copy sum of selection to clipboard

Copy the calculated sum of selected cells to your clipboard. Just like you can see in the

statusbar of Excel.

Copy average of selection to clipboard

Copy the calculated average of selected cells to your clipboard. Just like you can see in the

statusbar of Excel.

Available tools
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Put the selection as bitmap-image on the clipboard (as on
screen)

This utility places the selection as it looks on the screen as a bitmap-image on the clipboard.
You can then paste the picture into a program such as for example MS Word or a photo-
editor.

You can also do this in Excel itself but the advantage of having it in ASAP Utilities is that it
takes less steps and you can assign a shortcut to it.

Put the selection as image on the clipboard (as on screen)
This utility places the selection as it looks on the screen as an image on the clipboard.

You can then paste the picture into a program such as for example MS Word.

You can also do this in Excel itself but the advantage of having it in ASAP Utilities is that it
takes less steps and you can assign a shortcut to it.

Put the selection as image on the clipboard (as on printer)
This utility places the selection as it would look when printed as an image on the clipboard.

You can then paste the picture into a program such as for example MS Word.

You can also do this in Excel itself but the advantage of having it in ASAP Utilities is that it
takes less steps and you can assign a shortcut to it.
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5.5.18 Start

A collection of tools to quickly start the most used standard Windows applications.

1 Special Characters

This utility will start the MS Windows "Special Character" program.

We have added this to ASAP Utilities so that you can easily select special characters from
Excel.

Remember that if you use special characters from another font than used in your cell, then
you have to adjust the font in your cell too.

[ Character Map o |
Font:  EETE - [ b |
VI #( 8% & "[([)|* |+ ,|-|-|/]|0]1]2|3]|4|~
56789.‘<:>'?@.L‘\BCDEFGH_I
IJ|K[LIM[N/O|P|Q|R|S|T|U|VIW X|Y|Z|[|\
1M albjc|d|le|[f|g/ h|i|j|k|Il mn|lo|p
gris|{tiulviw/x|ylz|{| ||}~ i ¢ £ m|¥
IHNERORRCNNEEERNLENE
o ||| %] e |A|A|A|AIAIA|E|C|EIEIEIE|T|I
T/T|p|R[o[0|0O|0|0|=|@ UlUj0|0|Y|[P|B|ala
ald|alale/c e|léléle|l|i|T|i|0filo6o6|6|d
ol=|elolalala|y|p|y|AlalAla|Aala|Cle|Cle| .
Characters to copy : I Select Copy
[ Advanced view
lmzw Exclamation Mark

2 Calculator

This utility starts the MS Windows Calculator program.
Perhaps unnecessary in Excel, but some people find this easy to make a quick calculation or
to check their formula results.

r a
|2] Caleulator S

View Edit Help

La s L6 flellwe
LL)l2 )8 Jlmsall _
o | |_‘ |L‘ ]
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Windows Explorer

This utility starts the MS Windows Explorer program.

This can be easy on computers in some companies where the link to the Windows Explorer
is removed from the start menu.

Windows Explorer (start in current file's folder)

This utility will start the MS Windows Explorer program and opens it with the folder where
your current file is stored.
You will be surprised how useful this is.

Clipboard Viewer
This utility starts the MS Windows Clipboard Viewer program.

Notepad

This utility start the MS Windows Notepad program.

Funny (error) messages (English)

This utility displays random funny (error) messages.

These will make you smile (at least some of them should...) and give you a little distraction
from your work in Excel.

The messages are in English.

Example screenshot: File not found

Error 1077 ==
u0w File not found. Should Tfake it?
—— g

= —

Example screenshot: Mouse error

Error 3361

Mouse has out-of-cheese error.
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Example screenshot: Press F13...

Error 1018 —
§, FATAL SYSTEM ERROR: Press FL3 to continue..
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A collection of tools specific to ASAP Utilities such as changing the settings and help
information.

Here you can change the settings of ASAP Utilities.

When you press the "OK" button the changes will be saved, except for the language. If you
change the language this is immediately saved.

General

General

Ask for confirmation before starting certain utilities (recommended)

You can switch on/off the question that sometimes is asked before running the utility.
For example a question such as "Do you want to convert all text in the selected cells to
UPPERCASE?".

Enable undo where available (recommended)

Turn the undo on or off. Sometimes to increase the speed you might want to turn off the
undo.

Use the F11 key to switch between full screen and normal view.

Excel does not have a shortcut to switch between full screen and normal view. In most
internet browsers you can use the F11 key to do this.

You can now choose to use the F11 key to switch between full screen mode in Excel with
ASAP Utilities. By default, Excel uses the F11 key inserts a chart sheet in Excel but you can
also do that with the key combination Alt+F1.

ASAP Utilities menu

Show the ASAP Utilities menu also in the Add-ins tab ('classic' menu).

- Use numbered menu (recommended)
You can choose if you want the menu to be numbered. This option is only
available in Excel 2000/2002/XP and 2003 or when you have the option “Show the
ASAP Utilities menu also in the Add-ins tab ('classic' menu).” enabled.

- Use numbered submenu-items (recommended)
You can choose if you want the menu items in the submenus to be numbered.
This can make it easier to quickly find a tool in the menu.

- Show in right-click context menu (recommended)

Ribbon

ASAP Utilities Ribbon keyboard shortcut (when changed, Excel needs to be restarted
manually).
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Help improve ASAP Utilities

= Allow ASAP Utilities to report anonymous usage statistics.
These usage statistics do not include personal information, such as the data you work
with. Usage statistics do include the following information from your computer:
Windows version and language, Excel version and language, ASAP Utilities version and
language, and the id's of the 10 tools used most often and your ip address.
This information helps with the further development of ASAP Utilities and its
documentation and translations.

Language used in menus and dialogs

= Here you can change the language of ASAP Utilities into one of the available languages.

Folder settings

This tab shows you in which folder ASAP Utilities is installed.

= Folder to store your "Favorites and shortcuts" file.
Here you can specify the folder where your favorites menu file is stored. If you work on
multiple computers it can be useful to store the favorites menu file on a network folder
so that it is accessible from both computers.
If you pick a folder that doesn't have a favorites menu file yet, a file with the default
settings will be created.

= Default path to save a backup.
Here you can specify where the backups are saved that are created with the "Save file
and create backup" utility.

Contact information

If you encounter problems and you contact us, then please provide the information
displayed here.

It will give us information about the version of Excel and ASAP Utilities that you use,
including some other important information.

When you click on the button "Copy info to clipboard for use in email" the information will
be put on your clipboard and you can easily paste it into an email to use where you
describe the problem.

More information about contacting us is written in Chapter 8, Troubleshooting FAQ of the
User Guide (English).

The following page on our website shows how to report a bug:
https://www.asap-utilities.com/contact-support-bug-report.php
https://www.asap-utilities.com/contact.php

Important: We can only help you if you communicate in English or Dutch.
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Debug

In some cases, you will be advised by the ASAP Utilities support team to turn on this debug

setting to help solve specific problems.

This log file records certain steps in ASAP Utilities and can help detect at which point

something goes wrong.

ASAP Utilities - Settings, language and contact information...

General | Folder settings | Contact information | Debug |
General
v sk for confirmation before starting certain utilities {recommended)

M Enable undo where available (recommended)

[V Digable undo on a filtered worksheet with more than this number of rows: 25000

v Alert me when this occurs

I Use the F11 key to switch between full screen and normal view
ASAP Utilities Menu:

I™ Show the ASAP Utiities menu also in the Add-ins tab (‘dassic’ menu)
=

=

&

Ribbon
s ASAP Utiities Ribban keyboard sharteut (hen changed, Excel needs to be restarted manualy).

Help improve ASAP Utiities

I~ Allow ASAR Utiities to repart anonymous usage statistics

Language used in menus and dialogs:

| Match office Display Language Gf avalable)

Close

General | Folder settings  Contact information ]gghug|

We can only help you if you communicate in English or Dutch.

Contact information on our website:
https: /fwww.asap-utilities. com/contact. ph

Information an how to report a bug:
https: {/www . asap-utilities. com jcontact-support-bug-repert.php
If you encounter a problem with ASAP Utiities and want to contact us, please provide the following information. This

allows us to help you better.
You can copy this information and past it in your email to support@asap-utiities.com.

Copy info to dipboard for use in email

ASAP Utilities
Vezsion ¢ B-0 teevabd ASAp iilities - Settings, language and contact infarmation...
Language : en-us
Favorites menu path : C:\Users\Mi
Date start H €15

Actual days used

Registered version, licensed to:
Name : Bastien Mej

Order number 1174414137 sveswwrms

Excel wersion 3€5 (16.0.15629) €4-bit
Country code 1

The information is now on you dlipboard and can be pasted
in an email to us (support@asap-utilities.com).

Organizasion : R Must in §
Number of licenses 1

I

-
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Edit your favorite tools and shortcut keys...

ASAP Utilities contains a lot of different utilities.
With the "Favorite tools" you can add the tools from ASAP Utilities that you use most
frequently and assign your own shortcuts to them.

By default, ASAP Utilities uses the following shortcuts (which you can customize):

Shortcut Action

= Ctrl+Alt+A Select adjacent cells in column with the same value
= Ctrl+Alt+B Reload all installed add-ins (rebuilds the menu)

= Ctrl+Alt+C Color each n'th row or column in selection...

= Ctrl+Alt+D Deselect cells...

= Ctrl+Alt+E Set default path to current file

= Ctrl+Alt+F Create a list of filenames and properties in a folder...
= Ctrl+Alt+G Export selection or active sheet as new file...

= Ctrl+Alt+H Find and/or replace in all sheets...

= Ctrl+Alt+ Apply formula/calculation to selected cells...

= Ctrl+Alt+) Start the last used utility again...

= Ctrl+Alt+Shift+Right Arrow  Extend selection to the last used column

= Ctrl+Alt+Shift+Down Arrow  Extend selection to the last used row

= Ctrl+Alt+M Move or resize selected range...

= Ctrl+Alt+N Add new worksheet (fill in a name)...

= Ctrl+Alt+O Select cells based on content, formatting and more...
= Ctrl+Alt+P Change formulas to their calculated values
= Ctrl+Alt+Q Quick numbering of selected cells...

= Ctrl+Alt+R Reset Excel's last cell

= Ctrl+Alt+S Save file and create backup...

= Ctrl+Shift+ Vision Control...

= Ctrl+Alt+X Move selected data (only values)...

= Ctrl+Alt+Y Paste special (with combinations)...

= Ctrl+Shift+D Insert current date and time with seconds
= Ctrl+Shift+T Insert current time with seconds

= Ctrl+Alt+Z Find and run a utility...
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Example screenshot: 1 The favorites and shortcuts menu

B AutoSave

Book1 - Excel

File

_& E‘g a:cli EH Sheets ~ [ Columns & Rows +

Home Insert Draw Page Layout Formulas Data Review View Help

EARange~ 2 Objects & Comments ~

Favorites & | Vision | Select
Control - [ Fill ~ [ Format ~ fx Formulas
#
™\ 1. Select adjacent cells in column with the same value (Ctrl+Alt+A) paving tools
£ 7)) 2.Reload sll installed add-ins (rebuilds the menu} (Ctrl+Alt+B)
BB 3. Color each n'th row or column in selection... (Cirl+ Alt+ C) H
1
B
2
3 @
4
@
5
6 O
LANSS]
. @
9
10 &
1
g
13 O
L
15
16 E¥
7R

ASAP Utilities

Numbers & Dates v @ Web ~

[ Information ~
[ File & System

4, Deselect cells... (Ctrl=Alt+D)
5. Set default path to current file (Ctrl+ Alt+E)
6. Cregte a list of filenames and propertics in a folder... (Ctrl+Alt-F)
7. Export selection or active sheet as new file... (Ctrl+Alt+G)
8. Find and/or replace in all sheets... (Ctrl+ Alt+H)
9. Apply formula/calculation to selected cells... (Ctrl+Alt+1)
10. Start the last used utility again... (Ctrl+Alt+))
11. Extend selection to the last used column (Ctrl+ Alt+Shift+Right Arrow)
12, Extend selection to the last used row (Ctrl+ Alt=Shift-Down Arrow)
13. Move or resize selected range... (Ctrl+Alt+M)
14, Add new worksheet (fill in @ name)... (Cirl+Alt+N)
15. Select cells based on content, formatting and more... (Ctrl+ Alt+0)
16. Chenge formulas to their calculated values (Ctrl+ Alt+P)

17. Quick numbering of selected cells... (Cirl+ Alt+Q)

2 18, Reset Excel's last cell (Ctrl+ Alt+R)

26 I

27@

23 @
3 ©
ELl /@

19, Save file and create backup... (Ctrl+Alt+S)
20. Vision Control... (CtrlsShift+1)

21. Mave selected dats (only values)... (Cirl+Alt+X)

22, Paste special (with combinations)... (Ctrl+ Alt=Y)

23, Insert current date and time with seconds (Ctrl+Shift=D)
24, Insert current time with secends (Ctrl+ Shift+T)

25. Find and run @ utility... (Ctrl+Alt+2)

33 Customize favorites menu

34@

26. Edit your faverite toels and shortcut keys...
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Example screenshot: 2 Change your favorite utilities and assign your own shortcut

ASAP Utilities - Edit your favorite tools and shortcut keys x
| Available tools: Your favorite toals:
Vision Control... » Vision Control... - a|| Select adjacent cells in column with the same value
Favorites & Shortcut keys = Edit your favorite tools and shorto! Reload all installed add-ins {rebuids the menu)
Select = Select cells based on content, formatting and more... Color each n'th row or column in selection. ..

Select » Conditional row and column select, hide or delete. .. ~|| Deselect cells...

Select » Mave or resize selected range. .. Set default path to current file

Select » Deselect cells. .. Create a list of filenames and properties in a folder...
Select » Inverse selection. .. Export selection or active sheet as new file...

Select » Merge selection of selected areas Find and/or replace in all sheets...

Select » Select adjacent cells below active cell with the same ve Apply formula/calculation to selected cells...

Select » Select adjacent cells in column with the same value S Start the last used utility again. ..

Select » Extend selection to the last used row Extend selection to the last used column

Select » Extend selection to the last used column | Extend selection to the last used row

Select » Select cell in selection where value changes Remave Move or resize selected range...

Select = Select cells with the smallest number Add new worksheet (fil in a name). ..

Select » Select cells with the largest number Select cells based on content, formatting and more. ..
Select » Select all cells with an error Change formulas to their calculated values

Select » Select all sheets in your workbook Lick numbering of selected cells. ..

Select » Select all objects on current worksheet

Select » Print preview selection Save file and create badkup...

Select » Print selection Vision Control...

Select » Set current selection to all worksheets Move selected data (only values)...

Sheets » Add new worksheet (fil in a name). .. Reset to default Paste spedal (with combinations)...

Sheets » Insert multiple sheets {uses the cell values as sheet i T = Insert current date and time with seconds

Sheets » Rename current sheet...

Insert current time with seconds
Sheets » Quiddy rename multiple sheets at once... j

Find and run a utility...

| ¥ Display submenu name in list shortout: Cirl+alt+R ;I assign |

Reset Excel's last cell

Close Create a list of all shortouts Save §a;e and |
| ose |
T T T T

Enter license

Enter license information.

Start the last used utility again...

Start the utility you last used from ASAP Utilities.

By default you can start this utility with the shortcut Ctrl+Alt+).

_ o -

Help  ASAP Utilities
mbers & Dates ~ @ Web ~ Q Imnport ~ {<:>} ASAP Utilities Options ~ @ Online FAQ %
t~ [ Information ~ (i) Export ~ £® Find and run a utility (i) Info Tip of
mulas ~ [ File & System ~ [ Start ~ *, Start last tool again ), Registered version  the Day
Options and settings Info and help Tips tricks
| 1 K L N (o] P Q R 5
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Find and run a utility...
Quickly find the utility you need.

With this utility you can search in the names and descriptions of all available tools in
ASAP Utilities.

You can also immediately run the utility from the results box or click the ?-button to view
the details and a screenshot (if available) on our website.

2 search (alt+Q)
—

File Home Insert Draw Page layout Formulas Data Review View Help ASAP Utilities Table Des| Start

i& E‘g B-ZCI):‘\ T Sheets ~ HZ Columns & Rows ~ = Numbers & Dates ~ @ Web v [ Impo* ~ {53 ASAP Utilities Options +
& - i - ~ 2 ion v v ili
Favorites & Vision Select &8 Range Al Objects & Comments Text F@ Infarmation [&ﬁ Export P Findandruna utility
Shorteut keys~ - Control ~ I Fill~ % Format ~ Jx Formulas ~ P File & System ~ [> start~ (", Start last tool again
Favorites Time saving tools Options and settings
Enter the keywords to
A2 search for and press Enter
| or click the search button D E F G H J
1 | Monthly Searches (Netherlands|
2 [shop nncl 4 13800000 2cennn
3 |machine ASAP Utilities - Finu a utility (search help) X
o | — A )
5 7 Search for: :’T select bold cells 1 ¥ show Description Search
3 search bl 4 y
| ‘ =
7 (| results 5 T iz
Py ~ ' Select » Select cells based on content, formatting and more...
9 |table
10 | cup With this tool you can select cells based on their value, formatting style and other properties.
11 |bean ‘You can for example select all cells between 50 and 250 or all bold cells or all red cells.
12 |green ‘You can use the following criteria to select cells based on their contents:
~between
2] sz -not between
14 |beans -equal to
15 -not equal to 3
I -greater than B .
16|t ~Jess than Quickly start this tool Add the tool to
- greater than or equal to
17 | pots - less than or equal to from the search results your favorites menu
12 |cups -begins with
- does not begin with p———————
19| cake -ends with
20 |equi t - does not end with
EQtipmen - contains
21 |company - does not contain View the description of
22 |recipe ~lke (text, with use of widcard characters)
- -not like {text, with use of wildcard characters) this utility on our website
23 |recipes -duplicate values
24 |break - unique values
- empty cells
25 | cups mugs -not empty cells
" -FALSE
26 |grinder CTRUE
27 [review - text length
- - values in lowercase
26 | IEEE - values in UPPERCASE
20 roasters -odd numbers
-even numbers
30 |buy -number {constant)
31 |grinders -number (formulz)
~number {ink to sheet)
32 |art - number {ink to file)
33 |club ~ formula with reference to flle ~
34 [filter ASAP Utilities 8.0 RC7 (September 20, 2022) © 1999-2022 Bastien Mensink - A Must in Every Office BV Close
35 |for sale
36 |ground 0,05 135000 480|
37 | maker keuri 0,4 135000 73|
P e . |
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Open the ASAP Utilities User Guide (English, PDF)...
Start the English User Guide (PDF-document) of ASAP Utilities.

In my opinion a good program should be easy to use without the use of documentation.
During the last years the need for documentation has increased. In this document you will
find detailed information about the installation, the use of the tools and a chapter where
we show you how to solve frequently occurring problems (or challenges) with the help of

ASAP Utilities.
= aim Q @) B | (B Fagoview | A Readalowd | (D Addtedt | ¥ Dram ' Highiight @ s =] B2 ® g
ASAP Utilities
user guide

“The friendly Excel add-in that makes
working in Excel much easier and faster”

Tip of the Day - View online

ASAP Utilities contains an incredible amount of small handy tools and it might be hard to
remember them all.

Each day we show you a handy tool that you may have forgotten about or never knew
existed.

Read the latest news on ASAP Utilities

This utility will open the news section from our website (www.asap-utilities.com) in your
default internet browser.

Notes:
The news is in English.
This only works if you are connected to the Internet.
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Visit the online FAQ: Frequently Asked Questions about
ASAP Utilities

This utility will open the support section from our website (www.asap-utilities.com) in your
default internet browser.

Do you have a question about ASAP Utilities or do you encounter a problem? Then please
first read our list of frequently asked questions (FAQ) on our website because chances are
big that you will find the answer there.

Notes:
The support section is in English.
This only works if you are connected to the Internet.

Check for new version on the ASAP Utilities website

This utility will open our website (www.asap-utilities.com) in your default internet browser
and shows you if there is a newer version of ASAP Utilities available.

If you want to be informed by email when a new version is released, you can subscribe to
our newsletter:

https://www.asap-utilities.com/asap-utilities-newsletter.php

Notes:
The website is in English.
This only works if you are connected to the Internet.

New tools in development (English only)

New tools that are currently in development. These tools are available in English because
they are still in development.

Bulk replace: replace multiple values at once

This tool allows you to do multiple replacements at once.

You can specify a range with 2 columns with search and replace values, which allows you to
do many replacements automatically after each other. The target can be a certain range,
your current worksheet, all selected worksheets, the entire workbook or any other
workbook that is opened.

The search/replace is done in both cell values and hyperlinks.

The range with these search and replace values are always excluded from the target range.
Your last used settings are remembered.

Change cells to MAC Address formatting...

This tool changes the MAC addresses (such as 0123456789ab) in your selected cells into a
more readable and standardized format.
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You can choose between the following styles:

= (01:23:45:67:89:ab
= 01-23-45-67-89-ab
= 0123.4567.89ab

If required this tool will automatically remove any spaces, hyphens (-), colons (:) or points(.)
first, so that you can also easily convert it from one format to another.

Convert long HEX values to ASCII text in selected cells

This tool converts (long) HEX values in the selected cells to ASCII text.

For example, it converts
"446f6e277420796f75207468696e6b207468617420457863656c2069732067726561743f"
to "Don't you think that Excel is great?".

It converts values like the following:

446f6e277420796f75207468696e6b207468617420457863656c2069732067726561743f
44-6f-6e-27-74-20-79-6f-75-20-74-68-69-6e-6b-20-74-68-61-74-20-45-78-63-65-6¢-20-69-73-20-67-72-65-61-74-3f
44~6f~6e~27~74~20~79~6f~75~20~74~68~69~6e~6b~20~74~68~61~74~20~45~78~63~65~6c~20~69~73~20~67~72~65~61~74~3f
44 6f 6e 27 74 20 79 6f 75 20 74 68 69 6e 6b 20 74 68 61 74 20 45 78 63 65 6¢ 20 69 73 20 67 72 65 61 74 3f
44:6f:6€:27:74:20:79:6f:75:20:74:68:69:6€:6b:20:74:68:61:74:20:45:78:63:65:6¢:20:69:73:20:67:72:65:61:74:3f

Delete all empty columns, including the columns that have a field name in row 1, but no
data

This will remove all completely empty columns on your worksheet, including the columns
that have a field name in row 1, but no data.

Detect adjacent row/column data and merge cells

This tool detects adjacent cells with the same value and merges those cells into a single
merged cell using Excel's merge.
You can choose to:

= merge cells vertically, per column, merge cells with the same value below it
= merge cells horizontally, per row, merge cells with the same value next to it
= set the alignment

= add borders

Useful for quick styling of tables for presentation purposes.

Insert a space before Capital Letters (e.g. 'BigBearLake' > 'Big Bear Lake')

This tool puts a space in front of Captital letters in the text in your selected cells.

For example "NewYork" becomes "New York".

This tool is smart enough to detect when a space should be inserted and when not.

A space is only inserted before uppercase characters when it is not already preceded by a

space and also when it is not preceded by any of the following characters: -""' (| =" [{< "
?
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Keep or delete certain Rich Text formatted characters...

This tool allows you to keep or delete the characters inside the cells in your selection that
have a certain formatting applied (* Rich text formatting).

You can choose to either keep or delete bold charters, italic characters, strikethrough
characters, single underline characters, double underlined characters or normal characters
within each cell in your selection.

(* Rich text formatting is a combination of font, font size, font style (for example, bold or
italic) and underlining formatting in a single cell.)

List all possible combinations from two or more lists/columns

This will create a list of all possible combinations from the data in two or more columns

Manage duplicated records

With this utility you can easily remove the duplicated records from your sheet.
You can also have it remove records from your sheet that already exist on another sheet,
which can for example be useful if you are working with mailing lists.

Put all data from the worksheet into one single column

This tool takes the data in each of the columns on your worksheet and puts this data below
each other in column A.

Refresh all external data ranges and PivotTable reports

This tool refreshes all pivot tables and external data ranges in your entire workbook.

Remove duplicated values per row in your selection

This will remove the duplicated values per row in your selection.

Report pivot table(s) information

This tool creates a report in a new workbook with information about the pivot tables in
your workbook.

The report shows the following information: Sheet, Data Source, Name, DataBodyRange,
DatalabelRange, RowRange, ColumnRange, TableRangel, TableRange2, Date last
refreshed, Refreshed by, RefreshOnFileOpen, Fields in source, Record in source, Fields
shown, SourceType, SourceDataFile, Connection, CommandText.

Select all shapes within the selected range

Selects all shapes that are inside or touch the selected range. Both visible and hiddens
shapes will be selected.

Clear Pivot Tables cache and refresh

Clears the cache from the pivot tables on the current worksheet or in the entire workbook.

Show indented structure of formula in current cell
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This tool shows the indented structure of your formula.
This is useful when you have a nested formula. That way you can more easily see if the
brackets are placed properly. You can also edit the formula.

Show or hide formatting marks in selected cells

With this tool you can make spaces, tabs and linebreaks visible. This can be useful because
sometimes characters such as these mess up your lookup formulas.

The following characters are used to show these characters:

? = space

- =tab

9 = line breaks

This tool changes your data when you choose "Show" but you can quickly switch back to
the original when you choose "Hide". Basically the method is quite simple. It replaces
spaces, tabs and line-breaks with a unique character. Then the "Hide" option changes these
special characters back to spaces, tabs or linebreaks again.

Unfortunately it is not possible to make it work without changing the values like the
hide/show formatting marks in MS Word. However we think that this tool is a useful
alternative.

Sort each column in selection individually ascending (top to bottom)

This tool sorts each column in your selection individually from top to bottom.

Sort each row in selection individually ascending (left to right)

This tool sorts each row in your selection individually from left to right.

Text to Columns based on in-cell formatting changes (split by bold, italic, color etc.)

This tool allows you to split the values inside the cells into separate columns, based on a
change in the applied formatting (* Rich text formatting).

It is a similar to Excel's Data > Text to Columns, however in this case the splitting is done
based on changes in the applied formatting.

For example, cell with the value "Drum [in bold] Tambour [normal] (f) [italic]" is then split
into three columns; Bold, Tambour, (f)

(* Rich text formatting is a combination of font, font size, font style (for example, bold or
italic) and underlining formatting in a single cell.)

Transform table into 3 column matrix (reverse pivot table)

This tool transforms a table into a 3 column table that you can easily use as a source for for
example a pivot table.

Trim leading and trailing line breaks

This will trim all leading and trailing line break characters in the selected cells.

Ungroup all grouped columns in the selected worksheets

This tool ungroups all the grouped columns in the selected worksheets.
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Ungroup all grouped rows in the selected worksheets

This tool ungroups all the grouped rows in the selected worksheets.

Example screenshot: 01 New tools in development

ASAP Utilities - Mew tools in development

Below are some tools that are being developed and tested and haven't been fully translated

and incorporated in the standard menu yet.
Furthermare these tools are only available in English until they get officially added to ASAP

Utilities,

Choose a tool to start:

| Select all shapes within the selected range j

*

Manage duplicated records

joJololololofoRodotototoleloRoRoRotodofo ool o R o)

Bulk replace: replace multiple values at once

Change cells to MAC Address formatting. ..

Clear Pivot Tables cache and refresh

Convert long HEX wvalues to ASCII text in selected cells. ..
Delete all empty columns, induding the columns that have a field name in row 1, but no data
Detect adjacent row fcolumn data and merge cells...

Insert a space before Capital Letters (e.q. 'BigBearLake' > 'Big Bear Lake")
Keep or delete certain Rich Text formatted characters...

List &ll possible combinations from two or more listscolumns,

Put all data from the worksheet into one single column

Refresh all external data ranges and PivotTable reports

Remove duplicated values per row in your selection

Report pivot table(s) information

Select all shapes within the selected range

Show indented structure of formula in current cell

Show or hide formatting marks in selected cells

Sort each column in selection individually ascending (top to bottom)
Sort each row in selection individually ascending (eft to right)
Text to Columns based on in-cell formatting changes (split by bald, italic, color etc.)
Transform table into 3 column matrix {reverse pivot table)

Trim leading and trailing line breaks

Ungroup all grouped columns in the selected worksheets

Ungroup all grouped rows in the selected worksheets

Example screenshot: 02 Bulk replace. Multiple find and replace actions at once

g
>
2
B
&

@
4

o

1
2 |AL Alabama
3 |AK Alaska
4 |az Arizona
5 |AR Arkansas
6 |8 asap utilities - Bulk replace: replace multiple values at once
7
T2 | 1. Choose the range with search and replace values 2. Replace within: 3. Laokin:
9 c : A2
ol e — BT A ¥ Cellvalues
B " Current worksheet: States r
1 This range will be exduded from the find/replace action. c
| ] Selected worksheets: 1 I Hyperinks
== Find: Replace with:
13 [N " The following worksheet:
-
=4 AL Alzbama -
141 K Alaska [ K
EE Az Arizona
el AR Arkansas @ Entire workbook: -
cA Calfornia =
17 co Colorado | Reportaisx ]
B T Connecticut
18 DE Delaware
19 FL Florida 4. Options
Bl Gh Georgia
el HI Hawaii [¥ Proceed to next cell and skip other replacements after a replacement
21 jis) Idsha
T2 | L Tlinois [ Match entire contents {recommended when you replace numbers)
N Indiana
23 1A Towa ¥ Match case
F KS Kansas
e KY Kentucky
25 LA Louisiana Iv Create a report that shows the changes that are made
26| ME Maine
=0 MD Maryland I~ Don't make any changes, just show what would be changed
27 MA Massachusetts
28| M Michigan
= MM Mirnesota
9 MS Mississippi
30| MO Missouri
el M Mantana =l Cancel
31 =
32
33 |NY New York
34 |[NC North Carolina
35 |ND North Dakota
36 |OH Ohio
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Example screenshot: 03 Change cells to MAC Address formatting

A B = D E F A B
| 1 |001c142bd38b 00:1c:14:2b:d3:8b
000c29cbfoae | 2 |00:0c:29:ch:f0:ae
| 3 |00056939843a | 3 |00:05:69:39:84:3a
N 4 |00:1c:14:63:6f:6b
ASAP Utilities - Change cells to MAC Address formatting T 00:1c:14:83-8a:35
Style for the selected cells: |6 |00:05:69:3f:cd:0f
& 01:23:45:67:8%:3b | 7 |0:05:69:d0:55:af
019345675935 | 8 |00:1c:14:e5:90:51
| 9 |00:05:69:4b:6e:6e
(" 0123.4567.89ab Cancel ' 10 |00:05:69:9d:a1:7b
| 11 |00:50:56:bc:f3:40
et ot e s nspere e (| |2 ooacaesaaar
with built-in networking capability. | 13 |00:05:69:bb:35:5e
e e 18 ooacascazab
transmission order (e.g. 01-23-45-67-88-ab or 01:23:45:67:8:ab). This form is also | 15 |00:50:56:69:af:ea
e R s fimocasasacss
17 |00:0c:
118 18 |00:0c:29:6b:63:53
| 19 |000c292a7ed5
' 20 |000c29cedscs
| 21| 000568b17533 | 21| 00:05:69:b1:75:33
| 22| 000568b26bd9 | 22 |00:05:69: b2:6b:d9
| 23 |0005696c6e09 | 23 |00:05:69:6¢:6e:09
| 24 |0005693d4690 | 24 |00:05:69:3d:46:90
| 25 |00505631b79f | 25 |00:50:56:91:07:9F
26 1r 26 I

Example screenshot: 04 Detect adjacent row column data and merge cells

1
2 |Austria Luthorcorp a0
SETE e E e i T G e e
4 |Austria S 55

2
5 |Belarus How to merge: This taol detects 55
6 |Belarus & Vertically S?Jauﬁnt uel\ls wnﬂ'j 32
7 [Belarus Merge cells with the same value underneath it nerges those cols a8
8 |Belarus © Horizontally intoa jﬂdue 24
9 |Belgium Merge cells with the same value in the column next to it s Wf:,gf”g 23
10 |Belgium Useful for quick 18
= Vertical slignment Horizontal algnment stying of tables for | f———
11 [Belgium presentation 7
i & Top  Left ]
12 [Belgium BriTE= a3
13 |Bulgaria " Center " Center 1
14 |Bulgaria £ Bottom  pight 14
15 [Bulgaria 7
16 |Bulgaria E==n 20
1T |Croatia I Add borders 26
18 |Croatia 21
19 |Croatia ncel 13
20 |Croatia 1
21 |Czech Repul a4
22 |Czech Republic  Spade And Archer 22 23 19 5
23 |Czech Republic  Monarch Playing Card Co. 59 32 24 19
94 lrsoch Ranuhlic  Rahata Inductrioe 2a sa 27 A

Example screenshot: 05 Insert a space before Capital Letters

B c D , E F A
1 1 -
| 2 [NewYork y 2 |New York
3 |CampbellRiver 3 |Campbell River
4 k. - 4 |Dawson Creek
5 |GrandrFof ASAP Utilities - New tools in development 5 |Grand Forks
5 Below are some tools that are beng developed and tested and haven't been 5 [New Westminster
7 |NorthVs fully translated and incorporated in the standard menu yet. 7 |North Vancouver
8 Z:z?jgz;ﬁis;‘xz\‘s are only available in English untl they get offically 8 ce George
9 9 |Prince Rupert
10 | Choose a tool to start: 10 |Salmon Arm
L ’7| Insert  space before Capital Letters (.0, ‘BigBearLake’ > ‘Big Bear v | il el ReE
12 12 |williams Lake
13 |Baie-Conl| G 13 |Baie-Comeau
14 |pri o=l | oK | 14 |Prince Edward County
15 15
| 17 [CustomerName | 17 |customer Name
18 |CustomerCity 18 |Customer City
19 |CountryCode 19 |Country Code
20 | ThislsMyVariable 20 |This Is My Variable
21 21
22 22
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Example screenshot: 06 Keep or delete certain Rich Text formatted characters

A B £ D E
1 |Excel Settings Paramétres Excel (f)
2 |User settings Paramétres personnalisés (f)
3 |Worksheet Setting Paramétres de la feuille de calcul (f)
4 |Workbook Setting Paramétres du classeur (f)
5 |Textfile Fichier texte (f)
6 |Range Plage (f)
7 |Wer 5

ASAP Utilities - Keep or Delete Rich Text Formatted Characters
8 |Shee
9 |Werl
—] ks Keep or Delete the characters inside each cellsin
10 |cell @ Keep ont your selection that have a certain formatting
P only
11 |cha zpplied.
| petete only
12 Rich text formatting is a combination of font, font
13 - size, font style (for example, bold or italic) and
L= underlining formatting in a single cell
L % Bold characters
15 A
- " Italic characters
1 Text with mixed formattin
" Strkethrough characters | " lormatting

17 2 is called Rich Text Formatting
18 ¢ Single Underined characters 3
15 " Double Underlined characters
20 " Normal characters
21
23
24 \
25

A B C D E
1 [Excel Settings
2 |User settings
3 |Weorksheet Setting
4 |Workbook Setting
5 |Textfile
6 |Range
7 kbook
3 |Sheet
3 |Worksheet
10 |Cell
11 |Chart

Example screenshot: 07

ASAP Utilities - Handle duplicate records

Choase your dataset(s) fram the currently open workbooks

Dataset 1 | [ook1] : Sheett
Dataset 2 |

Ll

Action

" Remove duplicated records from Dataset 1

" Remove the records from Dataset 1 that are found identical in Dataset 2
-

Comparison

I™ Case sensitive
¥ Ignore leading and trailing spaces (example: "bastien” equals * bastien”)

r

Option
I™ Hide the rows instead of removing them

¥ Tell me upfront how many duplicated records are found

Cancel
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Example screenshot: 08 Text to Columns based on in cell formatting changes split by bold
italic color etc

A B [+
| 1 |Excel Settings Paramétres Excel (f)
|2 |User settings Paramétreg personnalisés (f)
| 3 |Worksheet Setting Paranyétres de la feuille de calcul (f)
| 4 |Workbook Setting Paramiztres du classeur (f}
| 5 |Text file Fichier texte (f)
6 |Range N 3
T Workbi ASAP Utilities - New tools in development
| 8 |Sheet Below are some tools that are being developed and tested and haven't been
o |Worksl| | fll¥ transiated and incorporated in the standard menu yet.
T Furthermore these tools are only available in English until they get officially
| 10 |Cell Cel | added to ASAP Urtiities.
11 |Chart G
ST Choose a tool to start:
13 ’7| Text to Columns based on in-cell formatting changes (splitby boid, il 7|
14
g Cancel
16
17 “
18
19
an
A B [+
Excel Settings Paramétres Excel f)
| 2 |User settings Paramétres personnalisés f)
| 3 |Worksheet Setting Paramétres de la feuille de calcul f)
4 |Workbook Setting Paramétres du classeur f)
| 5 |Textfile Fichier texte f)
6 |Range Plage )
| 7 |workbook Classeur )
| 8 |Sheet Feuille f)
| 9 |Worksheet Feuille de calcul f)
|10 |cell Cellule f)
| 11 |Chart lGraphique f)
12

Close ASAP Utilities

Close ASAP Utilities.
ASAP Utilities will be closed and disappears from the menu bar.

Fle  Home Inset Draw Pagelayout Formulas Data Review View Help  ASAP Ut

<& B [ | Foes oot

Fwortes & | Vison | Select | 1 Rangev ¥ Objects & Comments v

jurmibers & Dates » | 2 Web =

et « [ Informationy

Shottitkess | Contol  + @Fil- [ Fomat~ i Formos ~ B i & Systern -
Favortes Time sauing toaiz

a1 ~ =
A 5 c o £ r s H ' M

LN —

z

3

4

5 ASAP Utilities - Close ASAP Utiities. x

L]

7

a e Adt you sure ou want 1o dose ASAP Utites?

9

1

n ok ]| canea

Fle Home Insert Draw Pagelayout Fommulas Data  Review View Help

o = An &A= 1 wop et o
= Format Painter rTu-d-je-a- = Bl MegenConter ~ B~ % 9
undo Cuptont = Font = Algnmert & -
a1 . 5
s 5 c o e v s " ] i 3 . “

1

2

3

q

s

G

7

8

s

10

n

12

n

1

5

1

n

.

9

=

2

2
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Show me the time that I saved by using ASAP Utilities

This tool creates a report in a new workbook with in it which tools you have used, how
often you used them and how much time this has saved you approximately. (Only
completely executed tools are counted.)

You can enter your hourly rate to estimate how much money you have saved.

You can also use this report to show your colleagues and friends which tools you use the
most.
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5.5.20Find and run a utility...

Quickly find the utility you need.

With this utility you can search in the names and descriptions of all available tools in
ASAP Utilities.
You can also immediately run the utility from the results box or click the ?-button to view
the details and a screenshot (if available) on

our website.

£ Search (alt+Q)

File Home Insert Draw Page layout Formulas Data Review View Help  ASAP Utilities Table Desi Start
‘& 1;[ ET Sheets~  HF Columns & Rows ~ := Numbers & Dates~ | @3 Web ~ [ Impo=~ £5% ASAP Utilities Options ~
Favorites & Vision Select Eﬂ Range ~ ?J Objects & Comments v Text~ E) Information ~ Eﬁ Export ~ ,@ Find and run a utility
Shortcut keys ~ | Control e {1F Fill ~ [ Format ~ Jx Formulas ~ [ File & System ~ [> start~ ", Start last tool again
Favorites Time saving toals Options and settings
Enter the keywords to
A2 ~ | search for and press Enter
| A or click the search button D E F G H ! J
1 ord [ es [ Local Monthly Searches (Netherlands) [l
2 [shop nne L 132nnnAn 3zonnn
3 e ASAP Utilities - Finy 3 utility (search help) P4
)| — A 3
5 Search for: select bold cells 1 ¥ Show Description Search
search Bl p
6 | | =
7 results
2 '} Select » Select cells based on content, formatting and more...
9 |table
10 [cup With this tool you can select cells based on their value, formatting style and other properties,
‘You can for example select all cells between 50 and 250 or all bold cells or all red cells.
11 |bean
12 |green ‘You can use the following criteria to select cells based on their contents:
~between \
) itz ~notbetween
14 |beans ~equal to
15 -notequal to 3
mup) -greater than ) )
16 [mugs ~less than Quickly start this tool Add the tool to
~greater than or equal to
17 [pots ~Jess than or equal to from the search results your favorites menu
12 [cups ~begins with
~does not begin with [ p—eeer
19 |cake -ends with
20 |equi t - does not end with
S - contains
21 [company -does not contain View the description of
22 |recipe ~like (text, with use of wildcard characters)
- -nitlike (text, with use of widcard characters) this utility on our website
23 |recipes - duplicate values
- unique values
24 |break - empty cells
25 |cups mugs -not empty cells
26 |grinder :"I:'QILISEE
27 |review - text length
BT " - values in lowercase
feviews - values in UPPERCASE
289 [roasters - odd numbers
~even numbers
30 |buy - number (constant)
31 |grinders ~number (formulz)
| ~number {ink to sheet)
32 Jart - number (ink to file)
13 [ctub - formula with reference to file =
34 [filter ASAP Utiities 8.0 RC7 (September 20, 2022) @ 1999-2022 Bastien Mensink - A Must in Every Office B Close
35 |for sale
36 |ground 0,05 135000 480|
57 | maker keuri 04 135000 73|
= === —1
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5.5.21 Start the last utility again

Start the utility you last used from ASAP Utilities.

By default you can start this utility with the shortcut Control+Alt+).

£ Search (Alt+Q)

Help  ASAP Utilities

mbers & Dates ~ @ Web ~ [ Import ~ {54 ASAP Utilities Options ~
Tt F@ Information ~ [&% Export ~ ,@ Find and run a utility
mulas E] File & System ~ [> Start C.Startlasttoolagain
Options and settings
1 K L N o} P

() Online FAQ
@ Info

Q Registered version
Info and help

xS

Tip of
the Day

Tips tricks

5.5.22 Info...

Information about the tools available in ASAP Utilities, version number etc..

ASAP Utilities 8.0 - Registered version

-& asap utilities

List of all tools

Reviews (English)

About ASAP Utilities

3
ASAP Utilities makes working in Excel faster and easier with over 300 ;I
useful and powerful tools. Since 1993 it has grown to become probably
one of the world's most popular add-ins for MS Excel.

Our goal is to make work easier for Excel users, both beginner and
expert.

We are open to new ideas and suggestions. If you contact us, please use
English or Dutch.

Have fun!

Bastien Mensink (bastien@asap-utiliies.com)
A Must in Every Office BV, The Metherlands

Version info

ASAP Utiities 8.0 (October 4, 2022)
1 1995-2022 Bastien Mensink - A Must in Every Office BY
support@asap-utiities.com - https: /fwww.asap-utilities.com Close

Lackergnome:

'If you're not an Excel
powerhouse right now,
ASAP Utilities can transform
you into one avernight.'

PC Magazine:
'One of the best kept
secrets for Excel users.'

The Office Letter:
'ASAP Utilities Supercharges
Excel for Free'

Show me the time that I saved
by using ASAP Utiities
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Practical Tricks to Save
Hours 1n Excel with
ASAP Utilities

Latest tips on our website

Discover how ASAP Utilities makes YOU rock in Excel.
These short tutorials are guaranteed to save you time and speed up your work in Excel:

https://www.asap-utilities.com/tips.php

https://www.asap-utilities.com/discover.php

How to... examples

In this paragraph we show you some of the most asked questions we received either by
email or found in the newsgroups or online forums, and that can be (or have been) solved
by using ASAP Utilities.

Several questions can be similar here and have the same answer. Despite, we still list them
all because in those cases the problem was described in a different way.

We would like to use this opportunity to say a big THANK YOU to everybody who is active
on the Excel newsgroups and forums answering questions; especially those writing how to
solve problems with the help of ASAP Utilities.

We think reading this chapter might give you an idea how to solve certain issues with the
use of ASAP Utilities.

Delete only the even rows in your spreadsheet
Is there a way | can delete only the even rows in my spreadsheet?

| have over 6000 rows and | only need the odd ones

ASAP Utilities » Select » Select cells based on content, formatting and more...

In the form choose “even rows” then “select”. When selected right-click on a cell in your
selection and choose “Delete...” and select “Entire row”
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Automatically alternate row colors

How can | set up alternating row colors in Excel? | don't want to have to change the row
colors every time | insert, delete, or move a row

ASAP Utilities » Columns & Rows » Color each n’th row or column in selection...

Create a hyperlink to each sheet

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)...

Copy a long list of file names

| have a long list of file names (240 from a search) that | need to put into Excel. Copy won't
do it. How now?

ASAP Utilities » Fill » Create a list of filenames and properties in a folder...

How can I importing a folder of filenames into Excel?

I would like to download file names from a directory to MS Excel.

ASAP Utilities » Fill » Create a list of filenames and properties in a folder...

Extract value

How can | get the numeric value from the cell: "$4.57 dividend"?

ASAP Utilities » Text » Advanced character remove or replace...

Then select all except the numbers and the decimal character, which in this case is a point.
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ASAP Utilities - Advanced character rermoval/replace
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Perform action on: Replace each selected
Spaces Symbols character with:
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Invisible | Ling breaks | W Ess

Close ¥ Auto dose

Removing spaces in cells with data in it

We have a personnel roster that is kept in a database. Occasionally, this roster is exported
into Excel and sent out to members of the department. In one column are dates that each
person was employed. When | try to sort the entire roster, it doesn't come up right because
most of the cells that contain the date have spaces in front of it.

Sometimes it is 1 or 2, sometime more, other times there are no spaces.

In order for me to sort the entire roster correctly, I'm having to manually remove the
spaces in front of the date, then sort the roster according to date.

There are over 500 entries in this roster, is there a better way to remove the spaces other
than manually?

ASAP Utilities » Text » Delete leading, trailing and excessive spaces

Extracting Text only

I'm trying to extract text only from a column of cells with varying text and number strings.
Sometimes the cell starts with numbers, other times text. There is no constant for the
number at the beginning of the cells.

ASAP Utilities » Text » Delete all numbers in selection

or

ASAP Utilities » Text » Advanced character remove or replace...

Then select all except the letters.
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Strip leading spaces from cell

I need a formula to remove/delete leading spaces from a cell. Column b contains data
imported from another application. Unfortunately, some of these cells have padded leading
blanks added. | need to remove these, but 3000+ cells individually will take hours.

ASAP Utilities » Text » Delete leading and trailing spaces.

(note: this will also delete trailing spaces in each cell).

How to make duplicate entries blank

| want to make a column that lists "city name" to only show each name once, and then
leave each repeat of the name blank. Is there a formula for this?

ASAP Utilities » Range » Clear duplicated values in selection (leave one original)

Printing a Column in Multiple Segments on One Page

| have a list of names in a spreadsheet column. The data takes up, say, % of the page
horizontally. Let's say | have 200 names, and want to print them in columns of 50. In other
words, they should all be able to fit on one page - 1-50 in column 1, etc. | can cut and paste,
but that's rather labor intensive. | can print 4-up, but that reduces the font size so that it's
practically invisible.

Is there anything else | can do?

ASAP Utilities » Format » The paper saver (split columns)

Trailing negatives imported from ASCII file

How do | change a column of trailing negatives for example 123- to -123?

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65)

Deleting empty rows

Is there an easy (quick) way of deleting empty rows in a large spreadsheet?

ASAP Utilities » Columns & Rows » Delete all empty rows

Delete rows if Col C has a 0 value in it

What formula please will delete rows if Col C has a 0 value in the cell?
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ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete...

Inserting rows

| have a spreadsheet that is approx. 200 rows long and | need to insert a new row after each
existing row.

ASAP Utilities » Columns & Rows » Insert empty rows or columns in between...

White Space in a Cell

| 'm collating a lot of spreadsheets that many other people have filled in onto one big
spreadsheet template.

My problem is that there is a free text cell and, because people don’t know about the 'alt &
enter' option, they've hit the space bar many, many times make it look like a new point
starts on a new line.

In Word, you have the option of showing all the keyboard strokes so you can tell what
people have done - but I'm finding | have to go into each free text cell and hit delete, then
the cell magically shifts up so that there is no white space.

Any ideas? My document is currently 200 pages long and I'm nowhere near done!

ASAP Utilities » Text » Delete leading, trailing and excessive spaces

How do I conditionally delete rows based on cell contents?

ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete...

Coloring every other row in a range

ASAP Utilities » Columns & Rows » Color each n’th row or column in selection...

Removing Carriage Returns in Excel

To remove only trailing carriage returns:

ASAP Utilities » Text » Remove ending carriage return (alt+enter character)

To remove all carriage returns (the so called character 10 and 13):

ASAP Utilities » Text » Advanced character remove or replace...
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Then select the “line breaks” button:

[ Asa tites - Advanced character removal/replace
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Perform action on: Replace each selected

character with:
[¥ Constants
™ Formulas
Close ¥ Auto close oK

20 How to shade every third row?

ASAP Utilities » Columns & Rows » Color each n’th row or column in selection...

Choose a color and set the steps to 3.

-
ASAP Utilities - Color each n'th row or column

— Options

Color: I 15 Q. _| Give color to:

% Rows
Steps: I 3 a
 Columns

v Remove existing colors

— Color method:

' Standard cell coloring
[v Skip hidden rows/columns

" Conditional formatting (advanced)

With thiz option the colors will be automatically updated when you insert or
remove rows or columns, To remove the color choose in the Excel menu
'Format’ = 'Conditional Formatting' then remove the condition that sets the
alternate colors (by default condition 1).

Cancel |

21 How canltranslate a comment to text in a cell?

You can the function =ASAPGETCOMMENT() to read the comment of a cell.

Or you can use:

Objects & Comments » Comment tools...

288

Chapter 6



22

23

24

“Happiness inspires productivity” ASAP Utilities User Guide

And then choose “Extract/report content of comments”

ASAP Utilities - Comment tools

Extractfreport content of comments

(* ‘Place the value of the comment cel right next to the comment (on the entire shest);

" Create reportin new workbook
(sheet name - cell address - range name - cell value - author - comment value)

Position and size of comments
where:

[s) 12
A =

™ Reset all comments to their original position

(¥ this worksheet
™ autofitfresize all comments " &l warksheets
Set font and font size for comments
where:
don't change || don'tche~| | & this worksheet oK

" all worksheets

Search and replace in comments
where:

old value:

%+ this worksheet
new value:

" al worksheets

Close

E

How to convert Excel imported numbers from text to
numbers?

We have a software package from which we can export data to MS Excel. However, when
exported it arrives in Excel as text. Even though they are numbers, they act like text. The
only way to convert them text to numbers is to edit the cell (press F2) and hit enter. I've
tried every other method of copying and pasting (even pasting special), but nothing seems
to work.

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers

Sorting Excel worksheets by worksheet title

ASAP Utilities » Sheets » Sort all sheets...

Beginning zeros won't hold in field when saving as .CSV

When saving an Excel spreadsheet as a .CSV (comma delimited) file, beginning zeros
disappear. The only way | know to keep the zeros is to format the field as 'text.' However,
.CSV files wipe out all formatting. Is there a way to KEEP the zero in the number '08'
instead of '8' when saving as .CSV?

ASAP Utilities » Export » Export selection or active sheet as new file...

In the “How to export” select “As displayed”, and in the “Format to export” select CSV.
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Print multiple sheets in one print job

| want to print several worksheets (e.g. sheetl, sheet 4, and sheet5) in one print job. This is
a frequent task for users of one spreadsheet and would be much more convenient for
them. | could probably write a macro to print each sheet individually, but it would be nice
to print all at one time and have the printer staple them together.

ASAP Utilities » Sheets » Print multiple sheets at once...

Reverse the sign in a range of cells?

| have a spreadsheet that is generated from an accounting program. It generates the debits
as positive numbers and the credits as negative numbers. Is there a way to highlight a
group of cells and reverse the sign on that group or range?

There a few ways to do this. You can either multiply all values with -1:

ASAP Utilities » Formulas » Apply formula/calculation to selected cells...

or

ASAP Utilities » Numbers & Dates » Change negative numbers to positive and vice versa...

Ending spaces need to be removed

| have exported an SQL database table to a text file and need to do some work on it in
Excel. Each field is comma-delimited. However, the table must have used fixed field
lengths because the data now has blank spaces at the end of every field. | want to remove
the extra spaces.

ASAP Utilities » Text » Delete leading and trailing spaces.

(note: this will also delete leading spaces each cell).

Auto-naming of Sheets?

| have a list of numbers all 8 digits in length (roughly 200 numbers). | need a separate
worksheet for each number. Is there a way of taking each number, inserting a worksheet
and naming it according to the number?

Select the cells with the numbers and then:

ASAP Utilities » Sheets » Insert multiple sheets (uses the cell values as sheet names)...
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Printing question on a long list

| have a fairly long excel sheet, it's about 800-something rows but there aren't too many
columns. How can | make it wrap up and print what would normally be 2 pages on to one
page? The printer settings aren't working right and I’'m getting it to be terribly small when |
try and change those to fit. Do any of you know how i could do this? I'm pretty sure this is a
really simple task and | just have never had to use excel for anything this long before or
cared about manipulating it so that it could be done again.

ASAP Utilities » Columns & Rows » The paper saver (split columns)...

Mass Remove Hyperlinks

| want to remove 1200 Hyperlinks, is it possible to do it mass?

ASAP Utilities » Web » Remove all hyperlinks in selected cells

Automate naming of tabs

In Excel 2002 XP | have a workbook with 13 spreadsheets. | need to automate the naming
of the tabs on each spreadsheet so that each spreadsheet assumes the name of the
contents of cell P1 for that respective spreadsheet. For instance, if the contents of cell P1
are 1999, the tab needs to be 1999. If the contents of cell P1 are changed to 2000, | need
the tab to be 2000.

ASAP Utilities » Sheets » Change name of selected sheets to selected cell’s value

Leading zero conversion problem

| have exported data from Outlook 2002 Contacts into an Excel file. In the export process,
all the leading zeros in the zip codes have become "". For example, a Contacts zip code of
01075 has become '1075 in Excel. | tried using Excel "Find and Replace" to replace "™ with
"0", but Excel can't find the """ in the spreadsheet, although it shows in the cells.

You can either use the number format “00000” to have the values displayed with leading
zeros, or use ASAP Utilities to add the zeros:

ASAP Utilities » Fill » Fill up with leading zeros...

Protecting multiple worksheets easily

Is there a way to protect worksheets without having to do each one individually?

ASAP Utilities » Sheets » Print multiple sheets at once...
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Sorting Worksheet Tabs
| really need to sort multiple worksheet tabs within a workbook. | would like to sort them

numerically.

ASAP Utilities » Sheets » Sort all sheets...

Newspaper Columns

| have a long list of data consisting of three narrow columns. When | print the sheet, I'd like
to repeat the set of three columns a few times per page (exactly like a telephone book) to
prevent wasting paper.

ASAP Utilities » Columns & Rows » The paper saver (split columns)...

Changing range of cells to absolute references?

| am trying to figure out a way to change a table of formulas with multiple cell references to
absolute cell references. Does anyone know how to do this without going into each cell
and editing each one manually?

ASAP Utilities » Formulas » Change formula reference style (e.g. Al to SA1 etc.)...

Mainframe download to Excel has minus sign at the end of
the number

The report has positive and negative numbers in columns. The positive amounts do not
have a sign and are recognized in Excel as number format. The negative amounts have a
sign at the end of the number. Excel recognizes these as text format. Is there an easy way
to reformat all the amounts with a negative sign to be recognized as number format in
Excel?

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65)

Unhide hidden Sheets

Is there a way to unhide multiple sheets at one time without code?

ASAP Utilities » Sheets » Unhide all sheets

Making Cells Absolute

| have a spreadsheet that has 75 columns with data that is from two other sheets. Stupid
me when | did the formula | did not make it absolute, so now when | sort it the formulas
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change. Is there any way | can make the formulas absolute without going into every cell
and changing?

ASAP Utilities » Formulas » Change formula reference style (e.g. Al to SA1 etc.)...

Save selection as jpeg

| have just bought a mobile phone which allows me to view jpeg images. | would like to
carry around some information that | have on Excel sheets. Can | convert a sheet or a
selection on a sheet into a jpeg image?

ASAP Utilities » Export » Export selected chart or range as image (file)...

Password protecting multiple sheets

Is there a way to set a password for multiple sheets without having to set each one
separately? | have over 60 sheets in one of my workbooks. | don't want to protect the
whole workbook with a password because the file is used by other users but rather lock
cells in each of the sheets with a password thereby allowing users to only edit certain cells.
Because | have many packages to do, | don't want to be setting these passwords for over
600 sheets.

ASAP Utilities » Sheets » Protect multiple sheets at once...

Reversing a cell

I need a function that will reverse the data in a cell. For example if the value in a cell Al is
"xyzzy", then REV(A1) would be yzzyx. If the value in cell Z19 is "32767" then REV(Z19)
would be 76723.

ASAP Utilities » Text » Reverse text in selected cells

Edit Data - add *1000 to multiple cells, possible?

| have a set of data and | want to multiply each cell by 1000 so want to add *1000 in about
30-40 cells together. Is there any way to do it quickly rather than going into each cell
manually and entering *1000?

ASAP Utilities » Formulas » Apply formula/calculation to selected cells...

Printing a Price Guide

| have a price guide of 4 columns with about 6000 rows. In Word, you can specify the file to
print multiple columns on a page before creating the next page. | have scaled the output to
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65% and would like the 4 column worksheet to print at the top of the next print column
instead of creating the next page. How would | do this?

ASAP Utilities » Columns & Rows » The paper saver (split columns)...

Is there a quick way to merge workbooks?

Is there a quick way to merge workbooks, either by merging open workbooks or by merging
them before they are opened?

ASAP Utilities » Import » Merge and/or import multiple files...

Printing Long Columns

| have a simple worksheet with order numbers in column A and corresponding completion
dates in column B. Since there are over 1,000 orders, it takes many pages to print the sheet,
with a great deal of paper wasted on the blank area to the right of the two columns. Other
than the tedious process of cutting and pasting, is there a way to arrange the information
into multiple columns across the page?

ASAP Utilities » Columns & Rows » The paper saver (split columns)...

Converting numbers into text

| am trying to convert numbers into text. | have tried formatting but it does not work. | am
importing these excel data into SAS and SAS does not recognize the formatting. | think |
need a quick way to add an apostrophe in front of all my numbers, how?

ASAP Utilities » Numbers & Dates » Change values to text values (adding ‘ in front)

Unhiding work sheets

Is there any way to unhide multiple worksheets at one time? Currently, | can unhide a
worksheet by clicking on Format, Sheet and Unhide and then double clicking on the specific
worksheet.

ASAP Utilities » Sheets » Unhide all sheets

Is there a function to covert numbers into text?

Is there a function to convert a number, for example 23, into text, for example twenty-
three?

ASAP Utilities » Numbers & Dates » Spell/write out numbers or amounts (EN, DE, NL)...

294 Chapter 6



50

51

52

53

54

“Happiness inspires productivity” ASAP Utilities User Guide

How to remove a macro
How do | find a macro in a worksheet and then remove it?

If you want to remove all macros from your workbook:

ASAP Utilities » File & System » Remove all macros (VBA code) from current file

Printing a list of all named ranges

Is there a way to print a list of all the named ranges used within a worksheet/workbook
along with their respective references?

ASAP Utilities » Information » Create a list of all range names in the workbook

Adding 1 before phone number
| am looking to add a 1 before all of my long distance phone numbers...but | don't want to

go through every cell and add 1...is there an easier way??

ASAP Utilities » Fill » Insert before and/or after each cell in your selection...

Remove alphabet from a string

May | know is there any function or any method that | can remove ALPHABET characters
leaving only NUMERIC value? What | currently doing is that | been using formulas such as
MID, LEFT & RIGHT to remove the ALPHABET and special characters. This method is indeed
tedious. | am very curious to know if you have any better method to recommend.

Example:

Invoice Number Result
IV3F02/49271 30249271
IES-30600001 30600001
C31946 31946

ASAP Utilities » Text » Delete all text characters in selection

Negative sign at right of number acting as text field

| am importing some numbers into a spreadsheet that have the negative on the right side of
the number. Any idea on how to get that to be a number instead of a text? The normal just
clicking format and changing to currency doesn’t work, because it expects the negative sign
in front.

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65)
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Printing wrapped columns

I'm trying to print 2 columns of data over several columns on one page. I've seen a few
similar posts on other newsgroups but have not seen a solution. Any help would be
appreciated.

ASAP Utilities » Columns & Rows » The paper saver (split columns)...

Convert ALL CAPS to lowercase

Is there a way that | can take an Excel sheet that is entirely in all caps, and with a few steps
convert all text to lower case with first letter capitalized?

ASAP Utilities » Text » Change to lowercase

Save a sheet or range as XLS file

How can | save only the active sheet or my selected range as Excel file?

ASAP Utilities » Export » Export selection or active sheet as new file...

Show locked cells

| have an excel sheet with certain values to may not be changed and certain cells that users
have to fill. However it now appears some of the input cell are also locked. How can |
quickly see which cells are locked?

ASAP Utilities » Select » Select cells based on content, formatting and more...

Now in the “Based on formatting and more” tab you can choose to select all protected cells
or all unprotected cells.

Find Duplicates

| want to check for duplicate values in an array. If a duplicate is found | would like the font
color changed to red.

There are two options:

ASAP Utilities » Range » Count and/or color duplicates in selection...
This utility has the option to color all duplicates found.

or

ASAP Utilities » Select » Select cells based on content, formatting and more...
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Now in the values tab you can choose to select all duplicate values. When selected, you can
paint them any color you want.

Is There a Way to Print List of Worksheets

| have a workbook set up with over 100 worksheets, each of which is labeled. Is there a
way to print only a list of all the worksheets in the workbook?

ASAP Utilities » Information » Create a list of all sheet names

You can also create an index sheet that contains a list of all sheet names with a hyperlink to
the sheet:

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)...

Saved HTML more efficient

| need to make several Excel tables available as html. When | save them as .html in Excel the
files get way to big and they contain a lot of inefficient html code. Is there a way or a
program to create a more efficient (smaller) html output of Excel tables?

ASAP Utilities » Export » Export selection as HTML table to clipboard...

Naming Sheet Tabs

Is there a way to put a formula (or something) in a sheet tab that will enable me to name
the tabs based on list in one of my worksheets? Example: In a worksheet, A1=Mary,
A2=Brett, A3=James. The sheet tab 1 will be named Mary, sheet tab 2 will be named Brett,
and sheet tab 3 will be named James? Also, if | change the names on my list, then the sheet
tab will auto update with the new entry.

ASAP Utilities » Sheets » Insert multiple sheets (uses the cell values as sheet names)...

Erase all links in spreadsheet

I'm looking for a solution to remove all the internal hyperlinks | have in one spreadsheet.

ASAP Utilities » Web » Remove all hyperlinks in selected cells
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Is there an easy way to make cells absolute?

The only way | currently know how to make a cell absolute is to physically type in the "$" in
front of the row and column references for the cell. Is there a formatting tool that will
allow me to highlight a section of cells that all need to be absolute so | won't have to type in
"S" for the next 3 hours.

ASAP Utilities » Formulas » Change formula reference style (e.g. Al to SA1 etc.)...

Right side negative

In Excel, how can | convert right side negatives to left side easily?

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65)

Function to write amounts.

Is there a function for excel that writes amounts expressed in letters? | mean, if | have a
column with $ 22, I'd like to have another column that says Twenty two dollars.

ASAP Utilities » Numbers & Dates » Spell/write out numbers or amounts (EN, DE, NL)...

Adding a character to every cell in a column

| have a column of numbers, and | want to add a numeric code to the beginning of each of
these number strings. How do | add the same thing to multiple cells at once?

ASAP Utilities » Fill » Insert before and/or after each cell in your selection...

Invert a selection

| have certain cells which have a red background. | can easily find them with the find and
then format commands. This will highlight only those cells which fit the find criteria, or red.
Then, | want to invert the selection to find all cells which are not red.

ASAP Utilities » Select » Select cells based on content, formatting and more...

Select the based on formatting tab and choose cell color. Then select one of the cells as
source for example cell D17 if that has the color of the cells you want to select.
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r ~

ASAP Utilities - Advanced cell selecting

Based on content  Based on formatting and more l Date ]

Select all cells based on its format:

cell color j of cell: D17 B

Select in 32186 cells:
5 Range: AL:G4593 ]

™ Worksheet r (" Entire column

Close [V Auto dose after selecting

o+ Cel

" Entire row

After you have selected all the red cells this way, you can use the following tool to inverse
your selection:

ASAP Utilities » Select » Inverse selection...

Deleting rows with bolded text and numbers

| have a large worksheet and | want to delete all rows with bolded text and numbers. Is
there a quick way to do this?

ASAP Utilities » Select » Select cells based on content, formatting and more...

Select the “based on formatting and more” tab and choose “font=bold”.
Then when all the cells with bold text are selected, you can delete the rows by using Excel’s
Edit » Delete » Entire Row....

Deleting a Macro from a worksheet

Somehow | created a macro in a worksheet that I'm working on. It is setup on a control box.
| deleted the unwanted macro from the sheet, however I'm still prompted to enable macros
when opening the work sheet. | can't have this. | entered the VB editor and it’s still listed on
the worksheet.

ASAP Utilities » File & System » Remove all macros (VBA code) from current file

Deselecting a cell or column once selected via Ctrl Key

This happens on a regular basis, as | am Ctrl or Shift selecting a multiple range of cells via
the Ctrl or Shift click method, | will hit a wrong cell or column or row. | want to deselect this
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selection, but have not found a way to do so. If | attempt to click on the area | just
incorrectly selected, it highlights it but does not deselect it.

How do | perform this task of deselecting without starting all over?

ASAP Utilities » Select » Deselect cells

Unhighlighting a single cell?

In excel when you hit the ctrl button to highlight various cells you may highlight cells a1, a5
a9 al3 but then decide you don't want a5 highlighted. How do you unhighlight cell a5
without having to unhighlight all the others? This is very frustrating especially when you've
highlighted many cells and then the very last one you don't want highlighted.

ASAP Utilities » Select » Deselect cells

I need to add the same data to all values in column

| have a column of data for example the first couple of values in the column are: 3125019
and 3125021, now this is a long list and | need to add the letters RT to the beginning of each
value without doing so manually, any ideas?

ASAP Utilities » Fill » Insert before and/or after each cell in your selection...

Apostrophe’s gone mad

I'm exporting a bunch of account numbers (all numeric) to Excel. The problem is that all the
numbers are exported with an apostrophe. | do not need them. Is there any way | can
remove all apostrophe’s?

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers

Converting 65- to -65

Can someone help with a code or formula to convert 65- to -65? For example tailing
negative sign to be made preceding the number

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65)

Formatting PROPER to entire column?

Is it possible to use the PROPER function to do an entire column instead of taking each cell
separately?
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ASAP Utilities » Text » Convert to UPPERCASE

Getting to underlying url in a cell

| have pulled in info from a web table, in column A about 250 records is a named hyperlink
(i.e. says Google) but the hyperlink is https://www.google.com. | would like to strip away
the name and leave the hyperlink as the value of the cell.

ASAP Utilities » Web » Extract hyperlinks

Hyperlink Removal

| have created a spreadsheet by copying and pasting information (all numerical) from the
internet. With this copy and paste, hyperlinks also carried over with each of the cells (over
10,000 cells). My question is this... Is there any way to remove hyperlinks from an entire
spreadsheet w/o having to right click and remove in each individual cell? Also, is there way
that | can copy and paste this information w/o also pasting hyperlinks.

ASAP Utilities » Web » Remove all hyperlinks in selected cells

Activate multiple URL's

I have a list of many URL's and need to activate them all so that if they are clicked on this
will link to the web page of interest. If | activate each link one at a time this would take
forever. Is there a module | could use to activate all the URL's in a list (e.g. using fill down)?

For example:

URL1
URL 2
URL3
URL 4

These cannot be accessed as they are not active hyperlinks. | need a way to convert them
all into clickable links.

ASAP Utilities » Web » Activate hyperlinks (create from cell values)...

Absolute Copy/Paste

If | cut and then paste a block of cells, formulas in the cells retain their reference to specific
cells. If I Copy and then Paste a block of cells, formulas in the cells change to reference
relative to the pasted cells.

Practical Tricks to Save Hours in Excel with ASAP Utilities 301



81

82

83

ASAP Utilities User Guide “Save hours in Excel”

For example, if | have in cell B2 a formula "=A1"
If | Cut B2 and Paste it in B3, | have in B3 "=A1"
If | Copy B2 and Paste it in B3, | have in B3 "=A2"

Is there any way | can copy and then paste and retain the references to the original cells? |
know | can change just the formulas, i.e. make the formula "=SAS1" and then copy/paste at
will, but there are lots of times where this would be problematic.

Is there a simple way to do this Copy/Absolute Paste?

ASAP Utilities » Formulas » Copy formulas without changing their cell references...

Replacing blanks at end of text for =vlookup()

| have a =vlookup() that is failing to find matches. | have two lists with names that appear to
be matches; for example, "ALL CITY LOCK AND KEY" appears on both lists. The =vlookup()
does not recognize the cells as the same. Using "if" function to test to see if the values in
both is equivalent produces a not equivalent result. It appears that the actual values stored
in the cell in the first list is "ALL CITY LOCK AND KEY", and in the second list "ALL CITY LOCK
AND KEY ". I'm not sure why the spaces are being stored in this fashion. The data has come
from a download from a site | do not usually use, and | have not run into this before.

Is there any way | can loop through both lists and get rid of these recorded blanks after the
last alpha-numeric value, or in some other way alter the lists to get the =vlookup() to
function?

ASAP Utilities » Text » Delete leading and trailing spaces.

(note: this will also delete trailing spaces in each cell).

Removing Blank Lines

| was sent a workbook with a sheet that has about several lines, all numbered 1, 2, 3 .....
However there is a blank line between each line. Is there an easy way of DELETING all the
blank lines rather than highlight each one and delete them?

ASAP Utilities » Columns & Rows » Remove all empty rows

Add changes to entire column in excel

| have over 1000 items, all unique with letters / numbers / symbols. What | need to do is
down one entire column add something as simple as 01- to the front of each one.

For example, say the column is IDs
The first cell is h321dsa

the second is wr2dafw
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etc..

Is there a script or some sort of query | can have it go through and modify straight down the
column placing a 01- in the same cell so when it's done it looks like this:

The first cell is 01-h321dsa
the second is 01-wr2dafw

etc...

ASAP Utilities » Fill » Insert before and/or after each cell in your selection...

Index of worksheet names?
| have a workbook with 259 + worksheets. Is there some way that | can consolidate a list of

the worksheet names in a new worksheet without doing it one-by-one?

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)...

How do I column wrap an Excel printout
| have 10 pages of 2 skinny columns to print out.

In MSWord | would just CTRL-A, select the column button, select 2 columns and Wala - now
| have a 5 page printout. The column on the left of a page continues on the top right of the
same page - goes to the bottom and THEN starts a new page.

| want:

Page 1: Col A&B rows 1 -50 on the left of the page

Col A&B rows 51 -100 on the right of the page

Page 2: Col A&B rows 101 -150 on the left of the page

Col A&B rows 151 -200 on the right of the page

etc., etc.

I'm sorry for the "Column" definition problem between MSWord and Excel - | hope | have

been able to explain this problem accurately

ASAP Utilities » Columns & Rows » The paper saver (split columns)...

Fill down

Column A contains a date every 24 rows and i want it to automatically fill down all the dates
until it gets to the next date (without overwriting any dates).

This is what | want to do:
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On column B row 7 | have a date. Further down on column B in row 31 there is another
date, as there is on B55, B79 etc.... all the way down (about 500). | want to insert the first
date (the one in B7) into B8. B9. B10...B30.

| want the date in B31 to automatically fill down to the next date...B54 etc etc

ASAP Utilities » Fill » Copy values to empty cells below filled cells in selection

Merging Multiple Spreadsheets

| have 50 spreadsheets from various branches to merge every month. All spreadsheet
contains the same header fields & number of columns. Instead of cut & paste, is there a
better way to merge all the spreadsheets into one under one spreadsheet?

ASAP Utilities » Import » Merge and/or import multiple files...

-
ASAP Utilities - Merge/import multiple files

Import files of type:
(" Csv, comma delimited (" deAsE
(™ Text, space delimited % Excel*
Cancel
" Text, tab delimited " Lotus 123*
" Text, pipe ([) delimited " Quattro Pro*
(™ Text file, semicolon (;) delimited = Only data from the active
heet

(™ Text file, delimited by: ’N_ shee
-
[v start the import from row: 2 |+ Except the first file
Import to:
™ this workbook * a new workbook
(" Create a new worksheet for each file:

=
(* Merge the data into one new sheet: January

I~ Put filename in column A

Will Excel tell me the number of sheets in a workbook?

I've got a big workbook, it contains many, many sheets and | have no idea how to get Excel
to tell me how many sheets there are. It must know. While this seems rather simple the
only way | can think of working it out is to use the Create index sheet function in

ASAP Utilities and then count the rows, but there must be an easier way.

ASAP Utilities » Information » Counter number of sheets
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Pasting formulas without transposing
| would like to know how to copy and paste formulae without changing the formulas (as if

you were moving cells) and without using $ in every cell.

ASAP Utilities » Formulas » Copy formulas without changing their cell references...

Merging multiple Excel files into one

| have hundreds of separate Excel files, each with information in only 'Sheet1'. Each
file/sheet has the same information in the header (row1) and just one row of information
below it in row 2. The information that | want to combine in one Excel file stretches from
column A to column S inclusive.

| need to create a completely new Excel file that contains one header row and combines the
hundreds of rows of information below it.

Is there a quick and easy way of doing this rather than having to open each one and cut and
paste into the new file?

ASAP Utilities » Import » Merge and/or import multiple files...

Adding occasions of Red and Green text

Can | total a column in which there are two basic colors of text used? For example | want to
total the number of times a planned date in RED text occurs and then the number of times
a completed date occurs in GREEN text.

You can use the following function to do this:

= ASAPSUMBYFONTCOLOR (range, cell_with_color_to_count)

For example if one of the cells with a green font is in B2 you can count all these cells by
entering =ASAPSUMBYFONTCOLOR(A1:G200, B2)

Find duplicates in a column

How do you select an entire column and find and delete all of the duplicate information
from all cells?

To clear all duplicate values (make the cells empty), leaving only one original

ASAP Utilities » Range » Clear duplicated values in selection (leave one original)

To select all duplicate values:

ASAP Utilities » Select » Select cells based on content, formatting and more...
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Then in the tab “based on content” select duplicate values

To remove all rows containing duplicate values:

ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete...

Then choose “rows”, “delete” and duplicate values:

r 5

ASAP Utilities - Conditional row and celumn select, hide or delete

1. Search in: 2. Perform action on rows or columns?
This utility searches for a specified

’M—D * Rows " Columns value, and then selects, hides or
' - : deletes the entire column or row where
this value is found.
3. What to do with the entire row from each found cell:
When looking for duplicates the
(™ Select (" Hide {* Delete program also searches in hidden cells in
your selection, with the other search
4. Search options: options hidden cells are skipped.

| duplicate values j For ng.?re ﬁlexibility and options you can
use the utility:

I Case Sensitive
Select » Select cells based on content,
(% Keep the first value of each duplicate formatting and mare. ..

(™ Delete all duplicate values

Close v Auto dose

Color every other line
How can | change the color of a row for 2000 rows?

For example, rowl white, row2 grey, row3 white, row4 grey, row5 white, etc.

ASAP Utilities » Columns & Rows » Color each n’th column or row

Simple macro to import ALL xlIs files in dir into 1 workbook?

I need a simple macro that will take ALL files in any directory that | point to and import
them all into one workbook.

ASAP Utilities » Import » Merge and/or import multiple files...

Remove non value

| need to remove these squares from numbers. The squares are in column D and E before
and after some numbers and sometimes between the numbers where ever there is space
between the numbers asin D6, 7,9 and 11

ASAP Utilities » Text » Advanced character remove or replace...
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Dropping Text

Is there anyway that | can drop text within cells. For example column D has 120 cells all with
different amount a characters but | want the column to show only the first 6 and drop the
rest.

ASAP Utilities » Text » Delete all after n’th character

How to identify repeated values and delete them?

| have a sheet containing a lot of names. There are some names that are repeated. My
guestion is simple: how can | delete repeated values automatically?

To clear all duplicate values (make the cells empty), leaving only one original

ASAP Utilities » Range » Clear duplicated values in selection (leave one original)

To remove all rows containing duplicate values:

ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete...

Then choose “rows”, “delete” and duplicate values:

Excel will not recognize imported numeric data

The data was imported from an Access database (I believe), and put in columns at the end
of the spread sheet. Excel doesn't seem to recognize the imported data, e.g. formulas won't
recognize the data, and nothing happens when | change the format for the imported
columns. It's only when | retype the data in an imported cell that Excel recognizes it.

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers

Inserting an empty row after each row
| have a table with several rows. How would | insert an empty row after each one row?

So if | have:

m o O @ >
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=
G

| want to have:

A

G

ASAP Utilities » Columns & Rows » Insert empty rows or columns in between...

How can I mass-insert $ signs into a series of formulas?

| have a spreadsheet with a several thousand cells with formulas I'd like to convert to
absolute cell references. Some of the formulas already have S signs in them, but what |
have in mind is the same as when you're creating a formula one-by-one - when effectively
by using F4 you can toggle the S on, partially on or off.

Rather than go through each formula separately, is there a simple way of 'mass' converting
them?

ASAP Utilities » Formulas » Change formula reference style (e.g. Al to SA1 etc.)...

Protecting and unprotecting each worksheet separately=
PAIN!

My workbook has 7 different sheets in it. Basically | have password protection to even
opening the file, plus | protected each sheet individually with a password. But the problem
I'm having is that each of the 7 sheets needs to be updated in some way periodically, and |
don’t want to have to go to each sheet individually, unprotect it, type in the password,
update the info, re-protect it, go to the next sheet, unprotect it, type in the password,
update info, re-protect it, etc. | basically want someone to have either full access to the
whole workbook and all the sheets by using one password, or else have no access at all
(read only).

I've put a password in so that it's required in order to modify anything in the workbook, but
this only works if each sheet is protected. Is there any way to unprotect ALL sheets at the
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same time, and then re-protect them all at once? It's a pain to unprotect and protect each
sheet over and over again.

ASAP Utilities » Sheets » Protect multiple sheets at once...

ASAP Utilities » Sheets » Unprotect all sheets

| have a workbook that | use for employee names and other data. All names are in the same
column on every sheet and the last name is on the same row for every sheet. The problem
is that | have 2 spaces between first and last name and need only one space. Would
someone please tell me how to remove that one space? It is causing a lot of grief.

An example would be:

John Doe (2 spaces between John and Doe)
I need it to look like:

John Doe (1 space between John and Doe)

If it is always two spaces you can perform a simple search & replace in Excel. Search for for
two spaces and replace them with one. Another approach which will also works if there are
three or more spaces is:

ASAP Utilities » Text » Delete leading, trailing and excessive spaces

This will replace repetitive spaces to one and also removes all spaces at the beginning and
the end of your values.

| have 2 questions.

Question 1: Is there a way to delete all hyperlinks on a worksheet without having to
manually remove each one individually?

Question 2: | have a column (A) that has names in it. However before the first name there
are two blank spaces in front of each name. | would like to remove those two blank spaces
so the name aligns to the left. | tried the align function but that doesn't work. How can |
remove these blank spaces before the name?

This can be often the result when you copy information from your internet-browser into
Excel.

ASAP Utilities » Web » Clean data and formatting...
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F y

ASAP Utilities - Clean data and formatting

In selected range: A1:54230

[V Remove all hyperlinks IV apply standard font size
[+ Trim spaces ¥ Mo wrap-text

[+ Remove all cell colors ¥ Fix (textinumbers

[V Remove all font colors IV autofit columns

[+ Remove all borders Maximum width:

[+ Unmerge cells ¥ Autofit rows

[V Apply standard font Manimum height:

In this worksheet: Sheet1

[+ Remove all objectsfimages

Cancel | Al ‘ Inverse ‘ MNone

Copy-paste multiple formulae without changing cell
references

| have multiple cells with formulas in them, which | want to copy to elsewhere in the same
spreadsheet (about 20 rows below their current position). | would like to do this without
changing any of the cell references; however none of the cell references are currently
absolute.

Is there any way of having excel automatically change all cell references from relative to
absolute? (i would use find-replace, but all of the cell references are different, so it
wouldn't work).

ASAP Utilities » Formulas » Change formula reference style (e.g. Al to SA1 etc.)...

If not, is there any other way of moving the formulas without changing the cell references?

ASAP Utilities » Formulas » Copy formulas without changing their cell references...

Moving the "end" cell - Ctrl+End

This has me stumped. How does one "move" a current end cell in Excel?

Meaning if | have a something in G22 and D13, and then delete G22, whenever you go
Ctrl+End it always ends up at G22 not D13 or if | have the "last" closest thing on say G10 or
B22, etc.

| tried deleting the whole row or column, but always end up at the "new" G22.

Saving the workbook in most cases resets the last cell. Otherwise:

ASAP Utilities » Sheets » Reset Excel’s last cell
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By default this can be started with the shortcut Ctrl+Alt+R in ASAP Utilities.

Putting Sheet Name in a cell

| am creating multiple new sheets from names in a selected range of cells using
ASAP Utilities. | then want to go into each sheet and use the sheet name and place it in the
sheet itself. Is there a way to do this?

ASAP Utilities » Sheets » Insert sheet(s) name in selected cell(s)

- ~
ASAP Utilities - Insert sheet(s) name in selected cell(s) @

4 "‘-.I Do you want to insert the sheet name in range Al on each of the
W' selected 52 sheets?

oK | Cancel

Funny squares!

Has anyone ever noticed that when you export data from databases (e.g. Lotus Approach),
and open them using Excel, you get lots of little annoying squares in some of the cells.

| was wondering if anyone had any top tips or tricks for getting rid of them?

ASAP Utilities » Text » Advanced character remove or replace...

De-selecting cells

Can you please tell me how to DE-select a cell when | have already selected several cells
and then selected a cell on accident? | would like to de-select that cell without de-selecting
all of the selected cells.

ASAP Utilities » Select » Deselect cells

By default this can be started with the shortcut Ctrl+Alt+D in ASAP Utilities.

Link to charts within spreadsheet

| have a spreadsheet with a data worksheet and 30 charts | have built from the data, all on
separate tabs. How do | hyperlink from some text in my data worksheet to the associated
chart? Confused | don't know how to reference these charts.

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)...

Practical Tricks to Save Hours in Excel with ASAP Utilities 311



110

111

112

113

114

ASAP Utilities User Guide “Save hours in Excel”

Hiding error messages

| need to work on a large spreadsheet that someone else put together of sales figures for
the coming year. As the spreadsheet doesn't yet have many values, there are a lot of error
messages where there are formulas, such as #DIV/0!, as a result the spreadsheet looks very
messy.

When | do a spreadsheet like this | generally use the following:
=IF(ISERROR(formula), " ", (formula))

This works great, however, | need to clean up this spreadsheet that | received, and | am not
relishing the idea of going into every single formula in it and inserting this wording. Is there
any way of doing this sort of thing for the whole spreadsheet, instead of one cell at a time?
Unfortunately, the formulas are all different (=sum, =vlookup =if =count).

ASAP Utilities » ASAP Utilities » Formulas » Custom formula error message...

Converting email address text to HTML Links

| need to know how to take a column of email addresses and make them clickable.
Currently, the addresses are static and | have to go through one by one and make them a
live link.

ASAP Utilities » Web » Activate hyperlinks (create from cell values)...

Fill blank cells with previous cell data

| have a spreadsheet that was populated with exported data. | have some cells with the

correct data in them that needs to be filled with the previous cells data unless the cell is
already filled. For example | have a cell populated with "a", | want that data copied to all
cells below it, until the cell it encounters a cell that is already filled.

ASAP Utilities » Fill » Copy values to empty cells below filled cells in selection

Remove Drawing Objects

Can anyone tell me how to remove ALL drawing object & pictures in a spreadsheet, without
having to click each one & hit "delete".

ASAP Utilities » Objects & Comments » Delete all objects in selected worksheets

Multiple range copy

Is there a way in Excel to copy multiple ranges? In other words, can you select non adjacent
cells or ranges and then copy & paste them?
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ASAP Utilities » Range » Copy multiple selected ranges...

Removing leading Zero

How do | remove the leading zero from lots of rows of numbers?
For example:

046534765

046573737

046533333

065438373

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers

Page borders in Excel

I'm trying to make page borders print for a multiple page Excel sheet with changing
information. Actually, the left-right borders don't change, and | can make a top border
using the Repeat Rows at Top in Page Setup. So | just need the bottom border.

A search turned up the idea of using the underline key in the footer. This looks like a
horrible way to do it. For one thing, it doesn't create a continuous page border around the
lower corners. Is there a way to do this using conditional formatting? Or is a macro
necessary?

ASAP Utilities » Format » Place a border around each page

If your data or your page layout changes you have to re-run it.

Converting numbers (such as $100) into words

| often use excel to print invoices and would like to put a formula that converts numbers to
words, such as: "100" converted into "one hundred".

Example: Invoice Value $100, Value in words One hundred only.

ASAP Utilities » Numbers & Dates » Spell/write out numbers or amounts (EN, DE, NL)...

Copy Print Settings?

Is there a way to copy print settings over from one worksheet to another?

ASAP Utilities » Format » Copy a sheet’s page and print settings...
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Randomize columns
| have many columns of data. The records are sorted on the basis of column U.

| want to randomize them on the basis of column U. | don't want ascending records.

ASAP Utilities » Range » Sort the data in random order

Excel: How to merge info from column A & B into column C
How do |, for example, take the info in cell A2, B2, C2, D2 and merge it together in A1?

There are manual steps with formulas to accomplish this. Another approach is:

ASAP Utilities » Columns & Rows » Merge column data (join cells)...

Identical cells

Could someone tell me the easiest way to find identical numbers or text in a column? | have
3000 cells in a column, the majority of which contain different numbers, but | want to find if
there are any that contain the same number. | can't just use a custom filter because I'm
never looking for one number in particular, just any identical.

There are two options:

ASAP Utilities » Range » Count and/or color duplicates in selection...

This utility will tell you how many duplicate values there are and has the option to color all
duplicates.

or

ASAP Utilities » Select » Select cells based on content, formatting and more...

Now in the values tab you can choose to select all duplicate values. When selected you can
color them any color you want.

Converting DD/MM/YYYY to MM/DD/YYYY

| have a column of dates and Excel doesn’t recognize them as dates:

01/02/2003
01/03/2003
01/04/2003
01/05/2003 etc

Which should be :
02/01/2003
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03/01/2003
04/01/2003
05/01/2003 etc

ASAP Utilities » Numbers & Dates » Convert/recognize dates...

ASAP Utilities - Convert/recognize dates

Date format in selected cells:
|dd Jd | /I | =l =y ~|
\ =l

example (today): 04-01-2013

Convert to:

[N R (I A (v | | |
example (today): 01/04/2013

{% Use number formatting for dates (recommended)

(" Write out dates as text

o
-
(@

[ skip the first row in the selected range (header)

No match was found. This way the dates can not be converted.

Cancel

-

Suggest

123 Unwanted Macros

A file | copy annually to update for the current year has various macros. When | start the
new year | delete the macros to avoid confusion but each time | open the new file | am still
asked if | want to enable macros. How can this be when there are no macros listed and how

can | get rid of the message?

ASAP Utilities » File & System » Remove all macros (VBA code) from current file

124 Deleting hidden Columns

| have a file that generates 80+ report pages which are carved out & a ranged value copy is

sent out for reporting.

There are several different views | have to use - so there are lots of columns hidden &
unhidden - The columns are not adjacent. To make the report small enough to email - got

to delete the hidden cols.

ASAP Utilities » Columns & Rows » Delete all hidden rows and/or columns...

To see which columns and rows are hidden:

ASAP Utilities » Columns & Rows » View and manage hidden rows and columns...
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120 CSV files need to be pulled to 1 sheet

| receive e-mails from a customer that each have 1 CSV file attached. To date | have 120
received. | am looking for an easy way to save all the attachments and then open them all
and copy them to a single sheet. The columns are always the same and there will never be
any blank lines until the last row but the number of lines varies with each one.

ASAP Utilities

ASAP Utilities » Import » Merge and/or import multiple files...

Parsing multiple sheets into one

Hello, | was curious if there is a way, | can take a workbook containing multiple sheets, and
parse them into one single file. Really doesn’t matter the format of the file, | can do
another conversion on that. The reason | ask is | have a workbook, with like 600 separate
pages in it. And it needs to be reduced to one output file, for importing into a DB.

ASAP Utilities » Sheets » Put together rows or columns from several sheets...

For the export:

ASAP Utilities » Export » Export selection or active sheet as new file...

Or first export the worksheet as separate files and then merge them together into one long
worksheet with the data below:

ASAP Utilities » Export » Export worksheets as separate files...

ASAP Utilities » Import » Merge and/or import multiple files...
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Troubleshooting FAQ

In case you have any questions or face a problem then please first consult the Questions
and Answers section on our website as we may have answered your question already:

https://www.asap-utilities.com/fag.php

For questions regarding ASAP Utilities or feedback, please contact us at:

support@asap-utilities.com

https://www.asap-utilities.com/contact.php

Keep your question ASAP Utilities related

We are willing to help you, but we do not answer general Excel questions. We simply don't
have the time to. On our website we have several links to other resources where you most
likely will find the answer or can ask the question. Excel is being used by millions of people
for more than two decades. Keep in mind that most likely you are not the first one facing
the problem you are facing. On the internet there are many websites where people share
their Excel related problems and solutions.

https://www.asap-utilities.com/links.php

Priority support for customers

If you are a registered customer then please include your order number, for a fast-track
(priority) response.

You'll find your order number the email you received after the purchase.
You can also find your order details in the Excel menu: ASAP Utilities » Registered version.

Bug report guidelines

The basics: what you did, what you wanted, and what
happened.

Those are the three basic elements of a bug report. You need to tell us exactly what you did
(for example, "ASAP Utilities » Range » Clear duplicated values in selection (leave one
original)"), what you expected to have happen (to continue the example, "l expected to
have all duplicates removed"), and what actually happened ("it selected the duplicate cells
but didn’t remove them.").

Yes, the example is silly. But if your bug report simply said "the duplicates function doesn't
work," we wouldn't be able to know whether you used this tool or the Select » Select cells
based on content, formatting and more... tool, or the information » count duplicates tool.
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By telling us what you asked for, what you expected to get, and what you actually got, we
don't have to guess.

Excel and windows version

When you report a bug please include information about the Excel and windows version
you are using. To make this easier for you can go to:

ASAP Utilities » ASAP Utilities Options » Settings, language and contact information...

Then go to the tab “Contact information” and copy the information there in your email:

General ] Folder settings Contactinformation Igebug ]

‘We can only help you if you communicate in English or Dutch. —

Contact information on our website:

https: {/www.asap-utilities. com/fcontact. php

Information on how to report a bug:

https: //www.asap-utilities. com/contact-support-bug-report. php

If you encounter a problem with ASAFP Utilities and want to contact us, please provide the following information. This
allows us to help you better.
‘You can copy this information and past it in your email to support@asap-utilities. com.

Copy info to dipboard for use in email

RSRD Utilities
Version 8.0 10ctobé Acap Utilities - Settings, language and contact information... X
Language : en-us

Fawvorites menu path : C:\UsersiM¢

Date start : 20220€15

Actual days used - &0 o The information is now on you cipboard and can be pasted
in an email to us (support@asap-utilities.com).
Registered versiom, licensed to:
Hame : Bastien Me1 [
QOrganization : A Must in }
Worber of licenses | 1

Order number 0 1174414137 avaw—s |

Excel wversion © 385 (l6.0.1562%) €4-bit

Country code o1 ~| |
K1 r
Close oK

Always search our website and documentation first

Advice so good, we'll repeat it twice. Always search our website and documentation first.
ASAP Utilities is used by a lot of users. The odds are good that if you've found a problem,
someone else has found it, too. If you spend a few minutes of your time making sure that
you're not filing a duplicate bug, that's a few more minutes someone can spend helping to
fix that bug rather than sorting out duplicate bug reports.

Be brief, but don't leave any important details out

This is a fine line to walk. But there are some general guidelines:
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Remember the three basics: what you did, what you expected to happen, and what
happened.

When you provide a workbook that demonstrates the problem, make sure it is small and
remove information that is not subject to the problem. Otherwise it just contains a lot of
information that has nothing to do with the problem, which just makes it take longer to
figure out the real problem. (But don't forget to make sure that your workbook still
demonstrates the bug you're reporting and doesn't have some other problem because
you've accidentally removed something you thought wasn't important but was!)

Use meaningful, specific subject headers

A good convention for subject headers, used by many tech support organizations, is “object
- deviation”. The “object” part specifies what thing or group of things is having a problem,
and the “deviation” part describes the deviation from expected behavior.

Bad: Igetanerror

Good: The tool “Create an index page with links to all sheets (clickable)” returns an error. |
have attached a screenshot of the error and an example workbook to reproduce it
with.

Please use English or Dutch (if possible)

Yes, the ASAP Utilities users are global and include a great many people who can speak a
great many languages. But if you were to report a bug we prefer English or Dutch.

If you're worried about your English skills making it difficult to describe the bug, you can
provide a good example with some screenshots. Online translation tools such as Google
Translate will then help us to understand your question.

Don't report bugs about old versions.

Every time a new version of ASAP Utilities is released many improvements are made.

If you're not using the most recent version ASAP Utilities, you should upgrade to the latest
version to make sure the bug you are experiencing still exists.

You can quickly see if there is a newer version available via:

ASAP Utilities » ASAP Utilities Options » Check for new version on the ASAP Utilities
website

You can see which version you have in the info screen. In the Excel menu go to:

ASAP Utilities » Info
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About ASAP Utilities

History of ASAP Utilities

ASAP Utilities is a powerful Excel add-in that adds new functionality to Microsoft Excel to
save time and speed up your work.

Since 1999 it has grown to become probably one of the world's most popular addition for
Microsoft Excel.

Time saving - speed up your work in Excel

ASAP Utilities is the product of many time-saving features and additions for Excel.

The extensive features are the result of years of experience and development, combined
with the feedback from many respected users at different levels of experience. Particularly
the feedback from users has been very important and will continue to be important in
further development.

ASAP = As Soon As Possible

ASAP Utilities is called this way because it significantly reduces time-consuming work. ASAP
is an acronym stat stands for "As Soon As Possible". Some choose to spell it out, others tend
to pronounce it "aysap". The word “utilities” means something useful. Combined

ASAP Utilities stands for useful time-saving macro tools for Excel.

Most people struggle with managers, bosses or clients that tend to ask for you to get the
job done yesterday, which of course is often difficult to pull off. ASAP Utilities doesn't allow
you to travel back in time, but it can certainly help you to speed up your work in Excel.

Constant improvement

Since its first release in 1999, ASAP Utilities has been improved and extended with many
new features and a friendly interface. It is under constant development, so new features
and improvements are being added all the time. The first year | put the program on the
internet, nearly every month a new version was released. Nowadays a new version is
released at least twice a year. The input we get from users all over the world is a great
stimulation for us to make it a better product every time.

Time saving

On average ASAP Utilities saves people 32 hours each year (measured among 145,873 users
in January 2023).

We have made it easy to see how many hours you saved with ASAP Utilities. Via

“ASAP Utilities » ASAP Utilities Options » Show me the time that | saved by using

ASAP Utilities”, you can create a report which you can use for example to calculate the
Return on Investment or show it when you need to ask someone to approve the purchase.
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Help by offering a free edition

By offering a free version of ASAP Utilities (already since 1999) we want to contribute to
society.

The ASAP Utilities '"Home and Student' edition is free and is (only) for non-commercial use,
such as home projects, schoolwork and use by charitable/non-profit organizations such as
the International Committee of the Red Cross, UNICEF, Amnesty International,
MSF/Doctors Without Borders etc..

Companies and governments however should buy a license. (They can try it for 90 days).

Especially with providing it for free to students and charitable organizations, we hope to
contribute to a brighter future.

A Must in Every Office

In our humble opinion we believe that ASAP Utilities is a must in every office. We use it
ourselves on a daily basis, and it saves us an incredible amount of time. On our website we
have listed some reviews from independent magazines and websites about ASAP Utilities.

We are proud to mention that ASAP Utilities is used worldwide in over 170 different
countries by 750,000+ users and 26,000+ organizations.

P search (Alt+Q)

B AutoSave (@ Off) Bookl - Excel

File  Home Insert Draw Pagelayout Formulas Data Review View Help ASAP Utilities
_& E‘E[ a:(%‘\ Ef Sheets~ | R Columns & Rows ~ = Numbers & Dates~ | @ Web v [® Import~ 4G} ASAP Utilities Options~  (2) Online FAQ F
Favorites & Vision Select | EHRange~ ¥ Objects & Comments > [A] Text ~ [ Information ~ ik Export ~ S® Find and run a utility (@) Info ﬂp?
Shorteut keys~  Control e Fill ~ [z Format i Formulas ~ [Ry File & System~ | [> Start~ (*, Start last tool again @ Registered version  the Day
Favorites Time saving tools Options and settings Infa and help Tips tricks
AL ~ I ~
A B c D E F G H J K M N o P Q R s a
0 —
2
3
4
5
6
7
8
9
10
1
12
13
14
15
16
17
18
19
0 v
Sheet1 @® Ll »
| Ready @ 1% Accessibility: Good to go H 0 - ———+ 1% |

About ASAP Utilities

321



8.2

ASAP Utilities User Guide

“Save hours in Excel”

The primary goals of ASAP Utilities

Our mission is to put a smile on the face of Excel users all over the world, by providing a
friendly and easy to use add-in, that saves time and speeds up their work in Excel.

ASAP Utilities promises:

Speed up and automate your work in Excel.

Do things that otherwise would not be possible in Excel.
Merge several steps into one.

Reduce manual input of data.

Easy to operate with an intuitive and user friendly interface

The bottom line:

Make life easier for Excel users, both novice and expert
Save time

I"

“We make you the company's Excel guru
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8.3 Testimonials

8.3.1 Here's what our users say

Our users and clients are often kind enough to share some feedback on ASAP Utilities.

We're proud and happy that, ever since its first release 24 years ago, we can help Excel
users all over the world.

8.3.2 Enthusiasm and 5 star rating

We're proud to see that all over the world people are enthusiastic about ASAP Utilities.

See the feedback from users on our Trustpilot, Twitter, LinkedIn, or Facebook fan page, our
blog, view the reviews from magazines, websites, radio shows and newspapers or just
google for ASAP Utilities reviews.

ASAP Utilities is rated 4.9 out of 5 based on over 2,500 reviews on Trustpilot:
https://www.trustpilot.com/review/asap-utilities.com

ASAP Utilities is rated
Excellent

Based on 2,521 reviews

* Trustpilot
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Below is a screenshot of a few reviews abouon Trustpilot:

Showing our latest reviews

3 days ago

Steven Moddelmog

ASAP automates so many things
that you...

ASAP automates so many things that
you wish Excel had been designed to
accomplish. | use it frequently - it has
saved me countless hours of doing
things manually or trying to figure out
my own automation.

LM

March 25

ASAP Utilities is a must have for
all...

ASAP Utilities is a must have for all
excel work!!

Luke Trandal

Essential tool for our workforce

Essential tool for our workforce! Getting
alicense is a step in my new employee
onboarding process!

March 13

HAMILTON BOWSER

Invaluable Tool

ASAP Utilities has made my job
considerably easier. | spend a lot of time
cleaning up "bad dumps" of excel in
order to prep excel files for upload.
ASAP features include date formatting
and fill-in-the-blanks capabilities that are
invaluable for my job.

March 7

Vonda Hall

Recommend to everyone!

| have purchased this at every company
| have worked at over the last 10 years! |
love this! It saves me so much time!
Recommend it to everyone.

Excellent

Rated 4.9 / 5 based on 2,521 reviews on *Trustpilot

’

S. Sterling

This is my secret weapon in the war
on...

This is my secret weapon in the war on
spreadsheets. ASAP has helped me get
things done efficiently and accurately. It
simplifies mundane tasks freeing you
up with time to get the most from Excel!

)

March

Adam Larson

The perfect add-on for Excel!

The perfect add-on for Excel!

Excel users will love the simple and
quick functionality, which used to take
multiple steps and formulas in Excel.

March 16

BookBub User

I have used ASAP Utilities for over
14..

I have used ASAP Utilities for over 14
years. It is a godsend. A few Excel
functions do the same thing, but ASAP
Utilities are much quicker. Most other
ASAP Utility functions save a lot of time
for which there are no Excel equivalents.
| teach classes using Excel, and at the
beginning of each semester, | highly
recommend ASAP Utilities to my
students. It is undoubtedly worth the
money, especially since you only pay for
it once.

March 13

Chris Wilson

Helped me enormously.

Big thanks to Bastien for his help! Great
company to deal with.

March 7

Irina Trandafir

It is perfect if you want to save
time...

It is perfect if you want to save time
working in excel!

March 28

Allan

Superb product and fast support
Superb product and fast support when |
added more licences

A pleasure to deal with. Been using for a
number of years. Loads of shortcuts
that would normally take an age to
construct and/or process.

Highly recommend!!!

March 21

Mona Carmody

Life Changing!

ASAP Utilities has been a constant
throughout my career. This tool has
saved me countless hours and
frustration over the years. Couldn't live
without it!

March 14

Jules Vallesteros

Most useful add on | have ever used

Most useful add on | have ever used.
Time proven and have saved me many
many hours. Thanks.

March 10

Monique

Good job

1 use Excel a lot and ASAP really makes
my work very easy

March 4

Alexey Panin

10/10

“A must have for anyone who spends
time in Excel”

And this slogan does not lie) |
recommend 10/10

March 28

John M.

Excellent product

Excellent product! Saved us hours of
time! Pays for itself after it solves your
first problem! Customer service was
fantastic! Got an email response to my
question 5 minutes later! | can not
stress how great this product is
especially for us Excel illiterate.

March 18

Ranjan

Well dene

Had a really good experience with them.
Value for money.

March 14

Michael Masche

Perfect Service!
Perfect Service!

March 9

Michael Hubrich

I've been using ASAP for years

I've been using ASAP for years. It's one
of the first tools | install on a fresh
computer and saves me hours of time
while using Excel. If you don't have this
tool, you should.

March 1

Robert Czajkowski

Excellent utility

Excellent utility! We have been using
ASAP Utilities at my company to help
process our photometric test lab data
for a number of years. It has
streamlined the post processing of our
data and saved us countless hours.
Highly recommended!

We strive to continuously improve and every review helps us to provide a better
experience. For 24 years already we do everything possible to help our users and use their
feedback to further improve ASAP Utilities..

We really want to help you and provide you with the best and most user-friendly add-in for
Excel!
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= Thank you for your message. | have downloaded the New version, in French !!
| appreciate it very much and recommended it to my friends because you deserve it.
These utilities are very well thought, useful and the service excellent.

= Thanks, Bastien. ASAP rocks.

= | absolutely LOVE ASAP utilities and it has allowed me to create some really functional
spreadsheets in excel that look great, too! Thank you!

= Just to let you know. | absolutely love this program. It is great.

= Thanks for a wonderful tool that helps when | am stuck.

= A terrific set of utilities! | think that they are invaluable.

= Thanks for your quick support.....as | simply cannot do my work without ASAP Utilities
every single day :-)

= | just downloaded the ASAP utilities and find them to be very helpful.

= You’'re a genius!!

= Good Morning. | purchased and have been using your ASAP Utilities. It is an excellent
product.

= Qur research director has already fallen in love with ASAP.

= You are the BEST!!! | wish other software companies were as easy to work with as you
guys!!

= Came across ASAP in 2007 while needing an Excel Solution - it was love at first sight!

= | have been using the free version of ASAP utilities for at least the last five years, and
probably longer. | have admired it as the best single utility | have ever run across in 25
years of using computers.

= Please allow me to say thank you for your fabulous product. | am indebted to you.
Thanks very much!

= ASAP Utilities is one of the best products I've ever utilized when working in Excel. Keep
up the good work — this is an amazing product that | will find hard to live without...

= A huge thank you for making my life easier with your great product.

= Fantastic, you guys have thought of everything. Your response to emails is unmatched.
Thank you so much.

= Hi Guys, Continue like this, without You, excel will be much poorer.

= Please know that | greatly admire you and your hard work over the years. | don't know
exactly when | started using ASAP Utilities. My guess is that it was about 2005 or before,
but I've been a faithful user and evangelist for you for years. Since | had benefitted so
much from your hard work, | did register several years ago (don't quite remember when).
| will continue to let folks know the benefits of ASAP Utilities and encourage them to
register.

= Hi Bastien - every time | download the upgrades, | remind myself how grateful | am for
this utility. It's fantastic and makes my life less complicated. It has done miracles for work
performance even though I'm still on Excel '97. Thanks for your hard work.

= Thank you for a brilliant piece of software.

= My Thanks again for a great Utility & for your personal response (sincerely appreciated).

= | love this tool. | use it every day!
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= First, | want to congratulate ASAP Group for this great idea! Although | recently acquired
the software, it has done a huge amount of work for me and save a lot of time. | have
recommended the software to my colleagues and my partners at my master degree
program here in Colombia.

= Thanks for your quick reply. | use the utility at home (and have for a number of years).
Our company does not usually allow outside software to be loaded to the company pcs,
but | can see a real cost savings to our Project Management group, so | will begin
discussions about perhaps purchasing licenses. Thank you for your help.

= Thanks! ASAP Utilities is a very nice add-on.

= | just wanted to say thank you for ASAP Utilities. | am not an Excel expert, just an
administrator with very basic knowledge and skills. | am not allowed to download your
product at work so spent the whole afternoon trying to solve how to sort a column of
dates by month. Searching the internet didn’t help either. | thought I'd try again at home
on my laptop where | have your brilliant product and within a minute my list was sorted.
| wasn’t at all surprised ... you have helped me out on more than one occasion! This is
truly one of the best things you will find on the internet. Thanks again

= Thanks again. Your product is wonderful

= | have found ASAP to be useful over the past few years and thank you for this excellent
addition to EXCEL

= Thank you for replying so fast and solving the problem. | will suggest even more friends
to use this wonderful utility in excel and purchase it for using officially.

= ASAP utilities is a lifesaver. | really enjoy its functionality, and regularly use a half dozen
or so of its functions- especially the text functions such as change case, combine cell
contents or remove extra spaces. Great job.

= Thank you very much for this utility. It is a lifesaver.

= | find the ASAP utilities very useful, although only use a fraction of them. Keep up the
good work.

= As always, | continue to be impressed with your program. Thanks for making it available!

= Hello —I really enjoy using ASAP utilities every day. It saves me lots of time and that
makes me happy!

= Thanks so much for this program -- it is a wonderful tool!

= | have loved using ASAP with excel for years and would be lost without it....Thanks and
keep up the good work.

= Thanks for your time. | truly appreciate your wonderful product!!!

= Thanks again, and | have to say your program is so critical to my day-to-day worksheet
activities and | can’t praise it enough!

= | would just like to say that the ASAP Utilities are simply amazing and | would like to
congratulate you on the wonderful work.

= In honour of the 2010 Olympics, you deserve a GOLD MEDAL for this ;)

= What a GREAT product. | would be totally lost without it.

= | have bought the first ASAP about three years ago, and really, THANKS!.

= | love the program what a great tool. It is a great time saver.

= | have recommended your program to several of my co-workers and wish you much
success with your business.
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= | have been using the ASAP Utility for the last three years and found it to be very useful
and thanx for the same.

= Your utilities have saved me a lot of time. | have just purchased a license.

= Thanks again for your time and PS. I'm a huge fan of the product!

= |'m very pleased with your product and find it very helpful, even though | only use a small
amount of its capabilities.

= That was it! Thanks for your patience. By the way, love the product.

= | will tell you something, the ASAP utilities are just great. | have been using them for
many years... since they were free...hehe... My job involves TONS of time on Excel, and
ASAP is an incredible time and effort saver. You also have an outstanding record of
continuous development and improvement, always releasing updates. Thanks a lot for

your work!!!

Our clients, who uses ASAP Utilities?

ASAP Utilities exists since 1999 and is used in a variety of organizations.
Our list of clients exceeds 26,000+ organizations in more than 140 countries worldwide.

The list below shows a few organizations that purchased ASAP Utilities.

We're very proud to have these organizations among our clients:

#

= 20th Century Fox
= 3M Company
= 7-Eleven

A

= A.T. Kearney

= Abbott Laboratories

= Accenture

= ACCO Brands

= Accor

= Adobe

= ADP

= Aegon Bank

= Aer Lingus

= Aero Inventory UK Ltd

= Aetna

= Agfa Corporation

= Agilent Technologies

= Ahoy Rotterdam NV

= Air Products & Chemicals
= Airgas

= AkzoNobel Coatings

= Alcoa

= Alliant Energy

= Allied Wate Industries Inc
= Alpha Natural Resources

Altron Management
Services

Amazon.com Services, Inc.
Ameren

American Electric Power
American Express
American International
Group

Amerigroup

Ametek

AMN Healthcare, Inc.
AMNESTY INTERNATIONAL
Amo Plans

Anadarko Petroleum
Analysis Group

Aol

Aon Hewitt Limited
Applera

Applied Industrial
Technologies

Aramark

ArcelorMittal

Arizona State University
Ashland

AT&T

Atlas Pipeline
Atletiekunie

Atos Origin

Australian Department of
Business & Employment
Australian Department of
Treasury and Finance
Australian Dept of Business
& Innovation

Autodesk

Autoliv

AutoTrader.Com

Avery Dennison

Avnet

AXA Financial

B

Bain & Company, Inc.
Baker & McKenzie
Baker Hughes

BANK OF AMERICA
BASF

Bausch and Lomb
Bayer CropScience Ltd
Bayer MaterialScience
Beckman Coulter
Belden

BELL HELICOPTER AIRPORT
CENTER

Bentley Systems, Inc.
BEPCO, L.P.
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= Best Western International

= Beverly Hills Police

= Bharat Heavy Electricals Ltd

= BHPBilliton

= Biomet

= BKD, LLP

= Blizzard Entertainment

= BNP Paribas

= BOEING

= Boston Scientific

= Boston University

= BP America

= Braun GmbH

= Bridgestone Bandag Tire
Solutions

= British Airways

= Broadcom

C

= Canon U.S.A,, Inc.

= Cardinal Health

= Cargill

= Carglass NV

= Carl Zeiss Vision

= CARQUEST CANADA LTD.

= (Cascade Aerospace

= CASH AMERICA

= Caterpillar

= CBL & Associates

= CenterPoint Energy

= Central States Pension
Fund

= Cenveo

= Cephalon

= CH2M Hill

= Charles Darwin University

= Chevron

= Chiquita Brands
International

= Christchurch City Council

= CHS

= CIBER

= CIRQUE DU SOLEIL

= Cisco Systems

= Citrix Online

= City of Fresno

= CITY OF HENDERSON

= City of Seattle

= CITY OF TORONTO, Toronto
Fire Services

= Clear Channel
Communications

= Clorox

= Coca-Cola

= Colgate-Palmolive

Comcast

ConAgra Foods
ConocoPhillips
Consol Energy
Constellation Brands
Convergys

Corus Staal B.V.
Covance

Crane Group Limited
Critical Care Systems
CROSSMARK
Crosstex Energy

CsC

Cummins

CVS Caremark

D

DAF Trucks N.V.

Deere & Co

Dell

Deloitte & Touche M.E.
Deutsche Lufthansa AG
Del Monte

DHL Worldwide Express
Dick's Sporting Goods
Dimension Data

Disney Consumer Products
Dollar General

Dorsey & Whitney LLP
Dover

Dow Chemical
Drankenorganisatie
Nederland

Dreyers Grand Ice Cream
DSM NeoResins

DSM Nutritional Products
AG

DuPont

E

Eaton Aerospace

Ecolab

Electronic Data Systems
EMC

EMI Music Spain SL
ENSCO International
Environmental Protection
Agency

EPCOR

Epic Games, Inc.

Epic Systems Corporation
Ericsson AB

Ernst & Young

Estee Lauder

EVO Payments
International GmbH
EXEL

Exide Technologies
Expedia

ExxonMobil

EYEE ESTUDIOS
EMPRESARIALES, AIE

F

Facebook Inc

Faiveley Transport
Fannie Mae

FBI - ViCAP

FD Solutions

FedEx

Ferrero

Fidelity National Financial
FINANSBANK A.S.

Fiserv

FLEXTRONICS
TECHNOLOGIES PVT LTD
Fluor

FMC Technologies
Folkeuniversitetet Oslo
Foot Locker

FOSSIL

France Telecom

FSD Fahrzeugsystemdaten
GmbH

G

GameStop

Gannett

GE

Gemeente Almelo
Gemeente Leiden
General Dynamics
General Motors
Genworth Financial
George Washington
University

GfK Benelux MS B.V.
GlaxoSmithKline SA (Pty)
Ltd

Global Tower Partners
GODADDY.COM
Goldman Sachs JBwere
Services Pty Ltd
Google

GSK

G-Star Raw C.V.
Guess?, Inc.

Gulf Air
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H

= Halliburton

= Harland Clarke

= HCA

= Heineken USA

= HEINZ WORLD
HEADQUARTERS H57

= Hershey

= Hewlett Packard

= HOLLAND AMERICAN LINE
INC.

* Home Depot

= Home Shopping Network

= Honeywell

= Hormel Foods

= Hyundai Auto Canada

= IBM

= |EEE

= |kon Office Solutions
= IMF

= |MS Health

= Infor

® ING Car Lease
= Ingram Micro

= InSites NV

= Intel

= International Paper
= Intuit

= INVISTA

= |ron Mountain

J
= J.F. Shea Co,, Inc.
= Jabil Circuit

= Jack in the Box

= Jarden Leisure &
Entertainment

= John Deere

= Johnson & Johnson

= Johnson Controls

K

= Kaiser Permanente

= KBR

= Kelly Services

= KEMA Consulting GmbH
= Kiewit

= Knight

= KNSB

= Koninklijke Bibliotheek
= Kotak Mahindra Bank Ltd
= KPMG

= Kraft Foods

Kraton Polymers
Kuehne+Nagel AB

L

L-3 COMMUNICATIONS
Land O'Lakes

Landal GreenParks
Lands' End

Legal Marketing Services
Ltd

Leggett & Platt

Lennox International
Levi Strauss & Company
LexisNexis

Lexmark

Library of Congress
LinkedIn Corporation

LL Bean

Lockheed Martin
L'Oréal

Lyonnaise des Eaux

M

Magellan Health Services
ManTech

Marriott International
Martin Marietta Materials
MasterCard
McCormick

McKesson

McKinsey & Company
MDA Ltd
MeadWestvaco

Media Markt
Medtronic

Meijer Inc

Melbourne University
Student Union Ltd
Menard, Inc.

Meredith

METRO Cash & Carry
Nederland B.V.
Microsoft

Ministerie van
Economische Zaken,
Landbouw en Innovatie
Ministerie van SZW
Mitsubishi Motor
Monsanto

Monster

Motorola Solutions
MTV Networks BV
MultiCopy

Musgrave Retail Partners
NI

N

N.V. Eneco beheer
National Oilwell Varco
National Semiconductor
National Steel & Ship
NCR

Nederlands Meetinstituut
Ness Technologies India Pvt
Ltd

Nestle

Newell Rubbermaid
Newfield Exploration
NISSAN N.A.

Nokia Corporation
Norfolkline B.V.
Northern Operating
Services Pvt Ltd
NORTHERN TRUST
Northrop Grumman
Novartis AG

Novo Nordisk

Nutreco Nederland BV
Nvidia Graphics

(o)

OFFICE DEPOT
OfficeMax
OGE Energy
Oracle

owens & minor
Owens Corning

P

Panasonic Australia Pty Ltd
Parker Hannifin

Peabody Energy

Pentair

Peopleclick, Inc.

PepsiCo

PerkinElmer

Perot Systems

PetSmart

Philips Electronics

Philips Healthcare
Pinnacle Security
Pioneer Foods

PPG Industries

Praxair
PricewaterhouseCoopers
Procter & Gamble

PUMA Benelux BV

Q

Qatar Airways
QGC
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= Queensland Treasury
Corporation

R

= Rabobank Randmeren

= Raiffeisenbank Austria d.d.

= Raytheon

= Redland Shire Council

= Rentokil

= Repco Pty Ltd

= Repsol Services Company

= Ricoh

* Rio Tinto

= Roche

= Rockwell Automation

= Rockwell Collins

= Rolls-Royce Motor Cars

= Ross Stores

= RR Donnelley

= RTL Nederland

= Rural Telephone Service Co.
Inc.

= RUSSELL INVESTMENT
GROUP

S

= SAGER ELECTRONIC
CORPORATION

= SAIC

= Saint-Gobain Weber
Cimenfix

= Samsung Electronics
America, Inc.

= Sandvik

= Saralee

= SAS

= Scope International

= Seagate Technology

= Sennheiser

= ServiceMaster

= Shaw Group

= Shell Business Services
Centre

= Shutterstock

= Siemens

= SISTERS OF MERCY HLTH
SYS

= Sitel Inc.

= Smith International

= Smithfield Foods

= Smurfit-Stone Container

= Sodexo

= Softcell Technologies
Limited

SONY PICTURES
ENTERTAINMENT
Sorenson Communications
Southwest Florida Water
Management District
Spartan Stores

SPX

St. Jude Medical

Stahl Europe bv
Stanford University of
School of Medicine
Staples

Steelcase

Subsea 7

Sun Chemical

Sun Healthcare Group
Supervalu

Sutter Health

Suzuki Austria Automobile
Gbmh

Symantec

Syngenta Seeds

T

Tenneco

Teters Floral Products
Texas Instruments
Incorporated

The Australian National
University

The British Library

The Coleman Company
The Dow Chemical
Company

The George Washington
University

The Laminex Group

The New York Times
The Nielsen Company
The University of
Northampton

The World Bank
Thermo Fisher Scientific
Thomson

Thomson Reuters

Thule

Thyssenkrupp Aerospace
TIAA-CREF

Tiger Brands

Time Warner Cable
Timken

T-MOBILE USA
TORRENT
PHARMACEUTICALS LTD.
Toshiba Europe GmbH

Tourism Tasmania
Towers Perrin

Toyota SA

Trane

Trinity Industries
Triumph Motorcycles Ltd
TUI Nederland

Tyco Electronics

U

Ugam Solutions Private
Limited

Uline

Unilever

United Rentals

Universal American
Universal Health Services
Universiteit Groningen
University of Brighton
University of Helsinki -
Biomedicum

University of Richmond
University of St Andrews
University of the West of
Scotland

UPC Broadband Operations
BV

UPS

URS

US Department of Energy
US EPA

US Fish and Wildlife Service
US Foodservice

US Forest Service

USG

UTS CARRIER LLC

Vv

Value Retail PLC

Varian Medical Systems
Vectren

Verizon

Verizon Communications
VirginMedia

Vital Forsikring ASA
Vodafone Romania
Volkskreditbank AG
Volkwagen AG

Volvo Truck & Bus Centre
East Anglia
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W
= W.W. Grainger

= Walker & Associates, Inc.

= Walt Disney World Co
= Washington University
= Waste Management

= Wells Fargo

= Westminster City Council

= Weyerhaeuser

= Whirlpool

= Williams-Sonoma
= Windstream

= workday

= Wyeth

X

Xerox
Xstrata Coal South Africa

Y

Yahoo

Yamaha Golf Car Company
Yarden

Yellowbook USA

YUM BRANDS, INC

4

Zero Waste SA

Ziggo

Zumtobel AG

Zycus Infotech Pvt. Ltd
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Contact & Support

Get the latest information on
ASAP Utilities

Our website contains the latest information on ASAP Utilities, tutorials, background articles,
update information, links to relevant sites and more.

https://www.asap-utilities.com

Contact us

With great enthusiasm, and for over 24 years already, our team ensures that ASAP Utilities
is continuously evolving to help our users.

We love to hear your opinion and comments or suggestions. Please get in touch.
This helps us to make ASAP Utilities a better product every time.

Due to the international nature of ASAP Utilities with different languages and time zones
(we have clients in over 140 countries) we prefer contact by email.

For questions regarding ASAP Utilities or feedback send email to:

support@asap-utilities.com

or:

A Must in Every Office BV

Molenweg 242

8012 WT Zwolle

The Netherlands
https://www.asap-utilities.com/contact.php

Priority support for customers

If you are a registered customer then please include your order number, for a fast-track
(priority) response.

You can find your order number in email you received after the purchase.
You can also find your order details in the Excel menu: ASAP Utilities » Registered version.

Soclial media

You can also connect with us on:

facebook.com/ASAPUrtilities
twitter.com/ASAPUtilities
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F right-click/context menu, 27
FAQ, 317 S

G security, 359, 360

general Excel questions, 317 T

H temporarily uninstall, 355

History of ASAP Utilities, 320 translating, 9
Troubleshooting, 317
I Trust all installed add-ins and templates, 360

International versions of Excel, 11 Trusted sources, 360
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U Upgrade, 346
Undo, 19 Z
Uninstall, 352
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Appendix 1: Technical
information about the setup

This chapter is aimed at system administrators and is mainly written to give some in depth
information on how the setup process works.

The latest information is available on our website:
https://www.asap-utilities.com/setup-technical.php

Installation

ASAP Utilities is easy to install.

Standard setup

Just like most software, for the standard setup it is required that you have the sufficient
rights to install software on the computer. Upon the installation of ASAP Utilities you must
be logged in as an administrator or as a member of the Power Users group or you can
choose to run the setup as administrator.

Every user on the computer is able to use ASAP Utilities after the installation is finished.

https://www.asap-utilities.com/fag-questions-answers-detail.php?m=109

ASAP Utilities is automatically added to the Excel menu for the user that performs the
installation. If other users of the same computer also want to use ASAP Utilities in Excel,
you can specify this during the setup otherwise they need to perform steps 3 to 6 of the
paragraph “11.1.4 Manual installation” on page 343 or run the
'Add_ASAP_Utilities_to_the_Excel_menu.exe' program which only adds ASAP Utilities to
the Excel menu for the user that runs it. This file does NOT require special/administrator
rights, so any user can run it.

This file is located in the ASAP Utilities program files folder (by default

C:\Program Files (x86)\ASAP Utilities\).

Non-admin setup

We have created a special version of the Business edition that standard/limited users can
install.

This is edition is also available as a zipped-package with just the xlam, txt and pdf files.

This single-user setup does not require administrator rights during the installation.
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11.1.3 Automatic installation

Automatic installation is as easy as to follow the steps presented to you when you run the
setup file. During the setup you can specify the location where you want to install the files
and at the end ASAP Utilities will be available in your Excel menu.

ASAP Utilities does not require your computer to restart at the end of the installation.

1 Prior to installing

Just like with most programs it is recommended that all programs currently running on
your computer are closed before you run the setup.

It is not recommended to uninstall a previous version of ASAP Utilities. If you do so all
settings will be reset to the default settings, such as your favorite tools menu and your
registration information (license).

ASAP Utilities is digitally signed. This gives several benefits. For one example, it assures
you that the files come from us and have not been tampered with. The company name
you will see on the certificate is "A Must in Every Office BV". Windows might display this
before the setup starts.

The name of our company is A Must in Every Office B.V.:

User Account Control

Do you want to allow this app to make
changes to your device?

ASAP Utilities 8.0 setup

Verified publisher: A Must in Every Office B.V.
File origin: Hard drive on this computer

Show more details

| I

2 Performing the installation

1. Download the ASAP Utilities setup file and run it.
You can download the setup from:
https://www.asap-utilities.com/download.php
Select the language to use during the installation and choose OK.
You can choose from the following languages for the setup:
336 Chapter 11
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8.
9.

N o v A~ w N R

English
DeUtSCh (German) Select Setup Language *
- . Select the language to use during the installation.
Espaiiol (Spanish)
. English ~
Frangais (French) |Deutsch
. . Es;aﬁo_l
Italiano (Italian) Frangais
Nededands
Portugués Brasileiro
Nederlands (Dutch) Pycaont

RN gD
B

Portugués do Brasil (Portuguese
(Brazil))
Pycckuii (Russian)

th7(f&14) (Chinese (Simplified))

10. HA3E (Japanese)

2. The installation wizard begins and the welcome dialog is displayed. Click on the Next-
button to continue.

Setup - ASAP Utilities 8.0 - Trial version — X

Welcome to the ASAP Utilities 8.0
Setup Wizard

This will install ASAP Utilities 8.0 {October 4, 2022) for Excel
2010-2021/365+ together with the ASAP Utilities User Guide

on your computer,

It is recommended that you close all other applications before
continuing.

It is not necessary to uninstall a previous version of
ASAP Utilities, if you do so you lose your personal settings.

Click Mext to continue, or Cancel to exit Setup.

asa
utilﬁies

3. The License Agreement dialog is displayed. Please take time to read the license
agreement. If you agree choose "l accept the agreement" and then click on the Next-
button. If you disagree with the license terms, choose "l do not accept the agreement".
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If you do not accept the agreement the installation will be canceled.

Setup - ASAP Utilities 8.0 - Trial version — X
License Agreement
Please read the following important information before continuing.

Flease read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

ASAP Utilities End User License Agreement
Copyright @ A Must in Every Office BY.

Last Modified: March 2007.

Version: 1.00

CONDITIONS OF USE

“ou agree and continue to agree to use our software in a manner consistent
with all applicable laws and regulations and in accerdance with the terms and

I do not accept the agreement

4. Aninformation dialog is displayed. Click the Next-button to continue.

Setup - ASAP Utilities 8.0 - Trial version — X
Information
Flease read the following important information before continuing.

When you are ready to continue with Setup, dick Mext.
ASAP Utilities makes working in Excel faster and easier with over 300 useful and

powerful tools. Since 1989 it has grown to become probably one of the worlds most
popular add-ing for MS Excel

Our goal is to make work easier for Excel users, both beginner and expert.

Have fun!

Bastien Mensink
A Must in Every Office BV

Cancel

5. Select a folder to install ASAP Utilities. We recommend you use the default folder,
"C:\Program Files (x86)\ASAP Utilities" or "C:\Program Files\ASAP Utilities\" but any
other location can be used too.

ASAP Utilities + this PDF User Guide requires approximately 45 MB of disk space.
If you have a previous version of ASAP Utilities installed and are upgrading, then the

setup will automatically detect the previously used destination folder.
Click the Next-button to continue.
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Setup - ASAP Utilities 2.0 - Trial version — X
Select Destination Location
Where should ASAP Utilities 8.0 be installed?

| D Setup will install ASAP Utilities 8.0 into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

Browse. ..

At least 28,6 MB of free disk space is required.

6. If you want to, then ASAP Utilities can create an entry in your start menu. Click the
Next-button to continue.

Y Setup - ASAP Utilities 8.0 - Trial version — X
Select Start Menu Folder
Where should Setup place the program's shortcuts?
o—
B— Setup wil create the program's shorteuts in the following Start Menu folder.

o —
To continue, dick Next. If you would like to select a different folder, didk Browse.

ASAP Utilities Browse. ..

Don't create a Start Menu folder

Cancel

7. Add ASAP Utilities automatically to the Excel menu for:
If you want the ASAP Utilities menu to be automatically added in Excel for all users on
this computer choose "Anyone who uses this computer (all users)". Click the Next-
button to continue.

This will automatically add ASAP Utilities to the Excel menu for each user that logs in on
the computer. This is also handy when you log in with normal user-rights and run the
setup as an administrator. At the end of the setup, we'll show how to manually add
ASAP Utilities to the Excel menu if needed (step 10).

Trusted Publishers, Office Trust Center Setting

During the setup you can have our company (A Must in Every Office BV) automatically
added to the List of Trusted Publishers in Excel.
Some people have their Excel security settings set to 'only allow macros run by Trusted
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Publishers', and then this can help.

Setup - ASAP Utilities 8.0 - Trial version — X
Select Additional Tasks
Which additional tasks should be performed?

Add ASAP Utilities automatically to the Excel menu for:
Anyone who uses this computer (all users). A Reboot may be required.
© orly me (Moby)
Trusted Publishers, Office Trust Center Setting
ssdéﬂr:)ur company (A Must in Every Office BV) to the list of Trusted Publishers (all

Cancel

8. Click "install" to install the files to the selected folder.

Setup - ASAP Utilities 8.0 - Trial version — X
Ready to Install
Setup is now ready to begin installing ASAP Utilities 8.0 on your computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:'¥Program Files (x36)\ASAP Utilites

Start Menu folder:
ASAP Utilities

Additional tasks:
Add ASAP Utlities automatically to the Excel menu for:
Only me (Maby)
Trusted Publishers, Office Trust Center Setting
Add our company {A Must in Every Office BV} to the list of Trusted Publishe:

Cancel

The setup program now installs ASAP Utilities on your computer:

Setup - ASAP Utilities 8.0 - Trial version - X

Installing
Please wait while Setup installs ASAP Utllities 8.0 on your computer.

Extracting files...
C:'Program Files (x36) WASAP Utilities\ASAP_Utlities_User_Guide.pdf
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9. The Setup is completed. Click the Finish button.

Setup - ASAP Utilities 8.0 - Trial version —

Completing the ASAP Utilities 8.0
Setup Wizard

Setup has finished installing ASAP Utilities on your computer,
ASAP Utilities will be automatically added to the Excel menu

when you (Moby) start Excel. Other users on this computer
can add ASAP Utilities manually to Excel,

Click Finish to exit Setup.

[ view readme. txt

: Online Support: Questions and answers

Quick Start: Practical Tricks to Save Hours in Excel with
ASAP Utllities {on our website)

10. The installation is finished, and you are ready to use ASAP Utilities.

Depending on the language of your Excel version, ASAP Utilities will appear in that
same language if available. Otherwise it will default to English.

In the Excel menu you will find a new item called "ASAP Utilities".

(In the rare situation that you don't see ASAP Utilities in the Excel menu, read our FAQ:
https://www.asap-utilities.com/add-to-excel-menu.php)

File ~ Home Insert Draw Pagelayout Formulas Data Review View Help ASAP Utilities = Comments
_é E‘];[ a:ai B sheets~ B Columns & Rows ~ = Numbers & Dates > | @ Web~ [ import~ {5 ASAP Utilties Options > (2) Online FAQ F
Eavorites & vison | select | EdRange~ £ Objects & Comments - Text ~ [ Information ~ [ Export ~ O Find and run a utility @ Info np?f
Shorteut keys~  Control B Fill [ Format ~ Jfx Formulas Py File & System~  [> Startv *, Start last tool again @), Registered version  the Day
Favorites Time saving tools Options and settings Info and help Tips tricks
AL ~ i3 v
8 [ E F G H J K M N <} P Q R s -
1 -
2
3
4
5
3
7
8
]
10
1
12
13
14
15
16
17
18
19
0 v
Sheet! @ Ll »
| Ready B8 0 Accessibility: Good to go i 0 -———+ 0% |

If you've chosen to create a start-menu folder at step 6, then a new program folder
called "ASAP Utilities" is created in your Windows Start menu.
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Enter your license details
To turn your copy of ASAP Utilities into a registered version do the following:

= |n the Excel menu choose ASAP Utilities » ASAP Utilities Options » 3. Enter license...

_ p e _

fiew  Help  ASAP Utilities

= Mumbers & Dates~ | @ Web ~ [® Import~  [{5} ASAP Utilities Options ~ | () Online FAQ i=
A Text [@ Information ~ [ Export ~ 8} 1. Settings, langusge and contact information...
fi Formulas ~ [B File & System ~ [ Start [@ 2 Edityourfavorite tools and shortcut keys.
tools
QY 3.EnterLicense...

~

BO®DE B B

4. Start the last used utility again.
5. Eind and run a utility... E
6. Open the ASAP Utilities User Guide (English, PDF)...

7. Tip of the Day - View Online
8. Read the latest news on ASAP Utilities
9. Visit the online FAQ: Frequently Asked Questions about ASAP Utilities

10. Check for new version on the ASAP Utilities website
[& 11. New teols in development (English only]

12, Close ASAP Utilities

(8 13. Show me thetime that | saved by using ASAP Utilities

In case you have ASAP Utilities 7: In the Excel menu choose the right-bottom button in
the ASAP Utilities Tab in Excel. (Trial version..., Enter License... or Home&Student
Edition...). Then click on the button "Enter registration information".

= Fill in all the fields exactly the same as in the email with your full license details.
You received two emails after the order was completed. The email from "ASAP Utilities
(A Must in Every Office BV)" contains the full license information.

After you entered the information click on the "Register" button.

= We recommend you to use "copy and paste" to avoid typing errors.
The information is case sensitive.
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You can use the shortcut Control+V to paste the information in the fields.

e — - - ]
-&b asaputilities T - oo

License information

Thank you for registering ASAP Utilities.
Please enter the registration information exactly as sent to you. The information is case sensitive. You can use
the shortcut Ctrl+V to paste the information in the fields.

Mame:

Organization:

Number of licenses:

\
\
Order number: ‘
\
\

License key:

Cancel Buy license. .. Activate now >>

11.1.4 Manual installation

Although we recommend the automatic installation, the manual installation is easy to do.

This paragraph about the manual installation is only kept as background information.

Walk through the following steps.

1.

Place all the ASAP Utilities files on your hard drive. It doesn’t matter what the location
is, as long as all the files in the package are together.

The recommended location is: “C:\Program Files\ASAP Utilities\” or

“C:\Program Files (x86)\ASAP Utilities”

Start Microsoft Excel

In the Excel menu choose

File » Options » Add-Ins

In the Manage drop-down at the bottom select “Excel Add-ins” and press the Go...
button

Manage: | Excel Add-ins =

oK Cancel

Click on the browse-button in the Add-Ins dialog to locate the ASAP Utilities.xlam file
(by default in the folder “C:\Program Files\ASAP Utilities\” or
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“C:\Program Files (x86)\ASAP Utilities”)
If Excel asks you to copy the file to the library folder, always answer "no". (this is

important)

Add-ins

Add-ins available:

Il Analysis ToolPak 0K
| Analysis ToolPak - VBA
| Eura Currency Tools Cancel
_ Solver Add-in

Automation...

Analysis ToalPak

Provides data analysis tools for statistical and
engineering analysis

Add-ins available:

I 2nalysis ToolPak oK
Analysis ToolPak - VBA
Euro Currency Tools Cancel
Solver Add-in
Browse...
53 Browse X
€ -~ <« Progr.. » ASAP Utilities » ~ Search ASAP Utilit...
Organize v Mew folder W @
- certificate
Ana
pral | resources
eng .
E3H ASAP Utilities.xlam

\,‘ Add-ins (*xlam:*xla:* xII) “

Tools = Cancel

File name: | ASAP Utilities.xlam
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Add-ins ? X

Add-ins available:

Analysis ToolPak
__| Analysis ToolPak - VBA

ASAP Utilities 8.0 RCT Cancel

__| Euro Curreney Tools
|| Solver Add-in Browse...
Automation...

| ASAP Utilities 8.0 RC7

| ASAP Litilities makes YOU rock in Excel! Easy to
use tools that save time and speed up your work
in Excel.
© 1999-2022 Bastien Mensink - A Must in Every
Office BV | https://www.asap-utilities.com

Make sure that "ASAP Utilities" is “checked” press the OK-button. When you do that

ASAP Utilities will be opened by Excel and added to its menu.
In the add-ins tab there is the menu of "ASAP Utilities".

If you do not see ASAP Utilities in the menu you have to close and restart Excel.

Installation is now finished. Have fun!

File Home Insert Draw  Page Layout Formulas Data Review View Help ASAP Utilities = Comments
‘& E‘;f ﬁ:& BT Sheets~  [Z Columns & Rows ~ = Numbers & Dates ~ 2% ASAP Utilities Options | (2) Online FAQ F
Favorites & Vison | Select | g Renge~  § Objects & Comments~ | [A] Text - ) Find and run 5 utility (i) Info Fp?
Shortcutkeys > Control ~ £ Fill~ [ Format ~ Jx Formulas ~ (*) Start lasttool again ) Registered version  the Day
Favorites Time saving tools Options and settings Info and help Tips tricks ¥
Al ~ Jx ~
A 8 [s D E F G H N o P a R 3 a
1 ]
ol -
3
4
5
5
7
8
)
10
1
12
13
14
15
16
17
18
19
0 v
Sheetl ® >

| Reaty @ % Accessibility: Good to go

B 0 ———+——+ o |

In case you don’t see ASAP Utilities in the menu, then it can by caused by certain

settings or limitations by your IT department. The information in the following article

can help you to solve that:

What to do if | don't see ASAP Utilities in the Excel menu?

https://www.asap-utilities.com/fag-questions-answers-detail.php?m=44
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Upgrade to a new version

If you install the new version in the same location as the previous version, it is not
necessary to uninstall the previous version before installing the new one. The settings of
your previous version (including the favorites menu) will then be kept.

Important

Do *NOT* uninstall your existing ASAP Utilities version before installing the new version;
otherwise, you will lose your settings and you will have to re-enter your license details.
Just install the new version “on top” of your current version.

If you want to install ASAP Utilities in another location, we recommend you to back-up the
favorite’s menu file if you have made changes to the favorites menu
(asap_custom_menu.ini) and uninstall the old version first.

Make sure Excel is closed and then run the setup or overwrite the old files. During the setup
you have to install the files into the same location as the old version. Usually this is
“C:\Program Files\ASAP Utilities\” or “C:\Program Files (x86)\ASAP Utilities”.

If you are not sure about that location you can see it in ASAP Utilities. Start Excel and then:

ASAP Utilities » ASAP Utilities Options » Settings, language and contact information...

7 1

ASAP Utilities - Settings, language and contact information..

General Folder settings ]Fi_le size Toolbar ] Contact information ] Debug ]

ASAP Utilities is installed in:

C:'\Program Files (x86)ASAP Utilities),

Folder to store your "Favorites and Shortouts™ file.

C:'\UsersiTest\AppData'Roaming\ASAP Utilities), @

Default path to save a backup

C:'\UsersiTest\Documents\Backup', La

Cloze
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Home & Student edition: Required upgrade once a year

Since 2001 it's our policy to force an upgrade (free) once or twice a year to the
free/unregistered (Home and Student) edition to make sure you are always using the latest
stable and most complete version. This is the only way to make sure everybody is using the
most recent version. In the past we were receiving too many emails from people with
feature requests and bug reports that had already been implemented or solved in the new
version.

Starting from 2012 the required upgrade has been reduced to once a year.

The new-version date is a pre-built-in date. No connection to the internet is made when
determining if there is a new version available. When you start a utility in ASAP Utilities and
this new-version-date is available, you will get a notice about the new version.

When you start a utility in ASAP Utilities and this new-version-date has come, you will get a
notice:

ASAP Utilities 7.5 (32+64-bit) - A new version is available [
Home Secreenshots 10 Language: Why use it? Download Purchase ContactUs Blog® 3 <]
", asap utilities
the essential dd-in for excel users .} .

Download Buy license Whatisit? Why useit? Features Testimonials User Guide Mews Excel tips Support

A new version of ASAP Utilities is available!

We're proud to announce that a new and improved version of ASAP Utlities is available.
‘four current version, 7.5 (32+64-bit), is outdated and will be dosed.

On 2/18/2020 this unregistered,trial version (7.5 (32+64-bit)) has expired.

It's our policy to force an upgrade twice a year to make sure you are always using the latest and most complete
Version.

‘You should upgrade if you are allowed to use the free version or you should buy a license.

‘You should purchase a license and register ASAP Utilities either:

- if you use it in a commercial organization (after a free trial period of 90 days),
- or if you don't want to be forced to update to the new version twice a year,
- or if you like this program and think it is worth the money,

- or because you know the maney will be invested in further development,

- or if you want to get priority support.

‘fou can download the new version from our website: https: ffwww.asap-utilities. com.

If you can't download from our website, we can send you the new version by email. If you send an email to
download @asap-utiliies, com you will get an automated reply with the new version added as attachment (approx. 12
ME).

‘You have to dose Excel before you install the new version.
Please install the new version in the same folder as the current version:
C:\Program Files (x36)\ASAP Utilities),

Enter license information ‘
Kind regards,
Bastien Mensink
https: ffwww.asap-utilities. com Registration information ‘

Close Download |

When you click on the “Download from www.asap-utilities.com” button, Excel will try to
open <www.asap-utilities.com> in your default browser. It will not automatically download
the new version, you have to download the new version yourself and perform the
installation.

This message will be shown only once a day when you start one of the ASAP Utilities tools.
You have the option to turn off the message for the next ten days. This way you can
continue to work without being bothered too much. Make sure you do the upgrade before
the end date is reached. After the end date the current (old) version will no longer work.
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I’'m sorry, but this is the only way to make sure people are using the most recent version. In
the past we were receiving too many emails from people with feature requests and bug
reports that had already been implemented or solved in the new version.

You have a period of approximately 3 months to upgrade (free).
Be informed by email when a new version is released

Subscribe to our Newsletter and you will receive free e-mail updates when a new version or
an important update of ASAP Utilities is released.

https://www.asap-utilities.com/asap-utilities-newsletter.php

Registered users / commercial organizations

If you have a purchased a license and entered the license details in ASAP Utilities, then the
program will never expire. You can choose your own time to upgrade to a newer version or
just stay with your current version. This is one of the major benefits for large organizations
with locked down computers. Buying a license for ASAP Utilities is possible since

March 2007.

https://www.asap-utilities.com/license-benefits.php

https://www.asap-utilities.com/download-old-versions.php

Network installation

There are several options for a network installation. In this section we provide some tips
about the way Excel works with add-ins. Please test them before you deploy.

The latest (technical) information about network installations is available on our website:
https://www.asap-utilities.com/setup-technical.php

You can install ASAP Utilities (or place all files) on a central location on your network and
have ASAP Utilities listed in the add-ins dialog in Excel or have it automatically loaded. If
you manually place the files on a central location, make sure all files are in the same folder.
The benefit of having ASAP Utilities on a central location on the network is that upgrading
to a new version is as simple as installing it once into that folder.

After placing the files on a network drive there a few things you might have to do:

= Users have to be able to load ASAP Utilities (read access to the files).

= You can have ASAP Utilities loaded for every user each time Excel starts.
Excel stores which add-ins to load only on a per-user basis. Excel does not have a setting
to have your add-in loaded for every user on a computer. However, if you want
ASAP Utilities automatically added to the Excel menu for all users, you can specify this
during the setup or, in the registry (11.3.3, “Add ASAP Utilities to the Excel menu for all
users” on page 358)

= Besides the installation you should also add the license information in the registry of
every user (HKEY_CURRENT_USER) to make sure they get the registered version that
does not expire. This is described in paragraph 11.3.411.3.4, “Registration/license
settings” on page 359.
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Display ASAP Utilities in Excel’'s Add-in list

To have ASAP Utilities available in Excel’s add-in list you have to add it to the registry for
each user. This will only show ASAP Utilities in the add-in list. It will not automatically load
ASAP Utilities.

Create a new string value in the registry key:

HKEY_CURRENT_USER\Software\Microsoft\Office\ <version> \Excel\Add-in Manager\

For example, for Office 2021 this is:

HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Excel\Add-in Manager\

Excel 2010 14.0
Excel 2013 15.0
Excel 2016 16.0
Excel 2019 16.0 (same as Excel 2016)
Excel 2019 16.0 (same as Excel 2016)
Excel 2021 16.0 (same as Excel 2016)
Excel 365 16.0 (same as Excel 2016)

Create a new string value where the name is the full path and filename of ASAP Utilities.
ASAP Utilities 8, uses ASAP Utilities.xlam

For example: O:\Apps\Office\Add-ins\ASAP Utilities\ASAP Utilities.xlam.

The value data is empty:

[ Registry Editor - a * )
File Edit View Favorites Help
Computer\HKEY_CURREMT_USER\Software\Microsoft\Office) 16.0\Excel\Add-in Manager

S 15T Common Name Type Data

o Bxcel ab] (Default) REG_SZ (walue not set)

Edgniianaoey E1 0:\Apps\Office\ Add-ins\ASAP Utilities\ASAP Utilities.xlam REG_SZ
AddInLoadTimes

ClickToRunLicensing
DocumentTemplateCache
File MRU

Options

Edit String *

Value name:
O \Apps\Office’\Add-ins"\ASAP Liilities\ASAP Ltilities xlam

Value data:
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When the user now starts Excel, ASAP Utilities is optionally available in Excel’s File »
Options » Manage Excel Add-ins. And then the users can “check” it to be loaded.

Add-ins ?

Add-ins available:

Euro Currency Tools
Solver Add-in

ASAP Utilities 8.0 RCT

Analysis ToolPak oK
| Analysis ToolPak - VBA
H| ASAP Utilities 8.0 RCT Cancel

Browse...

Automation...

ASAP Utilities makes YOU rock in Excel! Easy to
use tools that save time and speed up your work

in Excel.

€ 1999-2022 Bastien Mensink - A Must in Every

Office BV | https:/fwww.asap-utilities.com

Load ASAP Utilities on Excel startup

To have ASAP Utilities automatically loaded every time Excel starts you have to follow the
steps in this paragraph. If you want this for all users on the computer, please have a look at
paragraph 11.3.3 Add ASAP Utilities to the Excel menu for all users on page 358.

You can either do this by editing the registry either manually or via a script, or by running
the program “Add_ASAP_Utilities_to_the_Excel_menu.exe” which is located in the

ASAP Utilities program files folder and automatically adds ASAP Utilities to the Excel menu
for the Windows user accounts that runs this program.

To have ASAP Utilities automatically installed you have to write an entry to the registry key:

HKEY_CURRENT_USER\Software\Microsoft\Office\<version>\Excel\Options\

Excel 2010
Excel 2013
Excel 2016
Excel 2019
Excel 2021
Excel 365

14.0
15.0
16.0
16.0
16.0
16.0

In Excel 2021 this is for example:

(same as Excel 2016)
(same as Excel 2016)

(same as Excel 2016)

HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Excel\Options\
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In this key there are a set of ascending entries numbered OPEN, OPEN1, OPEN2, etc. The
value of each of these entries is the full path to and the filename of the add-in.

To add ASAP Utilities, you have to find the highest numbered OPEN<n> value and create a
new value one higher. They must be continuous and in the following order:

OPEN
OPEN1
OPEN2
OPEN3
etc.

In a clean Excel installation without any add-ins installed there are no OPEN values. In that
case you can add ASAP Utilities by creating a new value of the string type with the name
OPEN and as value the full path and filename of ASAP Utilities, surrounded by quotation
marks.

ASAP Utilities 8, uses ASAP Utilities.xlam

For example:

"0:\Apps\Office\Add-ins\ASAP Utilities\ASAP Utilities.xlam".

You have to write the double-quotes (") around it because the path/filename contains
spaces.

Edit String X

Value name:

OPEN

Value data:

/R "O:\Apps \Office \Addins \ASAP Ltiities \ASAP Ltilities xlam”

If you precede the add-in name with a /R switch the add-in will be opened as read-only.

Example of the registry key with no other add-ins loaded:

B Registry Editor — ] X
File Edit View Favorites Help
ComputerHKEY_CURRENT_USER\Software\Microsoft\Office\ 16.0\Excel\Options

~ Bl 160 Narne Trpe

» B Access %4 FormulaBarExpanded REG_DWORD

» &5 Comman %) FormulaBarExpandedLines REG_DWORD

v EX“:LM Manager ) LastUlLang REG_DWORD
AdelintosdTrmes 24 Maximized REG_DWORD
ClekToRunLicensing % MonitorTopolagyFingerprint REG_QWORD

| 5 7 DocumentTemplateCache || 2*/MRUFuncs REG_SZ

: File MRU 24 MsoTbCust REG_DWORD

: Options 7 open | REG_SZ /R "0:\App=\Office\ Add-ins\ ASAP Utilities\ASAP Utilities xlam”

i ." Place MRU #%| OptionFormat REG_BINARY

{3 7 Recent Templates %4 Options5 REG_DWORD

§ 5T Security 24| Options25 REG_DWORD
StatusBar 25| PersonalTemplates REG_EXPAND_SZ

{37 UserMRU ab]Pos REG_SZ
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Example of the registry key when Microsoft’s Analysis Toolpak and Solver Add-in were

already active. ASAP Utilities now uses the OPEN2 key:

| File Edit View Favorites Help
Computer\HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Excel\Options

Uninstall

Automatic

v 2180 Mame Type

3 B Access 3 LastUlLang REG_DWORD

4 E:”‘Im” | Maximized REG_DWORD

- cel

: 24 MonitorTopologyFingerprint REG_QWORD
Asdniondtrme HURUFncs Rec sz
ClickToRunLicensing %':JMSDWCUS‘ REG_DWORD

i 5 7 DocumentTemplateCache 'h OPEN REG_SZ

; File MRU 28] OPEN1 REG_SZ
Options 55 open2 REG_SZ

: Place MRU 2| OptionFormat REG_BINARY

{37 Recent Templates %4 Optionss REG_DWORD

D T Security 4] Options3 REG_DWORD

: StatusBar ab)PersonalTemplates REG_EXPAND_SZ

i > T User MRU ab)Pos. REG_SZ

/R "C:\Program Files\Microsoft Office\root\Office18\Library\ Analysis\ANALYS32.XLL"
/R "C:\Program Files\Microsoft Office\root\Office16\Library\ SOLVER\SOLVER XLAM"
/R "O:\Apps\Office\Add-ins\ASAP Utilities\ASAP Utilitiesdam”

The easiest and recommended way to uninstall ASAP Utilities is to do this via the Windows

Control Panel.

Windows Start » Control Panel » Programs » Uninstall a Program

Then select ASAP Utilities in the list of programs and click on the "Uninstall" button:

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Backup and Restore (Windows 7)

Network and Internet
View network status and tasks
Hardware and Sound
View devices and printers

Add a device
Adjust commonly used mability settings

JdiE @

R
=] Programs

Uninstall s program

« 5

Control Panel H .

e Feneiome Uninstall or change a program
View installed updates

% Turn Windows features on or

off

Organize v Uninstall

Name

Note

View by:

User Accounts
®5 Change account type

Appearance and Personalization

Clock and Region
Change date, time, or number formats
Ease of Access

Let Windows suggest settings
Optimize visual display

EF1 > Control Panel > Programs > Programs and Features

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Publisher

E ASAP Utilities

A Must in Every Office BV - Bastien Mens... Product version: 8.0
Help link:  https://www.asap-util... Update information:

Category v

A Must in Every Office BY - Bast...

Installed On

g
b
2
B
B

- D0 X
v Search Programs and Features
=+v @
Size Version
|
407MB 80
I .
I .
I
I .
I .
N .

Support link: ~ hittps://www.asap-utilities.com

hitps://www.asap-utilities.com/asap-utilities-upgrade....
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If other users on the same computer used ASAP Utilities too, you will have to manually
remove ASAP Utilities from their list of Excel add-ins. This is something that can only be
automated for the user that runs the uninstall due to the design/restrictions of
Microsoft Windows. In such a case the user has to follow step 4 till 7 of the manual
uninstall.

11.2.2 Automatic uninstall #2

As an alternative you can also use the following method to uninstall ASAP Utilities.

You can also run “unins000.exe”, from the ASAP Utilities installation folder. The uninstaller
removes all ASAP Utilities installation files and removes all ASAP Utilities entries from the
registry.

If you have specified an alternative location to store your favorites menu settings, you have
to manually remove the file asap_custom_menu.ini from that location.

C:\Program Files (x86)\ASAP Utilities = (m] *

@ New ¥ (] =] B4 T T sort = View

€ v 1 <« Windows (C:) » Program Files (x86) > ASAP Utilities ~ G Search.. 0O
] Mame . Date modified Type Size

certificate 20-8-2022 11:04 File folder
FESOUICES 20-8-2022 11:04 File folder

Add_ASAP_Utilities_to_the_Excel_menu.exe 24-3-2022 14:58 Application 3.092 KB
D Add_ASAP_Utilities_to_the_Excel menu-0.bin 24-3-2022 14:51 BIN File T8 KB
D Add_ASAP_Utilities_to_the_Excel menu-1.bin 24-3-2022 14:51 BIN File 1KB
BH ASAP Utilitiesxlam 20-9-2022 09:31 Microsoft Excel Add-In 6711 KB
[ ASAP_Utilities_User_Guide.pdf 5-4-2022 21:31 Microsoft Edge PDF Document 21.055 KB
asap-utilities.ico 19-3-2022 20:14 lcon 40 KB
=] readmetxt 20-9-2022 09:33 Text Document 7KB
Remove ASAP_Utilities_from_the Excel_menu.exe 24-3-2022 14:58 Application 3.082 KB
D Remove_ASAP_Utilities_from_the_Excel_menu-0.bin  24-3-2022 14:51 BIM File T3 KB
D Remove_ASAP_Utilities_from_the_Excel_menu-1.bin  24-3-2022 14:51 BIM File 1KB
D unins000.dat 20-9-2022 11:04 DAT File T4 KB

uninsD00.exe 20-9-2022 11:04 Application 3.003 KB
B unins000.msg 20-9-2022 11:04 Outlock ltem 25KB
|=] version_history.txt 20-9-2022 09:32 Text Document 64 KB

unins000.exe Date modified: 20-9-2022 11:04 Date created: 20-9-2022 11:04
‘& Application Size: 3,01 MB
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ASAP Utilities 8.0 RCT Uninstall

Are you sure you want to completely remove ASAP Utilities 8.0
RC7 for Excel and all of its components and settings?
Itis recommended that you close all other applications before
continuing, especially MS Excel.

You do not need to uninstall before upgrading to a new
version,

If you do so you lose your personal ASAP Utilities settings and
you have to re-enter your license details,

Continue?

11.2.3 Manual

Another way is to manually remove ASAP Utilities 8 but we recommend the automatic
uninstall.

1. Close Excel, if it is opened.

2. Delete the folder where the ASAP Utilities program is installed.
Usually this is “C:\Program Files\ASAP Utilities” or
“C:\Program Files (x86)\ASAP Utilities”.

3. Start Excel, you will now receive an error, indicating that ASAP Utilities could not be
found.

Microsoft Excel X

! Sorry, we couldn't find C:\Program Files [x26)\ASAP Utilities\ASAP Utilities xlam. s it possible it was moved, renamed or deleted?

4. Inthe Excel menu choose

File » Options » Add-Ins

5. Inthe Manage drop-down at the bottom select “Excel Add-ins” and press the Go...
button

Manage: | Excel Add-ins i

oK Cancel

6. Then uncheck the check box next to Asap Utilities.
Excel will now ask you if you want to remove ASAP Utilities from the list. Answer with
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yes.

Add-ins available:

:AnalysisToo\Pak 0K

| Analysis ToolPak - VBA
H Asap Utilities Cancel

|| Euro Currency Tools

Microsoft Excel x

o Cannot find add-in "C:\Program Files (x86]\ASAP Utilities\ASAP Utilities.xlam’, Delete from list?

|

Yes Mo

Asap Uilities

7. Now close the form, and ASAP Utilities is successfully uninstalled.
ASAP Utilities is removed from your computer and Excel.

11.2.4 Temporarily deactivating ASAP Utilities from startup

If you want to temporarily uninstall ASAP Utilities, for example if you want to make
screenshots and want the default Excel menu bar shown without ASAP Utilities, or if you
think you have problems related to ASAP Utilities, you can do the following:

1 Automatically deactivate ASAP Utilities from starting up
with Excel

You can either uncheck ASAP Utilities manually from the add-ins list in Excel, or you can
simply run the program “Remove_ASAP_Utilities_from_the_Excel_menu.exe” which is
located in the ASAP Utilities program files folder. This tiny program will automatically
remove ASAP Utilities from the Excel menu/deactivate it as add-in in Excel, for the
Windows user accounts that runs this program and does not require admin-rights to run.
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Ci\Program Files (xB6)\ASAP Utilities = [m] X
@ New - &% O [2)] = W N sort ~ aee
« 3> v 4 <« Windows (C:) » Program Files (x86) » ASAP Utilities v G Search... O
Name Date modified Size
certificate File folder
resources File folder
E Add_ASAP_Utilities_to_the_Excel menu.exe 24-3-2022 14:58 Application 3.092KB
D Add_ASAP_Utilities_to_the_Excel_menu-0.bin 24-3-2022 14:51 BIN File T8 KB
D Add_ASAP_Utilities_to_the_Excel_menu-1.bin BIM File 1KB

@3' ASAP Utilities.xlam
[E ASAP _Utilities User_Guide.pdf
asap-utilities.ico

5] readmetxt

B Remove ASAP _Utilities_from_the Fxcel_ menu.exe  24-3-

D Remove_ASAP_Utilities_from_the_Excel_menu-0.bin

[ Remave_ASAP Utilities_from_the Fxcel_menu-1.bin

D unins000.dat

7 unins00D.exe 20-9-
[ unins000.msg 20-9-
5] version_history.xt 20-9-

Microsoft Excel Add-In

Microsoft Edge PDF Document

lcon 40 KB

Text Document

2022 14:58 Application 3.092 KB

BIN File

BIM File 1KB

DAT File TAKB
2022 11:04 Application 3.093KB
2022 11:04 Qutlook Item 25 KB
2022 09:32 Text Document 64 KB

i Remove_ASAP_Utilities_from_the_Excel_m... Date modified: 24-3-2022 1458

Application

Size: 3,01 MB

. Setup - Remove ASAP Utilities from the Excel menu

Remove ASAP Utilities from the Excel
menu for user "Moby™

If you continue then ASAP Ltilties will be removed from the
Excel menu for the cument user account {Moby) on this

computer.

Please close Excel before you continue.

asa
utilPt

es

Cancel
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2 Manually deactivate ASAP Utilities from starting up with
Excel

In the Excel menu choose:
File » Options » Add-Ins

In the Manage drop-down at the bottom select “Excel Add-ins” and press the Go... button

Manage: | Excel Add-ins = I
e |,

Add-ins ? X

Add-ins available:
;AnalysisToolPak oK

. Analysis ToolPak - VBA

Il ASAP Utilities 8.0 RCT

Euro Currency Toals
|| Solver Add-in

Cancel
Browse...

Automation..,

ASAP Utilities 8.0 RC7

ASAP Utilities makes YOU rock in Excel! Easy to
use tools that save time and speed up your work
in Excel.

® 1999-2022 Bastien Mensink - A Must in Every
Office BV | https:/fwww.asap-utilities.com

Then uncheck the check box next to ASAP Utilities.
This will remove ASAP Utilities from the menu and it will not automatically start with Excel.

If you want to enable ASAP Utilities again, just check the checkbox next to ASAP Utilities.

11.3 User data and registry settings

This chapter will tell you where ASAP Utilities saves its settings.

11.3.1 Registry

The settings of ASAP Utilities are stored in the registry in the following section:

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\ASAP Utilities\
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The favorites menu, asap custom menu.ini, is by default stored in your application
data folder, for example:

C:\Documents and Settings\<UserName>\Application Data\ASAP Utilities\
or
C:\Users\<UserName>\AppData\Roaming\ASAP Utilities\

However this can be changed via:

ASAP Utilities » ASAP Utilities options » Settings, language and contact information...

The folder where the favorites menu is located is stored in the value CustomMenuPath in
the key:

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\ASAP Utilities\Setup

The location of the favorites menu file should preferably be writeable and editable, if not
users can use the favorites menu but they cannot change it and will get a warning message
when trying to.

NOTE: In versions before 4.2.2 the file was by default placed in the same location where
ASAP Utilities was installed, which was usually the program files folder.

NOTE2: If you change the folder directly in the registry, make sure the .ini file exists in that
location, otherwise the user will be prompted that the file wasn’t found there and asked to
choose a new location.

During the setup you can specify to have ASAP Utilities added to the Excel menu for all
users or just for the user that runs the setup.

If you specified to have ASAP Utilities added to the Excel menu for all users, then the
program “Add_ASAP_Utilities_to_the_Excel_menu.exe” is added to the ActiveSetup to run
once for each user on the system.

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Active Setup\Installed Components\

Or

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Active Setup\Installed
Components\

The program will run once for each user that logs on the system and due to the command-
line parameter /VERYSILENT it will run quickly and invisible to the user.
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11.3.4 Registration/license settings

The license is stored per user and the license information is stored in:

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\ASAP Utilities\setup\

The following string-values are used to store the registration information:

* pame
= key

= order

= orderamount
= organization

Note: Some of these values are stored encoded. You will see this if you register
ASAP Utilities manually.

11.4 Macro security

ASAP Utilities is digitally signed. This gives several benefits. For one example, it assures you
that the files come from us and have not been tampered with.
The company name you will see on the certificate is "A Must in Every Office BV"

: ?
@ Microsoft Office has identified a potential security concern. U91ta Signature Details ? %
Gt |
Note: The digital signature is valid, but the signature is from a eneral  Advanced
blisher wh h t yet chosen to trust.
publisher whom you have not yef chosen to fr —_, Digital Signature Information
File Path: | c\Program Files (x3E)\ASAP Utilities\ASAP Utilities xlam o digital signature is OK.

Macros have been disabled. Macros might contain malware or other Signer information
security hazards, Do not enable this content unless you trust the

source of this file. Name: |A Must in Every Office B.V.
More information Email: -
mail |suppurt@asap1.mlmes.cum
Show Signature Details - .
Signing time: |Wednesday, April 6, 2022 6:36:28 AM
Trust all from publisher Enable Macros Disable Macros
View Certificate
Countersignatures
Name of signer: Email address: Timestamp
Sectigo RSATim... Mot available Wednesday, April &, ...

During the installation ASAP Utilities will be installed as default add-in. This means that
every time you start Excel, ASAP Utilities will be loaded and is ready to use.

In order to use ASAP Utilities your security need to be set at a certain level. This level can be
high, since ASAP Utilities contains a digital signature, you can choose to always trust us.
In Excel 2003 and newer you also have the option to set the security lever to “Very High”,
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however when you do that you won’t be able to use ASAP Utilities unless you set the level
back to high, or choose to “Trust all installed add-ins and templates” (see the next chapter).

You only need to change the below values if you encounter problems:

In Excel’s menu choose:

File » Excel options » Trust Center » Trust Center Settings

Then choose “Disable all macros except digitally signed macros” or “Disable all macros with
notification”

Macro Settings

For macros in documents not in a trusted location:
C) Disable all macros without notification
O Disable all macros with notification
(&) Disable all macros except digitally signed macros

O Enable all macros [not recommended; potentially dangerous code can runj

ASAP Utilities will never(!) require you to lower your security settings to low.

Trusted sources and security settings to “very high”

If you want to run ASAP Utilities in Excel with the security settings to “Very High”, then you
also have to have the “Trust all installed add-ins and templates” check box checked. This is
the default setting of Excel so most likely you don’t have to change any settings.

Choose in the Excel ribbon:

File » Options » Trust Center » Trust Center Settings

The default option that Excel uses is “Disable all macros with notification”.

Trust Center ? X

Trusted Publishers
fusted Fublisher Macro Settings

Trusted Locations
Disable VBA macros without notification
Trusted Documents . o X X X
® Disable VBA macros with netification
Trusted Add-in Catalogs Disable VBA macros except digitally signed macros
Add-ins Enable VBA macros (not recornmended; potentially dangerous code can run)
ActiveX Settings

[] Enable Excel 4.0 macros when VBA macros are enabled
Macro Settings

Protected View Developer Macro Settings

Message Bar [ Trust access to the VBA project object model
External Content

File Block Settings

Privacy Options

Form-based Sign-in
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By default add-ins are enabled in Excel 2007 and newer.
You can turn all Add-ins off via “Disable all Application Add-ins (may impair functionality)”.
Disabling all Application Add-ins will also disable ASAP Utilities.

Trust Center ? X

Trusted Publishers Add-ins (COM, VSTO and Other)

Trusted Locations
[] Require Application Add-ins to be signed by Trusted Publisher
Trusted Documents
O
Trusted Add-in Catalags [] Disable all Application Add-ins (may impair functionality)
ActiveX Settings
Macro Settings
Protected View
Message Bar
External Content
File Block Settings
Privacy Options

Form-based Sign-in
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How to use ASAP Utilities in your own
macros

Excel doesn't record the actions you do with add-ins, such as ASAP Utilities when you use
the macro recorder. However, you can start the tools in ASAP Utilities from within your own
macro.

You do have to know the basic understandings of macros/VBA (Visual Basic for
Applications). We do not officially support running ASAP Utilities macros from within your
own macros and offer help on this, but it can be done.

More information and a few examples are on our website:

https://www.asap-utilities.com/run-as-part-of-a-macro-vba.php
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